


 

Table of Contents

            

enu...............................................102
ne ................................................102
ttings ............................................103
....................................................106
....................................................107
e ..................................................107
....................................................108
tions ............................................113

  

.................................................115

 

vice Characteristics........................115
tor ...............................................123
....................................................129
....................................................133
....................................................141
....................................................143
....................................................147
....................................................148
....................................................149
....................................................150
....................................................151
....................................................152
....................................................154
....................................................155
1 Introduction............................................... 1
Welcome .......................................................... 1
Computer Requirements ..................................... 2
Software Installation........................................... 3
Upgrading from a Previous TRAX Version............ 4

2 System Overview ..................................... 6
Dataton Control Units......................................... 9
Software Overview .......................................... 12
System Modes ................................................. 16

3 TRAX Windows....................................... 20
Device Window............................................... 23
Device Status Windows .................................... 28
Timeline Window............................................. 29
Task Window .................................................. 51
Device Support ................................................ 63

4 Menus and Commands .......................... 72
File Menu........................................................ 73
Edit Menu ....................................................... 77
Object Menu ................................................... 89
Device Menu ................................................... 94
Cue Menu ....................................................... 95
Symbol Menu .................................................. 96

Window M
New Timeli
Timeline Se
List View....
Time Scale.
Track Nam
Preferences
Security Op

5 Devices ..
General De
Slide Projec
Switch .......
Tape .........
Audio Disc
Video Disc.
Still Store...
Lamp ........
Level .........
Panel ........
Text ..........
Time .........
Serial ........
IR..............

Hint
Click an entry to go to that page.



        

...................................219

 

..................................... 220

..................................... 226

..................................... 232
ns ................................. 234
ation ............................. 235
..................................... 238
..................................... 240

  

...................................241

 

..................................... 242

..................................... 246

..................................... 252

..................................... 257

..................................... 261

 

vice Drivers

 

.............264

 

..................................... 268
iver ............................... 278
..................................... 280
..................................... 282
ds ................................. 292
..................................... 298
er ................................. 311
..................................... 312
6 Panel Design..........................................156
Panel Status Window..................................... 156
Button........................................................... 163
Indicator ....................................................... 168
Slider ........................................................... 170
Bar Graph .................................................... 171
Display ......................................................... 172
Line, Frame and Oval .................................... 174
Static Text ..................................................... 174
Pictures......................................................... 175
Testing a Panel .............................................. 177

7 Cues ........................................................178
General Cue Characteristics ........................... 179
Locate........................................................... 186
Set/Fade ...................................................... 190
Dissolve ........................................................ 194
Zoom ........................................................... 198
Wipe............................................................ 200
Flash ............................................................ 202
Snap ............................................................ 204
Trigger ......................................................... 206
Gang ........................................................... 210
Control ......................................................... 212
Note............................................................. 218

8 Presentations......
Canned Presentations
Speaker Support.......
Live Events................
Interactive Presentatio
General Media Integr
Staging Shows..........
Automatic Start.........

9 Interactivity.........
Inputs.......................
Touch Panels ............
Virtual Devices .........
Timing .....................
Branching ................

10 Creating Serial De
Before You Begin ......
Editing an Existing Dr
Creating a Driver......
Driver Settings ..........
Entering the Comman
Command Strings .....
Downloading the Driv
Using Your Driver .....



 

11 SMARTPAX

 

............................................ 316

 

Front Panel.................................................... 317
Rear Panel .................................................... 324

         

15 TRANSPAX+

 

...........................................369

 

Tape Signals..................................................373
Front Panel ....................................................379

....................................................388
tors...............................................392
ly ................................................393

 

RAX 3

 

....................................394

 

....................................................394

....................................................396

....................................................399

....................................................400

....................................................404

....................................................405
s Made on TRAX 2........................405

  

.................................................409

  

.................................................423
SMARTLINKS................................................. 326
Power Supply ................................................ 340
Rack Adaptors............................................... 341

12 TOUCHLINK ........................................... 342

13 AIRLINK ................................................. 346
Transmitter .................................................... 346
Receiver ........................................................ 351

14 PAX........................................................ 355
Front Panel.................................................... 356
Rear Panel .................................................... 363
Projector Adaptors......................................... 366
Switch Functions ............................................ 367
Power Supply ................................................ 368

Rear Panel.
Tape Adap
Power Supp

A. News in T
Overview ..
Windows ..
Menus.......
Devices .....
Cues .........
Preferences
Using Show

B. Glossary

Index .....



   

ataton.se

ww.dataton.com/

  

se

 testers for their help in testing 

drews at Inline Inc. for kindly 
 on the IN1224 for the case 

roduced on Apple Macintosh 
rks CodeWarrior. This manual 

acintosh computers using 
lustrator, PhotoShop and 
s were scanned using Kodak 

Document number: 3943
Dataton TRAX version 3 software and manual © Copy-
right 1996, DATATON UTVECKLINGS AB (“Dataton”). 
All rights reserved. 

Dataton TRAX, TOUCHLINK, Dataton PAX and the 
Dataton logo are registered trademarks of DATATON 
UTVECKLINGS AB. SMARTPAX, TRANSPAX+, AIRLINK, 
SMARTLINK are trademarks of DATATON UTVECK-
LINGS AB. All other company and product names are 
trademarks or registered trademarks of their respective 
owners. Use of a term in this publication should not be 
regarded as affecting the validity of any trademark.

The information in this manual has been carefully 
checked and is believed to be accurate. However, 
Dataton assumes no responsibility for any inaccuracies 
that may be contained in this manual. In no event will 
Dataton be liable for direct, indirect, special, incidental, 
or consequential damages resulting from any defect or 
omission in this manual, even if advised of the possibility 
of such damages. The technical information contained 
herein regarding features and specifications is subject to 
change without notice.

Dataton AB
Box 1257
S-581 12  LINKÖPING
Sweden

Fax: int+46-13-13 84 45
E-mail: info@dataton.se
TRAX suggestions: trax@d

World wide web: http://w

Technical Support:
Fax: int+46-13-10 24 51
E-mail: support@dataton.

Special thanks to our beta
Dataton TRAX.

Special thanks to Mike An
providing the information
study in chapter 10.

The TRAX software was p
computers using Metrowe
was produced on Apple M
Microsoft Word, Adobe Il
FrameMaker. Photograph
Pro Photo CD technology.

Printed in Sweden.



 

Chapter 1: Introduction

 

1

 

1

 

1

 

INTRODUCTION

  

art of the Dataton media integration and 
 Apple Macintosh™, or compatible 
ating and running shows incorporating 
tion media. The control system expands 
, while maintaining the precise timing 
rk of all good presentations.

  

in sections. The first section consists of 
titled “System Overview.” These two 
 to TRAX as well as the rest of the 

 the reference section of this manual. 
cts of TRAX, such as windows, menus, 
where to look for detailed information 

resentation Methods” and “Interactivity,” 
resentations you can create, as well as 

nd of presentation.

dware parts of the control system in 
ARTPAX, PAX and TRANSPAX+ control 

ll as TOUCHLINK – the interactive touch 
ote control.
Welcome Welcome to DATATON TRAX® the he
control system. TRAX transforms your
computer, into a powerful tool for cre
virtually any combination of presenta
and enhances your Mac’s capabilities
and synchronization that is the hallma

About This Manual This manual is organized into four ma
this chapter and the following one en
chapters give you a quick introduction
Dataton control system. 

The subsequent five chapters make up
They go through all the different aspe
commands, devices and cues. This is 
related to a particular part of TRAX.

The following two chapters, entitled “P
give you an overview of the kinds of p
some tips and hints related to each ki

The remaining chapters cover the har
detail. Look here for information on SM
units and their interface cables, as we
panel – and the AIRLINK wireless rem



    

er Macintosh, PowerBook, or 
r. Mac OS version 7.5.3 or 
 functions.

M memory, after loading your 
ore memory may be required 
ou need at least 5 megabyte 

and its accompanying files. 

 port, is needed to connect 
e systems, TRAX can use two 
r of control units and devices 
d with computer models that 
ernal modem port (e.g., some 

ed. A color monitor is particu-
nel designs.
2 Chapter 1: Introduction

Computer 
Requirements

You can run TRAX on any Apple Macintosh, Pow
compatible running Mac OS version 7.0 or late
later is recommended, and is required for some

You must have at least one megabyte of free RA
System software and extensions. Substantially m
to use graphics and sounds with TOUCHLINK. Y
of free hard-disk space in order to install TRAX 

A free serial port, such as the modem or printer
TRAX to the rest of the Dataton system. For larg
serial ports simultaneously to double the numbe
that can be connected. This feature can’t be use
have a combined printer/modem port or no ext
PowerBook models).

A color monitor is recommended, but not requir
larly useful when making TOUCHLINK touch pa
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Software Installation

 

Before installing the software, please take a few moments to fill out the regis-
tration card and return it to Dataton either by fax or by mail. Registering your 

 benefits:

 TRAX become available.

rades, or even free upgrades to fix bugs 

  

, Dataton’s user magazine, with news 
d the world. 

  

ert the TRAX 3 diskette, as shown to the 
e steps:

staller” icon.

y folder where you want to install TRAX.

nying files in a folder at the location you 
ed or modified.

he “TOUCHLINK Graphics Sampler”. 

   

Dataton TRAX Runtime” diskette on your 
copy of TRAX gives you the following

• A Dataton T-shirt.

• Free support by fax or e-mail.

• Notification when new versions of

• Substantially reduced prices on upg
or other minor details.

• Free subscription to News&Views
from the field of multimedia aroun

Installing TRAX on Your Hard 
Disk

To install TRAX on your computer, ins
left, in your computer and follow thes

• Double-click the “Dataton TRAX In

• Navigate to your hard-disk, or an

• Click the Extract button.

This will install TRAX and its accompa
specified. No other files will be install

Follow the same procedure to install t

▼ IMPORTANT: Do not install the “
computer.



    

u will be asked to enter your 
 be found on the original 

f TRAX will carry your name, 
d. Furthermore, you can add 
icture), as well as an optional 
mand on the Window menu 

  

RAX, you should follow the 
this new version of TRAX in its 

   

e – in case you get them mixed 
r and choose “Get Info” from 

compared to earlier versions, 
ter as well. Although TRAX 
ons of TRAX, not all functions 

 their icon, and the right 
hen you double-click a show 

 details if you’re upgrading 
4 Chapter 1: Introduction

Personalizing TRAX The first time you use TRAX after installing it, yo
name and serial number. The serial number can
diskette as well as on the registration card.

All shows saved using your personalized copy o
which will be displayed when the show is opene
your own copyright message and logo (or other p
password, to the show using the Preferences com
(see “Preferences” on page 108).

Upgrading from a 
Previous TRAX 
Version

If you’re upgrading from a previous version of T
same procedure as described on page 3. Keep 
own folder so you can tell them apart.

◆ HINT: To tell the old version from the new on
up – select the application’s icon in the Finde
the File menu.

Due to the extensive changes in TRAX version 3 
you should keep the old version on your compu
version 3 can read files created with older versi
are fully upward compatible.

Shows saved from TRAX version 3 have a “3” in
version of TRAX will automatically be launched w
file.

See “News in TRAX 3” on page 394 for further
from an older version.

Hint
Click references, such as the reference to "Preferences" to the right, to go there.
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Installing TRAX Runtime on a 
Computer

 

Included in the TRAX package is a “Dataton TRAX Runtime” diskette, and a 
license to install the runtime version on any number of computers. This allows 

t a client’s site, or other installation, 
 behind. The TRAX runtime version does 
s except saving onto disk. If desired, you 
as the ability to stop the show – using a 
13).

mputer, insert the “Dataton TRAX 
e procedure as outlined above under 

   

“Dataton TRAX Runtime” on a computer 
 TRAX installed. If you do, the Mac OS 
untime version instead of the full version 
.

you to run a show from a computer a
without leaving the full TRAX package
everything the full TRAX package doe
can also block other functions – such 
password (see “Password” on page 1

To install the Runtime version on a co
Runtime” diskette, and follow the sam
“Installing TRAX”.

▼ IMPORTANT: Do not install the 
that already has the full version of
Finder may choose to launch the r
when you double-click a show file



     

RVIEW

 

can be hooked up, based on 
and number of control units 
which kinds of devices you 

  

s of virtually any size, incor-
s based on a device, task and 
e presentation – such as the 
layers, touch panel, etc. – are 
along timelines or in the Task 
en, and to which devices. See 
ils.

  

le used to connect the serial 
e chain. The TRAX cable can 
em cable (see page 8).

using two TRAX cables – one 
also need additional TRAX 
X Runtime.
2

6 Chapter 2: System Overview

2 SYSTEM OVE
The illustration to the right shows how a system 
TRAX and some Dataton control units. The type 
required depends on the size of the system and 
need to control.

Dataton TRAX Software With TRAX you can create and edit presentation
porating all kinds of presentation media. TRAX i
timeline metaphor. The devices being used in th
lamps, video projector, slide projectors, video p
represented in TRAX by icons. Cues are placed 
window, and determine what should happen, wh
“Software Overview” on page 12 for more deta

TRAX Cable The TRAX package includes one grey TRAX cab
port of the computer to the first control unit in th
be extended up to 20 meters using Dataton syst

You can double the capacity of your system by 
for each serial port on your computer. You will 
cables when making installations using the TRA
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Example System Hookup

Touch 
panel.

Wireless
remote.
Devices 
being 

controlled.

TRAX cable. System cable.

Control
unit.

Power 
supply.



    

ol unit to the next. These black 
ngths, as well as in a kit that 
 meters.

nits is 100 meters. The system 
it to avoid ground loops and 

  

isc players, lighting equip-
k of the control units using the 

indow in TRAX for a full 
devices is added continuously 
tact your Dataton dealer if you 

rmation on each supported 
window and click the “Info” 
tting Information on Devices” 
8 Chapter 2: System Overview

System Cables Dataton system cables are used to link one contr
cables are available in 0.3, 1, 2 and 5 meter le
allows you to make custom lengths of up to 100

The maximum cable length between two control u
cable bus is optically isolated in each control un
interference.

Presentation Devices The presentation devices – such as tape decks, d
ment, projectors, etc. – are connected to the bac
appropriate cables.

Please refer to the list in the “Device Support” w
rundown of supported devices. Support for new 
as new device drivers are developed. Please con
need to control a device not shown on the list.

TRAX also contains a built-in database with info
device. Select a device in the “Device Support” 
button to view its database information (see “Ge
on page 65).
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Dataton Control Units

 

The control units act as “intelligent hubs”, or junction boxes, allowing up to 
four presentation devices to be controlled from each unit. In addition to simply 

 to the devices, the control units also 
der to make sure that they do what they 
provide information back to TRAX, such 
tation devices.

  

n control unit. It can be adapted to 
nging from simple relay switches to 
 flexibility comes partly from the library 
ers built into TRAX, and partly from the 
ome smartlinks are just simple cables, 
elligence and interface circuits. Each 
s or sub-systems. Some devices provide 
th TRAX interactive capabilities. See 
etails.
distributing the information from TRAX
monitor the devices continuously in or
have been told. The control units also 
as user input or feedback from presen

SMARTPAX SMARTPAX is the most flexible Datato
handle virtually any kind of device, ra
sophisticated video effects devices. Its
of downloadable software device driv
SMARTLINK interface cables. While s
others come with their own built-in int
SMARTPAX controls up to four device
input functions, which can be used wi
Chapter 11 “SMARTPAX” for more d



    

ted, user interface for TRAX. It 
 direct user interaction, such 

porate boardroom.

 a touch-sensitive surface, 
t connects to a SMARTPAX 
lds up to 99 pages of pictures, 
ther interactive elements. See 
he hardware.

ser interface and to test it. 
TOUCHLINK units while also 
. This means that you don’t 
 it out. Please refer to Chapter 
CHLINK.

  

(product number 3448) and 
lows you to control the presen-
teractive applications. See 
10 Chapter 2: System Overview

TOUCHLINK TOUCHLINK is an interactive, graphically orien
can be used in all kinds of installations requiring
as in a museum, visitor center, exhibition or cor

TOUCHLINK combines a color LCD display with
sampled audio playback and a motion sensor. I
port, just like any other presentation device. It ho
text, graphics, buttons, sliders, and a variety of o
Chapter 12 “TOUCHLINK” for more details on t

You use TRAX both to design the TOUCHLINK u
TRAX can simulate all functions of one or many 
managing all other aspects of your presentation
even need to own a TOUCHLINK in order to try
6 “Panel Design” for details on how to use TOU

AIRLINK Remote Control AIRLINK consists of the AIRLINK TRANSMITTER 
AIRLINK RECEIVER (product number 3449). It al
tation from a distance, for speaker support or in
Chapter 13 “AIRLINK” for more details.
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TRANSPAX+

 

TRANSPAX+ acts as an interface to most professional open-reel and cassette 
audio recorders. TRANSPAX+ handles tape transport control as well as 

f timecode and cue track standards. See 
 details.

  

slide projectors, including both profes-
ight tray projectors. PAX supports 
lectronic home sensing and fast random 
 adaptors is available for various 
ed for simple on/off switch functions, as 
r a slide projector or two relay functions. 
ails.
recording and playback of a variety o
“TRANSPAX+” on page 369 for more

PAX PAX controls most electromechanical 
sional circular tray projectors and stra
features such as controllable shutter, e
access of slides. A range of projector
projector models. PAX can also be us
each of the four ports can control eithe
See “PAX” on page 355 for more det



    

 screen. The following pages 
s and menus, with references 
these elements.

  

 computer screen provide 
r 4 “Menus and Commands” 

  

ntations.

  

and Paste, as found in most 

  

ecific to TRAX.

  

w. You must select the Device 

  

indow.

  

as starting conditions for tasks 

  

r changes its appearance.

lication menu on the far right 
r computer’s configuration.
12 Chapter 2: System Overview

Software Overview The illustration on the right shows a typical TRAX
give you a quick overview of the various window
to the sections of this manual that fully describe 

Menu Bar The menus in the menu bar along the top of the
access to most commands in TRAX. See Chapte
for details on each menu.

File. Commands for saving and opening prese

Edit. Standard editing commands, such as Cut 
Macintosh applications.

Object. Additional editing commands more sp

Device. Adds new devices to the Device windo
window in order to use this menu.

Cue. Add new cues to a timeline or the Task w

Symbol. Inserts symbols into expressions used 
in the Task window.

Window. Opens or selects another window, o

The Apple menu on the far left as well as the App
contain system-wide functions according to you
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Anatomy of TRAX
Menu bar

Device window

Device icon

Device status window

Device support 
window

Task window

Task

Cue

Panel window

Timeline window

Cue



    

e Show” on the previous page 
sentation. Use the Device 

e Menu” on page 94).

s whether a tape deck is 
status of the devices, you can 
ibed below. All devices are 

  

ociated with the device of the 
as a status window, which can 
e Chapter 5 for a full descrip-
.

  

tion by using a touch panel, 
of the screen. The tools along 
 to add elements and function-
ee Chapter 6 “Panel Design” 
 user interface.
14 Chapter 2: System Overview

Device Window The icons in the window titled “Device – Exampl
represent the various devices used to run the pre
menu to add devices to this window (see “Devic

The icons show basic status information, such a
playing or not. For a more detailed view of the 
open individual device status windows, as descr
described in detail in Chapter 5.

Device Status The window titled “Beta” is a status window ass
same name in the Device window. Each device h
be used to view or change the device’s status. Se
tion of the status window for each kind of device

Panel Window Interactive elements can be added to a presenta
such as the one shown in the lower right corner 
the left hand side of the Panel window allow you
ality to the panel, as well as testing the panel. S
for information on how to design a touch panel
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Task Window

 

The window titled “Task – Example Show” on page 13 holds all the tasks that 
make up the presentation. Tasks can be short, consisting of a single action, 

” tasks. Or they can be longer, such as 
” tasks. See “Task Window” on page 51 

  

lines, such as the “Introduction” timeline 
eline, in its turn, is made up of cues, 
 to take place along the timeline. These 
o simplify editing. See Chapter 7 for the 
ow” on page 29 for more information 

  

behind the other windows in the screen 
the Window menu to show this window. 
f devices supported by TRAX. It also 

information database, which contains 
lar device. To view this information, 

 “Info” button. See “Device Support” on 
such as the “Light On” and “Light Off
the “Introduction” and “New Products
for more details.

Timeline Window Lengthy tasks are represented by time
shown in the lower left corner. The tim
which represent the individual actions
cues can be put onto separate tracks t
full story on cues and “Timeline Wind
about the timeline window.

Device Support The Device Support window appears 
picture. Choose “Device Support” on 
It contains a full list of all the models o
provides access to the built-in device 
further information about each particu
select a device in the list and click the
page 63 for more details.



    

ton control units, such as PAX 
rd Compatible” mode. This is 

teractive capabilities of TRAX, 
references dialog box.

  

s in any order on the primary 

, either free-running or syn-
eived through a TRANSPAX+.

udio track of a tape recorder, 

nected to the ADB port of your 
puter’s keyboard, or a simu-
onitor.

sures or similar, from inputs 

s laserdisc or betacam decks 

.

16 Chapter 2: System Overview

System Modes In order to maintain compatibility with older Data
and TRANSPAX+, TRAX can be used in “Backwa
the default mode when starting TRAX.

In order to take full advantage of all the new, in
you must activate the “Interactive” mode in the P

Backward Compatible Mode While in backward compatible mode, you can:

• Mix TRANSPAX+, PAX and SMARTPAX unit
system bus.

• Run one or many preprogramming timelines
chronized to LTC SMPTE or EBU timecode rec

• Record a control signal (cue track) onto an a
for later playback without the computer.

• Interact with the system using an AIRLINK con
computer, function or control keys on the com
lated TOUCHLINK panel on the computer’s m

You can not:

• Receive feedback signals, such as switch clo
connected to SMARTPAX units in the system.

• Synchronize timelines to other devices such a
controlled through SMARTPAX.

• Use the TOUCHLINK interactive touch panel
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In backward compatible mode, you 
can mix TRANSPAX+, PAX and 

To additional 
SMARTPAX 
and PAX units.

SMARTPAX
SMARTPAX on the primary 
system bus.

Primary system bus.

TRANSPAX+ PAX



    

e new capabilities of TRAX 

ures, analog faders or similar, 
 the system.

n provide timing information, 
synchronize different timelines 
 at the same time.

 well as any number of AIR-
X ports.

actions per second, versus 50 
mode.

primary system bus. However, 
us through a SMARTPAX port 

ANSPAX+”).

.

   

ive mode for the first time, you 
ew software. See “Device Sup-

  

eed to use active inputs, such 
kward compatible mode when 
 control units such as 
 the show on tape.
18 Chapter 2: System Overview

Interactive Mode The interactive system mode unlocks many of th
version 3, and allows you to:

• Receive feedback signals, such as switch clos
from inputs connected to SMARTPAX units in

• Synchronize timelines to most devices that ca
such as laserdisc or betacam decks. You can 
to the same device or different devices, even

• Use TOUCHLINK interactive touch panels, as
LINK receivers connected through SMARTPA

• Perform cues and other actions at up to 400 
actions per second in backward compatible 

In interactive mode, you can not:

• Use PAX or TRANSPAX+ control units on the 
these units can be connected as a secondary b
(see Chapter 14 “PAX” and Chapter 15 “TR

• Record a control signal (cue track) onto tape

▼ IMPORTANT: Before activating the interact
must update all your SMARTPAX units with n
port” on page 63 for more details.

Choosing the Right System 
Mode

Choose the interactive system mode when you n
as push-buttons or TOUCHLINK. Choose the bac
working with systems consisting mainly of older
TRANSPAX+ and PAX, or if you need to record
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In interactive mode, TRANSPAX+ 
and PAX must be on a secondary 

To additional 
SMARTPAX 
units.

To additional 
PAX units.

Secondary 
system bus.

PAX
bus, connected through a SMART-
PAX port. Only SMARTPAX units 
are allowed on the primary 
system bus.

Primary system bus.

SYSTEM OUT 
SMARTLINK 3478.

TRANS-
PAX+

SMART-
PAX



     

OWS

 

as cues and devices, are kept 
ou how to use these objects 

  

n a small monitor, there’s a 
y want to have open at any 

atibles allow you to connect a 
 will provide more space for 

ng their respective commands 

eline, first open the Task 
w menu, then double-click the 
 a new timeline and open its 

 menu.

e device in the Device window 
t menu (keyboard shortcut: 

   

Opens Device Status” in the 
n be opened by simply 

se “Close Window” on the File 
3

20 Chapter 3: TRAX Windows

3 TRAX WIND
The various objects manipulated in TRAX, such 
in their respective windows. This chapter tells y
and their windows.

Opening and Closing 
Windows

You can open as many windows as you like. O
practical limit to the number of windows you ma
one time. Most Macintosh computers and comp
larger monitor and/or multiple monitors, which
your windows.

The three main windows in TRAX are opened usi
at the top of the Window menu.

To open the timeline window for an existing tim
window using the Task command on the Windo
timeline’s name in the Action column. To create
window, choose “New Timeline” on the Window

To open the status window for a device, select th
and choose “Show Device Status” on the Objec
Command-R).

✈ SHORTCUT: By selecting “Double-clicking 
Preferences dialog box, the status window ca
double-clicking the device. 

To close any window, click its close box, or choo
menu.

Close Box
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TRAX Main Windows
Device window, with 
icons representing all 
devices in the system.

Device Support 
window, listing all 
supported devices.

Task window, listing all 
the tasks with their 
starting conditions and 
actions.

Timeline window 
opened by double-
clicking the Action field 
of the first task in the list.



    

onitor (or to another monitor) 
bers the window’s position, 

on the next time it is opened.

   

uter with a smaller screen, or 
ve to relocate windows to en-

size box, located in the lower 
ox, located in the upper right 
full screen size. Click it again 
sition.

ctive window is indicated by 
 the active window, or to the 
window, click in it.

   

 exception to this rule, as click-
vices to cues, buttons or other 
nment or device linkage cur-
indow will not select the win-
e selected object in the active 
is case, click its title bar in-
u.
22 Chapter 3: TRAX Windows

Moving and Resizing 
Windows

Move a window to its desired position on the m
by dragging the window’s title bar. TRAX remem
and restores the window to its designated positi

◆ NOTE: When opening the show on a comp
different screen configuration, TRAX may ha
sure that all windows remain on screen.

Many windows can be resized by dragging the 
right corner of the window. Clicking the zoom b
corner of some windows, zooms the window to 
to return the window to its previous size and po

Only one window can be active at a time. The a
stripes in the title bar. Most commands apply to
objects contained in it. To activate a non-active 

◆ NOTE: The Device window is sometimes an
ing inside the window is also used to link de
objects. This is indicated by the device assig
sors. In this case, clicking inside the Device w
dow, but rather alter the device linkage of th
window. To activate the Device window in th
stead, or choose Device on the Window men

Zoom box

Size Box

Device assignment 
cursor

Device linkage 
cursor
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Device Window

 

All the devices in your system are represented by icons in the Device window. 
The icons can be arranged in the Device window to match the physical 

. The device icons serve three main 

 devices to be controlled by clicking the 
e Assignment” on page 183).

formation, allowing you to see, for ex-
if a relay is closed.

ou access its dialog boxes, in which you 
 control it interactively and see all its sta-

 

, first select the Device window by 
e” on the Window menu. Then select the 
enu.

 the Device window by clicking inside it, 
signing devices to cues, panel items or 
e assignment or linkage cursor. Instead, 
 title bar or one of its inactive scroll bars.

ssign it a unique name and address. 
nder “Editing Device Specifications” on 
arrangement in the room or in a rack
purposes:

• They allow you to link a cue to the
devices with the mouse (see “Devic

• They provide basic device status in
ample, if a laserdisc is playing or 

• By double-clicking a device icon y
can configure the device as well as
tus information.

Adding Devices To add a device to the Device window
clicking its title bar or choosing “Devic
desired device type from the Device m

◆ NOTE: You can not always select
as this action sometimes implies as
tasks. This is indicated by the devic
you must click the Device window’s

When a device is created, TRAX will a
These can be changed as described u
page 27.

Device assignment 
cursor

Device linkage 
cursor



, start by creating the first 
esired, before creating the 
ice Specifications” on page 
tions individually for devices, 
cently edited device of that 

 Device menu to create addi-
-N). This command creates a 
hosen from the Device menu. 

specified for the previous 

when the Device window is 
ected by clicking each device 
ll command on the Edit menu 
er groups of devices, drag 
ll devices, enclosing the 

t selecting them and then drag-
ovement to horizontal or 
 drag. If you drag outside the 
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Creating Multiple Devices When creating multiple devices of the same kind
device and setting its various specifications as d
remaining devices of this kind (see “Editing Dev
27). This will save you from setting the specifica
as they will inherit their settings from the most re
kind.

✈ SHORTCUT: Use the New command on the
tional devices (keyboard shortcut: Command
new device of the same kind as the last one c
The new device copies many characteristics 
device.

Selecting and Moving Devices Select a device by clicking on it with the mouse 
active. Multiple devices can be selected or desel
while holding down the Shift key. Use the Select A
to select all devices in the window. To select larg
across the device window from a point outside a
desired devices with the selection rectangle.

You can move device icons in the window by firs
ging on one of the selected icons. To constrain m
vertical directions only, press the Shift key as you

Drag from here…

…to here
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window content area, the window will scroll automatically. You may want to 
zoom the Device window to full screen size before re-arranging the devices in 
order to avoid accidental scrolling. Use the scroll bars along the bottom and 

r parts of the Device window or to scroll 

ile holding down the Command key 
t direction. Holding down both the Shift 
n larger steps.

 the Edit menu to copy devices from one 

evices.

ng its title bar.

hem to (or create a new one using New 

w show and choose Paste on the Edit 

ws or from the Scrapbook, you must 
es are unique by editing any conflicting 
tions” on page 27).
right edges of the window to view othe
back to the top of the window. 

◆ HINT: Pressing the arrow keys wh
nudges the selected devices in tha
and Command keys moves them i

Getting Devices from Other 
Shows

Use the Copy and Paste commands on
show to another:

• Open the show that contains the d

• Select the Device window by clicki

• Select the devices you want.

• Choose Copy on the Edit menu.

• Open the show you want to copy t
on the File menu).

• Select the Device window in the ne
menu.

When copying devices from other sho
make sure that all names and address
devices (see “Editing Device Specifica



ts directly from other shows, 
 the Scrapbook.

bar.

e Apple menu.

. This makes it easy to find the 
.
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Storing Devices in the 
Scrapbook

As an alternative to copying device arrangemen
you can store recurring device arrangements in

• Open the show that contains the devices.

• Select the Device window by clicking its title 

• Select the devices you want.

• Choose Copy on the Edit menu.

• Open the Scrapbook by choosing it under th

• Choose Paste on the Edit menu.

The devices will show up as text in the Scrapbook
right set of devices for copying into other shows



Chapter 3: TRAX Windows 27

Printing Devices Although TRAX doesn’t have any built-in print functions, you can still print out 
the device arrangement of a show using virtually any word processor, for 

ents of the devices in text form, copy the 
scribed above, then paste them into your 
printing. This can provide useful docu-
 device list contains details such as the 
r each device. You may want to add 
y before printing the document.

icture, zoom it to full screen size by 
ht corner of the window. Then press 
f the screen. The snapshot ends up as a 
n then be opened and printed from your 

the picture file in the Finder and choose 
int the picture using Simple Text.

e, first select the device using the mouse, 
 menu.

ress of each device must be unique. You 
 addresses of imported devices to avoid 
you will be notified when you try to leave 
ect these before you can proceed.

 each device‘s dialog box.
example Simple Text. To print the cont
devices from the Device window as de
favorite word processor program for 
mentation for staging the show as the
address and device driver specified fo
further “staging information” manuall

To print out the Device window as a p
clicking the zoom box in the upper rig
Command-Shift-3 to take a snapshot o
picture file on your hard disk, which ca
word processor, paint program, etc.

◆ HINT: To print the picture, select 
Print on the File menu. This will pr

Editing Device Specifications To change the specifications of a devic
then choose Specifications on the Edit

▼ IMPORTANT: The name and add
must manually change names and
conflicts. If there are any conflicts, 
the Device window. You must corr

Refer to Chapter 5 for information on



w represent the eight device 
n “Max Number of Gangs” is 
box. See the description of the 
e this feature.

icons representing all devices, 
or each device. This shows the 
e the status manually.

vice status window associated 
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Device Gangs The letters along the bottom of the device windo
gangs. The gang letters are only displayed whe
set to a non-zero value in the Preferences dialog 
Gang cue on page 210 for details on how to us

Device Status 
Windows

In addition to the Device window, which shows 
you can also open an individual status window f
full status of the device, and allows you to chang

Please refer to Chapter 5 for full details on the de
with each type of device.

Gang Letters

The status window 
for a slide 
projector device.
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Timeline Window A timeline window represents the flow of your presentation. To make a device 
do something at a specific time, you place a cue with the desired functionality 

 it to the device or devices to be affected.

 using the “New Timeline” command on 
s can be started and stopped indepen-
imelines to control different areas of a 
 as a museum. Or you can use separate 
ndependent sections.

eed to go through the Task window to 

nu.

be opened in the Action column of the 

Jump Back button

Current time indicator
at that point on a timeline, and assign

Creating a New Timeline 
Window

You can create new timeline windows
the Window menu. Individual timeline
dently, allowing you to use separate t
larger presentation environment, such
timelines to break up your show into i

Opening a Timeline Window If you close a timeline window, you n
open it again.

• Choose “Task” on the Window me

• Locate the name of the timeline to 
Task window.

• Double-click the task’s name.

Numeric time readout
Time ruler
Cue
Current track indicator
Stop, Pause, Run and Re-record 
buttons



yed numerically in the upper 
ated by the gray, vertical line 
to the show at the current time 
 show, click a cue or click at 

d on the Window menu to go 
 time can be entered either in 

ve, enter a negative time value 
f time. See “Timeline Settings” 

Select “Relative” to jump 
forward or backward by 
the specified amount of 
time.
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Current Time Position The current time position of the timeline is displa
left corner of the timeline window. It is also indic
through the cue area. New cues will be entered in
position. To move to another time position in the
the desired position on the time ruler.

Alternatively, use the Timeline Settings comman
to a position by entering its time numerically. The
an absolute or a relative way. If you specify relati
to move backwards in the show by that amount o
on page 103 for more details.

Enter a time to go to.
Pressing the Tab key in the time-
line window jumps ahead by 
this amount of time.
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✈ SHORTCUT: Pressing the + or – keys while a timeline window is active au-
tomatically opens the Timeline Settings dialog box and selects the Relative 
mode. This is a quick way to jump forward or backward a specified amount 

ic time readout in the Timeline window is 
ialog box.

dow makes it jump forward by the 
ne Settings dialog box. Pressing the Tab 
makes it jump backward by the same 

lled out of view, the numeric readout is 
 of the displayed section rather than the 
ck button in the upper right corner of the 
t time position.

nt of a timeline in the Timeline Settings 
is 0:00.00. However, if you’re synchro-
, you may want to set another start time 

line you’re working on, it’s a good idea 
 programming. In that way the scroll bar 
w will match the length of the final show 
 see where you are. If you don’t specify 

t’s too small – TRAX will automatically 
henever you place a cue within 15 
of time. Double-clicking the numer
another shortcut for opening this d

Pressing the Tab key in a Timeline win
amount of time specified in the Timeli
key while holding down the Shift key 
amount.

When the current time position is scro
displayed in italics and shows the time
current time position. Use the Jump Ba
timeline window to display the curren

Setting the Length of the 
Timeline

You can specify the start and end poi
dialog box. Normally, the start point 
nizing to an external timecode source
in order to match the timecode. 

If you know the final length of the time
to set the end time of it before you start
along the bottom of the timeline windo
all the time, making it easier for you to
the end point – or specify a value tha
increase the end time by one minute w
seconds from the current end point.



s, initially named Track 1 
rrent track, which is indicated 
rrent track, click the desired 
o change the name of a track, 
 the Window menu, or simply 

 a show that uses many media, 
or example, lighting on one 
he tracks appropriately. For a 
nt to dedicate separate tracks 
 as parallel timelines in order 
rojectors.

k for new cues. Once the cues 
ix down” that track onto 

ues” on page 37).
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Tracks A timeline window contains 16 horizontal track
through Track 16. New cues are added to the cu
by an underlined track name. To change the cu
track name or select a cue on the desired track. T
first select the track then choose Track Name on
double-click the track name.

You can use the tracks in any way you see fit. For
it may be a good idea to put cues that control, f
track and cues for video on another, and name t
show using a lot of slide projectors, you may wa
to the individual screen areas, or simply use them
to simplify complex cue sequences on multiple p

Another way to use the tracks is to have one trac
have been edited and synchronized, you can “m
another track with finished cues (see “Moving C

Current track indicator. 
Double-click to rename track.
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Locking the Current Track You can lock the current track to avoid selecting another track by accident. This 
is particularly useful when using the current track as a “stop track” for speaker 

ort” on page 226). To lock the current 
Timeline Settings from the Window menu 
eck box. When locked, the name of the 

 change the current track, either remove 
box or click the name of the desired track 
y.
support purposes (see “Speaker Supp
track, first select the track then choose 
and check the Current Track Locked ch
current track will appear in italics. To
the lock first by un-checking the check 
while holding down the Command ke

Locks current track so it can’t be 
changed by mistake.

Italics indicate locked current track. 
Command-click to select another 
track.



 timeline window is activated, 
enu. The new cue will be 

track and at the current time 
e window when you create a 
e “Assigning Devices to Cues” 
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Creating Cues To add a cue to a timeline, first make sure that the
then choose the desired cue type from the Cue m
entered into the timeline window on the current 
position. If any devices are selected in the Devic
cue, the cue will be assigned to those devices (se
on page 40).

1. Select the 
device.

2. Choose a 
cue.

3. The cue is 
entered at the 
current time 
and track.
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Selecting Cues This section discusses how to select cues in Icon View, which is very similar to 
selecting files in the Macintosh Finder. For information on how to select cues in 

iew” on page 48.

th the mouse. Clicking an unselected cue 
 To deselect all cues, click in the white 
y while clicking a cue to toggle its selec-
 state of any other cues. When selecting 

 not to move the mouse while clicking as 
ime. If this happens, immediately choose 
cue to its proper position.

 them diagonally from a point outside all 
 by the selection rectangle will be 
nal groups of cues, press the Shift key 
le.
list view, see “Selecting Cues in List V

To select a single cue, simply click it wi
automatically deselects all other cues.
space between cues. Press the Shift ke
tion state without affecting the selection
individual cues in this way, be careful
this may accidentally move the cue in t
Undo on the Edit menu to restore the 

To select a group of cues, drag across
the cues. All cues touched or enclosed
selected. To select, or deselect, additio
before dragging the selection rectang

Drag from here…

…to here.



izontally across the time ruler. 
 ruler at the beginning then 
urrent time position to the end 
nu (Command-E).

lly across the track titles.

 or previous cue on the current 
ith the Shift key selects the next 
single step” through the show, 

ey to run in real time up to the 
nt track as a “stop track” (see 
e Shift key as you press the 

ct cues matching a certain 
 a particular device or having 
d commands to apply addi-
ge 85 for more details.
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Advanced Selection 
Techniques

To select all cues within a range of time, drag hor
To select a wide range of cues first click the time
shift-click at the end. To select all cues from the c
of the show, choose Select to End on the Edit me

To select all cues on specific tracks, drag vertica

Press the right or left arrow keys to select the next
track. Pressing these arrow keys in conjunction w
or previous cue on any track. This allows you to “
one cue at a time.

In the same way, you can use the down-arrow k
next cue on the current track. This uses the curre
“Speaker Support” on page 226). Hold down th
down arrow to run to the next cue on any track.

Use the Find command on the Edit menu to sele
search criteria, for example all cues referring to
a specific dissolve rate. You can use multiple Fin
tional search criteria. See “Find/Replace” on pa
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Moving Cues Cues can be moved by simply dragging them with the mouse. Press the Shift 
key while dragging to constrain movement. This makes it easier to move cues 

ting them in time. 

t of selected cues, press the Shift key 
ss it before you start to drag, as that will 
ked cue.

g cues horizontally changes the numeric 
o indicate relative time, indicating how 
rag them.
from one track to another without shif

◆ NOTE: To constrain the movemen
while dragging the cues. Don’t pre
toggle the selection state of the clic

Pressing the Option key while draggin
time readout in the Timeline window t
far you have moved the cues as you d

Press the Option key as you 
move the cues to see the 
relative time distance.



ng down the Command key 
time. Pressing the right or left 
y nudges them horizontally in 
d Command keys moves them 

ab Key Time specified in the 
” on page 104). Command-
e amount.

ve cues one video frame at a 
ponding time.
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Moving Cues using the 
Keyboard

Pressing the up or down arrow keys while holdi
moves selected cues up or down one track at a 
arrow keys in conjunction with the Command ke
steps of 0.01 seconds. Pressing both the Shift an
in 0.1 second steps.

Command-Tab moves the selected cues by the T
Timeline Settings dialog box (see “Tab Key Time
Shift-Tab moves the cues backwards by the sam

◆ NOTE: This can be used for example to mo
time by setting the Tab Amount to the corres
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Changing the Time Scale Using the Time Scale commands on the Window menu you can zoom in or out 
on the timeline. Smaller time-scale values give better precision in moving cues 

cues that are close together. Larger time-
 and make it easier to select a long time 
pond to the five time scales.
with the mouse, and allow you to see 
scale values provide a better overview
range. Command-1 through 5 corres



e, first select the cue as 
 the Edit menu (Command-I), 
 7 for details on each cue type.

 same effect as selecting it and 

imultaneously using the 
s (see page 90 and page 85 

 order for it to have any effect. 
king each device using the 
nt pointer is only shown when 
d and the pointer is within the 

 to assign devices to a cue (see 
ng devices to existing cues, 
rt clicking devices. When 
vices before or after creating 

device assignment pointer, as 
cted cue. If you want to work 
indow by clicking its title bar.
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Editing Cue Specifications To change the specifications of an individual cu
described earlier, then choose Specifications on
or press the Enter or Return key. Refer to Chapter

✈ SHORTCUT: Double-clicking the cue has the
choosing the Specifications command.

You can change specifications of multiple cues s
Expand/Compress and Find/Replace command
respectively).

Assigning Devices to Cues You have to assign the desired devices to a cue in
This is done by first selecting a cue and then clic
device assignment pointer. The device assignme
the Task window or a timeline window is selecte
Device window.

You can use all the standard selection techniques
“Selecting Devices” on page 24). When assigni
make sure that the cue is selected before you sta
creating new cues, you can select the desired de
the cue.

▼ IMPORTANT: Be careful how you use the 
it changes the device assignment of any sele
with the devices only, first select the Device w

Device assignment pointer:
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Running the Timeline To run the timeline from the current time position, click the play symbol in the 
lower left corner of the timeline window. The current time indicator will start to 

he time indicator reaches the middle of 
croll to keep the current time centered. 
heckbox in the Timeline Settings dialog 
on page 105).

use symbol or any other object on the 

 to toggle between the play and pause 
move in the timeline window. When t
the track area, the window will auto-s
This feature can be disabled using a c
box (see “Autoscroll While Running” 

To stop running the show, click the pa
screen, or press a key.

✈ SHORTCUT: Press the space bar
mode of a timeline.

Gray time readout indicates 
a stopped and inactive time-
line.

Click the Stop symbol to 
make the timeline inactive.

Click the Play symbol to acti-
vate and run the timeline.



g or just pausing a timeline. 
 and relinquishes control over 
 by other tasks. See “Device 
 on the relationship between 

in the lower left corner of the 
gured to automatically stop a 
top After Last Cue” on page 
es – you must first activate the 

stop mode, it will accept the 
al position. This device status 
 beginning of that timeline.

licit control over the initial 
le, want all slide projectors 

and turn their lamps off. To 
escribed on page 209.

tion of any device capable of 
t the beginning of a timeline, 
rce (see “Synchronize To” on 
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Stopping vs. Pausing a 
Timeline

There’s an important difference between stoppin
When a timeline is stopped, it becomes inactive
its devices, thus freeing those devices to be used
Ownership” on page 121 for more information
tasks and devices.

You stop a timeline by clicking the Stop symbol 
timeline window. The timeline can also be confi
specified amount of time after its last cue (see “S
105). A stopped timeline can’t control any devic
timeline by selecting pause or run.

Initial Device Status When you start a timeline after having been in 
current status of the devices as their correct initi
will be restored whenever you jump back to the

In some cases, you may want to have more exp
device status for a timeline. You may, for examp
controlled by a timeline to go to tray position 0 
accomplish this, use a “Trigger: Reset” cue, as d

Synchronizing a Timeline to a 
Device

A timeline can be synchronized to the time posi
supplying such information. Use a Control cue a
assigned to the device to be used as the sync sou
page 214).
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Re-recording Cues In addition to positioning cues manually along the timeline by dragging them 
with the mouse, it is also possible to position them by tapping the space bar in 

s referred to as re-recording the cues, as 
rily removed from the timeline and then 
you tap the space bar.

cord cues in relation to other cues, or to 
om a device (see “Synchronizing a Time-
rding relative to a device is particularly 

ood timing between the audio and the 

ch cues to re-record. This can be done 
automatic method selects all cues ahead 
propriate after adding new cues to the 

synchronized are on the same track. To 
n the time ruler at the point from which 
lick the record symbol in the bottom left 
tomatically selects all cues ahead on the 
real time as you run the timeline. This i
the cues to be positioned are tempora
re-recorded again – one by one – as 

You can use this method either to re-re
an external timecode source coming fr
line to a Device” on page 42). Re-reco
useful as it makes it easy to achieve g
visuals.

Before you start, you must decide whi
either manually or automatically. The 
on the current track. This method is ap
end of the timeline and all cues to be 
use the automatic method, first click o
you want to start re-recording, then c
corner of the timeline window. This au
current track.

Clicking the re-record button with 
no cues selected selects all cues 
ahead on the current track.



f you just want to re-record 
nually select the cues before 
rner of the timeline window.

he first cue, type a minus sign 
ues. This will move the current 
out deselecting the cues. 

e lower left corner of the time-
 each cue.

d to a device which can not be 
faced through a TRANSPAX+ 
you must press the play button 
eline window.

es are temporarily moved into 
ue visible. Tap the space bar 
 while re-recording the cues, 
ll the re-recorded cues to their 

corded. Grouped cues are re-
bar. Re-recording is not avail-
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If the cues are scattered over several tracks, or i
specific cues in the middle of the show, then ma
you click the record symbol in the bottom left co

If you want some pre-roll before synchronizing t
and the desired pre-roll time after selecting the c
time position back by the specified amount with

To start re-recording, click the play symbol in th
line window, then tap the spacebar to re-record

◆ IMPORTANT: If the timeline is synchronize
controlled by TRAX, such as a tape deck inter
not using a locator adaptor or remote cable, 
on the tape deck instead of the one in the tim

When you click the play symbol, the selected cu
a synchronization stack, with only the topmost c
to re-record each cue. If you make any mistakes
simply choose Undo on the Edit menu to restore a
previous positions.

◆ NOTES: Cues retain their tracks when re-re
recorded together with one tap of the space 
able in List View.
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The Jump Back Button The Jump Back button is located in the upper right corner of the timeline 
window. It serves two purposes:

e current time position if this has been 
ed by the double-arrow symbol in the 

 the show’s last start position, indicated 
Jump Back button.

led out of view, the double-arrow symbol 
hich direction the current time is located. 
in the timeline window is italicized, and 
ed show section rather than the current 
• It causes the window to scroll to th
scrolled out of view. This is indicat
Jump Back button.

• It makes the window jump back to
by the single arrow symbol in the 

When the current time position is scrol
in the Jump Back button indicates in w
In this case, the numeric time readout 
shows the time position of the display
time position in the show.



ent timing information about 
does not show all cue details. 
ue you need to select the cue, 
lick it to open its dialog box. 
ne cue at a time.

sing the command on the 
 you can see all details for all 
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List View While the standard view of cues provides excell
the cues and their relationships to each other, it 
In order to see which devices are assigned to a c
and to see its various settings you must double-c
In both cases, you can only see the details for o

Switching a timeline window over to List View, u
Window menu, changes all that. In the List View
cues currently visible in the timeline window.

✈ SHORTCUT: Command-M tog-
gles between icon and list views.
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In List View, the next cue to be executed (corresponding to the current time posi-
tion in Icon View) is indicated by a small square to the left of the cue’s time 
display. The width of the track, cue and device columns can be adjusted by 

s in the List View just as you can in the 
etc. When pasting multiple cues, keep in 
se with any existing cues at that point in 
 a word processor inserts text, for 

cord cues in List View. Use the keyboard 
and forth between these views.
dragging the gray separator lines.

You can perform most editing function
Icon View, including cut, copy, paste, 
mind that they will be merged time-wi
the show, which is different from how
example.

You can not drag cues around or re-re
shortcut Command-M to switch back 

Drag the gray separator lines 
to re-size the columns.

The box indicates next cue to 
be executed.



ay in both list and icon views. 
 across the cues vertically or 
n. Switch back to icon view to 
plex combinations. You can 
s without disturbing the selec-

s you to select cues based on 
 fields. You can, for example, 
iew” on page 49) and paste 
at contain that text in the cue 
re details.

S
s

S
c
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Selecting Cues in List View Selection of individual cues works in the same w
To select a range of cues in list view, either drag
Shift-click in the time column to extend a selectio
select cues on specific tracks or other more com
freely switch back and forth between the two view
tion state of the cues.

Using the Find command on the Edit menu allow
any text string that appears in the Cue or Device
copy a part of a cue’s text (see “Editing in List V
that into the Find dialog box to select all cues th
column. See “Find/Replace” on page 85 for mo

hift-click in the time column to 
elect a range of cues.

hift-click here to select individual 
ues.
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Editing in List View You can edit cues in List View either using the cue’s dialog box, just as in icon 
view, or by highlighting the text in the Cue column. This is particularly useful to 

ssolve rates or frame positions. To edit a 
ntally across the value. This selects the 

hout going through the dialog box. Press 
editing, or press Escape to cancel the 

enter any information in any cue, using 
n entering keywords (i.e., words that are 
es), you only need to type the first few 

the time, track or device assignment of a 
 assignment, click the devices as usual. 
) to change the time or track of a cue or 
d-arrow key or Command-Shift-arrow 
change values such as lamp levels, di
value in a cue in list view, drag horizo
value and allows you to type over it wit
Enter or Return when you’ve finished 
editing.

In this way it is possible to change or 
the syntax displayed in List View. Whe
names of specific fields or named valu
letters of the keyword.

It is not, however, possible to change 
cue in this way. To change the device
Switch to the icon view (Command-M
use the nudging commands (Comman
key).

Drag across a value to edit it.



s such, you can use any word 
m in List View. Select the cues 
enu. You can then paste them 

ield in List View. Add corre-
ign the columns. The example 
t Word. Note that the leftmost 
 aligned. It might be a good 
stationary document to re-use 
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Printing Cues Although TRAX doesn’t have a print command a
processor to print out the cues just as you see the
you want to print and choose Copy on the Edit m
into your favorite word processing program.

There’s a tab and a vertical line between each f
sponding tab stops in your word processor to al
below shows how to format the cues in Microsof
tab is right aligned while the other three are left
idea to save the word processor document as a 
this format for future print-outs.

Use tabs to align the columns.
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Task Window The Task window lists all tasks that make up your show, together with the 
starting conditions that determine when each task will be started. It also 

 the starting conditions.

 that is performed by the task. An action 
. To create a task with a timeline, choose 
. 

cue, choose the cue from the Cue menu. 
g the cue in the Action column and then 
ow (see page 24).

e currently selected task in the list, or 
tion.

ask list and choose Specifications on the 
action item. When opening a timeline 
ustration above, it opens to a timeline 
if desired. When opening a single cue 
ing the cue before you can proceed.
contains the play button for activating

Adding a Task The Action column contains the action
may be either a timeline or a single cue
“New Timeline” on the Window menu

To create a task consisting of a single 
Link the cue to a device by first selectin
selecting the device in the Device wind

The new task will be inserted before th
appended to the list if there’s no selec

Editing the Task’s Action To edit a task’s action, select it in the T
Edit menu, or simply double-click the 
action, such as “Main Show” in the ill
window which can then be left open, 
action for editing, you must finish edit

Click here to select the task.

Click here to activate the 
starting conditions.



ion field. To select a range of 
e last task while holding down 
sks, hold down the Command 

e tasks to be moved, choosing 
e where you want the tasks to 

n copying a task containing a 
as well.

vidual cues between shows, 
tasks exist in the target show, 
ot be assigned properly to the 
 the other show, then the tasks 

e, then choose “Clear” on the 

ion item is a timeline, that time-

w to change a task’s priority. 
 granted access to a device if 
e.

page 51, the task that opens 
e task that closes it has lower 
also controlled by cues in the 
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Selecting and Moving Tasks To select a single task, click its ID number or act
tasks, start by selecting the first task then select th
the Shift key. To select or de-select individual ta
key while clicking.

Tasks can be moved in the task list by selecting th
Cut on the Edit menu, selecting the task at the lin
go, and choosing Paste on the Edit menu.

You can also copy tasks from other shows. Whe
timeline, all cues on that timeline will be copied 

▼ IMPORTANT: When copying tasks or indi
make sure that all devices referenced by the 
and have the same names. If not, cues will n
devices. If necessary, first copy the devices to
or cues.

Deleting a Task To delete a task, first select it as described abov
Edit menu.

▼ CAUTION: When deleting a task whose act
line and all its cues will also be deleted.

Changing a Task’s Priority Use the Priority pop-up menu in the Task windo
The task’s priority determines which task will be
two or more tasks attempt to use the same devic

For example, in the Task window illustration on 
the door has higher than normal priority, and th
than normal priority. Assuming that the door is 
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Main Show timeline, these priorities would dictate that the door can be opened 
using the door switch while the show is running, but it can not be closed.

sk doesn’t affect whether it can be start-
ility to control devices currently in use by 
rrently in use by a Task is indicated in 
ration dialog box (see “Device Owner-

ks start and stop each other. A Control 
evices required by a timeline are indeed 
 for more details.

ion stated in the Condition column. Such 
atus properties of the devices in the 

k window shown below will be started 
orSwitch device becomes true. The Door-
ure input, connected to a mechanical 
◆ IMPORTANT: The priority of a ta
ed or not. It only affects a task’s ab
other tasks. Whether a device is cu
the title bar of the device’s configu
ship” on page 121).

You can use Control cues to make tas
cue can also be used to verify that all d
available. See “Control” on page 212

Specifying the Starting 
Condition for a Task

A task will be started under the condit
a condition is based on the various st
Device window.

For example, the Close task in the Tas
when the Input On property of the Do
Switch device is a simple contact-clos
toggle switch.

Click in a task’s condition 
column to edit the condition.



hould start it, first click in the 
in the Device window. When 
, it displays a pop-up menu, 
.

input and output – in order to 
le, to have a task started at a 

 the Device window, then link 
wn in the “Lights On” task on 
y day.

es, always use the “is greater 
e “is equal to” symbol, as the 

ing the same button by 
e day of the week using an 

full rundown of all the symbols 
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Linking Conditions to Device 
Status

To link a task to the device status property that s
Condition field of the task, then click the device 
you press the mouse button on the device’s icon
listing the various status properties of the device

You can refer to any status of any device – both 
construct starting conditions for tasks. For examp
certain time of the day, add a “Clock” device to
the task’s condition to its Time status. This is sho
page 53, which will be started at 7:00 AM ever

▼ IMPORTANT: When referring to time valu
than” or “is less than” symbols. Do not use th
task may then not be started.

Conditions Based On Multiple 
Status Properties

In the same way, you can start different tasks us
combining the input switch with, for example, th
“and” symbol.

Please refer to “Symbol Menu” on page 96 for a 
you can use in task conditions.

Device 
linkage 
cursor.
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Editing Conditions When you click in the condition field of a task, this also activates the edit field 
at the top of the Task window. If the task already has a condition, the condition 

be used to view long conditions without 
dition column.

red using the mouse, either by selecting 
g symbols from the Symbol menu (see 
 condition items can be edited using the 
 with the other choices available for the 

 “Clock:Mode:Week-Day:Tuesday” item 
up menu showing the other status prop-
he possible settings for the currently 
is displayed in the edit field. This can 
changing the column width of the Con

Most items in a condition can be ente
properties from devices or by selectin
“Symbol Menu” on page 96). Existing
mouse, which displays a pop-up menu
clicked item. For example, clicking the
in the task with ID# 7 displays a pop-
erties in the Clock device, as well as t
selected property.



esponding text in the edit field 
evice reference with another, 
 pick a property from another 

the edit field serve as Cancel 
k-mark to accept the entry. 
ffect. 

validity of the condition as 
n that doesn’t make sense, the 
nter key in this case displays 
 in the edit field.
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Clicking a condition item also highlights the corr
at the top of the window. Thus, to replace one d
first click the old reference in the condition, then
device.

The cross and check-mark symbols to the left of 
and OK buttons for the edit field. Click the chec
Pressing the Enter or Return keys has the same e

Furthermore, the check-mark also indicates the 
entered into the edit field. If you enter a conditio
check-mark symbol is grayed out. Pressing the E
an error message and selects the offending item

Gray checkmark 
indicates error in 
condition formula.
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Condition Variants The pop-up menu in the “1/0” column allows you to specify whether the action 
should be started when the condition becomes true or when it becomes false. 

 will be started when the switch is turned 
 when it is turned on.

se” causes an action to be performed 
 is true or false, instead of just once when 

hed before being re-started. For single 
f a tenth of a second. For timelines, the 
eline Settings command on the Window 
ge 104).
In the example below, the “Open” task
off and the “Close” task will be started

Choosing “While True” or “While Fal
repeatedly for as long as the condition
it becomes true or false.

The action will run until its end is reac
cue tasks, this is usually in the range o
duration can be specified using the Tim
menu (see “Timeline Start/End” on pa



 conditions, such as in the time-
se the keyboard to enter a 
Task window. First click in the 
esired value into the text field.

ndard time format (see “Stan-
 formats, you can use the time 
ue’s dialog box.

ember that TRAX interprets a 
conds – not as 7:30 am. To 

to a non-zero result to be true, 
ng a non-zero constant value 
ting its “1/0” pop-up menu to 

utomatically as soon as the 
Tasks” on page 60).
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Using Constants in Conditions You can use constant numeric and time values in
of-day example in the illustration on page 53. U
numeric value into the text field at the top of the 
Condition field of the desired task, then type the d

When entering time values, you must use the sta
dard” on page 137). To convert from other time
format pop-up menu in, for example, a Locate c

▼ CAUTION: When entering time values, rem
time entered as 7:30 as 7 minutes and 30 se
enter the time 7:30 am, type 7:30:00.

Making a Task Start Auto-
matically

As TRAX considers any condition that evaluates 
you can make a task start automatically by putti
– for example 1 – into its condition field and set
“Becomes True”.

Any task configured in this way will be started a
system run mode is activated (see “Running the 
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Evaluating Task Conditions Sometimes a starting condition may not work as intended, and you may want 
to take a closer look at the result of the condition. To evaluate the expression 

, first click it to activate it (this also acti-
sk window), then press the Enter key on 
Option key. This displays the result of the 
imple expression “Clock:Time” evaluates 

ition should cause the task to be started, 
t is “true” or “false”. A result that is zero 
lse is considered to be “true”. Thus, the 
ed “true”. Actually, since this is a contin-
nsidered “false” for a hundredth of a 

a time value, like the one shown above, 
ater than” or “less than” symbols on the 
you’ve entered into the Condition field
vates the edit field at the top of the Ta
the keyboard while holding down the 
condition. In the example below, the s
to the time of the day.

When deciding if the result of the cond
TRAX only considers whether the resul
is considered to be “false”, anything e
result shown above would be consider
uously running clock, it will only be co
second after midnight.

To make a useful condition based on 
you would typically use one of the “gre

Command-click the check-mark, or 
press Command-Enter, to display 
the result of the condition formula 
while editing it.



ondition Clock:Time > 
M, and could be used to start 
” pop-up menu is set to 

 9:00:00 & Clock:Time 
ll start the task repeatedly 

ymbol in the lower left corner 
anning the list of Conditions, 
re met.

de, you can also press Com-
w in TRAX.

ed. For timeline tasks, you can 
is open.

other TRAX windows already 
 through their status windows. 
ll windows, or give any other 

te the system run mode.
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Symbol menu (see page 96). For example, the c
7:00:00 will be considered “true” after 7:00 A
a task once at 7:00 AM, assuming that its “1/0
“Becomes True”.

The more elaborate condition “Clock:Time >
< 17:00:00” combined with “While True” wi
between 9:00 AM and 5:00 PM.

Running the Tasks To activate the system run mode, click the play s
of the Task window. This causes TRAX to start sc
activating any tasks whose starting conditions a

✈ SHORTCUT: To activate the system run mo
mand-space bar from any non-modal windo

When a task is started, its action field is highlight
also see the timeline run if the timeline window 

While the system is running, you may switch to 
on the screen, or operate simulated panel devices
You may not, however, open new windows, scro
commands. Doing so will automatically termina

Click the play symbol in the Task 
window to start running eligible 
tasks.
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To run an individual timeline without running the entire system, open the time-
line window and click its play button. See “Running the Timeline” on page 41 
for more details.

mode automatically when the show is 
lly when Opened” in the Preferences di-

be resized by dragging the gray sepa-

ssions, click on the task. This causes the 
it field at the top of the Task window.
◆ HINT: To activate the system run 
opened, choose “Start Automatica
alog box (see page 108).

Re-sizing the columns The columns in the Task window can 
rator lines.

◆ HINT: To see long condition expre
condition to be displayed in the ed

Drag here to re-size columns.



st column of the Task window. 
s the owner of a particular 
sk.

device’s configuration dialog 
oosing Specifications on the 
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Referring to Tasks by ID 
Number

Each task is identified by a number in the leftmo
This number unambiguously identifies the task a
device, or in error messages pertaining to the ta

To see if a device is owned by a task, open the 
box by selecting it in the Device window and ch
Edit menu.

The ID number of the task that 
owns this device.
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Device Support The Device Support window contains a list of all the various brands and models 
of devices that can be controlled by TRAX. It also contains buttons to obtain 

d to download device support functions 
nloading the appropriate device support 
ow to talk to the devices. Once down-
ill remain in effect until you download 
information about selected devices an
to SMARTPAX and other units. By dow
functions to SMARTPAX you teach it h
loaded, the device support functions w
again.

A device driver automatically 
chosen for downloading according 
to the current configuration of the 
devices in the Device window.

Devices shown in italics can not be 
chosen for downloading.

Display information about the 
highlighted device.

Downloads chosen device drivers.



s, such as slide projectors and 
the left in the list. A corre-
the Type pop-up menu in each 
ype” on page 116).

ns that it is chosen for down-

d with the PAX control unit or 
ARTPAX, and can not be 

ng a device driver with choos-
iver, simply click it with the 
g into SMARTPAX are tagged 

 list. Drivers can be chosen 
the following pages.
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The Device List The devices are grouped under their various type
video disc players, as indicated by the icons to 
sponding list of devices is also available through 
device’s configuration dialog box (see “Device T

A checkmark to the left of an item in the list mea
loading into a SMARTPAX control unit.

Items displayed in italics in the list are associate
other devices not directly controlled through SM
chosen for downloading.

▼ IMPORTANT: Don’t confuse merely selecti
ing it for downloading. To select a device dr
mouse. Device drivers chosen for downloadin
with a checkmark to the left of its icon in the
automatically or manually, as described on 
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Getting Information on 
Devices

To obtain information about a device, first select it in the list, then click the 
Help/Info button at the bottom of the window. The information displayed tells 

you need to connect the SMARTPAX to 
 various mode switches on the device (if 
you, among other things, what cable 
the device to be controlled, how to set
applicable), etc.

Device information database built 
into TRAX.

Hardware configuration of the 
device, such as DIP switches, special 
wiring, etc.

◆ HINT: The same information can 
also be obtained by clicking the 
“information” button in each de-
vice’s configuration dialog box.



ARTPAX are tagged with a 
utomatically or manually. To 

 select “Download Everything” 
t the bottom of the window.

ce drivers required for control-
cording to their configuration. 
l complement of devices in the 
up properly in their respective 
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Automatic Device Selection Device drivers chosen for downloading into SM
checkmark in the list. This choice can be made a
make TRAX choose device drivers automatically,
or “Device Drivers Only” on the pop-up menu a

In the automatic mode, TRAX will choose all devi
ling the devices that are in the Device window, ac
This is appropriate when you already have a ful
Device window. The devices must have been set 
configuration dialog boxes.
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Manual Device Selection The manual selection mode is activated by choosing “Device Drivers, Manual 
Mode” from the pop-up menu at the bottom of the window.

e which device drivers to download into 
ted by a check-mark. To choose a driver, 
k the Check button at the bottom of the 
rs by Shift-clicking them in the list before 

 buttons are only available in Manual 
ing a driver with choosing it for down-
 a checkmark will be downloaded.
In this mode, you can manually choos
SMARTPAX. A chosen driver is indica
first select it using the mouse then clic
window. You can select multiple drive
you click the Check button.

◆ NOTES: The Check and Uncheck
Mode. Don’t confuse merely select
loading – only drivers tagged with

Select “Device Drivers, Manual 
Mode” to choose device drivers 
manually.

Check or un-check highlighted 
device drivers using these buttons.



ightforward way of down-
d drivers into any number of 
ted as part of a complete 
nload Everything” on the pop-

d button, make sure that all 
e Device window are connect-
et properly.

 all port addresses referred to 
isplayed if TRAX can’t find an 
red for each SMARTPAX, and 
sed on the address specified 

y panel designs (see “Down-
wnloading of panel designs, 
u.
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Downloading in Automatic 
Mode

Downloading in automatic mode is the most stra
loading device drivers. It allows you to downloa
SMARTPAX units while still having them connec
system. To use the automatic mode, select “Dow
up menu at the bottom of the window. 

▼ IMPORTANT: Before clicking the Downloa
SMARTPAX units referred to by devices in th
ed, powered and have their port addresses s

TRAX first analyzes the system to make sure that
by the devices are available (a warning will be d
address). TRAX then downloads all drivers requi
assigns those drivers to their respective ports, ba
for each port. Finally, TRAX also downloads an
loading Panel Designs” on page 70). To skip do
select “Device Drivers Only” on the pop-up men
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Downloading in Manual 
Mode

Sometimes you may just want to download a certain set of device drivers into 
a SMARTPAX, without first adding and configuring those devices in the Device 

 selecting “Device Drivers, Manual 
ttom of the Device Support window.

you can only download to a single 
nnected directly to the computer.

e each SMARTPAX port manually using 
ge 321).

blems while downloading:

, make sure that all port addresses used 
w are available in the system. TRAX will 
dress.

ceive data from TRAX by checking the 
ront panel of each unit before you click 

 system mode in the Preferences dialog 
112), you can only have SMARTPAX 
em bus. TRANSPAX+ or PAX must be on 
 SMARTPAX port using the appropriate 
 19).
window. This can be accomplished by
Mode” on the pop-up menu at the bo

▼ IMPORTANT: In manual mode, 
SMARTPAX unit, which must be co

After downloading, you must configur
the buttons on the front panel (see pa

Troubleshooting Check these points if you run into pro

• If downloading in automatic mode
by the devices in the Device windo
tell you if it can’t find a specific ad

• Ensure that all SMARTPAX units re
green DATA OK indicator on the f
the Download button.

• If you have selected the Interactive
box (see “System Mode” on page 
units connected to the primary syst
a secondary bus, routed through a
driver (see the illustration on page



ode in the Preferences dialog 
system software version 3.0 or 
 the SMARTPAX display when 
tible” mode before download-
ownloading also updates the 
rect version, you only have to 

nnect a single SMARTPAX unit 
oth” serial ports in the Prefer-
X to the modem port, or else 

 box.

ARTPAX, you can also down-
s to one or many TOUCHLINK 

t specified in its configuration 

-K), and verify that the “Inter-
 Mode” on page 112).

 menu at the bottom of the De-
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• If you have selected the Interactive system m
box, all SMARTPAX units must already have 
later. This version number is shown briefly in
powered up. If not, select “Backward Compa
ing (see “System Mode” on page 112). As d
system software in the SMARTPAX to the cor
do this once.

• If downloading in manual mode, you must co
only to the computer. If you have selected “B
ences dialog box, then connect the SMARTPA
to the port selected in the Preferences dialog

Downloading Panel Designs In addition to downloading device drivers to SM
load graphics, buttons, sound and other element
touch panels:

• Connect TOUCHLINK to the SMARTPAX por
dialog box.

• Open the Preferences dialog box (Command
active” system mode is selected (see “System

• Select “Download Everything” on the pop-up
vice Support window.

• Click the “Download” button.
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TRAX will then download first all relevant SMARTPAX device drivers, and then 
the panel design. If you have multiple TOUCHLINK units in the system, it will 
download all of them.

d a new design to a TOUCHLINK, it may 
ownloads to the same unit, with only mi-

 substantially faster.

wnloaded all the right device drivers to 
 choose “Panels Only” on the pop-up 

port window. This will download only 
e SMARTPAX units as they are.

ner of the Device Support window allow 
ivers. Such drivers can be used to control 
 of serial data input (RS232, RS422, 
 control this kind of device when there is 
efer to Chapter 10 for details on how to 

ible when “Device Drivers, Manual 
enu at the bottom of the Device Support 
◆ NOTE: The first time you downloa
take several minutes. Subsequent d
nor changes to the design, will be

If you know that you have already do
the SMARTPAX units, you may instead
menu at the bottom of the Device Sup
your panel design changes, leaving th

Creating and Editing 
SMARTPAX Drivers

The two buttons in the bottom right cor
you to create and edit Serial device dr
most devices equipped with some kind
MIDI, etc.). This is useful if you need to
no standard driver available. Please r
create such drivers.

◆ NOTE: These buttons are only vis
Mode” is selected on the pop-up m
window.



D 
S

lated commands in TRAX as 
 commands ending in an 

e functions like saving and 

ands used to manipulate the 
 selected objects in the active 
iting commands, such as Cut 
ations, while the Object menu 
 as Disable Device and Distrib-

d to add new objects of those 
 window must be selected for 
 menu is only active when the 

ow and control the appear-
ess to miscellaneous dialog 
4
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4 MENUS AN
COMMAND
This reference chapter describes all the menu-re
well as the dialog boxes accessed through menu
ellipsis (…).

The menus can be grouped into four kinds:

• The File menu provides standard, system-wid
loading from disk, quitting the program, etc.

• The Edit and Object menus provide the comm
various objects. These commands operate on
window. The Edit menu contains standard ed
and Paste, available in most Macintosh applic
contains more TRAX-specific commands such
ute Cues.

• The Device, Cue and Symbol menus are use
kinds to the active window. The appropriate
these menus to become active, i.e., the Device
Device window is selected.

• The Window menu provides commands to sh
ance of the different windows as well as acc
boxes such as Preferences.
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File Menu TRAX can only have one show open at a time, so when choosing the New Show 
or Open Show commands you will be prompted to save any changes in the 

ing a new show. When creating a new 
the current set of devices and customized 

w. Clicking the close box located in the 
ssing Command-W, has the same effect. 

isplayed in the window from the 
the window. See “Opening and Closing 
ils.
C

current show first.

New Show This command lets you start programm
show you have the option of retaining 
cues on the Cue menu.

Close Window This command closes the active windo
upper left corner of the window, or pre

This doesn’t remove the information d
computer’s memory – it merely closes 
Windows” on page 20 for more deta

Keep devices currently in 
the Device window.

Keep any customized 
cues on the Cue menu.

Close Box



devices, tasks, timelines, cues, 
xactly as they were when the 
n Opened” was selected when 

atically (see “Start Automati-

e, the current show will be 
 made any changes to the 
e changes before opening the 
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Open Show Opens an existing show. This will bring in all its 
etc. It will also open and position the windows e
show was last saved. If “Start Automatically whe
the show was saved, it will also be started autom
cally when Opened” on page 108).

As TRAX can only have one show open at a tim
closed before opening the new one. If you have
current show, you will be prompted to save thos
new show.

Chose a show file or a folder to 
open in the list.

Use the pop-up menu above the list 
to navigate to other disks and 
folders.
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Save Saves the entire show, including all the elements listed under Open Show on 
the opposite page. The first time you use the Save command, a dialog box 

aves will save the show under this name.

X first writes to a temporary file named 
ique character combination. Once the 
 is deleted and the temporary file re-
 two-tiered approach protects you in the 
 similar mishap during a save operation. 
 be left on the disk and must be removed 
C

prompts you for a name. Subsequent s

◆ NOTE: When saving a show, TRA
TRAX_TMP_xx with xx being a un
save is completed, the original file
named with the correct name. This
unlikely event of a power failure or
In this case, the temporary file may
manually.

Choose a folder to save into…

…or create a new folder.

Enter the name for the show here 
and click the Save button.



ther name. This new name will 
d when you want to start 

 other shows. It imports only 
s on timelines. If you want to 
 show, use the normal method 

 your favorite cues in a sepa-
em into other shows whenever 
mber of show files. However, 
 menu, a dialog box will 

 cues if there is a name conflict.

ort the original device assign-
ake sure that the relevant 

e the same names as in the 
es will still be imported, 
e the hint on page 180 for 

inder or other application. If 
prompted to save the show to 
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Save As Saves the current show as a new show using ano
be used for subsequent saves. Use this comman
making a new show based on an old one.

Import Menu Cues Allows you to import customized menu cues from
the customized cues on the Cue menu – not cue
import cues into a timeline window from another
of Copy and Paste. 

A good way to use Import Menu Cues is to keep
rate show file. You can then conveniently bring th
you need them. You can import cues from any nu
as there must be no duplicate names on the Cue
prompt you to choose between new and existing

When importing cues, TRAX also attempts to imp
ment for those cues. For this to work, you must m
devices exist in the new show, and that they hav
show from which you’re importing. If not, the cu
although their device assignment will be lost. Se
some more details.

Quit Ends your TRAX session and returns you to the F
there are any changes to the show, you will be 
disk before quitting.
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Edit Menu Use the commands on this menu to edit the contents of the currently selected 
window. It contains the same basic editing commands as found in most Mac 

diting change in the current window. The 
Cut, Paste, Clear, Create, Edit, Move, 

vices or other objects. 

gh the dialog box shown by double-
 view, or changes to the device assign-

es including re-recording of cues and the 
and.

 entry changes to Redo…, allowing you 
re is only one level of undo. 

ter you edit, paste, move etc., and before 
n make a change, run the show to see 
hange. 
C

OS applications.

Undo/Redo The Undo command reverses the last e
following operations can be undone: 
Duplicate. 

Create refers to creating new cues, de

Edit refers to any changes done throu
clicking an object, editing a cue in list
ment of a cue or panel item. 

Undo Move will undo all kinds of mov
effects of the Expand/Compress comm

When you undo something, the menu
to undo the Undo command itself. The

You must choose Undo immediately af
you leave the current window. You ca
what it looks like, and then undo the c



d places it on the Clipboard. 
nel items, as well as text and 

places the copy on the Clip-
cts from the most recent cut/
the contents of the Clipboard. 
 another place in the show, or 
78 Chapter 4: Menus and Commands

Cut Removes the selected object or set of objects an
This can be used on cues, devices, tasks and pa
graphics.

Copy Copies the selected object or set of objects and 
board. The Clipboard holds only one set of obje
copy operation – the next cut/copy will replace 
From the Clipboard, the objects can be pasted to
into another show.
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Paste Pastes a copy of the contents of the Clipboard into the active window.

When you paste devices or panel items, they will enter the window at the orig-
py and then immediately paste, the copy 
see both the original and the copy, you 
 in the window.

tered with the first pasted cue at the 
e, it will be entered on the current track. 

 retain their original track positions. 
C

inal location of the object. So if you co
will appear on top of the original. To 
must drag the copy to a new position

When you paste cues, they will be en
current time. When pasting a single cu
When pasting multiple cues, they will



 show or between shows. 
mes and addresses of the 

en shows, the names of the 
both shows. This is because 
ice assignments. If the names 

but you will then have to re-

pying Fade cues with multiple 
ced by the cues are not avail-
e device assignments for those 
vels.

ows, you can also use the 
jects until needed. This allows 
ents, cues or panel items for 
rapbook, only their text repre-
r properties.

ote cue that says what the set 
n the Scrapbook.
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Copying Between Shows You can copy and paste objects within the same
When pasting devices, TRAX will change the na
pasted devices to avoid conflicts, if necessary.

When copying cues, tasks or panel items betwe
devices which they refer to must be identical in 
TRAX uses the device names to correlate the dev
are not identical, you can still paste the objects 
establish the device assignments manually.

▼ CAUTION: Be particularly careful when co
faders between shows. If any devices referen
able in the new show, not only will you lose th
devices but also their corresponding fader le

Using the Scrapbook As an alternative to copying directly between sh
Scrapbook under the Apple menu to hold the ob
you to build a library of useful device arrangem
easy retrieval. When pasting objects into the Sc
sentation will be shown – not their icons or othe

◆ HINT: For sets of cues, begin the set with a N
does. You will then be able to see this note i
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Clear The Clear command removes the selected objects without placing the selection 
on the Clipboard. Use this command only when you have something more 

on’t want to overwrite, as the Clipboard 
ime. Normally you should use the Cut 
jects.

ace key usually has the same effect as 

an be used on cues, devices, tasks and 
ffect the Clipboard. 

ges the name and port address of the 
C

important on the Clipboard that you d
can only hold one set of objects at a t
command (Command-X) to remove ob

✈ SHORTCUT: Pressing the backsp
choosing Clear on the Edit menu.

Duplicate Duplicates the selected objects. This c
panel items. This command does not a

When duplicating devices, TRAX chan
duplicates to avoid conflicts.



up on top of the original ones. 
ath the cue.

ght).

is distance, allowing you to 
ls.
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Duplicating Cues When you duplicate cues, the new cues will end 
This is indicated by the thick, black line underne

Drag the new cues the desired distance to the ri

Subsequent Duplicate commands will now use th
“step up” any number of cues at specific interva

A cue on top of another is indi-
cated by a thick line below the 
cues.

Press the Option key while drag-
ging to see the distance.

Keyboard shortcut: Command-D.
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Select All Selects all objects in the active window.

▼ WARNING: This command literally selects all objects in the active 
creen.

 a timeline window is active. It selects all 
the end of the timeline. 

e middle of a timeline:

 some space for new cues.

x, allowing you to see and edit its name 
s 5, 6 and 7 for detailed descriptions of 
, panel items and cues.

object has the same effect as selecting an 
. You can also use the Enter or Return 
alog box.
C

window, even those currently off-s

Select to End This command is available only while
cues from the current time position to 

This can be used to “insert time” in th

• Use the Select to End command.

• Drag the cues forward to open up

Specifications Opens the selected object’s dialog bo
and other characteristics. See chapter
all the dialog boxes related to devices

✈ SHORTCUT: Double-clicking the 
object and choosing Specifications
keys to open a selected object’s di



mands to change the front-to-
ics on a panel.
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Bring to Front, Send to Back Use the “Bring to Front” and “Send to Back” com
back ordering of layered objects, such as graph

Select an object…

…choose “Bring to Front”.
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Find/Replace This command is only available when a timeline window is selected. It allows 
you to find and optionally replace various items using the same text form syntax 

rch only the name field of Control cues. 
labels to locate various points in a show. 
ards show you may have different show 
rious possible winners. When the name 
ocate the appropriate show segment. By 
ames into the Name field of Control cues 
egment, you can quickly locate the right 
n’s name into the Find field.
C

as displayed in the List View.

By default, the Find command will sea
This allows Control cues to be used as 
For example, if you’re making an aw
segments pre-programmed for the va
of the winner is read out, you have to l
putting the various potential winner’s n
marking the beginning of each such s
segment simply by entering the perso



lace the next occurrence. This 
n. When the Search option is 

rection and then – if not found 

ccurrences and then jump to 
es matching a search criteria 

 for example.

f the Find/Replace command. 
earched. When Backward or 
ad of the current time position 
earch to the currently selected 
le search criteria to a set of 
g the “All” mode, then – from 
es referring to projector A5.

hich part of the cue will be 
is “Name Only, Control Cue”, 
and to locate named positions 
on is similar but searches the 
he name field is the topmost 
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Finding One at a Time By default, the Find command will only find/rep
is determined by the “One at a Time” radio butto
set to All, TRAX will first search in the forward di
– it will search in the reverse direction.

Finding All at Once Choosing “All at Once” will find and select all o
the first selected cue. Use this to select a set of cu
when you want to copy, move or expand them,

Search Extent The Search radio buttons determine the extent o
If All is selected, all cues in the timeline will be s
Forward is selected, only cues in the past or ahe
will be searched. The Selection choice limits the s
cues. This can be used as a way to apply multip
cues, for example first find all Dissolve cues usin
the result of that first Find command – find all cu

Field to Search in The radio buttons in the Field area determine w
searched for a match. The default selection here 
which is appropriate when using the Find comm
in a show. The Name Only, Any Cue radio butt
Name field of any cue – not just Control cues. T
field in each cue’s dialog box.
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The “Cue Contents as Text” option searches all text in the Cue column of the list 
view, including the name. This allows you to search for dissolve rates, frame 
numbers, etc. 

e the “Cue Contents as Text” option with 
if you are in icon view mode.

s the Find command to only look at the 
iew. This makes it easy to find all cues 
, this option is easiest to use with list view 
 list view turned off.

o replace the text found with any other 

ion with care! The safest way to use it is 
n to ensure that no unwanted side-effects 

 text string with another, its uses are 
ace all Tray-Step Delays for a range of 
 replace all references to one laserdisc 
n work on partial items. For example, 
rs with a letter followed by a number, 
ea. You can then transpose a set of cues 
ly by replacing A with C in the Device 
C

◆ NOTE: Although it is easiest to us
list view activated, it will still work 

Choosing “Device Assignment” cause
contents of the Device column in List V
referring to a particular device. Again
activated, but it works identically with

Replace With The “Replace With” field allows you t
text. 

▼ WARNING: Use the Replace opt
in conjunction with Search Selectio
occur.

As this command simply replaces one
unlimited. You can, for example, repl
dissolve cues with another delay time,
player with another one. You can eve
assume you name your slide projecto
where the letter specifies the screen ar
referring to screen A to screen C simp
Assignment field.



mmand the dialog box comes 
ble to re-use the specifications 
ing to re-enter all the details. 
osing the Find/Replace 

command described on the 
l cues in the current timeline 
keyboard with function keys, 
F1” through “F15” as names 
nction keys will then instantly 
use control key combinations 
s and pressing the letter while 

less remote control act as func-
n conjunction with the Quick-
s in the show (see Chapter 13 

ol key combinations, it can not 
any of these keys.
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Re-using the Last Find Normally when you choose the Find/Replace co
up empty. However, sometimes it may be desira
of the last Find/Replace command, without hav
Do this by holding down the Shift key while cho
command (or press Command-Shift-F).

Using QuickFind A special QuickFind feature, similar to the Find 
previous pages, allows you to search for Contro
window using a single keystroke. If you have a 
you can use those for this purpose by entering “
of Control cues. Pressing one of the assigned fu
jump to that Control cue. Alternatively, you can 
by entering cA through cZ as Control cue name
holding down the Control key.

◆ HINT: Nine of the keys on the AIRLINK wire
tion keys F5 through F13. This can be used i
Find feature to jump directly to specific point
for details).

As this feature depends on function keys or contr
be used on Macintosh Plus, which doesn’t have 

+
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Object Menu This menu is similar to the Edit menu in that it allows you to manipulate the 
selected objects. However, while the Edit menu contains general commands 

enu contains more TRAX-specific 

 a timeline. That is, all selected cues 
be moved so that the time between them 
mple, when you want a certain number 

ount of time. After using this command 
rd single cues, for example in order to 

n you want cues timed to go on the beat 
f time. First count the number of beats, 
t and last cue on their respective beats, 
 remaining ones evenly.
C

such as Copy and Paste, the Object m
commands.

Distribute Cues Distributes selected cues evenly along
(except the first and the last ones) will 
is equally distributed. Use this, for exa
of actions to occur over a specific am
you can manually fine-tune or re-reco
match the sound track.

Distribute Cues can also be used whe
of the music for an extended period o
then enter that many cues. Put the firs
then use Distribute Cues to spread the



imeline either by a percentage 
es to use this command. Enter 
ues, or a negative value to 

 the timeline, their internal 
s to any small time value, such 
g box.

 to Change, note that effect 
he expansion/compression 
 time or a percentage). Owing 
nd-off errors may occur. 
lated to external timings not 
lide projector), the result may 
there may not be enough time 
 slide.

, the time value will be added 
can be used to decrease all 
 amount. 

◆ HINT: You can offset the 
time positions in Locate 
Time cues using the Effect 
Rates option with By Time.
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Expand/Compress Cues Expands or compresses a range of cues along a t
or a specific time. You must select at least two cu
a positive percentage or time value to expand c
compress them.

You can choose to change the cues’ positions on
effect rates, or both. The internal effect rate refer
as a dissolve or wipe rate, inside the cue’s dialo

If you choose the Both radio button under What
rates will always be changed proportionally to t
factor (regardless of whether this is specified as a
to the limited resolution of some effect rates, rou
Furthermore, if you compress a series of cues re
controlled by TRAX (such as the cycle time of a s
not exactly match your intentions. For example, 
left after the compression to advance to the next

If you choose to change Effect Rates and By Time
to or subtracted from the cue’s effect rates. This 
dissolve rates in the selected cues by a specified
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Group, Ungroup The Group command lets you link several objects together to form a group. This 
command can be used with devices, cues and panel items (i.e., buttons, etc.). 

 been carefully arranged to perform a 
te cue to always stick to the cue whose 

ms, they will always stick together when 
or otherwise manipulated. When one 
ers are selected automatically.

roup of mutually exclusive switch closure 
 that only one of the switches in the group 
tually Exclusive in Group” on page 130 

 group, making the objects individually 

 an object in order to edit its contents. 
use. Once you finish editing the object, 
matically be re-selected again.
C

A set of cues may, for example, have
certain effect. Or you may want a No
function it describes.

Once you’ve grouped a number of ite
they are moved, copied, re-recorded 
object in the group is selected, all oth

You can also use grouping to form a g
outputs. By doing so, TRAX will ensure
is activated at a time. See “Output Mu
for more details.

Use the Ungroup command to break a
accessible again. 

◆ HINT: You don’t have to ungroup
Simply double-click it using the mo
the other group members will auto

Selecting any object in a group 
selects all group members.



ngroup commands in that they 
the Lock command is even 
es at all to the locked object 

lock menu commands if all 

 a locked object, a warning is 

lied, or proceed if you want. 
hanges without first unlocking 
soon as you‘re finished with 
e minor changes later on, if 
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Lock, Unlock These two commands are similar to the Group/U
allow you to protect selected objects. However, 
stronger in that it won’t let you make any chang
(unless you really insist, as described below). 

A checkmark is displayed next to the Lock or Un
selected objects are locked or unlocked.

Whenever you try to do anything that will affect
displayed:

You can then cancel the change before it is app
This soft lock allows you to make any necessary c
the cue. Thus, you can lock a section of cues as 
them, while still being able to go back and mak
necessary.
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Disable/Enable Device Use Disable Device when you want to keep a device stationary while working 
on other devices or parts of the show. A disabled device will operate normally 

ysical device will remain as it was prior 

enu items is the same as the one shown 
s window for each device. Furthermore, 
ear crossed out in the device window.

d often convenient to select devices to be 
 timeline window, be careful not to alter 
st click away from all cues to make sure 
device selection.

w for the selected device. Use the status 
device, or to manipulate it manually. The 
 screen while the show is run.

ber of devices, first select all the desired 

d description of the status window for 

from the Cue menu. A dialog box tells 
rom the Cue menu. When you have 
dialog box. Deleting cues from the menu 
itself.
C

on the computer’s monitor, but the ph
to disablement.

The disabled state indicated by these m
by the Disabled checkbox in the statu
the icons for disabled devices will app

▼ CAUTION: While it is possible an
disabled or enabled from within a
the device assignment of a cue! Fir
that none will be affected by your 

Show Device Status This command opens the status windo
window to see the detailed status of a 
status window can be left open on the

To open the status windows for a num
devices in the Device window. 

Please refer to Chapter 5 for a detaile
each device.

Delete from Cue Menu Allows you to delete customized cues 
you to choose the cues to be deleted f
finished deleting cues, click OK in the 
has no effect on the cues in the show 

The icon for a 
disabled device.

Status window for 
a Lamp device.



 window. See Chapter 5 for a 
d windows. 

the Device window is selected. 
ar.

rt assignment and name. You 
as other details particular to 
from the Edit menu. However, 
nment of each device is unique 
ose port assignment may, in 

s – see “Switch” on page 129 

e menu adds a new device of 
 by a bullet to the left of the 
command will add another 

ifications for the device being 
evice of the same kind. Thus, 
 start by creating the first one, 
emaining ones. They will then 
cations.

m from another show. See 
e details.
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Device Menu Use this menu to add new devices to the Device
description of each kind of device and associate

◆ NOTE: The Device menu is only active when 
To activate the Device window, click its title b

New devices are automatically given a unique po
can change any of these specifications, as well 
each kind of device by choosing Specifications 
you must make sure that the name and port assig
(the only exception here is the Switch device, wh
some cases, coincide with slide projector device
for details).

The “New” command at the bottom of the Devic
the kind last chosen from the menu, as indicated
icon. In the example shown to the left, the New 
video disc.

The type, name, port assignment and other spec
created are based on the most recently edited d
when creating multiple devices it’s a good idea to
and set all its specifications before creating the r
be configured based on the first device’s specifi

An alternative way to add devices is to copy the
“Copying Between Shows” on page 80 for mor

The “New” command creates 
a new device of the kind 
currently marked with a bullet.
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Cue Menu Use this menu to add cues to the current window. Cues tell the assigned devices 
what to do and when to do it. The what part is determined by the kind of cue 

ions. The when part is determined by the 
 starting condition in the task list. Cues 
ces in order to have any effect. This is 
also find a detailed description of each 

imeline or the Task window is selected. 
e and on the current track of a timeline 
en entering a cue into the Task window, 
f a new task (see “Adding a Task” on 

ifferent on your Macintosh than in the il-
 models without Color Quickdraw – such 
arly PowerBook models – only the full 
 may cause the Cue menu to be chopped 

e menu, you can also create your own, 
appear on the Cue menu, and can be 
he menu, or by typing the name of the 
s speeds up the cue entry process consid-

 by one, you can import them from other 
mand on the File menu. Use the “Delete 
ject menu to remove customized cues 
C

chosen as well as its internal specificat
cue’s position along the timeline or its
must be assigned to one or more devi
described in Chapter 7, where you’ll 
cue type and its various settings.

The Cue menu is only active when a t
New cues are entered at the current tim
(see “Creating Cues” on page 34). Wh
the cue will be entered as the action o
page 51).

◆ NOTE: The Cue menu may look d
lustration to the left. On Macintosh
as Macintosh Plus, SE and some e
height icons can be displayed. This
off at the bottom.

Customized Cues In addition to the basic cues on the Cu
customized cues. These cues will also 
chosen either by selecting them from t
customized cue. Using customized cue
erably (see “To Menu” on page 180).

Instead of adding customized cues one
shows using the Import Menu Cues com
from Cue Menu” command on the Ob
from the menu (see page 93).Customized Dissolve cues 

installed on the Cue menu.



nditions for tasks in the Task 
for a Task” on page 53). The 
 properties (both input and 
matical expressions, very 
base program.

≠.

 perhaps the most useful ones 
an also come in handy from 
sk to be started if the number 
a preset limit, then you could 

eric Position * 0.75

re devices used to keep track 
e current limit. The limit value 
tion desk, and the counter 
rs.
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Symbol Menu Use the Symbol menu when entering starting co
window (see “Specifying the Starting Condition 
symbols can be used together with device status
output properties) and constants to create mathe
much as you would do in a spreadsheet or data

The symbols can be divided into three groups:

• Arithmetic symbols: *, /, \, + and –.

• Relational Symbols: <, ≤, >, ≥, = and 

• Logical Symbols: & and |.

Of these, the relational and logical symbols are
in task conditions. But the arithmetic operators c
time to time. For example, assume you want a ta
of people in a room is more than 75 percent of 
set up the condition like this:

Count:Numeric Position > Limit:Num

where “Count” and “Limit” are two virtual stillsto
of the number of people in the room as well as th
can be adjusted from a touch panel in the recep
driven by turnstiles at the entrance and exit doo
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Symbol Precedence When combining multiple symbols to form an expression, some symbols take 
precedence over others. For example, in the expression

 the addition. So the result of the above 
add 3), not 32 as would have been the 

hly equal to their order on the menu, 
t the same precedence level:

s built-in order of precedence, if desired. 
ression shown above to be evaluated as 
 by 5”, you can write it like this:

med before the multiplication, thereby 
tion.

xpression, you can try it out as described 
n page 59.
C

3 + 5 * 4

The multiplication is calculated before
expression is 23 (5 times 4, and then 
case if evaluated strictly left to right.

The precedence of the symbols is roug
although some symbols are actually a

Highest: *, /, \
+, –
<, ≤, >, ≥, =, ≠
&

Lowest: |

You can use parenthesis to override thi
For example, if you would like the exp
“add 3 and 5, then multiply the result

(3 + 5) * 4

This means the addition will be perfor
achieving the desired order of evalua

If you’re unsure about the result of an e
under “Evaluating Task Conditions” o



, addition and subtraction of 
would expect. Note, however, 
 always give a whole number 

order to obtain any fractional 
have a fractional part (even if 

emainder of a whole number 
f the whole number division is 

t varies with the kind of symbol 

a time to the right, the result is 
een used on the right hand 

nds in the time value. That is, 
ince 1 minute and 10 seconds 

:50 * 2 equals 3:40.00.

:50 / 2 equals 0:55.00.

 + 2 equals 1:52.00.

1:50 – 2 equals 1:48.00.
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Arithmetic Symbols The arithmetic symbols – multiplication, division
whole and fractional numbers – behave as you 
that an expression involving only whole numbers
as its result; for example 7 / 2 results in 3. In 
part of the result, at least one of the values must 
it is zero); 7.0 / 2 results in 3.5.

The “Remainder” symbol (backslash) gives the r
division, such as 7 / 2. In this case, the result o
3, with one left over. Thus 7 \ 2 equals 1.

When used with time values, the type of the resul
and what’s on the other side of the symbol:

When used with a numeric value to the left and 
always the same as if a fractional number had b
side, with the value equal to the number of seco
3000 / 1:10.00 is the same as 3000 / 70.00, s
equals 70 seconds.

time * number The product, as a time; 1

time / number The quotient, as a time; 1

time + number The sum, as a time; 1:50

time – number The difference, as a time; 
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When used with time values on both sides, the following combinations produce 
useful results:

maximal numeric range that can be 

RAX truncates all values to two fractional 
ut +/– 20 million.

eric as well as time values, although the 
s may not be very useful. The maximum 
:59:59.99 through 99:59:59.99 (that is, 
 99 hundredths). See the description of 

s a number; 3:30 / 1:00 equals 

ime; 1:50 + 1:50 equals 3:40.00.

 as a time; 3:40 – 1:50 equals 
C

Type and Range of Values When used with whole numbers, the 
handled is about +/– 2 billion.

When used with fractional numbers, T
digits, and the maximum range is abo

All the symbols can be used with num
results obtained by some combination
time range that can be handled is –99
99 hours, 59 minutes, 59 seconds and
each symbol below for more details.

time / time The quotient, a
3.5.

time + time The sum, as a t

time – time The difference,
1:50.00.



g conditions for tasks (see 
n page 53). For example, you 
 to) to start a task at 8:00 AM:

Clock” in the Device window, 
 True” is selected for the task.

duce a “true” or “false” result, 
. For example, the expression 
0 (i.e., “false”) before 8:00 

on-zero result is considered 

 compare values of the same 
ou mix time and numeric 

seconds. For instance, the 

idnight, as 800 seconds 
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Relational Symbols The relational symbols are often useful in startin
“Specifying the Starting Condition for a Task” o
could use the ≥ symbol (is greater than or equal

Clock:Time ≥ 8:00:00

This assumes that there is a Time device named “
and that the starting condition variant “Becomes

Expressions using relational symbols always pro
where “true” is represented by 1 and “false” by 0
shown above would produce the numeric result 
AM, and the result 1 (“true”) after 8:00 AM.

When used in starting conditions for task, any n
“true”, and zero is considered “false”.

In general, you should use relational symbols to
type; i.e., compare a time with another time. If y
values, the numeric value will be interpreted as 
expression

Clock:Time ≥ 800

becomes true 13 minutes and 20 seconds past m
equals 13 minutes and 20 seconds.
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Logical Symbols The logical symbols & and |are often used to combine several other sub-
expressions using the relational symbols, for example. Logical symbols are 

 repeatedly while the time is between 
ke this:

ck:Time < 12:00:00

bine the results from the first sub-expres-
ith the second sub-expression 

orten a statement like the above to “The 
ess than 12:00:00”, that doesn’t work 
he Clock:Time reference explicitly as 

l to start a task repeatedly if the time is 
M:

ck:Time > 17:00:00 

 starting condition variant “While True” 
 the task repeatedly for as long as the 
 just once when it becomes true.

” symbols in the same expression. But 
as higher precedence than the “Or” 
arenthesis, if desired.
Cha

sometimes called Boolean operators.

For example, if you want a task to run
8:00 AM and noon, you could do it li

Clock:Time > 8:00:00 & Clo

Here the “and” symbol is used to com
sion “Clock:Time > 8:00:00” w
“Clock:Time < 12:00:00”. 

◆ NOTE: While we humans might sh
time is greater than 8:00:00 and l
with computers. You must specify t
part of both sub-expressions.

Likewise, you can use the “or” symbo
either before 8:00 AM or after 5:00 P

Clock:Time < 8:00:00 | Clo

Both examples above assume that the
is selected, which will keep re-starting
condition is true, instead of running it

You can combine the “And” and “Or
keep in mind that the “And” symbol h
symbol. You can override this using p



ility and appearance of the 
can’t find it on the screen, this 
cellaneous dialog boxes from 

mary windows in TRAX. 
cified window or moves it to 
 one of these items indicates 
 menu item indicates that the 

ch window to close it. 

each of these windows. 

 open additional windows on 
tance, to open a timeline 
w, double-click the timeline’s 
en a window associated with 
t the icon and use the “Speci-

nd displays its window. The 
“Timeline Settings” command 

etails.
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Window Menu The items on the Window menu control the visib
windows. If you look for a certain window and 
is the place to go. You can also get to some mis
this menu.

Device, Task, Device Support These commands provide access to the three pri
Choosing one of these commands opens the spe
the front of other windows. A checkmark next to
that the window is already open. An underlined
window currently is the active window.

Click the close box in the upper left corner of ea

Refer to Chapter 3 for a detailed description of 

From within the three primary windows, you can
objects contained within those windows. For ins
window associated with a task in the Task windo
name in the task’s Action column. Likewise, to op
a device, double-click the device’s icon, or selec
fications” or “Show Device Status” commands.

New Timeline Creates a new timeline, adds it to the Task list, a
timeline is created with a default name. Use the 
to rename the timeline (see page 103).

See “Timeline Window” on page 29 for more d
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Timeline Settings Opens the dialog box for specifying the name and other details related to the 
currently active timeline window. This option is only active when the frontmost 

ge the settings for a timeline in the Task 
y double-clicking the timeline’s name in 

e timeline, enter the time value here and 
rrent time position, enter a positive or 
ative checkbox.

in a timeline window opens this dialog 
tive time. You can also double-click the 
e window to bring up this dialog box.
Cha

window is a timeline window. To chan
list, first open the timeline’s window b
the Action column of the Task list.

Go to To jump to any time position along th
press Enter. To jump relative to the cu
negative time value and select the Rel

✈ SHORTCUTS: Typing a + or a – 
box, allowing you to type in a rela
numeric time readout in the timelin



 active moves you forward 
is field. Pressing Shift-Tab 
venient if you often work with 

ponding to one video frame. 
ove forward or backward one 
te, use 0.03 to approximate 

 by first selecting the cues and 
r Command-Shift-Tab (back-

 of the timeline. Normally the 
 timecode from tape, you may 
h the starting time of the time-

 be moved forward automati-
n fifteen seconds from the 
w before you start program-
 final show in advance) keeps 
bottom of the timeline window 
aking it more useful as a time-
d point closer to the starting 
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Tab Key Time Pressing the Tab key while a timeline window is
along the timeline by the amount specified in th
moves backward by the same amount. This is con
a particular amount of time, like the time corres
Setting the Tab Amount to 0.04 allows you to m
video frame at a time (assuming a PAL video ra
one NTSC frame).

You can nudge cues by the amount specified here
then pressing Command-Tab (moves forward) o
wards).

Timeline Start/End These fields determine the beginning and the end
timeline starts at 0:00.00. However, if used with
want to offset the beginning of a timeline to matc
code.

The End field is initially set at ten minutes. It will
cally by one minute if a cue is placed closer tha
current end point. Pre-setting the end of the sho
ming (assuming that you know the length of the
the display of the horizontal scroll bar along the 
consistent throughout the production process, m
of-show indicator. It is not possible to set the en
point than ten minutes.
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Stop After Last Cue Select this option to make the timeline stop automatically the specified amount 
of time after the last cue on a timeline. This causes the timeline to stop and relin-

cquired. See “Stopping vs. Pausing a 
ice Ownership” on page 121 for more 
en tasks and devices.

indow will automatically scroll while the 
me position centered in the window. If 
where you may be able to see a suffi-
g – you may want to turn this option off.

urrent track selection. When not locked, 
 whenever you select a cue, just like the 
ue. This is usually what you want when 
use problems when using a track as a 
tions. In this case, it’s important that the 
s it contains the cues at which TRAX will 
m the speaker before proceeding. See 
ore details.

 status of two settings controlled by 
settings in this dialog – they’re included 
ontrol cue to change these settings at the 
 Both these settings are related to 
other timelines. See “Control” on page 
Cha

quish control over the devices it has a
Timeline” on page 42 as well as “Dev
information on the relationship betwe

Autoscroll While Running If this option is selected, the timeline w
show runs, thus keeping the current ti
you’re working on a large monitor – 
ciently long time span without scrollin

Current Track Locked This check box allows you to lock the c
the current track selection will change
current time moves to the time of the c
creating new cues. However, it can ca
stop-track for speaker support applica
same track stays selected all the time a
stop and wait for a new key-press fro
“Speaker Support” on page 226 for m

Current Control Cue Settings This area of the dialog box shows the
Control cues. You can’t change these 
for information purposes only. Use a C
appropriate points along the timeline.
synchronizing timelines to devices or 
212 for more details.



d synchronization source for 
e Running)”. Using a Control 
sk – you can change the sync 

ee running, and then – after 
e to that device. When you’re 

h back to free running again.

e, so that whenever the master 
s with it. This relationship must 
imeline that starts the slaved 
aved timeline is running. See 

tive – is used when synchro-
sitions of the device and the 
e Control cue that establishes 

is discrepancy. See “Control” 

eline window between icon 
shown as a box with a name 
orizontal timeline. In list view, 
nd all information is displayed 

 timeline window is selected. 
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Sync Source The Sync Source field shows the currently selecte
the timeline. By default, this is set to “None (Fre
cue – either on the timeline itself or in another ta
source for a timeline at any point.

For example, you may want to start a timeline fr
starting to play a device – synchronize the timelin
about to stop playing the device, you may switc

A timeline can also be slaved to a master timelin
timeline is re-positioned, the slaved timeline goe
be established in the Control cue in the master t
timeline, and it can not be changed while the sl
“Control” on page 212 for more details.

Offset Relative Sync Source This time value – which can be positive or nega
nizing a timeline to a device. Often, the time po
timeline don’t match. By specifying an offset in th
the synchronization, you can compensate for th
on page 212 for more details.

List View Choosing this menu item toggles the current tim
view and list view. In the icon view, each cue is 
and an icon representing the cue type, along a h
cues are displayed vertically, one line per cue, a
as text.

The List View command is only available while a
See “List View” on page 46 for more details.
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Time Scale This menu item reveals a second menu that allows you to change the time scale 
of the current timeline window while in Icon View.

 gives you an overview of about twenty 
” gives a good overview but sacrifices 
. Choosing 0.3 or 0.1 gives better preci-
re close together, which might otherwise 

rrent time scale, you can always move 
ps using Command-right arrow or Com-
 to move in 0.1 second steps). You can 
ab value by pressing Command-Tab or 
 Time” on page 104).

are very close together in time, you may 
 0.3 or higher Time Scale modes. This is 
e cue icons. To see the cues underneath, 
r switch to List View.

 indicates that two or more cues are 
track. In this case, it won’t help to zoom 
ther. You must move the topmost cue to 
 order to see each individual cue.

 allowing you to change the name of the 
 a timeline window is selected. See 
.

Cha

The standard time scale of one second
seconds. Choosing “3 sec” or “10 sec
detail and precision for dragging cues
sion and allows you to see cues that a
overlap too much.

✈ SHORTCUT: Regardless of the cu
the selected cues in 0.01 second ste
mand-left arrow (add the Shift key
also move the cues by the current T
Command-Shift-Tab (see “Tab Key

If two or more cues on the same track 
not be able to see some of them in the
indicated by a thick gray line below th
zoom to a smaller Time Scale value o

A thick black line below the cue icons
located at exactly the same time and 
in as they will still be on top of each o
another track or switch to List View in

Track Name This command brings up a dialog box
current track. It is only available while
“Tracks” on page 32 for more details

Cues on top
of each other.

Cues almost on top 
of each other.



you to specify miscellaneous 
e show, and not in a separate 
ther computer it will retain all 

rameters, like the serial port 
ough this is very unlikely (the 
r an AppleTalk network).

hen it’s loaded from disk. By 
 Items folder located in the 
e automatically loaded and 
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Preferences Brings up the Preferences dialog box, allowing 
settings. Note that these settings are stored with th
preferences file. So if you bring your show to ano
its preferences.

The disadvantage of this method is that some pa
selection, may differ on the other computer, alth
printer port is typically used to talk to a printer o

Start Automatically when 
Opened

Causes the show to start running automatically w
placing the show (or an alias of it) in the Startup
System Folder of the startup disk, the show will b
started when the computer is turned on. 
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Double-click Opens Device 
Status

By default, double-clicking a device icon in the Device window opens its config-
uration dialog box. The configuration dialog box is used for the initial config-

y accessed again. The configuration 
lecting the device’s icon and choosing 

g box, each device also has a status 
 Opens Device Status” option, the status 
onfiguration dialog box when the device 
ow can also be opened by selecting the 
vice Status” from the Object menu.

ile double-clicking the device’s icon tem-
ehavior.

ndicator in a panel device will be played 
he panel’s status window is selected. 
problems playing sounds while keeping 
ut interruptions. If you run into problems 
k of such sounds, you may want to turn 
Play Panel Sounds” option.

 playback of sounds in simulated panels 
back of sounds downloaded into 
Cha

uration of the device, but is then rarel
dialog box can also be opened by se
“Specifications” from the Edit menu.

In addition to that configuration dialo
window. By selecting the “Double-click
window will be opened instead of the c
icon is double-clicked. The status wind
device’s icon and choosing “Show De

◆ HINT: Pressing the Option key wh
porarily reverses the double-click b

Play Panel Sounds By default, any sound attached to an i
when that indicator is turned on and t
However, some computers may have 
all other aspects of TRAX running witho
that seem to be related to the playbac
off those sounds by un-checking the “

◆ NOTE: This option affects only the
in TRAX. It does not affect the play
TOUCHLINK panels.



rved gang addresses in the 
es responding simultaneously 
to a gang using the Gang cue, 
. Later, when sending a cue to 
ue by sending it to the gang 
ress.

e set aside for use as gang 
 purpose, they are allocated 
hese addresses can’t be used 
um number of reserved Gang 
ng letters shown at the bottom 
 See “Gang” on page 210 for 

e” checkbox displays the 
jectors in the Device window. 
name, which can often be 

e delay used by slide projec-
 Dissolve, Zoom or Wipe cue 
 pop-up menu was set at Stan-
y Step Delay to the most suit-

ng. As a general guideline, 1 
e 250 W lamps, for example 
 voltage lamps, like the Kodak 
s.
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Max Number of Gangs The Gang setting determines the number of rese
system. Gangs allow you to have multiple devic
to a cue. This is done by assigning those devices 
which essentially assigns them a second address
all members of that gang, TRAX optimizes this c
address instead of each device’s individual add

In order for this to work, some addresses must b
addresses. When you reserve addresses for this
from the highest address (77) and downwards. T
by any device in the Device window. The maxim
addresses is eight, corresponding to the eight ga
of the Device window when gangs are activated.
details on how to program using gangs.

Slide Projector Options The “Show Slide Number Instead of Device Nam
current slide number inside the icon of slide pro
This number is shown instead of the projector’s 
deduced from its position in the window.

The “Standard Step Delay” option determines th
tors when advancing to the next slide following a
in which the “Delay After Light Out Til Tray Step”
dard. Normally, you would set the Standard Tra
able value for the kind of projectors you are usi
second is suitable for projectors with low voltag
the Kodak S-AV range. For projectors with high
Ektagraphic or Ektapro models, use 0.6 second
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However, depending on various factors, such as the slides themselves, the 
image size and the lighting conditions in the room, a shorter delay may be 
sufficient. This can be useful for very fast-paced shows that often need to get to 

ard step delay whenever required using 
p” pop-up menu in those cues.

t to use for communicating with the 
ould use the Modem port (the one indi-
 may want to substitute the Printer port.

 the Preferences dialog box, TRAX will 
not, an alert will be displayed telling you 

 no port available even though there is 
m may be another program you’ve run 
ed the serial port without closing it prop-
or system extensions, such as AppleTalk 
x software may also cause such 

by such a background program, TRAX 
port. Use this option with great care, as 
or TRAX to fail.

 to control twice as many devices, as it 
 system. It can also be used to divide the 
s, such as controlling two floors in a 
Cha

the next slide very quickly.

Individual cues can override the stand
the “Delay After Light Out Til Tray Ste

Serial Port Allows you to choose which serial por
Dataton control units. Normally you w
cated by a telephone symbol), but you

When you try to select a serial port in
check to see if that port is available. If 
about the problem.

◆ NOTE: TRAX may say that there’s
indeed one. In this case, the proble
before starting TRAX, which has us
erly. Some background programs 
Remote Access (ARA) and some fa
problems.

If the serial port appears to be in use 
gives you the option of “stealing” the 
it may cause the other program and/

Using Both Ports Selecting Both ports makes it possible
doubles the addressing capacity of the
system into two buses for other reason
museum from the same computer.



al port each device is attached 
’s configuration dialog box 

etween “Backward Compat-
aton control units, such as PAX 
tive mode unlocks all the inter-
ecode sources, etc. See 

as your company’s logo – that 
 copy of TRAX. To use this 

go, possibly from another 

will be displayed.
112 Chapter 4: Menus and Commands

After selecting “Both”, you can specify which seri
to using the “Choose Port” button in each device
(see “Port Assignment” on page 117).

System Mode The System Mode options allow you to choose b
ible” – for maximum compatibility with older Dat
and TRANSPAX+ – and “Interactive”. The interac
active features, such as active inputs, multiple tim
“System Modes” on page 16 for more details.

Paste “Open” Picture This button allows you to specify a picture – such 
will be included with all shows saved using your
feature, follow these steps: 

• Copy the picture, such as your company’s lo
program.

• Click the “Paste Open Picture” button.

• Save the show as usual.

The next time that show is opened, your picture 
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Security Options The Security Options button in the Preferences dialog box brings up the dialog 
box shown below. If your show is already protected by a password, you will 

 access the Security Options dialog box.

n features, you must first enter a pass-
sword can contain any combination of 
ase sensitive, meaning that the word 
ed interchangeably.

e a note of your password in a safe 
s the protected areas of your show if you 

ow. Thus, individual shows may have 
Cha

be requested to enter it before you can

Password In order to use the password protectio
word into the Password field. The pas
characters and punctuation. It is not c
“Chicago” and “chicago” could be us

▼ IMPORTANT: Remember to mak
place. You will not be able to acces
forget it.

The password is local to the current sh
their own passwords, if desired.



eas of the show will be 

lf will always be protected as 
dless of which other areas you 

 asked to enter the password 

asked to enter the password 
vent unauthorized users from 

t. When selected in conjunc-
” option in the main Prefer-
in order to stop the show or 
ly applies after opening the 

 a “turn-key” installation, by 
“Startup Items” folder, located 

he show, and displayed while 

ow After an Automatic Start” 
n the screen until the correct 
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Ask for Password to… The checkboxes in this area determine which ar
protected by a password.

◆ NOTE: The Security Options dialog box itse
long as the password field is not empty, regar
have chosen to protect.

Open the Show. When selected, you will be
when opening the show. 

Save the Show. When selected, you will be 
when attempting to save the show. This can pre
overwriting your show file by mistake.

Stop the Show After an Automatic Star
tion with the “Start Automatically when Opened
ences dialog box, you must enter the password 
access any other window on the screen. This on
show file – not after starting it manually.

You would typically use this last option to create
putting the show file – or an alias to it – into the 
in your System folder.

Copyright Notice The message you enter here will be saved with t
opening that show. 

If you select the “Ask for Password to Stop the Sh
option (see above), your message will remain o
password is entered.
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5 5 DEVICES
iptions of the various kinds of devices 
to “Adding Devices” on page 23 for a 
nipulate the device icons in the Device 

 all devices, and include the name, type 
are specified in the device configuration 
evice icon and choosing Specifications 
ve a unique name and port assignment. 

 internally in TRAX. If you make different 
devices, you should use the same names 
ows. This allows TRAX to correlate cues 
if you copy objects from one show to 

Information about chosen type.

Shows port assignment details.
This chapter provides detailed descr
and their dialog boxes. Please refer 
description of how to create and ma
window.

General Device 
Characteristics

General characteristics are similar for
and port assignment. These attributes 
dialog box, opened by selecting the d
on the Edit menu. Each device must ha

The name is used to identify the device
shows using the same or similar set of 
for the common devices in all your sh
and other objects to the right devices 
another.

Device configuration dialog box.

Device name

Brand and model of device

Port assignment

Opens the device’s status window



nd and model of device is 
dapt its behavior to the 
r example, once TRAX knows 

l be able to precisely calculate 
come “ready” after a dissolve 

e devices may have type-
 you’ve selected the right type 

rticular details, your selection 
 determine which device 
e SMARTPAX control units. 
evice Support window (see 

p menu provides access to 
s model-specific features or 
etc. This information can also 
evice Support window (see 
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Device Type Use the Type pop-up menu to specify which bra
being used. This allows TRAX to automatically a
requirements and specifications of the device. Fo
which slide projector model you are using, it wil
the time it should take for the slide projector to be
with automatic tray advance. Furthermore, som
specific features which can’t be accessed unless
of device.

In addition to informing TRAX on the device’s pa
– together with the port address – is also used to
drivers will be automatically downloaded into th
This is done using the Download button in the D
“Device Support” on page 63).

Device Information Database The “Information” button next to the Type pop-u
additional information about the device, such a
limitations, switch settings, programming hints, 
be obtained using the Help/Info button in the D
“Getting Information on Devices” on page 65).
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Port Assignment The port assignment associates the device icon with an output port on a 
SMARTPAX or other control unit. 

indow, TRAX automatically assigns 
You can change these by selecting the 
 the Edit menu. However, you must make 
in unique. If not, a message will be 
nflict.

nt directly into the Port field, or use the 
ter it interactively.

mputer to communicate with the control 
 then you must specify which computer 
 through here.

sen one serial port in the Preferences 
se the other port, TRAX will accept your 

Only used if you’ve selected 
“Both” serial ports in the 
Preferences dialog box.

Sub-addresses are used for some 
types of devices.
When adding devices to the Device w
unique names and port assignments. 
device and choosing Specifications on
sure that the name and address rema
displayed informing you about the co

You can either type the port assignme
“Choose” button next to the field to en

Computer Port When using both serial ports of the co
units (see “Serial Port” on page 111),
port this particular device is controlled

You can ignore this field if you’ve cho
dialog box. If you then attempt to choo

Address assigned to the port using 
the buttons on the front panel of 
the SMARTPAX or other control 
unit.

Composite representation of the 
port assignment.



orts in the Preferences dialog 

u have set for the output port 
h the device is physically 
10 through 77, where no digit 
ol units later in this manual for 

sses. Sub-addresses are used, 
n the DIGITAL SMARTLINK, 
ey all originate from the same 
 for very different purposes in 
ividual devices in the Device 
ARTPAX output port will have 

sses.

ends on the particular brand 
p menu in the device’s config-
wed, TRAX will automatically 
ialog box. You may then 
 The actual number of sub-
ill tell you if you enter a sub-

 Lamp and Level devices 
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new choice and remind you to activate “Both” p
box.

Address The entry in this field must match the address yo
on the SMARTPAX, or other control unit, to whic
connected. An address is a number in the range 
exceeds 7. See the chapters describing the contr
details on how to set the addresses.

Sub-address Some types of devices allow the use of sub-addre
for example, to address individual output pins o
which provides 32 separate outputs. Although th
port on a SMARTPAX, these signals may be used
your system. Hence, they are represented by ind
window. All such devices associated with one SM
the same main address, but different sub-addre

Whether you can use sub-addresses or not dep
and model of device, selected on the Type pop-u
uration dialog box. When sub-addresses are allo
append ‘1 to the Port field in the configuration d
change the sub-address to any allowable value.
addresses handled by the device varies. TRAX w
address that is out of range. Only some Switch,
support sub-addresses.



Chapter 5: Devices 119

Device Status Windows In addition to the configuration dialog box, each device also has an associated 
status window. You can open the device’s status window using any of the 

ice’s configuration dialog box (see 

ce window and choose “Show Device 
age 93).

e holding down the Option key.

 Status” in the Preferences dialog box 
ouble-click the device’s icon.

status of the device, and allows you to 
ore detail than the icon representing the 

mple, a slide projector icon will look the 
d to an intermediate value explicitly, or 
 the status window for the device will 
is may be helpful when you don’t under-
s.

s a remote control for the device by 
es remain in effect until you re-activate 
y).

bled device, you must first make sure the 
r making the changes, you can check the 
ces your changes to remain in effect until 
following methods:

• Click the “Status” button in the dev
page 115).

• Select the device’s icon in the Devi
Status” on the Object menu (see p

• Double-click the device’s icon whil

• Select “Double-click Opens Device
(see page 109), and then simply d

This status window shows the current 
change the status. It also displays far m
device in the Device window. For exa
same whether the level has been fade
stopped by a Level Stop cue. Opening
reveal what has actually happened. Th
stand why a device behaves as it doe

You can also use the status window a
changing its status there. These chang
the timeline that owns the device (if an

In order to change the status of a disa
Disabled check box is unchecked. Afte
Disabled check box if desired. This for
the device is re-enabled.

Example of a status 
window for a slide 
projector.

See each individual 
device in this chapter 
for a description of its 
status window.



ndow allows you to tempo-
d, the physical device will not 
 any changes in the status 
with only a few of the devices 
ed by – the others. Simply set 
isabled check box. Note that 

ternal status displayed in the 
un the show, but the actual 

d check box, you can also use 
enu to disable multiple devic-

you to see and manipulate the 
 menu for linking its status to 
layed when you click the 
stances:

 which case you can use the 
n expression (see “Linking 

cted a single panel item, such 
y link between the panel item 
g either to control the other 
perties” on page 160).
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Disabled The Disabled check box in the device’s status wi
rarily disable the physical device. While disable
be affected by any actions in your show, nor by
window itself. This is useful if you want to work 
in your rig without disturbing – or being disturb
the state of the device as desired, then click the D
the icon in the Device window, as well as the in
device’s dialog box, will still update when you r
device won’t be affected.

✈ SHORTCUT: As an alternative to the Disable
the Disable Device command on the Object m
es in one go (see page 93).

Device Status Linkage Menus In addition to the status window – which allows 
device’s status – each device also has a pop-up
tasks and panel items. This pop-up menu is disp
device in the Device window under these circum

• You are editing a task’s starting condition, in
device’s status as part of the starting conditio
Conditions to Device Status” on page 54).

• You are editing a panel layout, and have sele
as a Button or a Slider. This forms a two-wa
and the status property of the device, allowin
(see “Linking Panel Items to Device Status Pro

The icon for a 
disabled device.

The device function linkage menu 
for a Switch device.
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Device Ownership As TRAX can have many tasks running at the same time, conflicts may occur 
whenever a task or timeline wants to use a device. If the device is already 

 same or higher priority than the new 
ill not be granted access to the device. 

he first task. See “Changing a Task’s 

ues or other actions, you can see if it is 
 opening the device’s configuration 
wned, that will be stated in the title bar 

w is currently owned by Task ID# 2. To 
 then need to open the Task window and 
 “Referring to Tasks by ID Number” on 
owned by another task, which has the
task trying to access it, the new task w
The device is said to be “owned” by t
Priority” on page 52 for more details.

Thus, if a device doesn’t respond to c
already owned by some other task by
dialog box. If the device is currently o
of the device’s configuration dialog. 

The device in the example shown belo
find out who that might be, you would
look up the task by its ID number. See
page 62 for more details.

The ID number of the task that 
owns this device.



ing a radio-button in their 
itch, Level, Still Store, Text and 
evice in most aspects, except 

t have an address, and is only 

anel devices. Items on a panel 
 become operational. In many 
ectly using a panel button or 
 start a timeline or other task. 
l Switch device, as it is only 
“Linking Conditions to Device 

 this solution facilitates access 
r panel – a definite advantage 
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Virtual Devices Some devices can be designated as “virtual” us
configuration dialog boxes. This includes the Sw
Time devices. A virtual device works like a real d
it has no physical counterpart. Hence, it does no
used internally in TRAX. 

These devices are used primarily together with P
must be assigned to a device function in order to
cases, you can control a function of a device dir
slider. But sometimes you may want the button to
In this case, you could use, for example, a virtua
used as a way to link the button to the task (see 
Status” on page 54).

While this may seem overly complicated at first,
to the same function from more than one page o
for large systems.

A virtual Still Store device used 
to count the number of visitors.
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Slide Projector Slide projectors are controlled either through SMARTPAX or PAX. You can mix 
both kinds of control units in the same system, but be aware that the lamps may 

different types of lamps.

ontrolling slide projectors through PAX. 
 connect and configure projectors 
respond differently in projectors with 

See Chapter 14 for further details on c
Likewise, Chapter 11 discusses how to
controlled through SMARTPAX.



slide projector must also be 
ce order within that screen 
 grouped so that each group 
on a separate screen. The 
e screen may be totally sepa-
mless panoramas.

ave the same area number. 
ight, so that the leftmost screen 
the next, number two and so 
ally calculate horizontal 

ves must be designated a 
late the order in which projec-
s selected for a cue. When a 
e projectors are normally 
ector is number one in the 

e same screen area, try to 
is minimizes the effect of 
g from one image to the next. 
g the slides into the trays.
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Screen Area and Sequence 
Order

In addition to the name and port assignment, a 
designated a screen area number and a sequen
area. In large presentations, projectors are often
works on a separate part of a larger screen, or 
images from multiple projector groups on a larg
rate, edge-to-edge, or overlapping to create sea

All projectors on the same screen area should h
These area numbers are designated from left to r
(from the audience’s viewpoint) is number one; 
on. This makes it possible for TRAX to automatic
effects, like a Wipe.

Within each screen area, the projectors themsel
sequence order number. TRAX uses this to calcu
tors ought to dissolve when a sequential mode i
single stack of projectors is used on a screen, th
sequenced from top to bottom. I.e., the top proj
sequence order; the next is number two, etc. 

When using more than one projector stack on th
sequence the projectors in a circular fashion. Th
keystoning (perspective distortion) when dissolvin
Remember to take this into account when loadin

Sequence: 1

2

3

Screen Area:  1  2  3

Using nine projectors on three 
screen areas.

Using nine projectors on 
one screen area.
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Slide Projector Status Indica-
tion

Some status information is indicated by the projector’s icon in the Device 
window. The lens of the projector indicates the lamp, snap and busy status.

e shown when the projector lamp is at a 
rammed by a Set/Fade cue – or when 

ny Fade, Dissolve, Wipe or Zoom before 
s the target level, it won’t change during 

.

n the Device window is shown whenever 
fect that causes the projector lamp to go 
sy indicator is shown as soon as the cue 

ray has advanced to the next slide. The 
rmal Light Off state. The busy status time 
e lamp-down rate, the tray-step delay 
s determined by your choice on the 
ulation will only be correct when going 
s.

jector causes the Flashing status. When 
jector, you must use a subsequent Flash 

e projector will still be flashing the next 

ntrolled by Snap cues. They also remain 
 corresponding Snap Open cue. It is not 
p on a projector at the same time.
The Intermediate Level indicator will b
level between fully on or off – as prog
you’ve used a Fade Stop cue to stop a
completion. As the indicator only show
the course of a dissolve or fade effect

The Busy status in the projector’s icon i
you make a dissolve, wipe or zoom ef
off and the tray to step forward. The bu
is executed and remains on until the t
status indicator then changes to the no
is an estimate calculated by adding th
and the cycle time of the projector – a
device’s Type pop-up menu. This calc
from fully on without any interruption

Applying a Flash Start cue on the pro
you’ve used a Flash Start cue on a pro
Stop cue to turn off the flashing, or th
time you turn its lamp on.

The Hard and Soft Snap states are co
in effect until explicitly turned off by a
possible to use Flashing and Soft Sna

Light Fully Off
Light Fully On
Light at Intermediate Level
Projector Busy
Flashing
Hard Snap
Soft Snap

Status indicated by the device’s 
icon in the Device window.

To see the full status of a 
projector, open its status 
window.



r in the range 0…80. The 
 decreases the value. TRAX 
is zero. 

s, there will be a one slide off-
s straight tray projectors start 

 The slide number can also be 
nd Wipe cues.

light level. This will usually 
t may differ if you’ve inter-
ted by the Fading Stopped 
 resume fading to the specified 

level, or to suspend a fading 
controlled by the Dissolve, 

 results in a different fading 
n page 197.
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Slide The Slide field indicates the current slide numbe
button to the right of the Slide field increases or
assumes that the home position in the slide tray 

◆ NOTE: If you’re using straight tray projector
set between the displayed and actual values a
at slide number one. 

Use a Locate cue to go to a slide (see page 186).
automatically advanced by the Dissolve, Zoom a

Light The Light field indicates the target value for the 
match the current light level of the projector, bu
rupted a fading with a Fade Stop cue, as indica
check box. In this case, uncheck the check box to
target level.

Use a Set/Fade cue to program a specific light 
(see page 190). The light level is also implicitly 
Wipe and Zoom cues as part of these effects.

Using a Dissolve cue to fade the projector lamp
curve compared to the Fade cue, as illustrated o
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Hard Snap This check box indicates that the mechanical shutter of the projector is closed. 
Use a Snap cue, set to Hard Snap, to control this function (see “Snap” on page 

ed with projectors that have a controlla-
ktapro models, Kodak Carousel 
da and Elmo models. Specifically, it 
hic models.

 is simulated by chopping off the power 
sing a mechanical shutter. Thus, unlike 
 with all kinds of slide projectors.

en the Soft Snap is performed will 
d off. Whenever you de-activate the Soft 
at the proper point. This can be used to 
ffects by using multiple Soft Snap cues 

e obtained using the Flash cue, although 
ontrol over the sequencing of the flash 
n’t use Flashing and Soft Snap at the 

ontrol this function (see “Snap” on page 

has been applied. When you’ve used a 
t use a subsequent Flash Stop cue to turn 
till be flashing the next time you turn its 
204).

◆ NOTE: Hard Snap can only be us
ble shutter (snap), such as Kodak E
S–AV 2030, 2050 and 2060, Sim
doesn’t work with Kodak Ektagrap

Soft Snap Soft Snap is similar to Hard Snap, but
to the projector’s lamp rather than clo
the Hard Snap, this effect can be used

Any dissolve or fading in progress wh
continue even though the lamp is turne
Snap, the lamp will resume its fading 
create flash-fade and ripple-dissolve e
set to Sequence. A similar effect can b
the Soft Snap cue gives you greater c
effect over multiple projectors. You ca
same time on the same projector.

Use a Snap cue, set to Soft Snap, to c
204).

Flashing Flashing means that a Flash Start cue 
Flash Start cue on a projector, you mus
off the flashing, or the projector will s
lamp on.

Light

Time
Using Soft Snap to 
create a flash-fade.



lied to the device. In this case, 
ld have been reached if the 

is function. See “Fading Stop/

 use in task triggering condi-
ice Status Linkage Menus” on 

percent.

.

er is closed, else 0.

losed, else 0.

 Level Stop cue, else 0.
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Fading Stopped This indicates that a Fade Stop cue has been app
the Light field indicates the target level that wou
Fade Stop cue had not been used.

Use a Set/Fade cue set to “Stop” to program th
Resume” on page 191 for more details.

Status Pop-up Menu The following status properties are available for
tions and direct linkage to panel items (see “Dev
page 120):

Light The current light level in 

Slide The current slide number

Hard Snap 1 if the mechanical shutt

Soft Snap 1 if the “soft” shutter is c

Fading Stopped 1 if fading stopped by a
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Switch The switch device provides a basic on/off function. It can be used to control 
anything from a low voltage on/off output to mains voltage power relays. A 

TRAX, providing input signals from 
s or wireless remote control (see 

28) is the most common way to interface 
, you can use up to 32 sub-addresses, 
r input signals available on that smart-

).

r example to link a button on a 
sk list. You can also use it to keep track 
t be deduced from any other device 
cluded in starting conditions for tasks 
tatus Properties” on page 54).
switch device can also be an input to 
sensors, push-buttons, MIDI keyboard
“AIRLINK” on page 346).

The DIGITAL SMARTLINK (see page 3
with basic switch closures. In this case
corresponding to the 32 output and/o
link (see “Sub-address” on page 118

Real vs. Virtual Switch Device You can use a virtual switch device fo
TOUCHLINK panel to a task in the Ta
of some state of your system that can’
status. This information can then be in
(see “Conditions Based On Multiple S



 as outputs or inputs, or both. 
NK. These choices are made 
ction on the Type pop-up 

 use in task triggering condi-
linking a task triggering condi-
evice Status” on page 54 for 

witch in a group of switches 
ple when controlling curtains 

 “open” and “close” switch 

g box for each Switch device 
ive in Group.” Then select all 
 and choose Group on the 

1). Now, whenever one of the 
iously activated switch will be 
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Function: Output, Input, Both Some types of switch devices can be used either
This includes for example the DIGITAL SMARTLI
available as appropriate according to your sele
menu.

The input state of a switch is made available for
tions through the pop-up menu displayed when 
tions to the switch. See “Linking Conditions to D
more details.

Output Mutually Exclusive in 
Group

This option allows you to specify that only one s
may be activated at a time. This is useful for exam
or screens, where you must not activate both the
simultaneously.

To use this feature, open the configuration dialo
in the group and select “Output Mutually Exclus
the switches to be grouped in the Device window
Object menu (see “Group, Ungroup” on page 9
switches in the group is activated, any other prev
released automatically.
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Status Window The status window allows you to monitor the device’s status, and to manually 
control the device (if applicable). Certain items in the status window may be 

 the device’s configuration dialog box.

s the output status of the switch. Click 
 cue to program the switch (see “Switch” 

status indicates whether this switch was 
itches that all have “Mutually Exclusive 
s sometimes useful to know which output 
ted, since that will tell you whether, for 
 or closed.

put of the switch is currently activated or 
r “Both” is selected in the device’s config-

most of this information. However, if the 
u will not be able to tell which function is 
. In this case, open the status window to 
inactive, depending on the settings in

Output On. This check box indicate
here to close the switch. Use a Trigger
on page 206)

Last On In Group. This read-only 
the last one activated in a group of sw
in Group” selected (see page 130). It i
in the group was most recently activa
example, a controlled curtain is open

Input Status. Shows whether the in
not. This is only applicable if “Input” o
uration dialog box (see page 130).

The icon in the Device window shows 
switch is both an input and output, yo
activated simply by looking at the icon
see all details.

Not activated
Last activated in group
Activated
Pulsed

Status indicated by the device’s 
icon in the Device window.



 use in task triggering condi-
Device Status Linkage Menus” 

 PAX for output-only functions. 
 and Y. You select these using 
 switch device’s configuration 
y if the same PAX is also used 

relay functions, set its OBJECT 
 on the menu.

right to left on the PAX, while 
nt view). Thus you may have 
elays with address 10 at the 
le that each device must have 

d, else 0.

ctivated in a mutually exclu-
roperty is read-only.

. This property is read-only.
132 Chapter 5: Devices

Status Pop-up Menu The following status properties are available for
tions and for direct linkage to panel items (see “
on page 120):

Controlling PAX Relays The switch device can also be used together with
Each output on the PAX has two relays, called W
the corresponding items on the Type menu in the
dialog box. Choose PAX W-Relay or PAX Y-Rela
to control projectors. If the PAX is only used for 
selector at E AUX and use the PAX E AUX items

◆ NOTE: Relay addresses are assigned from 
projectors are assigned from left to right (fro
both a projector with address 10 and PAX r
same time. This is the only exception to the ru
a unique address. 

Refer to page 355 for further details on PAX.

Output On 1 if the output is activate

Last On in Group 1 if this output was last a
sive group, else 0. This p

Input On 1 if the input is activated



Chapter 5: Devices 133

Tape This device handles audio as well as video tape. Click the Type pop-up menu 
in the device’s configuration dialog box for a complete list of supported 

connect devices to SMARTPAX using the 

vices controlled through a TRANSPAX+ 
pe decks, and is then only available 
ted in the Preferences dialog box (see 

X+ to be connected directly to TRAX, on 
ture allows TRANSPAX+ to be used in a 
ion 1 and 2 of TRAX (see illustration on 
models. Chapter 11 discusses how to 
appropriate smartlink cable.

TRANSPAX+ Connected to 
Computer

This check box applies only to tape de
control unit, such as most open-reel ta
when “Backward Compatible” is selec
“System Mode” on page 112).

When checked, it allows the TRANSPA
the primary system cable bus. This fea
way similar to how it was used in vers



 you to use the interactive 

 Connected to Computer” is 
an address. 

 connected through a 
 16 for more details.

rting positions on the tape. 
te a precise position using 
yers may allow you to locate 

 options, TRAX will usually be 
lly, in which case the other 

 positions at all, both options 

e. This is useful if the tape has 
se, enter the time corre-
X will then tell the tape to go 
 time – whenever you reset the 

ing time in this field, the tape 
nd will continue to search in-
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page 17). Note, however, that this will not allow
features of TRAX.

The “Port” field can not be used if “TRANSPAX+
selected, as the TRANSPAX+ itself doesn’t have 

If this option isn’t selected, TRANSPAX+ must be
SMARTPAX port. See “System Modes” on page

Position By This option determines how to locate specific sta
Most professional tape devices allow you to loca
timecode or similar. Some DAT or DCC tape pla
specific index or song numbers.

As very few tape devices can handle both these
able to make the right selection here automatica
option will become unavailable (grey).

If the selected model can’t locate specific starting
will become unavailable.

Time at Beginning of Tape This field lets you set the home position of the tap
timecode that doesn’t start at 0:00.00. In this ca
sponding to the beginning of the tape here. TRA
to this time – rather than the nonexistent 0:00.00
device to its home position.

▼ CAUTION: If you don’t enter the right start
may not be able to find its correct position, a
definitely.
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Status Window The five buttons at the top of the status window provide basic transport func-
tions: rewind, stop, pause, play and fast forward. These functions can be used 

ammed using a Trigger cue (see “Trans-

r Frame Number” is selected in the de-
 page 134), you can not use the Rewind 

gger cue. Use a Locate cue instead to tell 

p menu.

ific Modes.
on all kinds of players, and are progr
port” on page 207). 

◆ NOTE: When “Position By Time o
vice’s configuration dialog box (see
and Fast Forward modes of the Tri
the tape where to go.

This symbol in the 
device’s icon in the 

Device window indicates the 
current transport mode.

Basic transport functions.

Current time or index position.

Record button. 
Time format pop-u
Locate button.
Shuttle slider.

List of Device Spec



ce. To actually start recording, 
ction is not available for all 

SPAX+, the record button also 
cording. See Chapter 15 for 

 Trigger cue. Note, however, 
ediately when executed.

rrent time position of the tape, 
nfiguration dialog box. You 
e tape by entering it and 
ssing Enter on the keyboard).

ition is determined by the pop-
 page 137), which is only 
r” is selected in the device’s 

 device (see page 186). If the 
r positions then use “By Time”, 
s”. Some tape devices can’t 
elected type of device for 
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Record Button This button activates the record mode of the devi
you have to click the play button. The record fun
devices.

◆ NOTE: For devices controlled through TRAN
provides access to timecode and cue track re
more details.

The record function can be programmed using a
that the Trigger cue will then start recording imm

Position/Index This field shows either the index number or the cu
depending on the “Position By” setting in the co
can also use this field to go to any position on th
clicking the locate button next to the field (or pre

The format used to display and enter a time pos
up menu above the field (see “Time Formats” on
available if “Position By: Time or Frame Numbe
configuration dialog box.

Use a Locate cue to program the position of the
device can locate arbitrary time or frame numbe
otherwise use “By Number”, “Next” or “Previou
locate at all; see the device information for the s
details.
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Time Formats The time format pop-up menu determines the format used for displaying and 
entering time positions. This pop-up menu is only available when “Position By 

 the device’s configuration dialog box 

econds and hundredths, displayed as 
 time format – all times are internally 
of the displayed format. 

 minutes, seconds and frames, displayed 
 per second are normally used for movie 
C format laserdiscs transferred from film.

minutes, seconds and frames, displayed 
 per second is the standard video rate in 
ystems. This format is sometimes referred 

inutes, seconds and frames, displayed 
econd is the standard video rate in coun-
ere are two versions of this format. The 
-broadcast applications.

cond version of the SMPTE format. It is 
tions, where the video time has to match 
 NTSC frame rate is actually 29.97 fps, 
e mode overcomes this discrepancy by 
uence.

onds to “black-and-white NTSC”, i.e., a 
etimes used for non-TV applications.
Time or Frame Number” is selected in
(see page 134).

Standard. Time in hours, minutes, s
HH:MM:SS.hh. This is the native TRAX
stored with this resolution, regardless 

Film time (24 fps). Time in hours,
as HH:MM:SS/FF. Twenty-four frames
films. It is also sometimes used on NTS

EBU time (25 fps). Time in hours, 
as HH:MM:SS/FF. Twenty-five frames
countries using PAL or SECAM video s
to as SMPTE 25.

SMPTE non-drop. Time in hours, m
as HH:MM:SS/FF. Thirty frames per s
tries using the NTSC video system. Th
non-drop format is often used for non

SMPTE drop-frame. This is the se
commonly used for broadcast applica
real time. The reason for this is that the
and not exactly 30 fps. The drop-fram
“dropping frames” in the counting seq

SMPTE 30 fps. This format corresp
frame rate of exactly 30 fps. It is som



 frame number, starting from 
25 fps.

le frame number, starting from 
9.97 fps (i.e., standard color 

sed on NTSC laserdiscs origi-

cts the displayed value. TRAX 
 resolution of 0.01 second, re-

ld is used to single-step one 
n you drag the slider. Not all 

ape players and many simple 
.

 for a specific starting point. 
 cue, which is used to locate 
is feature.

lider, as well as the validity of 
ds on whether TRAX receives 
. If no data is forthcoming, the 
is. Furthermore, when using 
 indication is valid only while 
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PAL frames. Displays the position as a simple
frame number 1 and assuming a frame rate of 

NTSC frames. Displays the position as a simp
frame number 1 and assuming a frame rate of 2
NTSC video).

NTSC/24 frames. This format is sometimes u
nating from film.

◆ NOTE: Your choice of time format only affe
calculates and stores all time positions with a
gardless of the display format.

Shuttle Slider The arrows and the slider below the position fie
frame at a time or to wind the tape in the directio
players support this. Specifically, analog audio t
video players can’t do frame-by-frame stepping

The shuttle control is useful when you’re looking
Similar controls are also available in the Locate
time positions on tape players equipped with th

▼ IMPORTANT: The operation of the shuttle s
the time displayed in the position field, depen
data from the device about its current position
shuttle slider will be grayed out to indicate th
TRAX in its Backward Compatible mode, this
the status window is the active window.

Shuttle slider 
grayed out.
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Eject This button lets you eject the tape or disc in the device. This feature is not 
supported for all devices. Use a Trigger cue to program this function (see 

dow shows the device-specific modes 
e. Use the triangle above this list to show 
 grayed out, the chosen type of device 

at indicates its current state and choose 
ay take an additional numeric value, 

lue” field at the bottom of the window.

ice-specific modes (see “Device Specific 

s available for specific models, click the 
p-up menu in the device’s configuration 
“Eject” on page 209).

Device Specific Modes The list at the bottom of the status win
available for the selected type of devic
or hide the list. If the triangle appears
doesn’t have any such modes.

To change a mode, click on the box th
from the pop-up menu. Some states m
which can then be entered in the “Va

Use a Trigger cue to program the dev
Mode” on page 208).

For more information about the mode
information button next to the Type po
dialog box.



 use in task triggering condi-
ice Status Linkage Menus” on 

ng the Tape, Audio Disc and 
o specific types of devices.

r audio out level, as a 
100.

 of the device, if applicable, 

tion of the device (i.e., song 
licable.

de. The “Reverse” mode 
eo disc devices.

 only to some video disc 

else 0.

e listed below the grey line. 
vary with the type of the 
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Status Pop-up Menu The following status properties are available for
tions and direct linkage to panel items (see “Dev
page 120):

◆ NOTE: This set of status fields is shared amo
Video Disc devices. Some fields apply only t

Output Level The current video and/o
number between 0 and 

Time Position The current time position
as a time.

Numeric Position The current numeric posi
or index number), if app

Transport The current transport mo
applies only to some vid

Speed Playback speed. Applies
devices.

Record 1 if currently recording, 

Device specific 
modes

Device-specific modes ar
Their names and values 
device.



Chapter 5: Devices 141

Audio Disc This device handles audio discs of various kinds, including CD and minidisc 
devices. Click the Type pop-up menu in device’s configuration dialog box for 

hapter 11 discusses how to connect 
opriate smartlink cable.

pe device, beginning on page 133, for 
ion dialog box and status fields. See 
c devices.

r or the current time position of the disc, 
 the configuration dialog box. You can 
 on the disc by entering the position and 
eld (or pressing Enter on the keyboard). 

m the device in “Position by: Song Num-
en the disc moves on to the next song. It 
he last song you’ve told it to locate.
a complete list of supported models. C
devices to SMARTPAX using the appr

Please refer to the description of the Ta
general information on the configurat
below for details specific to audio dis

Position/Song Status Field This field shows either the song numbe
depending the “Position By” setting in
also use this field to go to any position
clicking the locate button next to the fi

◆ NOTE: As there’s no feedback fro
ber” mode, TRAX will not know wh
will simply display the number of t

Audio disc status 
window.



ition is determined by the pop-
 page 137), which is only 
r” is selected in the configura-

evice. If the device can locate 
se “By Time”, else use “By 
. Some devices may not be 
for the selected type of device 

ade cue to program this func-

ort this function.
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The format used to display and enter a time pos
up menu above the field (see “Time Formats” on
available if “Position By: Time or Frame Numbe
tion dialog box for the device.

Use a Locate cue to program the position of the d
arbitrary time or frame number positions then u
Number”, “Next” or “Previous” (see page 186)
able to locate at all. See the device information 
for details.

Volume Status Field This field controls the level of sound. Use a Set/F
tion (see page 190).

◆ NOTE: Many audio disc devices don’t supp
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Video Disc This device handles video disc players such as laserdisc, CRV and hard-disk 
video systems. Click the Type pop-up menu in the device’s configuration dialog 

odels. Chapter 11 discusses how to 
he appropriate smartlink cable.

pe device, beginning on page 133, for 
on dialog box and status properties. See 
 devices.

s you to play the video backwards. Use 
(see “Transport” on page 207). Whether 
e selected model of player as well as the 
 Formats” on page 146).

video playback speed in Play or Play 
rdisc players allow you to play slower or 
 available depend on which model of 
box for a complete list of supported m
connect devices to SMARTPAX using t

Please refer to the description of the Ta
general information on the configurati
below for details specific to video disc

Play Reverse This button in the status window allow
a Trigger cue to program this function 
this is actually possible depends on th
format of the disc used (see “Laserdisc

Speed The Speed pop-up menu controls the 
Reverse mode. Most professional lase
faster than normal speed. The speeds

Video disc status 
window.



u as well as which type of disc 
 Check the device information 

ger cue to select the speed in 
nd (see “Transport” on page 

e’s status window shows the 
 here if the device doesn’t re-
n a Trigger cue.

e current time position of the 
 the configuration dialog box.

t possible to automatically de-
his is due to the fact that these 
isc being used (see “Laserdisc 
 button to the right of the Type 
el.

ld to go to any position on the 
ate button next to the field (or 

ice in “Position by: Chapter 
 moves on to the next chapter. 

hapter you’ve told it to locate.

ition is determined by the pop-
 page 137), which is only 
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player you’ve selected on the Device pop-up men
is being used. Other restrictions may also apply.
for details.

Use the corresponding pop-up menu in the Trig
conjunction with the Play or Play reverse comma
207).

◆ HINT: The Speed pop-up menu in the devic
valid playback speeds for the device. Check
spond properly to a speed you’ve specified i

Position/Chapter Status Field This field shows either the chapter number or th
disc, depending on the setting of “Position By” in

◆ NOTE: With some video disc players, it is no
termine the correct setting for “Position By”. T
capabilities are also affected by the kind of d
Formats” on page 146). Click the information
pop-up menu for details on the selected mod

You can also use the Position/Chapter status fie
disc by entering this position and clicking the loc
pressing the Enter key on the keyboard). 

◆ NOTE: As there’s no feedback from the dev
Number” mode, TRAX will not know if the disc
It will simply display the number of the last c

The format used to display and enter a time pos
up menu above the field (see “Time Formats” on
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available if “Position By: Time or Frame Number” is selected in the device’s 
configuration dialog box.

ion of the device. If the device can locate 
ons then use “By Time”, else use “By 
age 186). Some devices may not be 

formation for the selected type of device 

llows you to turn the video output from 
pported by the player. This can be done 
y selecting the appropriate check box in 
put Control” on page 207 and “Turn 
 When using a Set cue, set its Level to 
ee page 191).

ckbox controls the video output. This 
he video.
Use a Locate cue to program the posit
arbitrary time or frame number positi
Number”, “Next” or “Previous” (see p
able to locate at all. See the device in
for details.

Video On This check box in the status window a
the player on or off, if this function is su
explicitly using a Set cue or implicitly b
the Trigger and Locate cues (see “Out
Level Off” on page 189 respectively).
either 0 or 100% and the Rate to 0 (s

◆ IMPORTANT: The Video On che
must be activated in order to see t



 NTSC formats. In addition to 
s of storing the video onto the 

 methods. The method used is 

 the preferred format as it 
layer. It’s also faster than the 

mmonly used for discs 
o to be packed onto the disc . 
f capabilities when used with 

 to the closest chapter, minute 

 located frame waiting for a 

ds than normal.

hese limitations using digital 

 on NTSC discs. When trans-
er houses retain the frame 
rame rate is 29.97 fps the 
mes per second. Use the 
ime Format pop-up menu to 
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Laserdisc Formats Just like video tape, video discs come in PAL and
these video standards, there are also two method
disc; CAV and CLV. Many players support both
usually stated on the disc.

CAV (Constant Angular Velocity). This is
provides access to all features of the laserdisc p
CLV format when locating video frames. 

CLV (Constant Linear Velocity). This is co
intended for domestic use as it allows more vide
However, most players have a very limited set o
CLV discs. Common limitations are:

• Not able to locate exact frame numbers, only
or second.

• Not able to show still images, or to sit at the
Play cue before starting to play.

• Not able to play backwards or at other spee

Some advanced players work around some of t
signal processing techniques.

There are also two variants of frame numbering
ferring a movie onto an NTSC disc, some transf
numbers from the movie. Thus, while the video f
frame numbering scheme of the disc uses 24 fra
NTSC/24 Frames or Film Time choices on the T
obtain the corresponding readouts in TRAX.
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Still Store This device provides control over most computer-based presentation programs 
as well as dedicated still-image presentation devices and lighting consoles. 

devices to SMARTPAX using the appro-

the first position. Some devices consider 
to be number 1, while others consider it 
nfigured automatically when a specific 
 menu.

ailable for use in task triggering condi-
 (see “Device Status Linkage Menus” on 

On is activated, else 0.

sition of the device, as a number.
Chapter 11 discusses how to connect 
priate smartlink cable.

First Position Is Number This setting determines the number of 
the first position (e.g., picture, scene) 
as number 0. This setting is usually co
device is selected on the Type pop-up

Status Pop-up Menu The following status properties are av
tions and direct linkage to panel items
page 120):

Status window.

Configuration dialog box.

Output Level 100 if Output 

Position The current po



of two ways; using analog 
 dimmers are often a suitable, 
ting applications. Serial data, 
er proprietary protocols are 
ers are connected to the 
K, which provides a 0 to 10 
hapter 11 discusses how to 

s (see “Sub-address” on page 
es, TRAX reserves additional 
ppearing below the Port field.

e between 0 and 100%. Use a 
90).

e (see page 191). This feature 

The current lamp level 
is also indicated in 
the device’s icon 
(blank when at 
100%).
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Lamp Lamps are controlled using this device in either 
voltage or serial data. Analog voltage-controlled
low-cost solution for small to medium-sized ligh
such as the standard DMX-512 and various oth
often used for larger applications. Analog dimm
Dataton system through an ANALOG SMARTLIN
V DC control signal suitable for most dimmers. C
connect devices to SMARTPAX.

Most lamp devices allow the use of sub-addresse
118). When using more than eight sub-address
main addresses. This is indicated by a message a

Light Level The lamp’s brightness level is specified as a valu
Set/Fade cue to program this value (see page 1

Stopped A fading has been stopped by a “Fade: Stop” cu
is not supported for some lamp devices.

Status window.

Configuration dialog box.

Enlarge the 
window to 
increase the 
precision of the 
slider.
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Level The Level device basically provides the same functionality as the Lamp device, 
but contains some features which make it more appropriate for applications 

vel is specified as a value between 0 and 
 the indicator in the device’s icon. 

ution, allowing the level to be specified 
vice information by clicking the informa-
p-up menu.

en the show is loaded from disc or when 

e by the specified number of decibels. It 
ontrol devices.

The current level is 
also indicated in the 
device’s icon.
involving motion and sound control.

Just like the Lamp device, the output le
100%. The current level is reflected by

Some devices support enhanced resol
in steps of 0.01%. Check this in the de
tion button to the right of the Type po

Initial Value The initial value for the level. Used wh
you apply a “Trigger: Reset” cue.

Boost Output This boosts the maximum output volum
only applies to certain audio volume c

Status window.

Configuration dialog box.

Enlarge the 
window to 
increase the 
precision of the 
slider.



-user interface to your system. 
 to design and use panels.

l’s status window and can be 
 drawing grid is not displayed 
dow.

rid, making it easy to align 
precise positioning of panel 

 to Grid,” hold down the Op-

task triggering conditions and 
ple, link a button to the page 
the button is pressed.
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Panel A touch panel device can be used to add an end
Please refer to Chapter 6 for full details on how

Show Drawing Grid This option displays a drawing grid in the pane
used as an aid in laying out the panel items. The
on the real panel device – only in the status win

Snap to Grid This causes panel items to snap to the drawing g
buttons and other items. Turn off this option for 
items.

◆ HINT: As an alternative to turning off “Snap
tion key while dragging the item.

Status Pop-up Menu The current page number is available for use in 
direct linkage to panel items. You can, for exam
number in order to go to a specific page when 

Visible drawing grid in status 
window.
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Text Use a Text device to display text messages in the device’s status window, on a 
Panel device, or on an external device connected through a SMARTPAX such 

used for on-screen messages only (e.g., 
 displayed on Panel devices, choose 
ialog box.

device (see page 218).

e the font size and the background color 
e. This is useful, for example, if you use 

 dark room.

o link the text from a Text device to a 
ou to show text messages on the panel 
ge 172 for more details.
as a printer or LED sign. When this is 
operator notes), or for messages to be
“Virtual Device” in the configuration d

Use a Note cue to put text into a Text 

Enlarged Font and Black 
Background

These check boxes allow you to chang
of the status window for the Text devic
the status window as a prompter in a

Status Pop-up Menu You can use the status pop-up menu t
Display field on a panel. This allows y
using Note cues. See “Display” on pa

Status window.

Configuration dialog box.



f day, date, etc., for use in 
ouch panel. Alternatively, use 
ctions. When used with the 
so allow you to bring in timing 

window and inside the icon in 
e 137).

roperly in the icon when the 
ying the time of day. You may 
 use the Time device as a 
e is displayed inside the icon. 

y in the status window.
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Time Use the Time device to obtain the current time o
starting conditions for tasks or for display on a t
it for general purpose timer and countdown fun
appropriate device driver, the Time device will al
information from external sources.

Time Format Specifies the time format to be used in the status 
the Device window (see “Time Formats” on pag

Suppress Seconds Select “Suppress Seconds” to display the time p
time may exceed one hour, such as when displa
want to de-select this option if, for example, you
countdown timer. This affects only the way the tim
It doesn’t affect the time value itself, or its displa

Status window.

Configuration dialog box.
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Time of Day Functions To use the Time device for obtaining time of day, day of week, etc., choose 
“Apple:Macintosh System Clock” on the Type pop-up menu. The values 

en be obtained from the clock built into 
, etc., are displayed as device-specific 
n page 139).

an’t use cues to set or stop the time). You 
starting conditions for tasks and in panel 
y the time of day in a Display field on a 

ation dialog box to use the device for 
s only. Then use a “Locate By Time” cue 
e a Trigger cue to play the time forward 

he timer on a Panel device using a 
displayed in the status window will th
your computer. The date, month, year
modes (see “Device Specific Modes” o

All properties are read only (i.e., you c
can still refer to all status properties in 
items. You could, for example, displa
panel (see “Display” on page 172).

Timer and Countdown Func-
tions

Select “Virtual Device” in the configur
internal timer and countdown function
to set the time (see page 187), and us
or backwards (see page 207).

You can display the current value of t
Display, Bar Graph or Indicator item.



 control equipment fitted with 
This could, for example, be a 
e. The functions available are 
ntirely determined by your 
uration dialog box (see 

dicated by a trailing number-
the value field at the bottom of 
 to enter the value.

ge 208).

 yourself, as described in 

iguration 
g box.
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Serial This is a general purpose device, allowing you to
an RS232, RS422, MIDI or similar control port. 
video projector, switcher or special effects devic
shown in the list in the status window, and are e
selection on the Type pop-up menu in the config
“Device Specific Modes” on page 139).

Some functions may take a numeric value, as in
sign on the pop-up menu in the list. In this case, 
the status window becomes active, allowing you

Use a Trigger cue to program the device (see pa

If desired, you can create a Serial device driver
Chapter 10.

Status window.

Conf
dialo

State with 
numeric 
value.

Device 
specific 
modes.

Value field.
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IR The IR device lets you drive most kinds of equipment that use infrared remote 
control by simulating the signals from the remote. Just like the Serial device, the 

tus window are entirely determined by 
nu in the configuration dialog box (see 
).

ice (see page 208).

available on the Type pop-up menu, 
r information on how to obtain addi-

Configuration 
dialog box.
functions available in the list in the sta
your selection on the Type pop-up me
“Device Specific Modes” on page 139

Use a Trigger cue to program the dev

If the device you need to control isn’t 
please contact your Dataton dealer fo
tional IR device drivers.

Status window.



GN
nel devices to create an 

m. It tells you how to use text, 
s provided in the panel 

ndow, or select any already 
e Status” on the Object menu 
or the panel device doubles as 
 to try out your design, either 

 in your show.

Open the panel device’s 
configuration dialog box.

Change the page’s color.

Assign a background 
page to the current page.

Select a page to edit.
6
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6 PANEL DESI
In this chapter you will learn how to employ Pa
attractive front end for your media control syste
graphics, sound, buttons and all the other tool
window’s tool bar.

Panel Status Window Start by adding a Panel device to the Device wi
existing panel device. Then choose “Show Devic
to open the panel’s window. The status window f
its design and editing window. It also allows you
on its own, or in concert with all other functions

Hand: Try out the panel
Arrow: Edit panel items

Create Button
Create Indicator

Create Slider
Create Bar Graph

Create Display
Draw Line

Draw Frame
Draw Oval

Draw Static Text
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Pages Each panel can have up to 99 pages. Each page can contain any number of 
buttons or other items. Use the Page arrows to move one page at a time in the 

e following keyboard shortcuts:

ly to a specific page. Likewise, you can 
 – by clicking the background page 
page 159).

e 187) to program a panel to go to a 
an also use a button to go to a page by 
status property of the panel (see “Linking 
s” on page 160).

ropriate tool in the tool bar along the 
ally across the page using the selected 

row tool, then select the desired item. 
tc., as usual. They can also be grouped 
ommands on the Object menu. Use the 
mmands on the Edit menu to change the 
age 84).

Go to first page

Go to previous page

Go to next page

Go to last page
desired direction. You can also use th

Click the page number to jump direct
jump to the background page – if any
number (see “Background Pages” on 

Use a Locate By Number cue (see pag
page from a task or a timeline. You c
linking the button to the Page Number 
Panel Items to Device Status Propertie

Drawing New Items To draw a new item, first click the app
window’s left edge, then drag diagon
tool. 

Editing Items To edit existing items, first click the Ar
Items can be cut, pasted, duplicated, e
and locked using the corresponding c
“Send to Back” and “Bring to Front” co
layering of overlapping objects (see p

Command-1

Command-2 or Left Arrow

Command-3 or Right Arrow

Command-4



“Specifications” on the Object 
 dialog box allows you to 
 caption or action. See the 
ls.

ncluding the pages. To set the 
 located next to the Settings 
 used to fill all areas not 
ou paste a large picture onto 
 will not be able to see the 

g box and choose from the 
m. See the description of each 

nd passive. These are divided 
 are Button, Indicator, Slider, 
ine, Frame, Oval, Text and 

ctive items may overlap 
verlap each other, or be over-

t” and “Send to Back” 
nt-to-back ordering of panel 
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Open a selected item’s dialog box by choosing 
menu, or by double-clicking the item. The item’s
change its settings, such as its shape, color, text
description of each item in this chapter for detai

Colors You can apply colors to all elements on panels, i
color of the current page, click the color swatch
button in the panel window. The page’s color is
covered by any panel items. This means that if y
a page – as in the example on page 156 – you
page’s color.

To color the various items, open the item’s dialo
swatches available for the various parts of the ite
item later in this chapter for more details.

Kinds of Panel Items There are two basic kinds of panel items; active a
by a dotted line in the tool bar. The active items
Bar Graph and Display. The passive items are L
Picture.

Overlapping Items Passive items may overlap other passive items. A
passive items. However, active items should not o
lapped by passive items. Use the “Bring to Fron
commands on the Object menu to control the fro
items.
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Background Pages A page can be used as a background of another page. This allows items 
common to a number of pages to be entered only once, and then re-used by 

 the same background page.

aste the same set of items across a 
ommon items on a background page, 
 should the need arise.

e the Page arrows to go to an empty 
 common across a range of pages. 

 is to use the background page you have 
 arrows to select the background page’s 

a background, then use the Background 
oreground page number. This causes the 
w “--”, indicating that no background is 

nd page, only its items will be shown on 
 All items from the background page will 
 on the page using the background. Ac-
ge may not be overlapped by items on 
e “Overlapping Items” on page 158).
simply making all those pages refer to

Of course, you could also copy and p
number of pages. But by combining c
there will be only one page to change

To create a background page, first us
page. Then draw the items that will be
Finally, go to the first of the pages that
just created, and click the Background
number.

If you no longer want a page to have 
arrows to set the number equal to the f
background page number field to sho
used.

◆ NOTES: When using a backgrou
the page that uses it – not its color.
be drawn under the items that are
tive items from the background pa
the page using the background (se

Items on a background page, such 
as the two green buttons above, are 
also visible on other pages that uses 
that page as a background.



in order to do anything. Panel 
erties of devices. For example, 
ss of a lamp in a slide 
 to the play function of a CD 
ssed. 

m must be linked to the status 
, want an indicator to turn on 
 on the tape.
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Linking Panel Items to Device 
Status Properties

An active panel item must be linked to a device 
items are linked directly to individual status prop
a slider on a panel can be linked to the brightne
projector. Or a button on a panel can be linked
player, causing it to play when the button is pre

Likewise, an Indicator, Bar Graph or Display ite
property to be indicated. You may, for example
when a tape deck moves past a certain position

Linking a panel item to a device’s 
status property:

1. Select the panel item by clicking 
it using the arrow tool. Make sure 
only one item is selected. 

2. Click on the device’s icon in the 
Device window. This displays a 
pop-up menu, allowing you to 
choose a status property.
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After linking an item to a device in this way, you can further specify how the 
item and the device relate to each other by double-clicking the panel item. Your 
options will vary depending on the kind of status property you linked the item 

he example on the previous page, there 
ing you could possibly do to the Play 
 the CD, use another button linked to 

eric or time property – e.g. the song 
serdisc – you have more options as that 
s. The illustration below shows the top 

or a button that has been linked to the 

ns that can be applied to the status prop-
ed. See “Action” on page 164 for more 

utton to a status property before you can 
 dialog box.
to, as well as the kind of the item. In t
are no options to set since the only th
status of a CD is to activate it. To stop
Stop.

However, if you link a button to a num
number of a CD, or the position of a la
property can take on a range of value
part of the configuration dialog box f
song number of a CD player.

The Action pop-up menu lists all actio
erty to which the button has been link
details.

◆ IMPORTANT: You must link the b
use the Action pop-up menu in the



 status property to which it is 
 is automatically updated to 

trolling the play function of a 
at device begins to play, even 
ch as from a cue on a timeline.

ol devices that are not owned 
ussed in the previous para-
device is owned or not.

 panel regardless of whether 
directly through a task. Use a 
irtual Devices” on page 122), 

ad. Set the priority of the task 
erformed into the Action field 

 of that device at any time, un-
k.

 how to use panels and other 
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Status Indication The button both controls and is controlled by the
lin ked. Whenever the status changes, the button
reflect its new status. For example, a button con
tape deck will automatically light up whenever th
if the play command comes from elsewhere – su

Priority of Panel Items vs. 
Tasks

The item-to-device link can only be used to contr
by any task. However, the status indication disc
graph always works, regardless of whether the 

◆ HINT: If you need to control a device from a
it’s currently owned or not, you can do this in
virtual Switch device to trigger the task (see “V
then link the button to the virtual Switch inste
to “High,” and put the action you want to be p
of the task. This will allow you to take control
less it’s already owned by a high priority tas

To Learn More About Interac-
tivity

Please refer to Chapter 9 for more examples on
devices to create interactive presentations.
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Button The Button is the most basic kind of panel item. It can perform an action when 
pressed, such as starting a CD, setting the brightness of a lamp, or showing 

tion it performs depends on what kind of 
, and how it is configured. 

 the button by double-clicking it with the 
another page on the panel. Which ac
device status property it is assigned to

Open the configuration dialog box of
arrow tool.



uld happen when the button is 

 value when the button is 
 is at the specified value.

 property by the specified 

s property by the specified 

een the two stated values. The 
ecified value.

the status property to the value 
 to the value specified in the 
e is at the first specified value.

 device status property before 
ge 160).
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Action Use the Action pop-up menu to specify what sho
operated. 

Set To. Sets the status property to the specified
pressed. The button will light up while the device

Increase By. Increases the value of the status
amount for as long as the button is depressed.

Decrease By. Decreases the value of the statu
amount for as long as the button is depressed.

Toggle. Makes the status property toggle betw
button lights up while the device is at the first sp

Momentary. When pressed, sets the value of 
specified in the first field. When released, sets it
second field. The button lights up while the devic

◆ IMPORTANT: You must link the button to a
you can use the Action pop-up menu (see pa



Chapter 6: Panel Design 165

Kind The Kind pop-up menu allows you to designate the button as a regular button 
or as a special button. These include invisible buttons used to create touch 

 sensor and the side buttons. 

isplayed on the panel. It is pressed by 

can perform the same functions as a 
n the panel. An invisible button is 
 as a gray, crossed rectangle. It is not 

e. Use this when you want to make a 
itive. by drawing an invisible button on 

tion sensor built into TOUCHLINK. When 
utton” will be pressed.

buttons on the right hand side of 
on is actually two buttons; the top and 
rately.

Side Button” can be attached to any 
hows up as an invisible button in the 
te its functionality by pressing it with the 
 TOUCHLINK, nor does it respond if the 
.

sensitive areas in pictures, the motion

Normal. A regular, visible button d
touching the button on the panel.

Invisible. An invisible button which 
normal button, but doesn’t show up o
displayed in the panel’s status window
visible at all on the actual panel devic
picture or part of a picture touch-sens
top of the picture.

Motion Sensor. Represents the mo
the motion sensor is activated, this “b

Side Buttons. Represents the three 
TOUCHLINK. Note that the large butt
bottom of it can be programmed sepa

A button set to “Motion Sensor” or “…
function, just like a normal button. It s
status window, allowing you to simula
mouse. It doesn’t show up on the real
user presses in that area of the screen



y when “Kind” is set to 

e specified corner radius.

gular buttons, in pixels.

a few pixels to the right and 
om other, passive items on the 

s in the dialog – one for when 
own”. This allows you to make 

y its name inside the button, 
ed, you can give the button a 
aking it alternate between 
 “Down” title field, the button 

 line width instead of different 
r example, if you alternate be-
ink that the function will be 
N, while this in reality may in-
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Shape Determines the shape of the button. Applies onl
“Normal”.

Oval. Makes round or oval buttons.

Rectangle. Makes rectangular buttons, with th

Radius. Determines the corner radius of rectan

Drop Shadow. Adds a black drop shadow, 
below the button. This distinguishes the button fr
page.

Title, Line, Fill and Icon There are two sets of Title, Line, Fill and Icon item
the button is “Up” and the other for when it is “D
the button change colors or title when pressed.

The title field gives the button a name. To displa
you must also select the “Text” checkbox. If desir
separate title for its “down” state, for example m
“On” and Off”. If you don’t put anything into the
will display the “Up” title in both states.

◆ HINT: It’s often a better idea to use colors or
texts to indicate that a button is activated. Fo
tween ON and OFF texts, some users may th
turned ON by pressing the button labelled O
dicate that the function is already on.



Chapter 6: Panel Design 167

Text The “Text” items allow you to specify the type and size of the font used for the 
text on the button, as well as to turn the text display off using the check-box. 

ually for the “up” and “down” states, as 

ing the dotted rectangle displays a list of 
is list and click OK. 

ve the text in the button. If there’s not 
 will instead be shown to the left of the 
 will be shown. In this case, make the 
 icon or the text, or turn off the text 

tures from other programs, or make your 
. Icons can be up to 32 pixels high and 

 small picture from another program, 
lick the Paste button next to the dotted 
 paste is too big, it will be scaled to fit 

or the “Up” and “Down” states of the 
nus.

n” state without closing the dialog box, 
se. This only shows the visual appear-
 its action. When using a large font for 
e sample button may not accurately 
ke. You can move the dialog box to the 
th its actual size.
The color of the text is specified individ
described above.

Icon Selecting the “Icon” checkbox or click
ready-made icons. Select an icon in th

If possible, the icon will be shown abo
enough room above the text, the icon
text. If it won’t fit there either, no icon
button large enough to show both the
display using the Text checkbox.

You can also copy icons and small pic
own using a drawing or paint program
56 pixels wide. To transfer an icon or
copy it from the other program then c
rectangle. If the picture you attempt to
within the maximum size.

The icon can be colorized differently f
button using the Icon color pop-up me

Sample To see the button as it looks in its “dow
click the Sample button using the mou
ance of the button – it doesn’t perform
the text in conjunction with an icon, th
reflect what the real button will look li
side so you can see the real button wi



wo states, called Off and On. 
 linked to – it merely indicates 

 in the Button dialog box 

 linked the indicator to, you 
f” using the pop-up menu and 

o a device status property be-
menu (see page 160).
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Indicator An indicator is similar to a button in that it has t
However, it doesn’t affect the status property it’s
its state.

Most fields in the dialog box are similar to those
described on the previous pages.

Indicator “On” Depending on what kind of status field you have
can specify when it should indicate “on” and “of
the value field. 

◆ IMPORTANT: You must link the indicator t
fore you can use the “Indicator On” pop-up 
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Sound The Sound button allows you to attach a sound to the indicator. A sound 
attached to an indicator will be played when that indicator is turned on. The 

und files available in the same folder as 
r. Only System 7 and AIFF sound file 
st remain in the same folder as the show 
lay and download properly.

und when the status window of the orig-
. This is to avoid confusion as you may 
indows open on the screen, each with its 
l sounds can be turned off in the Prefer-

 Sounds” on page 109).

 visible indicator, you can create an 
function that is to be indicated by the 
 in the panel’s status window as a gray, 
le at all on the real panel device.

d in the indicator, you may prefer to put 
 using a Static Text item (see page 174).
Sound button brings up a list of all so
your show file and in your TRAX folde
formats can be used. The sound file mu
file or in the TRAX folder in order to p

◆ NOTE: TRAX will only play the so
inating panel is the active window
have any number of panel status w
own sounds. Furthermore, all pane
ences dialog box (see “Play Panel

Invisible If you just want the sound, and not the
invisible indicator and attach it to the 
sound. Such an indicator will show up
crossed rectangle, but will not be visib

Title Although the title text can be displaye
a text label next to it. This can be done



ic value. It can also be used to 
te arbitrary time or frame 

y on the panel, but the sample 
. You can move the dialog box 

ithout closing the dialog box.

the dialog box can be used to 
trolled status property fully on 
 changed by dragging their 
aption should be displayed 
 similar to those in the dialog 

Drag here to re-
size the knob.

Drag here to re-
size the slot.
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Slider A slider is used to control a level or other numer
control the time position of devices that can loca
number positions, such as a video disc player. 

A slider can be oriented vertically or horizontall
in the dialog box will always be shown vertically
to the side to see what the real slider looks like w

The Minimum and Maximum fields at the top of 
limit the range, so that the user can’t turn the con
or fully off. The size of the knob and slot can be
corners. You can also choose whether the title c
above or below the slider. Most other fields are
box for the Button item (see page 163).
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Bar Graph The Bar Graph item is very similar to a Slider item, as described on the 
previous page. However, it can only indicate a value – not change it. You can 

ar graph to a device status property be-
ee “Linking Panel Items to Device Status 

igher than the To value in the fialog box, 
ckwards. The same applies to the Mini-
lider’s dialog box.
link it to any numeric or time value.

◆ IMPORTANT: You must link the b
fore you can set the Range fields (s
Properties” on page 160).

◆ HINT: By setting the From value h
you can make the indicator go ba
mum and Maximum fields in the S



e to be displayed. Arbitrary 
lay to a Text device and 
s, such as numbers and time 
y item to the desired status 

 item above, below or next to 
tyle of the title separately from 
wever, is always the same as 

g the “Show Title” checkbox 
xt item (see “Static Text” on 

Left, centered, right or 
fully justified alignment.
172 Chapter 6: Panel Design

Display The Display item allows any text or numeric valu
text strings can be displayed by linking the disp
assigning a Note cue to that device. Other value
positions, can be displayed by linking the Displa
properties.

Title You can choose to display the title of the display
the display field. You can set the color and text s
the display content. The alignment of the title, ho
that of the display content. 

If desired, you can turn the title off by uncheckin
and supplying a title separately using a Static te
page 174).
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Displayed Text Style Determines the font style, size, color and alignment of the contents of the 
display. Note that the alignment setting also applies to the title of the display 

 for more details).

 frame as well as the background color 

splay is attached to a device status prop-
 a time or the level of a Level device 
es.

he value will not be shown in the display.

“Always Show Hours” options are only 
 The “Time” pop-up menu determines the 
, for example, display the current frame 
 frame number instead of as a time.

es a leading “0:” to be displayed even if 
lly what you want for a time-of-day 

 checkbox to suppress the display of 
also implied by selecting “Suppress 
(se under “Title” on the previous page

Frame Determines the width and color of the
of the display.

Suppress Fractions This checkbox is available when the di
erty that has a fractional part, such as
supporting fractional percentage valu

When selected, the fractional part of t

Time The “Time”, “Suppress Seconds” and 
available when linked to a time value.
displayed time format, allowing you to
number from a Video Disc device as a

The “Always Show Hours” option forc
the hour is less than 1, which is typica
display.

You can use the “Suppress Fractions”
hundredths of seconds. This option is 
Seconds”.



w graphics to improve the 
elated buttons together, or use 
an change the look of these 
r panel item.

tons and other items when the 
nt. You can write several lines 
rent ways.

gs are not reflected by the text 
 side to see the actual text item 

Left, centered, right or 
fully justified alignment.
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Line, Frame and Oval The Line, Frame and Oval tools are used to dra
layout of a page. You can use frames to group r
lines as dividers between groups of items. You c
items by double-clicking them, just like any othe

Static Text Use Static Text items to add labels to sliders, but
flexibility of the built-in text captions is insufficie
of text, and the text can be justified in four diffe

◆ NOTE: The alignment, color, and other settin
in the dialog box. Move the dialog box to the
in the panel’s status window.

Click here to force a new line at 
the insertion point.
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Pictures In addition to the basic drawing shapes, you can also import pictures from 
most drawing and painting programs. Simply copy the picture from the other 

 status window. This allows you to use a 
, maps and other symbols.

es (the map and the three flags). The 
 using the Frame tool and filled with 
lags with the map are drawn using the 
riate.

available on the TOUCHLINK panel, you 
s of pictures. Sometimes, mixing color 

erred to as “dithering”), can improve the 
our drawing program for details.
program and paste it into the panel’s
larger variety of fonts, as well as flags

The example below shows four pictur
drop-shadows of the flags are drawn
black. The three lines connecting the f
Line tool, and then colored as approp

Color Fidelity of Pictures Owing to the limited number of colors 
may run into problems with some kind
pixels with alternating colors (often ref
colors. Check the documentation for y



ged in TRAX, there are some 
, re-size the picture by drag-
y result in a jagged picture, 
rom “Draw” programs usually 
int” programs.

e’s dialog box to restore the 

onochrome picture.

onochrome pictures. By 
s appears transparent.

e Pictures Options” box apply 
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Picture Options Although most aspects of pictures can’t be chan
details you can influence. You can, for example
ging any of its four corners. Sometimes, this ma
depending on the origin of the picture. Pictures f
look better when re-sized than pictures from “Pa

You can use the “Reset Size” button in the pictur
original size of a picture.

Color. Allows you to colorize the pixels of a m

Background. Colorizes the background of m
default, the background of monochrome picture

◆ NOTE: The settings inside the “Monochrom
only to originally black and white pictures.

These options apply only to mono-
chrome pictures.

Click this button to restore the 
picture to its original size.
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Testing a Panel There are two ways you can test your panel within TRAX, without actually using 
a real, physical panel device:

ntrolling only the devices directly linked 

 starting timelines and other tasks. 

ant to see what it looks like when the 
l then click the buttons and drag the 
 between the hand and arrow tools. 
 items (unless they’re owned by tasks, in 
 panel items, as described under 
age 162).

the entire system, including all currently 
utton in the Task window (or press 
 run mode. You can then operate panel 

onse to your actions. See “Running the 

ibly together with the SMARTPAX device 
 the Device Support window. You can 
sign using the “Panels Only” choice on 
rt window. See “Downloading Panel 
.

an test your design using the real, phys-
ll system, first click the Play button in the 
ce).
• By running the panel on its own, co
to its items. 

• By running the full system, possibly

The first method is useful if you just w
panel is operated. Select the hand too
sliders. Pressing the space bar toggles
Linked devices will be controlled by the
which case they can’t be controlled by
“Priority of Panel Items vs. Tasks” on p

The second method allows you to run 
open panel windows. Click the Play b
Command-space) to activate the system
buttons and observe the system’s resp
Tasks” on page 60 for more details.

Downloading Your Panel 
Design to TOUCHLINK

The panel design is downloaded, poss
drivers, using the Download button in
choose to download just the panel de
the pop-up menu in the Device Suppo
Designs” on page 70 for more details

After downloading to the panel, you c
ical panel device. In order to run the fu
Task window (or press Command-spa



the devices what to do and 
 kind of cue chosen as well as 

rmined by the cue’s position 
 assigned to the devices to be 

ow by selecting them from the 
ized cue using the keyboard 
e 29 for details on how to 
 on page 51 for details on 

mized cues appear as 
e on the Cue menu. See 

s.

the Task window, you can 
e remainder of this chapter 

in detail. To open the dialog 
s on the Edit menu, or simply 

 single cue at a time. You can, 
ultiple cues in one operation 
ce commands (see page 90 
7
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7 CUES
Cues are the active elements of TRAX – they tell 
when to do it. The what part is determined by the
its internal specifications. The when part is dete
along a timeline or in the Task window. Cues are
controlled using the mouse.

Cues are entered into a timeline or the Task wind
Cue menu, or by entering the name of a custom
(timelines only). See “Timeline Window” on pag
select cues, use tracks, etc. See “Adding a Task”
using cues as task actions.

The Cue menu shows the basic cue types. Custo
secondary pop-out menus next to each basic typ
“Customized Cues” on page 95 for more detail

Editing a Cue’s Specifications Once a cue has been entered into a timeline or 
change its specifications using its dialog box. Th
discusses the contents of each cue’s dialog box 
box, first select the cue then choose Specification
double-click the cue.

◆ HINT: You can only open the dialog box of a
however, change various specifications of m
using the Expand/Compress and Find/Repla
and page 85 respectively).



Chapter 7: Cues 179

General Cue 
Characteristics

All cues have a common set of characteristics: a name, a time position and a 
track. In order for a cue to have any effect, it must be assigned to the device to 

the Control cue, which doesn’t control 

 name field of the cue’s dialog box. This 
icon in a timeline window, or to the right 
lso used to refer to the cue when it’s 
ue menu (see “To Menu” on page 180).

 partial name consisting of some char-
 “Cue Name and … Value Substitution” 
be affected (the only exception being 
devices directly).

Name The name of the cue is specified in the
name is displayed as part of the cue’s 
of the icon in the Task window. It is a
installed as a customized cue on the C

For many cue types, you can specify a
acters followed by an ellipsis (…). See
on page 181 for more details..



ifications – on the Cue menu. 
ilar, specifications repeatedly. 
. Then choose the cue from the 
 again.

basic cue type from the menu, 
he cue’s dialog box. Enter a 
 as desired, and click the To 
dicate that a cue has been 
wn the Cue menu to see your 

 Cues” on page 95).

 selecting it from the menu or 

ice assignment. To use a cus-
sure that no devices are select-
 devices are selected when the 
r the original device assign-

conjunction with the value 
lows you to create generic cue 
e cue is entered into a timeline 

 contain any blanks. Nor can 
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To Menu This button installs the cue – including all its spec
This saves you from re-entering the same, or sim
Simply enter it once and put the cue on the menu
menu or type its name on the keyboard to use it

To create a customized cue, start by selecting a 
or an existing cue in a timeline window. Open t
suitable name, configure the cue’s specifications
Menu button. The Cue menu flashes briefly to in
added. Click OK to close the dialog box. Pull do
new cue next to its basic type (see “Customized

You can now use your customized cue either by
by typing its name on the keyboard.

◆ HINT: Customized cues can retain their dev
tomized cue’s original device assignment, en
ed when choosing the customized cue. If any
cue is chosen, they will take precedence ove
ment.

The “To Menu” function is particularly useful in 
substitution feature described on page 181. It al
types where the actual value is specified when th
window, rather than when it’s put on the menu.

The name of a customized cue can’t be blank or
it contain any of these characters:

; ^ ! < / (

Customized Dissolve cues 
installed on the Cue menu.
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Cue Name and … Value 
Substitution

It may be useful to have the name of the cue, as shown in its icon, reflect its 
primary value. For example, a Dissolve cue named D3 indicates that it is a 3 

 position 341. Rather than creating each 
 to the name field, you can simply type 

e. When displayed as part of the cue’s 
 the cue’s primary value. The primary 
b order following the name field.

njunction with customized cues (see “To 
 a customized cue using the keyboard, 

 in place of the ellipsis, rather than going 

m the menu, the dialog box will open 
elected
second dissolve, or L341 is a Locate to
individual cue with its value appended
an ellipsis at the end of the cue’s nam
icon, the ellipsis will be replaced with
value is typically the first field in the ta

This feature is particularly useful in co
Menu” on page 180). When choosing
you can simply enter the value directly
through the dialog box.

When selecting a cue ending in … fro
automatically with the primary value s



per left corner of the timeline 
he time positions of multiple 
 page 46).

them along their track. It is not 
 in list view.

ow or Command-left-arrow 
 0.01 second increments. 
re moved in 0.1 second incre-
rrent Tab time by pressing 
Tab Key Time” on page 104). 
ell.

anged using the Distribute 
ge 89 and page 90).

h one of 16 on-screen tracks. 
ly, and has no effect on the 
e track assignment any rela-
 choose to record a cue track. 
recorded onto a single tape 

drag it to another track in icon 
oving the cue in time.

ow or Command-up-arrow 
hese shortcuts can be used in 
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Time Position The time position of a cue is displayed in the up
window when the cue is selected. You can see t
cues by switching to list view (see “List View” on

To change the time position of cues, simply drag 
possible to change the time position numerically

✈ SHORTCUTS: Pressing Command-right-arr
moves selected cues forward or backward in
When combined with the Shift key, the cues a
ments. You can also move the cues by the cu
Command-Tab or Command-Shift-Tab (see “
These shortcuts can be used in list view as w

The time position of multiple cues can also be ch
Cues and Expand/Compress commands (see pa

Track Assignment Each cue in a timeline window is associated wit
The track assignment is for your convenience on
cue’s behavior or device assignment. Nor has th
tion to the tracks on a multi-track recorder if you
If the show is recorded on tape, all cues will be 
track.

To change the track assignment of a cue, simply 
view. Press the Shift key as you drag to avoid m

✈ SHORTCUT: Pressing Command-down-arr
moves selected cues down or up one track. T
list view as well.
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Device Assignment Most cues must be assigned to one or many devices in order to have any effect. 
The exception is the Control cue, which acts on TRAX itself rather than a device.

lecting the cue, then selecting the desired 
e device assignment pointer. The device 
n a timeline or the Task window is active 
indow.

u use the device assignment pointer, as 
f any selected cue. If you want to work 
e Device window by clicking its title bar.

 techniques to assign devices to a cue 
 an existing cue, make sure that the cue 
vices. When creating new cues, you can 
ting the cue, however.

 assignment of multiple cues using the 
. First select the cues you want to change 
nd by selecting the All at Once, Device 
 Type the name of the old device into the 
 the Replace With field.

ed cues one by one, you can also import 
her shows using the Import Menu Cues 
ort Menu Cues” on page 76 for more 
A cue is assigned to devices by first se
devices in the Device window using th
assignment pointer is only shown whe
and the pointer is within the Device w

▼ IMPORTANT: Be careful how yo
it changes the device assignment o
with the devices only, first select th

You can use all the standard selection
(page 24). When assigning devices to
is selected before you start clicking de
select the desired devices before crea

◆ HINT: You can change the device
Find/Replace command (page 85)
then use the Find/Replace comma
Assignment and Selection options.
Find field and the new device into

Importing Customized Cues As a complement to creating customiz
entire sets of customized cues from ot
command on the File menu. See “Imp
details.

Device assignment pointer:



han an individual cue – which 
n be stored in the Scrapbook 

.

.

at says what the set does. You 
ok.

it is useful to group them 
r, maintaining their internal 
lect them, then choose Group 
rs will be selected when you 
age 91 for more details.

part of the timeline, you may 
 mistake. If you try to change 
lert box to warn you. To lock 

n the Object menu. See “Lock, 
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Saving Cues in the Scrapbook Sometimes you may have a set of cues – rather t
together perform a desired effect. These cues ca
for later use.

• Select the cues.

• Choose Copy on the Edit menu.

• Open the Scrapbook under the Apple menu

• Choose the Paste command on the Edit menu

For sets of cues, begin the set with a Note cue th
will then be able to see this note in the Scrapbo

Grouping and Locking Cues When a set of cues perform a specific function, 
together. Grouped cues will always stay togethe
time relationship. To group a set of cues, first se
on the Object menu. Once grouped, all membe
select one of them. See “Group, Ungroup” on p

Once you’re finished tweaking the cues on one 
want to lock the cues to avoid changing them by
a locked cue in any way, TRAX will display an a
a set of cues, first select them, then choose Lock o
Unlock” on page 92 for more details.
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Printing Cues Although TRAX doesn’t have any built-in Print functions, you can still print the 
cues of a timeline using virtually any word processing program. The printout 

the cues. To print the cues, select the cues 
 Edit menu, then paste them into your 
 Cues” on page 50 for more details.

oose Icon View, then zoom the timeline 
 the zoom box in the upper right corner 
3 to take a snapshot of the screen. The 
our hard disk, which can then be opened 
r, paint program, etc.

g picture file will automatically open it 
nted.
has the same format as the list view of 
to be printed and choose Copy on the
favorite word processor. See “Printing

To print the cue icons as a picture, ch
window to full-screen size by clicking
of the window. Press Command-Shift-
snapshot ends up as a picture file on y
and printed from your word processo

◆ HINT: Double-clicking the resultin
using Simple Text, ready to be pri



 a device’s medium. This can 
such as a slide number in a 
 program, a frame number on 
 song number or specific time 

es: discrete position devices 
d computer graphics 

ny “players” fall into the latter.
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Locate Use the Locate cue to locate specific positions on
be used with most devices that have a position, 
slide projector, a picture in a computer graphics
a video disc, a time position on a video tape, or a
position on an audio disc.

These devices can be grouped into two categori
and time-continuous devices. Slide projectors an
programs fall into the former category while ma

Locate button.

Shuttle slider.
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Next/Previous Position Use these selections with discrete position devices to locate the next or previous 
position, for example, to step one slide forward or reverse on a slide projector.

ing still images – such as most video disc 
 can also be used to advance a single 

ust make sure that the time format pop-
 window is set to match the frame rate of 
s is important as this setting is then used 
 device. The Normal setting assumes the 

n devices to locate a particular image, 
n. 

 capable of locating time positions, but 
c positions. This includes most audio disc 
ect a song number – as well as some 
bers.

to locate frame numbers on video. In-
isplayed Time Format to one of the 

f locating arbitrary time or frame posi-
 and disc players. Make sure that the 
 is selected in the device’s configuration 
 134). 
On video devices capable of reproduc
players – the Next/Previous selections
frame.

▼ IMPORTANT: In this case you m
up in the video disc device’s status
the video standard being used. Thi
to calculate the time position of the
25 fps PAL frame-rate.

By Number Use “By Number” with discrete positio
song, chapter or other numeric positio

Some time-continuous devices are not
may be able to locate discrete, numeri
players – which often allow you to sel
video disc players using chapter num

◆ NOTE: Do not use “By Number” 
stead, use “By Time” and set the D
“Frames” settings.

By Time Use “By Time” with devices capable o
tions, such as many professional tape
“Position by: Time or Frame Number”
dialog box (see “Position By” on page



e In field allows you to imme-
to adjust the position using the 
 box, the device will return to 
ened.

 wind the device’s medium in 
hich the device will wind 

ing that the device supports 
ach end of the slider single-

buttons, the device must be 
 The time position displayed in 
ed from the device being 

e Locate cue, only the first de-
ialog box. When running the 
e the specified position.

 the shuttle slider, first click the 
eld, then wait for the device to 
 you click the shuttle slider 
e set to the current position of 

nt position in order to use it as 
and (see next section).

n out-time for the segment 
e the In field, but specifies the 
 you to take advantage of the 
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The double-arrow Locate button to the right of th
diately go to the specified position, for example 
shuttle slider. As soon as you dismiss the dialog
the position it had before the dialog box was op

The shuttle slider below the In time field is used to
the direction you drag the slider. The speed at w
depends on how far you drag the slider (assum
variable speed winding). The arrow buttons at e
step the device one frame at a time.

In order to use the shuttle slider and frame step 
connected to a properly configured SMARTPAX.
the time field while using these controls is retriev
controlled.

◆ NOTE: If multiple devices are assigned to th
vice will be operated interactively from the d
cue, however, all assigned devices will locat

In order to adjust an existing time position using
double-arrow Locate button next to the In time fi
locate before you start using the shuttle slider. If
before you click the Locate button, the field will b
the device. This can be used to pick up the curre
an in-point for a contiguous play-to-frame comm

Out Time Selecting the Out option allows you to specify a
about to be played. The Out time field is used lik
end point for the next Trigger Play cue. This lets
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play-to-frame feature built into most video disc players, as well as some tape 
players.

l automatically stop in still mode at the 
his method over simply putting a Trigger 
 that it guarantees that the end position 
sing a Trigger cue to stop it may be off 
ces between the computer and the 

rigger Play cue to actually start playing 
ose restrictions on available playback 

me feature.

use a variety of standard formats. See 
tailed description of the time formats.

he Locate cue only affects how the values 
sary to use the same time format in the 
ontrolled. You may, for example, freely 
 the Normal format in order to calculate 

ime of a segment.

 output level off before locating the spec-
ojector, this means turning the lamp off. 
eans turning the video output off (if 
If you select this option, the device wil
specified position. The advantage of t
Pause cue at the end of the segment is
will be exactly the right frame, while u
by a few frames due to timing differen
player.

◆ NOTE: You must use a separate T
the tape or disc. Some players imp
speeds when using the play-to-fra

Displayed Time Format The time fields in this dialog box can 
“Time Formats” on page 137 for a de

◆ NOTE: The time format chosen in t
are displayed. Thus, it is not neces
Locate cue as in the device being c
switch between Frame formats and
the real-time duration or starting t

Turn Level Off When checked, the device will turn its
ified position. In the case of a slide pr
When applied to a video player, it m
possible).



vice to a specified level. When 
s fading the lamp level. When 
lled (if possible).

t level is controlled, if possible. 
et the Rate field to 0.

ses a linear lamp curve while 
ear curve. The linear ramp of 
om black, while the nonlinear 
ooth transitions between 
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Set/Fade Use this cue to set or fade the output level of a de
used with a slide projectors or lamps, this mean
used with an audio device, the volume is contro

When applied to a video player, the video outpu
Use 0% and 100% only for video devices, and s

When used with slide projectors, the Fade cue u
the Dissolve, Wipe and Zoom cues use a nonlin
the fade cue makes it suitable for fading to or fr
curve of those other cues is tailored to make sm
images.
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Fading Start Select this option to start a new fading, then enter the rate and target value of 
the fading in the corresponding fields. You can also choose whether to fade all 

to independent levels using the Single/

ng already in progress – an effect also 
s a way to fade to an intermediate level 
 that starts the fading and the Fading 

brightness of a Dissolve, Wipe or Zoom 

 with the desired target value.

econds. The value can be specified with 
vices are capable of fading the level, in 
red.

TPAX (except slide projectors), the rate 
ch the new target level from the current 
always take three seconds, regardless of 

lled through other control units, the rate 
e fading, assuming a fading from 0 to 
g from 0 to 50% takes half the specified 
assigned devices to the same level or 
Multiple controls.

Fading Stop/Resume Allows you to stop and resume a fadi
known as a Freeze. This can be used a
by timing the relation between the cue
Stop cue. This allows you to hold the 
cue at an intermediate value.

Alternatively, you can use a Fade cue

Rate Determines the rate of the fading, in s
an accuracy of 0.1 second. Not all de
which case the Rate value will be igno

For devices controlled through SMAR
value determines the time taken to rea
level. Thus, a three second fading will 
the starting and ending levels.

For slide projectors and devices contro
value determines the slope angle of th
100 percent. Thus, performing a fadin
time with these devices.



 devices fade to the same 
 enables you to enter an indi-
ction provides separate level 
hting and sound control appli-
 the Live Edit check box for 
 positions, etc.
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Faders Single/Multiple The Single fader selection will make all assigned
target level. Selecting Multiple Faders, however,
vidual value for each assigned device. This sele
sliders for each device, making it suitable for lig
cations. Combine the Multiple Faders mode with
fully interactive editing of lighting, sound, motor

Multiple Faders selected.
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Level This value determines the new level for the device at the end of the fading. If 
the rate field is set to 0, the level will immediately be set to the Level value. For 

n be specified with an accuracy of 0.01 
vices).

c value in this field, you can also use the 
lue field. When the “Multiple Faders” 
 the value of the currently selected fader. 
er corresponds to the name of its 

d next to the Level value field.

n’t handle intermediate values, in which 
ered as “on”.

) will immediately take on the specified 
r example, light levels, pan and tilt posi-
r with the Multiple Faders option, this 
onsole.

ialog box, the levels will revert to their 
imeline. Play the timeline to see the new 
ith other cues.
increased precision, the level value ca
percent (this is not supported by all de

As an alternative to entering a numeri
level slider located below the Level va
option is selected, the Level field shows
The name of the currently selected fad
assigned device, and is also displaye

Some devices (e.g., video devices) ca
case any level except 0 will be consid

Live Edit When selected, the assigned device(s
level value(s). This allows you to set, fo
tions, volume levels, etc. Used togethe
provides a virtual lighting or mixing c

◆ NOTE: As soon as you close the d
correct values at this point on the t
values take effect in conjunction w



devices. It is used to create 
es detailed control over the 
g of projectors.

one image to the next, in 0.1 
e 0.1 to 0.5, it is often a good 
, or a small delay between the 
(see “Advanced Options” on 

e fading down automatically 
een when the lamp current is 

tered in the Preferences dialog 
 the need arise, as described 
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Dissolve The Dissolve cue applies only to slide projector 
cross-fades between projected images. It provid
dissolve characteristics as well as the sequencin

Dissolve Rate Determines the time it will take to dissolve from 
second steps. For very fast dissolves, in the rang
idea to specify a slightly slower Lamp-Down rate
Lamp-Up and Lamp-Down parts of a crossfade 
page 196).

Automatic Step to Next Slide Select this option to make any projectors that ar
advance to the next slide position. The delay betw
turned off and the tray is actually advanced is en
box (page 110), but may be overridden, should
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under “Advanced Options” on page 196. This extra delay is required to 
account for the thermal lag of the lamp, in order to avoid chopping off the light 
at the end of the dissolve.

solve, wipe or zoom effects in rapid suc-
 projectors to advance to the next slide. 
dicated by their icons in the Device win-
e 123 for more details.

thin the same screen area will sequence 
equence orders. This means you don’t 
tors to turn on and off for each single 
vant projectors, and let the Dissolve cue 

e sequence order reversed. This can be 
 through a set of slides (without 

e the sequence, dissolving back to the 

e Descend
After

No Sequence
Before After
◆ NOTE: When making multiple dis
cession, allow enough time for the
The projectors’ “ready” status is in
dow. See “Slide Projector” on pag

Sequence Ascend/Descend When enabled, selected projectors wi
automatically using their designated s
have to explicitly specify which projec
dissolve. You simply select all the rele
figure out the rest.

Use Sequence Descend if you want th
used, for example, to dissolve forward
advancing the trays), and then revers
original slide again.

Sequence Ascend
Before After

Sequenc
Before



d some tweaking before they 
ons gives you this capability 
jectors to fade on and off. For 

seconds, may look better if the 
an the one that goes off. This 
d may differ according to the 

s to introduce a small delay (a 
etween the lamp that turns on 

neven in brightness, you may 
ng a shorter or longer delay 
doesn’t affect other cues or the 
ialog box.
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Advanced Options Fast dissolves or sequences of dissolves may nee
perform the way you want. The Advanced Opti
without the need to resort to separate cues for pro
example, a fast dissolve, with a total time of 0.2 
projector that comes on does so slightly faster th
compensates for the thermal lag of the lamp, an
model of projector used.

Another way to put some punch into a dissolve i
few hundredths of a second might be enough) b
and the one that turns off.

For fast sequences of slides, or when slides are u
need to override the tray advance delay, choosi
time. This only applies to the particular cue, and 
standard tray step delay set in the Preferences d
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Fade and Dissolve Curve 
Shapes

The Dissolve cue results in a non linear lamp curve, suitable for cross-fades 
between projectors. You can also fade a projector lamp using a Fade cue. This 

or fading to or from black.

Light

Time

Linear fading using 
a Set/Fade cue.
results in a linear ramp, appropriate f

Light

Time

Nonlinear crossfade 
using a Dissolve cue.



lve, applying a number of 
rs. It is useful when you have 
a (see “Hint” on the next page 

ue can create a sense of 
rom a lit projector or with all 
issolve cue before using Zoom 

creen area, the fancier zooms 
new slides fast enough, it is 
he same projector more than 
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Zoom The Zoom cue acts as a kind of compound disso
successive dissolves to the selected slide projecto
more than two projectors on the same screen are
for another possible use).

Used with a suitable slide sequence, the Zoom c
motion, or a change in perspective. It can start f
projectors off. You should be familiar with the D
as many settings are similar. 

In general, the more projectors you have on a s
you can make. As the projectors can’t bring up 
usually not practical to make a zoom that uses t
once through the effect.

ZOOMZOOMZOOMZOOMZOOMZOOM
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◆ HINT: Applying a Zoom cue to a single projector makes a momentary flash 
effect, with the capability of specifying a different lamp on and lamp off rate 
as well as the flash time. Such brief flash effects are often used to highlight 

 effects.

m effect is called the Zoom rate, and can 
onds. It is usually a small value, around 

equence in ascending order, but going 
 useful if you want to reverse a zoom 

t to a small value, equal to, or smaller 
ro-second Lamp rate and a Lamp-Down 
ke a tail-effect on the zoom.

 Delay parameters are the same as for 

nvolved in the zoom effect with their 
nt a very long tail-effect on the zoom. 

 cue to take out the desired projectors.

used to create rapid “builds”, more akin 
 a zoom. This could, for example, be an 
es, each projected by one projector.
items in other images, or for glow

Zoom and Lamp Rates The time between each step in the zoo
be specified in increments of 0.01 sec
0.1 second.

Sequence Normally you would have the zoom s
backwards (descending order) can be
effect using the same slides.

Lamp Rate The Lamp rate of a zoom is usually se
than, the Zoom rate. You can use a ze
rate of a few tenths of a second to ma

The Automatic Step to Next Slide and
the Dissolve cue (page 194).

Normal / Zoom On / Zoom 
Off

Use Zoom On to leave all projectors i
lamps on. This can be useful if you wa
You can then use a second Zoom Off

Zoom On and Zoom Off can also be 
to a wipe on a single screen area than
image broken up into horizontal strip



e the Zoom cue. It applies a 
s on selected screen areas. It 
projector screen areas.

rd panorama dissolve, as it 
 effect. You should be familiar 
y settings are similar. 

ctors per screen area, a Wipe 
 have. There is no point in 
 may use a Zoom to create a 
projectors (see the hint on 
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Wipe This is also a kind of compound dissolve, just lik
number of successive dissolves to slide projector
can only be used when you have multiple slide 

A Wipe is a good alternative to a straightforwa
introduces a sense of motion or creates a reveal
with the Dissolve before using the Wipe as man

Just as a Zoom is more effective with more proje
gets more impressive the more screen areas you
making a wipe on a single screen, although you
wipe-like effect on a single screen with multiple 
page 199).

Wipe direction.
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Wipe Direction Wipes can be done from left to right, right to left, center out, or from the sides 
towards the center (the last one being the least common). Which one to choose 

 what kind of motion they convey. For 
ck with the cars going from right to left 
 to right, as the leading car is on the left 
owards the viewer should be wiped in 
f depth to the transition.

creen Area numbers set for each 
sition in the Device window. Indeed, 
ring a rear-screen presentation, viewing 
uction.

ch step of the wipe effect, and is usually 
higher number results in a slower wipe. 
d for each screen, and may be greater 
 Different Lamp-Down rate, resulting in 
ifference may make the transition look 

alue here to remove the old image first 
mple a zero second Lamp-Down rate on 

 the remaining settings.
depends on the image or images, and
example, a panorama over a race tra
should probably be wiped in from left
side. A front view of people running t
from center and out, adding a sense o

The wipe’s direction depends on the S
projector involved, not its physical po
these may be opposites if you’re prepa
it from the projector side during prod

Wipe and Lamp Rates The Wipe rate is the time between ea
in the range of tenths of a second. A 
The Lamp rate is the dissolve rate use
than the Wipe rate. You can specify a
a tail effect. However, too much of a d
clumsy. You may also use a smaller v
before the new one comes up, for exa
a one second Lamp (up) rate.

See the Dissolve cue on page 194 for



initiates a flash effect that can 
 highlight a city on a map), or 
nimations.

r or projectors to flash, and 
 dialog box is unchecked. 
 to be turned on (this param-
Time and Ratio pop-up menus 
 determines the duty cycle of 
arily affects the brightness, but 
eadily apparent. It is normally 
).

dless of other fading and 
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Flash The Flash cue applies to slide projectors only. It 
be used either for a single projector flash (i.e., to
a sequential flash effect used in multi-projector a

Simple Flash Effects To make a simple flash effect, select the projecto
make sure that the Sequence option in the Flash
Specify the Lamp On rate for projectors that are
eter has no effect if they’re already on). Use the 
to fine-tune the flash effect. The Ratio parameter
the projector lamp. For fast flash effects this prim
for moderate and slow flashes the duty cycle is r
set to 50% (on half the time and off half the time

Stopping a Flash Once started, the flash effect will continue regar
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dissolve cues, until explicitly told to stop. Thus you can fade the lamp up and 
down while still flashing.

effect, but now select the Stop Flashing 
 stop (possibly with the lamp still on), or 
 the flash effect is stopped.

tart Flashing, TRAX will attempt to 
 projectors so that the lamps will be 
reate a simple alternating flash between 
a, or a sequential animation using three 
n, combined with the right images, will 
 for example, be three pictures of a 
ith the wheel rotated to three successive 

lly use a rather slow flash rate (i.e., high 
epending on the number of projectors 
u desire. More complex animations 
rent animation rates and/or ratios can 
cribed on the next page.

 an image already on the screen, you 
 to be included in the animation by 
 cue), and turning them on using a Set 

light will reach the screen until the Flash 
additional delay caused by the Flash cue 
rting to flash them. You can also use Soft 
ct, in which case the imaginary light 

ps will be closed.
Use a new Flash cue to stop the flash 
part. Decide if the flash should simply
if the light should be faded out before

Sequential Flash Effects If you select the Sequence option for S
stagger the flash effects of the selected
flashed in order. This can be used to c
two projectors on the same screen are
or more projectors. Such an animatio
introduce a sense of motion. This can,
wheel, taken from the same spot but w
angles.

For such animations, you would norma
Time setting) at a 50% or 30% ratio, d
involved and the degree of overlap yo
involving multiple projectors and diffe
be created using the Snap cue as des

Using Soft Snap to Start and 
Stop a Flash Effect

If you want to start an animation from
must first prepare the other projectors
closing their Soft Snaps (using a Snap
cue. As the soft snaps are closed, no 
cue is performed. This trick avoids the 
if it has to turn the lamps on before sta
Snap to stop a Flash or animation effe
levels will remain on, but the Soft Sna



 and the Soft Snap. The Hard 
 professional slide projectors. 
to simply turning off the lamp. 
off, it takes a few moments for 
ermal lag of the lamp.

t have a slide projector with a 
nap cues will not run properly 

off instantly. The difference 
he Soft Snap doesn’t affect the 
s will continue, and the bright-
s is similar to a Flash cue, but 
events.
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Snap There are two kinds of Snap cues: the Hard Snap
Snap uses the mechanical shutter built into most
This gives a very sharp, abrupt effect compared 
Remember that when you turn a projector lamp 
the light to die away completely owing to the th

▼ CAUTION: To use the Hard Snap, you mus
controllable shutter. A show that uses Hard S
on projectors that don’t have this feature!

Soft Snap A Soft Snap Close cue turns the projector lamp 
between a Soft Snap and a plain Set cue is that t
imaginary lamp intensity. Any fading in progres
ness can be restored using Soft Snap Open. Thi
provides greater control over the sequencing of 
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Open, Close and Sequence Use Open or Close to specify what the projector should do. Use Sequence 
when you just want the Hard or Soft snaps to change their states, or to 

ny screen areas (see “Sequence” on 

successive Soft or Hard Snap cues, you 
h detailed control over the speed and 
reating the first Soft Snap cue (using its 
rojectors to animate, and then dupli-
n of time (see “Duplicate” on page 81). 
r Distribute Cues commands to alter the 
tion afterwards.

nimation effect using a Flash cue, do it. 
n be achieved by a Flash, or greater con-
 set to Sequence to create the desired ef-

e in order to start or stop the flash effect 
p to Start and Stop a Flash Effect” on 
sequence themselves within one or ma
page 199).

Using the Sequence mode of a set of 
can create a sequential animation wit
other characteristics. This is done by c
Sequence mode), assigning it to the p
cating this cue for the desired duratio
You can use the Expand/Compress o
duration and speed of such an anima

◆ HINT: Whenever you can do an a
If you want a slower speed than ca
trol, use a string of Soft Snap cues
fect.

Using Soft Snap with Flash Soft Snap can be used after a Flash cu
in a specific way. See “Using Soft Sna
page 203 for more details.



s in a way similar to pressing 
 resetting the device, control-
ons, or control of other device-

 pulse, turn on or off or toggle 
h or a solid state switch.

rily activated for 0.2 seconds. 
turned on or off continuously. 
urrently off and vice versa.
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Trigger The Trigger cue is used to perform many function
buttons on the devices being controlled, such as
ling switch closures, tape or disc transport functi
specific modes and functions.

Switch The four buttons in the Switch area allow you to
Switch device outputs. This can be a relay switc

The Pulse button causes the output to be momenta
The On and Off buttons causes the output to be 
The Toggle button will turn on the output if it is c

Play speed pop-up menu.

Device specific mode value field.

Pulse, On, Off and Toggle func-
tions, used with Switch devices.
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Transport The six buttons in this area control basic transport functions related to tape, 
video or audio disc devices. Not all buttons are applicable to all devices – for 

capable of playing backwards.

, the Play Speed pop-up menu – located 
 – becomes active, allowing you to 
his can be used with video disc players 
s may not be available on some players 
 inside each video disc device’s dialog 
ds. Some video disc players impose 
ck speeds when playing to a target time 
ost video disc players are incapable of 

ormal speed, when used with CLV discs. 
ll as the device information database 

 are used with simple players, such as 
o cassette decks, which can’t locate 
ttons with devices that can locate time – 
Frame Number” selected in the device’s 
ate By Time” cue instead.

 and/or video) will be automatically 
e selected transport button. Play will turn 
ward will turn it off. Alternatively, you 
ontrol the output level independently of 
example, only video disc players are 

When selecting one of the Play buttons
to the right of the six transport buttons
specify the desired playback speed. T
that have this capability. Some speed
– see the corresponding pop-up menu
box for information on available spee
further restrictions on available playba
using the Out field in the Locate cue. M
playing backwards, or at other than n
See “Video Disc” on page 143 as we
entry for your device for more details.

The Rewind and Fast Forward buttons
most consumer VHS players and audi
specific positions. Do not use these bu
i.e., which have “Position by: Time or 
configuration dialog box – use a “Loc

Output Control When selected, the output level (sound
turned on or off, as appropriate for th
it on, Stop, Pause, Rewind or Fast For
can use a separate Set/Fade cue to c
the Trigger cue.

Rewind

Play reverse

Stop

Pause

Play

Fast Forward



ansport button to start 

vices or device drivers. Please 
 window. If it is grayed out, it 

ound channel selection, audio 
 many tape, video and audio 

 and IR devices.

nly available when the Trigger 
 See “Device Specific Modes” 

be assigned to the device 
 to multiple devices, they must 

ment of such a Trigger cue, or 
evice’s configuration dialog 
se. TRAX tries to match up the 
fied name can’t be found, you 
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Record Mode Use this checkbox in conjunction with the Play tr
recording. 

◆ NOTE: This feature is not supported by all de
check the Record button in the device’s status
does not support recording.

Device Specific Mode Device-specific modes include such features as s
muting, index display, etc., and can be used with
disc devices. This option is also used with Serial

This button, and the pop-up menu next to it are o
cue is assigned to a device that has such modes.
on page 139 for more details.

In order to use this button, the Trigger cue must 
before opening this dialog box. When assigned
all be of the same type.

▼ CAUTION: If you change the device assign
if you change the Type specification in the d
box, the Trigger cue may no longer make sen
mode using its name. If a mode with the speci
will be notified.
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The value field next to the pop-up menu becomes active if the selected mode 
requires a value. This, again, depends on the device to which the cue is 
assigned.

own drivers for devices controllable by 
 or MIDI. These devices are then con-

r to the names of the various commands 
so use the numeric value field, if desired. 
ting your own drivers.

f the assigned devices to their power-up 
used with all kinds of devices. This is 
 timelines when you want some or all 
ositions. 

its medium. This can be useful in semi-
erator is supposed to change media at 
tion.

d by all devices or device drivers. Please 
’s status window. If it is grayed out, it 
◆ HINT: It’s possible to create your 
serial data, such as RS232, RS422
trolled using Trigger cues that refe
in your driver. Such drivers may al
See Chapter 10 for details on crea

Reset (Home) This option resets all status properties o
state. This kind of Trigger cue can be 
particularly useful at the beginning of
devices to always start at their home p

Eject This option causes the device to eject 
automatic presentations, where an op
pre-determined points in the presenta

◆ NOTE: This feature is not supporte
check the Eject button in the device
does not support this feature.



es, where you may want to 
ple devices. Normally when 
AX sends a separate instruc-
. If you send a cue to a large 
 timing difference between the 
first assigning the devices to a 

ng, any cue sent to all those 
rather than several individual 
n effect, the Gang cue assigns 
nd then sends the instruction 

s individual address.

ax Number of Gangs” field in 
rder to use the Gang cue, you 
ro.

ang cue and select one of the 
ove. Assign the devices to the 
signments of the devices using 
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Gang Gangs are useful in shows that use lots of devic
execute a particular cue simultaneously on multi
executing a cue assigned to multiple devices, TR
tion through the system data bus to each device
number of devices this may result in a noticeable
first and the last device. This can be avoided by 
gang.

Once a set of devices has been assigned to a ga
devices will be sent as a single gang instruction 
instructions – thereby avoiding any time delay. I
an additional address to the specified devices, a
to this common address instead of each device’

The Gang cue works in conjunction with the “M
the Preferences dialog box (see page 110). In o
must first set that field to a value greater than ze

To assign a set of devices to a gang, choose a G
settings A through H in the dialog box shown ab
Gang cue as usual. You can change the gang as
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additional Gang cues, if desired. The None option in the Gang cue removes 
the gang assignment from the devices assigned to the cue so they no longer 
belong to any gang. 

ains in effect until changed by another 

rt of the device’s status, just like the trans-
 the current slide number of a projector. 
n a timeline prior to the point where you 
ar set of devices

ent gang status is not indicated inside the 
k the gang letter at the bottom of the 
re assigned to a particular gang at the 
age 28). Be careful, though, so you 

assignment of any selected cue.

 one time in the show is eight (A through 
ned to gangs dynamically – using addi-
s limitation. A device can only belong to 
ed to a gang must be of the same kind. 
h the Device Specific Mode option in the 
e of the same type.
The gang assignment of a device rem
Gang cue.

◆ NOTE: The gang assignment is pa
port state of a video disc player or
Thus, you must enter a Gang cue o
wish to use the gang for a particul

Unlike other status properties, the curr
device’s status window. You must clic
Device window to see which devices a
current time (see “Device Gangs” on p
don’t accidentally change the device 

The maximum number of gangs at any
H). However, as devices can be assig
tional Gang cues – this is not a seriou
one gang at a time. All devices assign
Furthermore, if used in conjunction wit
Trigger cue, all gang members must b



t it doesn’t directly control any 
RAX itself. This is useful in 
 single timeline from start to 
p into several parts, of which 
nized to a device – and others 
teractively. See Chapter 8 for 
rious kinds of presentations.

yed at the bottom of the Time-
 on page 103 for more details.

et of the control cue. This can 
e control cue sits on), or 
ose “Named” on the Timeline 
e in the field to the right.
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Control The Control cue is different from other cues in tha
devices. Instead, it controls the timelines within T
many cases when the show isn’t simply run as a
finish. The show may, for example, be broken u
some are to run automatically – possibly synchro
run manually as speaker support modules, or in
some ideas on how to use the Control cue in va

Some of the effects of the Control cue are displa
line Settings dialog box. See “Timeline Settings”

Target Timeline Use the Timeline pop-up menu to specify the targ
either be the current timeline (i.e., the timeline th
another timeline. To target another timeline, cho
pop-up menu, and enter the name of the timelin
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Jump To Select the “Jump To” checkbox to make the target timeline jump to a specific 
position. If not, it will simply remain at the current position.

specify the destination of the jump either 
r the name of a Control cue somewhere 
e to jump to a Control cue, you can also 
rd or reverse direction relative the 

This is particularly useful when the target 
 timeline the control cue is on), and you 

e same name.

option, TRAX will first attempt to search 
n of the target timeline. If the named con-
 search backwards. So this option will 
less of where it is on the target timeline.

 loops on a timeline by jumping back to 
ating a section of cues. To exit the loop, 
page 88) or a Control cue in the Task 
 the looping timeline past the “loop 

 to program a loop.
After selecting this checkbox, you can 
by specifying the exact time position o
along the target timeline. If you choos
specify whether to search in the forwa
current position of the target timeline. 
timeline is the current timeline (i.e., the
may have several control cues with th

◆ NOTE: When using the “Ahead” 
ahead from the current time positio
trol cue isn’t found, it will then also
find the named control cue regard

Creating Loops You can use the Control cue to create
a point earlier on a timeline and repe
either use the QuickFind feature (see 
window or on another timeline forcing
back” cue.

See page 229 for an example of how



 similar to clicking the corre-
imeline window. Stopping the 
o they can be used by other 

n remains paused indefinitely, 
 can cause problems if other 
n you don’t want a timeline to 
t Stop rather than Pause. Use 

eline again shortly.

ynchronization source for the 
ither to a device or to another 
ns that it isn’t synchronized to 
ck.

imeline to the time position of 
tion. This includes most tape 
r frame positions. You must 
e. This device doesn’t have to 

nother timeline, you have the 
o act as a synchronization 
elines interlocked until one of 
e as a “macro” from another 
ply triggering the sub-timeline 
need them along the master 
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Run, Pause, Stop Runs, pauses or stops the target timeline. This is
sponding buttons in the lower left corner of the t
timeline also releases any devices owned by it s
tasks.

▼ CAUTION: If you pause a timeline and it the
it will retain ownership of all its devices. This
tasks need to access those devices. Thus, whe
continue to run any longer, you should selec
Pause only when you intend to re-start the tim

Synchronize To This pop-up menu allows you to determine the s
target timeline. A timeline can be synchronized e
timeline. Or it can be “free running”, which mea
anything at all except the computer’s internal clo

Synchronizing to a device allows you to lock a t
any device that can provide such timing informa
and disc players that can locate arbitrary time o
assign the Control cue to the synchronizing devic
be owned by the timeline to be syncronized.

When using a Control cue on a timeline to start a
option of specifying that the starting timeline is t
source for the started timeline. This keeps the tim
them is stopped. This allows you to use a timelin
timeline, e.g. to repeat a sequence of cues by sim
rather than duplicating the cues every time you 
timeline.
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The target timeline in this case becomes more like an extension of the starting 
timeline than an independent timeline on its own. As the starting timeline 
“owns” the target timeline, it also owns all devices controlled by the target time-

 to own those devices even after the 
ore, a timeline synchronized to such a 
vices owned by the master timeline.

 between the timelines, simply un-select 
t the target timeline will run on its own, 

rting timeline.

 can specify an offset between the 
s. If you choose “Relative”, TRAX will 
lculated device position and the current 
particularly useful if you’ve just used a 
ice from a specific position.

 offset manually for full control. You can 
 offset. This is useful for example when 
code from multiple tape reels, where the 
s there can only be one “zero” position 

 offset the sync source time for all but the 
urse use separate timelines corre-

ization source for a timeline can be seen 
ialog box for that timeline (see “Current 

This also shows the current synchroniza-
line. The starting timeline will continue
target timeline has stopped. Furtherm
“master” timeline can freely use all de

If you don’t want this close relationship
the “Synchronize To” checkbox so tha
without any special relation to the sta

Synchronization Offset When synchronizing to a device, you
device’s time position and the timeline
compute an offset that matches the ca
position of the target timeline. This is 
Locate and a Play cue to start the dev

Alternatively, you may specify the time
specify either a positive or a negative
synchronizing a single timeline to time
timecode on each reel starts at zero. A
along a timeline, you will then have to
first reel. Alternatively, you may of co
sponding to each of the reels.

The current offset relative the synchron
at the bottom of the Timeline Settings d
Control Cue Settings” on page 105). 
tion source for a timeline.



ue’s dialog box to ensure that 
e are available (i.e., not 
riority). If all devices assigned 
will not be performed. 
le, the control cue will be 
nditionally stop the timeline. 
g an alternative function if all 
displaying a message to the 

 are indeed available, the 
 devices. Thus, after getting 
at you now own all devices 

g of timelines where you know 
es. In this way, you can make 
f devices deemed to be critical 
t can include all devices to be 

slide show as well as controls 
that all the slide projectors are 
ntrolling the house lights. To 
e projectors and select the 
g box to perform it condition-

ssed.
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Perform Conditionally Use this checkbox at the bottom of the Control c
all devices needed to successfully run the timelin
owned by other tasks with the same or higher p
to the control cue are available, the control cue 
Conversely, if any of the devices are not availab
performed. This can be used, for example, to co
Or it can start another timeline instead, providin
the required devices can’t be accessed (such as 
operator/user).

In addition to checking that all required devices
control cue will also claim ownership of all those
past such a control cue successfully, you know th
you need, and you can proceed safely.

You may want to use this feature at the beginnin
that other timelines may be using the same devic
the timelines mutually exclusive, based on a set o
for each timeline to perform successfully. This se
used by the timeline, or a critical sub-set.

For example, if you have a timeline that runs a 
the houselights, you may want it to run provided 
available, even if some other task is currently co
accomplish this, assign the control cue to the slid
checkbox at the bottom of the control cue’s dialo
ally, in case some slide projectors can’t be acce



Chapter 7: Cues 217

Special Control Cue Names By giving a control cue a special name, it is possible to instantly jump to this 
cue by pressing either a function key or a control key combination while the 

ndow. This is useful if you don’t know in 
along a timeline will run, or if you have 
 be chosen depending on the circum-

me field of a Control cue, you can jump 
ing the F5 function key on the keyboard. 
 keys, or if you need more than 15 direct 
 combinations. Pressing A while holding 
 Control cue named “CA”. See “Using 
ils.

 timeline, TRAX first scans forward from 
ot found, it scans backward from the 
d the closest cue ahead with a given 
e. This allows you to use the same key 
e to exit loops, as described under 
timeline containing it is the current wi
advance in which order the segments 
a number of different sections that can
stances.

If you, for example, put ”F5” in the Na
directly to this cue at any time by press
If your keyboard doesn’t have function
access points, you can use control key
down the Control key will jump to the
QuickFind” on page 88 for more deta

When searching for a Control cue on a
the current position of the timeline. If n
current position. Thus it will always fin
name, in case there are more than on
over and over again along the timelin
“Creating Loops” on page 213.



mments or for sending text to 
indow for the Text device 

, or for manual operator cues 
age 151 for some additional 

isplay item on a Panel device, 
el.

text field of this dialog box 
ssing the dialog box. Press the 
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Note Use the Note cue for your own programming co
Text devices (page 151). By keeping the status w
open, you can also use it as a speaker prompter
(see “Enlarged Font and Black Background” on p
hints).

Furthermore, a Text device can be linked to a D
allowing text strings to be displayed on the pan

◆ NOTE: Pressing the Return key while in the 
forces a new line in the text rather than dismi
Enter key or click OK to dismiss it.
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8 8 PRESENTATIONS
f presentations, and shows how you can 
ing TRAX. Examples of presentation 

nned” presentations. These run from be-
normally play a video tape.

ese typically also run from beginning to 
 can control the pace of the presentation 
y section.

s, musicals and other events. TRAX can 
ting many functions and increasing the 
presentation.

n a museum or a visitor center. Here the 
and can choose what should happen, or 
h panels, buttons and other sensors.

ntrol. Whenever you need to provide an 
nt end” to a heterogeneous set of audio-
uld be, for example, in a fixed installa-
om – or in a conference rental situation.

ds of presentations separately, you can 
ues as you see fit in order to create your 
This chapter discusses different kinds o
handle the various aspects of them us
methods include:

• Fully automatic, single timeline, “ca
ginning to end, just as you would 

• Speaker support presentations. Th
end along a single timeline, but you
as well as skip ahead or review an

• Live presentations, such as theater
cooperate with your crew, automa
precision and repeatability of the 

• Interactive presentations, such as i
audience plays a more active role 
interact in various ways using touc

• General media integration and co
easy to use and well integrated “fro
visual devices, lighting, etc. This co
tion – such as a corporate boardro

While this chapter discusses these kin
of course mix and match these techniq
own unique applications.



time, just as a videotape or an 
 and stop it. This is the simplest 
. Although useful on its own, 
monly used as part of larger, 

ng a single timeline, corre-
an either run such a presenta-
udio track on an audio or 
ter.

 canned presentation is to put 
 timeline. See “Timeline 
imelines. See also “Start Auto-
how to make your show start 

combined with sound from a 
n either of the following ways:

 programming, either free-

formation provided by many 
ers.

corded on a separate audio 

 track on the tape, for subse-
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Canned 
Presentations

A canned presentation runs the same way every 
audio cassette. Basically, all you can do is start it
form of presentation you can create using TRAX
such a pre-programmed presentation is also com
more interactive presentations.

A canned presentation is often programmed usi
sponding to the extent of the presentation. You c
tion from the computer or record it onto a free a
video tape for later playback without the compu

In its simplest form, all you need to do to make a
all the cues along a single timeline, and run the
Window” on page 29 for details on how to use t
matically when Opened” on page 108 to learn 
automatically when the computer is turned on.

Audio Synchronization A canned, single timeline, presentation is often 
tape deck or other device. This can be handled i

• By controlling the audio device as part of the
running or synchronized to the timeline. 

• By synchronizing the timeline to the timing in
intelligent professional audio and video play

• By synchronizing the timeline to timecode re
track.

• By recording a control signal on a free audio
quent playback without using the computer.
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Controlling the Device The most basic way to achieve synchronization between a timeline and an 
audio or video player is to simply control the player from the timeline. Use a 

e desired starting position (see 
y cue to start it at the right moment (see 

me or frame positions, you can choose 
X will then also make sure that the device 
u start the timeline from any point after 
e desired position of the device.

an run the device and the timeline “free 
e before any drift becomes noticeable. 

eline in TRAX, as well as the playback 
recise crystal frequencies. This includes 

.), as well as most video devices. Analog 
curate, however.

 to control the speed of the device, and 
y long time periods. This applies to some 
otape devices normally used for editing. 
atabase for details on your device (see 
age 65).
Locate cue to position the device at th
page 186), and then use a Trigger Pla
page 207).

For devices that can locate accurate ti
any location as the starting point. TRA
is positioned appropriately even if yo
the Play cue, as TRAX can calculate th

With most professional devices, you c
running” for an extended period of tim
This is due to the fact that both the tim
rate of the device, are locked to very p
all digital audio devices (CD, DAT, etc
audio players are generally not as ac

For some devices, TRAX may be able
thereby ensure accuracy even over ver
audio devices as well as high-end vide
Please check the device information d
“Getting Information on Devices” on p



rolled using bi-directional, 
 provide accurate timing infor-
ronize a timeline to the device 

here TRAX was the “master” 
se depends on the capabilities 

trol cue assigned to the device 
hronizing to the device, make 
 a Trigger Play cue just before 
vice, use another Control cue 
sed tutorial show named 
ow this can be programmed. 
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Synchronizing to an 
Intelligent Device

Most professional audio and video devices cont
serial data (RS-232, RS-422 or similar) can also
mation back to TRAX. This can be used to synch
while it is playing.

This is the reverse of what’s described above, w
and the device the “slave”. Which method to cho
of the devices at hand.

To synchronize a timeline to a device, use a Con
(see “Synchronize To” on page 214). Before sync
sure the device is playing, for example by putting
the Control cue. Likewise, before stopping the de
to make the timeline free-running. See the enclo
“Timecode Synchronization” for an example of h

Disengage synchroniza-
tion using a control cue 
set to “Synchronize To: 
Nothing” before stop-
ping the device.

This control cue 
activates the 
synchronization 
of the timeline, 
as seen in the 
dialog box.
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Synchronizing to Timecode Some devices – most notably analog audio tape devices – can’t provide such 
inherent timing information, as described on the previous page. In order to 

s, a separate timecode track is required. 
X+, as described on page 375, and can 
nize a timeline to the tape.

eline to the timecode on the tape 
corder. It also depends on the control 
 TRANSPAX+ and the tape recorder. 
rious hardware configurations.

g a LOCATOR ADAPTOR cable (i.e., it 
 tape using the autolocator feature of the 
ed under “Synchronizing to an 

u can’t use the autolocator feature, you 
lly prior to starting it.

tely, start it either using a Trigger Play 
er’s basic transport functions), or manu-
eline to the timecode coming from the 
ize To” on page 214.

ck that can’t be controlled by TRAX, you 
n entire timeline – rather than a portion 
n operate the tape deck manually, 
priate. This is common practice in tradi-
 use a single timeline driven by the time-
h also contains the soundtracks.
control and synchronize to such device
This can be recorded using TRANSPA
later be read back in order to synchro

The method used to synchronize a tim
depends on the capabilities of your re
cable (or absence of one) between the
Chapter 15 provides details on the va

If your tape recorder is controlled usin
can locate an arbitrary position on the
TRANSPAX+), you proceed as describ
Intelligent Device” on page 222. If yo
will have to position the device manua

Once the tape is positioned appropria
cue (if you can control the tape record
ally. Use a Control cue to lock the tim
device, as described under “Synchron

Synchronizing an Entire 
Timeline

When using timecode from a tape de
may sometimes want to synchronize a
of one – to that timecode. You can the
causing the timeline to follow as appro
tional slide shows, where you typically
code from an open-reel recorder whic



at establishes the tape device 

 it to the Tape device.

you want to synchronize using 
low).

l cue task to make it auto-start.

sing the single-cue task to run, 
code from the Tape device.
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This can be accomplished using a startup task th
as the sync source for the main timeline:

• Add a Control cue to the Task list, assigning

• Open the Control cue and target the timeline 
its name (“Main Timeline” in the example be

• Put “1” into the Condition field of that Contro

• Press Command-space to run the system, cau
which locks the “Main Timeline” task to time

Device used as sync source.

Name of target timeline.

Started in Pause mode, 
waiting for the timecode.

Put “1” here to make the 
Control cue auto-start (see 
“Making a Task Start Auto-
matically” on page 58).
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Recording a Control Track You can record a control signal – also called a cue-track – onto a free audio 
channel. This control track can then be played back directly into the PLAY input 

 the tape containing your sound and the 
on of the timeline. This is assuming that 
ne track (the new control track) while 

track (the timecode track). If this is not 
control track onto another recorder, 
ter recorder.

ge 376 for more details on how to 
using TRANSPAX+.
of the first control unit in the chain.

You can record the control signal onto
timecode track used for synchronizati
the recorder is capable of recording o
simultaneously playing back another 
possible, you may instead record the 
copying the soundtracks from the mas

See “Control Signal Recording” on pa
record and play back a control track 

1

2

3

4

Control signal 
being recorded.

Timecode 
being read.



nned presentation in that it 
d of running it from beginning 
egments – sometimes as small 
l. The same applies to other 
nts, such as dancers or an 
e of events may vary from one 
 determined in advance. 
to slow down the TRAX part of 
e to have optional show parts 
ny order.

RAX-controlled aspects of the 
imeline or you can have TRAX 
aker or operator before 

cks in the timeline as a stop-
be changed by mistake. Put 
k. During your presentation, 
oard to run to the next cue on 
 the active window).
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Speaker Support A speaker support presentation is similar to a ca
often uses only a single timeline. However, instea
to end at a stretch, it is typically run in smaller s
as a single cue at a time – under manual contro
kinds of presentations involving some live eleme
orchestra. In these cases, the timing and sequenc
presentation to the next, and often can’t be fully
Depending on the circumstances, you may want 
the presentation or speed it up. It is also possibl
which can be skipped entirely or presented in a

Timing of Events There are two ways to regulate the pace of the T
show; you can force TRAX to skip ahead on the t
stop at predetermined points and wait for a spe
proceeding.

To make TRAX stop and wait, use one of the tra
track. Lock the current track selection so it can’t 
each cue at which TRAX should stop on this trac
use the down arrow key on the computer’s keyb
the stop track (make sure the timeline window is

Track being used as a stop track. 
Lock the stop track as described on 
page 105 to prevent it from being 
changed accidentally. When the 
current track is locked, its name is 
italicized.
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The top outsize button on the Dataton AIRLINK wireless remote control can be 
used in the same way as the down arrow on the Macintosh keyboard (see 
“Remote Control” on page 231). The up arrow key allows you to skip back-

ow key lets you skip forward.

 if you have a time-continuous medium 
l something else starts happening, the 
ined in advance.

nough running time between the cues to 
oint. You then put a named Control cue 
nction key or control key name into this 
ctions” on page 230). When you run the 
ion key to skip ahead to this point as 

 forward when performing a QuickFind, 
ontrol key name at several points in the 

 function.
ward one stop at a time. The right arr

Skipping Ahead You may want to skip ahead in a show
– e.g. videotape or CD – running unti
exact timing of which can’t be determ

In this case, you would first program e
cover the worst case situation at this p
at the end of the running time. Put a fu
Control Cue (see “Jumping to Show Se
show, simply press the assigned funct
required.

◆ NOTE: As TRAX always searches
you can use the same function or c
show to perform the “skip ahead”

Jump to the end of the video roll by 
hitting function key F5, or the corre-
sponding key on an AIRLINK remote 
control.



ed in the previous section is to 
d clip, while the main timeline 
this method is that it gives you 
/audio roll on to the following 
rupt.

audio from a secondary time-
a Control cue. The secondary 
 playing the video, as well as 
o the video clip. By putting the 
eline, you can use the same 
t clips.

automatically after the last cue 
ng the main timeline to regain 
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Using secondary timelines An alternative to the skip-ahead method discuss
use a separate timeline to run the video or soun
waits for the user to proceed. The advantage of 
greater control over the transition from the video
segment. Simply skipping ahead may be too ab

This can be accomplished by running the video/
line, which is started by the main timeline using 
timeline contains the Trigger Play cue that starts
any other cues required for the initial transition t
Locate cue that cues up this clip on the main tim
secondary timeline over and over to run differen

Configure the secondary timeline so that it stops 
(see “Stop After Last Cue” on page 105), allowi
control over the device when it proceeds.

The Locate cue positions the 
device and the following Control 
cue starts the secondary timeline 
named “Play a Clip”.

The priority of the secondary time-
line must be higher than the main 
timeline’s in order to take control 
over the device.
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Programming Loops In some extreme cases you may not be able to tell if the unspecified duration 
will be one minute or, say, three hours. All you know is that there should be 

tton. In this case, you can create a loop 
til you press the skip ahead button.

ing of the loop content. Then put another 
ng TRAX to jump back to the named 
ause TRAX to repeat the segment 
nitely.

rol cue after the loop, giving it the name 
Jumping to Show Sections” on page 
d key to exit the loop.

e function or control key combination as 
lways starts a QuickFind in the forward 
age 88).

dary timeline for the loop, similar to the 
can provide better control of the termina-
some action going until you press a bu
which will be repeated indefinitely un

Put a named Control cue at the beginn
Control cue at the end of the loop telli
Control cue and run again. This will c
between these two Control cues indefi

To get out of the loop, put a third Cont
of a function key or control key (see “
230). Then simply press the designate

The third Control Cue may use the sam
in other “skip ahead” cues as TRAX a
direction (see “Using QuickFind” on p

Alternatively, you can also use a secon
method described on page 228. This 
tion of the loop.

Loops back indefinitely…

…until you press F5.



ility, requiring show segments 
near sequence. This can be 

X, you can jump instantly to 
 controlled from the AIRLINK 
keys on the computer’s 
he bottom three rows of keys 
ugh F13 on the computer’s 
oints in the show. You can use 
 doesn’t have function keys by 
 of a Control cue. See “Using 

o locate any Control cue by 
5). This has the advantage of 

 timeline, with easy to 
tails more typing than the 
e timeline is running.

 show. This allows you to re-
s are run without actually 
 select one of the Jump To 
ferable as it means you will 
n if it is moved during editing.

rate timelines for each show 
r from a main timeline (see 

s, please refer to Chapter 9.
230 Chapter 8: Presentations

Jumping to Show Sections Some presentations may call for even more flexib
to be chosen in any order rather than run in a li
accomplished in various ways.

For example, using the QuickFind feature in TRA
any point along the current timeline. This can be
wireless remote control or you can use function 
keyboard as well as control key combinations. T
on AIRLINK correspond to function keys F5 thro
keyboard, giving you direct access to nine cue p
this feature of the AIRLINK even if your keyboard
simply putting the name of the key into the name
QuickFind” on page 88 for more details.

Another possibility is to use the Find command t
entering its name (see “Find/Replace” on page 8
offering even more cue points along the current
remember names. The disadvantage is that it en
QuickFind method, and it can’t be used while th

You can also insert programmed jumps into the
arrange the order in which the various segment
moving the cues around. Use a Control cue and
options. Jumping to a named Control cue is pre
automatically find the right spot in the show eve

Alternatively, modularize your show using sepa
segment, and then call these in the desired orde
“Using secondary timelines” on page 228).

◆ HINT: For even more interactive capabilitie

+
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Remote Control To use the AIRLINK wireless remote control with TRAX for speaker support 
applications, connect the AIRLINK receiver to your Macintosh as described 

r Speaker Support” on page 351.

LINK transmitter corresponds to the 
yboard. It will run the timeline up to the 
ing of Events” on page 226). The three 

and right arrow keys. Both the left key 
 to the previous cue on the current track. 
e next cue on the current track.

 the F5 through F13 function keys on the 
e used in conjunction with the QuickFind 
ns” on page 230).

ts to the ADB 
us connector: 

AIRLINK MAC 
DAPTOR 3440

LINK
EIVER
8

under “Connecting to the Computer fo

The topmost, oversized key on the AIR
down arrow key on the computer’s ke
next cue on the current track (see “Tim
keys below correspond to the left, up 
and the middle key in this row reverse
The right-arrow key skips ahead to th

The remaining nine keys correspond to
Apple Extended keyboard. They can b
feature (see “Jumping to Show Sectio

F5 F6 F7

F8 F9 F10

F11 F12 F13

Connec
b

A

AIRLINK 
TRANSMITTER
3449

AIR
REC
344



ents such as conferences, 
s of presentations typically 
port presentations. Some 
le others require manual 

forcement and playback, 
 switching, tape rolls, plus a 
ed manually for safety 

em for live events is that it 
t is hard to achieve the same 
ators and intercoms. 

ch as in a theater, the repeat-
w that they can rely on the 

 the computer, it is also 
g for example TOUCHLINK or 
 can provide manual control, 
rs. This allows them to manu-

required.

ns automatically as an actor 
he speaker control the pace of 
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Live Events You can use TRAX to assist your crew for live ev
theatres, musicals, rock concerts, etc. These kind
combine the aspects of canned and speaker sup
segments may run totally pre-programmed, whi
control either by a speaker or an operator.

Such events typically call for lighting, sound rein
computer graphics, video projection and source
number of operator cues that have to be perform
reasons or for increased flexibility.

Repeatability One of the chief reasons for using a control syst
improves the repeatability of the performance. I
degree of precision when relying solely on oper

Even when the show actively involves people, su
ability makes their jobs easier because they kno
system to perform consistently time after time.

Manual Control While you can run the presentation directly from
possible to control it from remote locations, usin
AIRLINK. Using multiple TOUCHLINK units, you
override functions and feedback to your operato
ally control some aspects of the presentation, if 

You can also use input signals to trigger functio
moves past a sensor. Or, for conferences, have t
the presentation using a button on the lectern.
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Modularity The modularity of the system, both in terms of hardware and software, makes 
it suitable for live events. 

vents require equipment and crew both 
ind the screen. Lighting and sound 
k of the room, where the operators have 
on and computer graphics, on the other 
e screen.

ing the control units and operator panels 
ter (300 feet) of system cable between 

 powered locally, and the system bus has 
and other kinds of noise, resulting in a 
itions.

rize the show by using individual time-
 show. For example, the lighting can be 
o. Or you can program each section of 
 timelines can then be assembled into the 
nder a master timeline or started individ-

perator control a function – perhaps for 
ation – you can use Note cues to tell the 
o and when to do it. These notes can be 
 connected to the main computer or on 
e used for operator input as well. 

ate system status and provide other kinds 
For example, many conference-type e
in the back of the room as well as beh
control is usually handled from the bac
a good overview. Video rolls, projecti
hand, are typically run from behind th

This can be easily handled by distribut
as needed. You can run up to 100 me
each control unit. The control units are
built-in protection from ground loops 
reliable system even under harsh cond

On the software side, you can modula
lines to handle the various parts of the
programmed separately from the vide
the show as a separate timeline. These
final presentation, and consolidated u
ually by operators.

Operator Prompting In cases where you prefer to have an o
safety reasons or to allow for improvis
operators what they’re supposed to d
displayed either on separate monitors
TOUCHLINK panels, which can then b
TOUCHLINK can also be used to indic
of feedback to the operators.



 in many ways, thereby 
 needs. This can mean 
 used by a single person at a 
, motion sensors or other kinds 

d on menus and branching – 
so create more elaborate and 
 other software packages. For 
hronously, you can choose 
 started actions. It is also easy 
ouse and touch screen. TRAX 

as well as MIDI.

ay want to exert a certain 
le, making sure they keep 

hile interacting with the system 

 to create interactive 
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Interactive 
Presentations

Your audience can interact with the presentation
making it more responsive or tailored to specific
anything from a small kiosk-style presentation –
time – to a multi-floor visitor center using buttons
of inputs.

While traditional interactive applications – base
can certainly be managed by TRAX, you can al
complex interactions, typically not supported by
example, using multiple timelines running async
new paths without necessarily stopping already
to provide other kinds of inputs than keyboard, m
supports a variety of digital and analog inputs, 

In addition to responding to the audience, you m
amount of control over the audience. For examp
moving along a predetermined path or maze, w
along the way.

Please refer to Chapter 9 for full details on how
presentations using TRAX.
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General Media 
Integration

Although primarily designed for show applications, TRAX can also be used 
when you simply want to integrate a complex – and potentially confusing – set 

eeting room, including lighting, curtains, 
s various presentation media.

ck provided by a rental company, allow-
l functions from a wireless remote or a 

re not designed to work together.

 environment has proliferated due to the 
d presentation graphics and multi-
cing, etc. Although most of these media 
f their applications, the practical imple-
ntegration or inflexible control solutions.

 full of presentation equipment, start by 
ch as:

ers, shareholders, school children, etc.

iving presentations in your facility.
of equipment under a single system:

• Controlling the environment in a m
screens and sound levels, as well a

• Acting as a front end for an AV ra
ing the client to control some or al
touch panel.

• Acting as “glue” for devices that a

Meeting Room Control The use of AV media in the corporate
widespread use of computer generate
media, video projection, teleconferen
are almost infinitely flexible in terms o
mentations are often limited by poor i

In order to get the most out of a room
defining the purposes of the room, su

• Board meetings.

• Sales and R&D meetings.

• Staff training.

• Customer training.

• Corporate presentations to custom

• Visits by sales people and others g



m, the variety of people that 
d, it’s easy to see the need for 
 run on a small computer 
r sound and video equipment. 
er interface. Separate buttons 
ystem, if desired, through 
ol can be added for wireless 

ct control and timeline based 
be accomplished simply by 
the devices to be controlled 
rties” on page 160). Pre-
andled by timelines (see 

ment to hotels and other 
nits and an AIRLINK or 
ce to your equipment. This 
uipment directly, or provides 
 for commonly used functions.

mplifier, a CD player for walk-
ireless microphones, and 

ons and sliders to the functions 
an put together the user inter-
. Add your client’s logo to the 
e solution.
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Considering the many possible uses for such roo
will utilize it and the amount of equipment neede
control system to bring it all together. TRAX can
installed in a rack together with most of the othe
TOUCHLINK panels can provide an attractive us
or hard-wired panels can also be linked to the s
DIGITAL SMARTLINK. An AIRLINK remote contr
remote control of selected functions.

The TRAX programming consists of a mix of dire
programming. Most basic control functions can 
linking the buttons on a TOUCHLINK directly to 
(see “Linking Panel Items to Device Status Prope
programmed presentations and sequences are h
“Timeline Window” on page 29).

AV Rental Applications If you’re in the business of renting out AV equip
venues, you can use TRAX, a few SMARTPAX u
TOUCHLINK to provide a consistent user interfa
allows the client to control some, or all, of the eq
your crew with a more easily managed front end

Such an AV rental rack could include a sound a
in music, an equalizer, video deck, wired and w
possibly a basic lighting dimmer. 

Using the ability to directly link TOUCHLINK butt
to be controlled (as shown on page 160), you c
face in a matter of minutes – no coding required
first page, and you have provided a tailor-mad
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General Equipment Glue Due to its open design, and ability to accept and provide a variety of control 
methods, TRAX can also be used as a general way of interfacing seemingly 

is allows you to integrate all kinds of 
rd, off-the-shelf hardware and software 

presentation to timecode from an audio 

stems in parallel, to create electronic vid-

e same time from a single push-button.

ace to control a number of different de-
gle TOUCHLINK touch panel.

nd lighting from motion detectors and 

 a MIDI keyboard.

 console to trigger sound effects from a 

 can solve a number of control and inter-
require expensive, tailor-made solutions. 
 first place. Furthermore, once the job is 
ipment for other applications.
incompatible pieces of equipment. Th
devices in creative ways, using standa
components.

You could for example:

• Synchronize a computer-graphics 
tape.

• Run multiple computer-graphics sy
eo-walls.

• Start a number of tape decks at th

• Provide a custom-made user interf
vices from one location using a sin

• Trigger MIDI-based sound effects a
other sensors in the room.

• Play video clips off a laserdisc from

• Use some buttons on your lighting
CD player.

By using TRAX in a creative way, you
facing problems that otherwise would 
This saves you time and money in the
finished, you can re-use the same equ



g slide and/or video projec-

ate of the show tape and disk. 
f all other unique material in 
tc.).

ps, slide mounts, etc.

, showing how all the parts are 
d to which ports, etc. If the 
en mark them clearly so you 

 and positions. Use a felt-tip 
’t use labels as they may peel 

to use an existing screen? Is it 
ur kind of presentation? Some 
t-spots.

g height to make sure it will fit.

ce them high enough to avoid 
 the table or shelf is rock-solid, 
d or lean on it.

using regular three-gun CRT 
 and video projectors close to 
e projectors will distort the 
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Staging Shows Here is a basic checklist for staging a show usin
tion.

• Make sure you have at least one extra duplic
You should preferably have an extra copy o
your show as well (videotape, disks, slides, e

• Carry some blank tapes and disks, spare lam

• Make a detailed drawing of the entire system
interconnected, which addresses are assigne
SMARTPAX units aren’t installed in a rack, th
know which unit goes where.

• Number slide mounts with their tray number
pen and write directly onto the mounts – don
off and jam the tray.

• Check the room in advance. Are you going 
large enough? Is it of the right material for yo
screens may cause uneven illumination or ho

• If you bring your own screen, check the ceilin

• Figure out where to place your projectors. Pla
interference from people’s heads. Make sure
and that no-one in the audience can sit, stan

• If you’re mixing slides and video projection 
based video projectors, don’t place the slide
each other as the magnetic field from the slid
video image.



Chapter 8: Presentations 239

• What’s the projection distance? Do you have the right lenses to handle it?

• Check the room at about the same time of the day as your show will run to 
te the curtains, blinds and light switches.

 example, at an exhibition or a shopping 
 rear screen projection. This requires spe-
ing all the slides around 180 degrees. If 
eck that it is capable of rear screen pro-

r your slide projectors? Figure out how 
bring twice that number as well as some 
g PAX dissolve units, always power all 
AX unit from the same outlet in order to 
dicated by projector lamps that won’t go 
to SMARTPAX.

und system, or plug into an existing sys-
s are long enough, and tape them to the 
oing to tap into an existing system, check 
Bring some line-level signal transformers 
t may cause unexpected hum when con-

p. Rehearse everything thoroughly. Last 
e a single thing in the system – not matter 
re-doing the rehearsal!
ensure that it’s dark enough. Loca

• If you can’t turn all the lights off, for
mall, perhaps you should consider
cial screen material, as well as turn
you are using a video projector, ch
jection.

• Is there enough power capacity fo
many power-strips you need, then 
heavy-duty extension cords. If usin
projectors connected to the same P
avoid phasing problems (usually in
off). This restriction doesn’t apply 

• Are you going to use your own so
tem? Make sure the speaker cable
floor to avoid accidents. If you’re g
what kind of connectors are used. 
to break up any ground loops tha
necting the two systems together.

• Give yourself plenty of time to set u
but definitely not least, don’t chang
how simple it may seem – without 



y from the computer, it can be 
e automatically loaded when 

d” is selected in the Prefe-
Start Automatically when 

the Startup Items folder inside 

oad and the task window will 
e). To make a timeline start 
 column in the Task window 
ge 58). 

 so it can’t be stopped by 
e “Password” on page 113).
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Automatic Start If the final presentation is to be run automaticall
set up in such a way that TRAX and the show ar
the computer is switched on: 

• Make sure “Start Automatically when Opene
rences dialog box, then save the show (see “
Opened” on page 108).

• Put the show document, or an alias to it, into 
the System folder. 

When the system is powered up, the show will l
be started automatically (i.e., set to its play mod
automatically as well, put a “1” in its Condition
(see “Making a Task Start Automatically” on pa

You can also use a password to protect the show
touching the computer’s keyboard or mouse (se
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9 9 INTERACTIVITY
ractive” with CD ROM, computers and 
 presentation by pointing and clicking. 
 be created using TRAX, the primary 
ments rather than just a computer 
ral) could enter a room to trigger an 
d on his synthesizer, or a performing 
 floor.

ghout the environment. This can be 
ttons through temperature sensors all the 
 including sound and graphics.

its ability to trigger any number of inde-
rm at the same time. In most traditional 
, you move along a single timeline, or 
dependent actions happening simulta-
 systems. 

e environment, such limitations are not 
ant to control lighting in one part of the 
t the same time, another person could 

of the room to see a small slide show, 
deo clip. Such concurrent actions can 
e Task list and using independent time-
Many people associate the term “inte
multimedia, allowing a user to view a
Although this kind of presentation can
focus in TRAX is on interactive environ
screen. For instance, a visitor (or seve
action; a musician could strike a chor
artist could move over a sensor in the

Individual inputs can be located throu
anything ranging from simple push bu
way up to the ubiquitous touch panel,

Multi-tasking Interactivity Another major advantage of TRAX is 
pendent actions, and have them perfo
interactive software authoring systems
through a menu tree. Having totally in
neously is usually not possible in such

However, when creating an interactiv
acceptable. You may, for example, w
room, triggered by a motion sensor. A
press a button in the opposite corner 
while a third person wants to run a vi
easily be handled by TRAX through th
lines.



d to provide inputs to TRAX, 
ote, a MIDI keyboard or a 

e Device window. For some of 
r a bi-directional signal, after 
d User Feedback” below).

 Task window. Add an action 
 on page 51. Then link the 

of the switch, as described on 

ore details on how to create 

h through a DIGITAL SMART-
SMARTLINK” on page 328). 
TAL SMARTLINK, the same 
d as an output to drive an indi-
er. Such immediate user feed-
articular if the result of the 

 a second to appear.

hown under “Digital Input 
tput Functions” on page 332. 

 either as “Input” or “Both” in 
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Inputs In order to create an interactive system you nee
such as a touch screen, an AIRLINK wireless rem
hard-wired push-button.

Programming the Inputs Most such inputs show up as Switch devices in th
these devices you must specify that it is an input, o
choosing the device type (see “Input Switches an

You program the functionality of the inputs in the
– either a single cue or a timeline – as described
Task’s Condition to the Input On status property 
page 54.

See “Compound Conditions” on page 245 for m
more elaborate input conditions.

Input Switches and User 
Feedback

You can connect a push button or a toggle switc
LINK connected to a SMARTPAX (see “DIGITAL 
Due to the bi-directional capabilities of the DIGI
wire can work both as an input for the button an
cator in the button, providing feedback to the us
back is important in all interactive systems – in p
user’s input may take more than a few tenths of

Wire the switch to the DIGITAL SMARTLINK as s
Functions” on page 331 or “Combined Input/Ou
Add it to the Device window in TRAX, and set it
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its configuration dialog box (see “Function: Output, Input, Both” on page 130). 
Select “Both” if you want to provide user feedback for the button.

dback is activated (i.e., the output func-
 not possible to detect any input signals. 
ill indicate that it is on (true) for as long 
ust turn off the feedback in order to de-

 on the feedback at the beginning of the 
is way, the indicator will not only show 
hen it is finished.

s that represent a multiple choice – such 
dback in one button should be turned off 
ressed. In this case, pressing the button 
shouldn’t have any effect, so it’s OK for 
efinitely.

 through a DIGITAL SMARTLINK in the 
s section. This includes for example most 
ten used for burglar alarms, as well as 
 etc.

ust determine if the output from the 
 the electronic parts of the sensor itself. 
he output of the sensor. In this case, it 
 can be connected to DIGITAL SMART-
▼ IMPORTANT: While the user fee
tion of the switch device is on), it is
The switch’s input status property w
as the feedback is activated. You m
tect new user input.

If the button starts a timeline then turn
timeline and turn it off at the end. In th
that the sequence is started, but also w

If the button is part of a group of button
as choosing a language – then the fee
when another button in the group is p
while its function is already activated 
the button’s indicator to remain on ind

Sensors Various kinds of sensors can be wired
same way as described in the previou
infrared motion sensors of the kind of
limit switches, magnetic door sensors,

When using electronic sensors, you m
sensor is galvanically separated from
This is usually handled by a relay at t
behaves just like a switch closure, and
LINK in the same way.



that is not separated, such as 
 those outputs provided that:

 of up to 12 V DC to ground.

e wired to the ground terminal 
 ground loop or other unwant-

st open collector outputs in the 
g a pull-up resistor as shown 

l as an input. Connect the 
nfigure it as described under 

 Applications” on page 353.

evice window as a separate 
switches as desired.

r (fader, wheel, etc.) can be 
I devices (including some 
input, choose “MIDI:Note 
configuration dialog box. See 
s.

input, add a Level device and 
-up menu. For such analog 
bols and a threshold value to 
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Using Electronic Sensors Some electronic sensors may provide an output 
an open collector transistor output. You can use

• The open collector can pull a positive voltage

• The ground of the open collector output can b
of the DIGITAL SMARTLINK without causing a
ed current path.

Provided these criteria are met, you can wire mo
same way as a switch that closes to ground, usin
under “Digital Input Functions” on page 331.

Wireless Remote Control You can use an AIRLINK wireless remote contro
AIRLINK RECEIVER to a SMARTPAX port and co
“Connecting through SMARTPAX for Interactive

Each button on the AIRLINK will appear in the D
input switch. Link task starting conditions to the 

MIDI A MIDI keyboard, pedal or continuous controlle
used as an input. For keyboards and other MID
lighting consoles) add a Switch device for each 
Input” on the Type pop-up menu in the device’s 
the device information database for more detail

Likewise, to read a MIDI Continuous Controller 
choose “MIDI:Control Change” on the Type pop
inputs, you need to use one of the relational sym
determine when to start the associated task.
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Compound Conditions You may sometimes want to combine multiple inputs to create a more complex 
triggering condition. For example, you may want a task to be started when a 

c sensor is also activated, or only if it’s 
 conditions can be programmed into the 
indow, using the symbols on the Symbol 

is the “and” symbol, which performs the 
. For example, to trigger a task if both 
n, enter a condition like this:

:Input On

lational operators. For example, to start 
d Sensor2 is not activated, do this:

:Input On = 0

 device named Clock, you could make it 
:00 PM:

ime < 17:00:00

tatus Properties” on page 54 for more 
button is pressed, but only if a specifi
before five o’clock in the evening. Such
Condition field of the task in the Task w
menu. 

The most common symbol in this case 
task if both input signals are available
the Sensor1 and Sensor2 inputs are o

Sensor1:Input On & Sensor2

You can also use the comparison or re
the task when Sensor1 is activated an

Sensor1:Input On & Sensor2

Or, assuming you have a system clock
start on Sensor1 provided it’s before 5

Sensor1:Input On & Clock:T

See “Conditions Based On Multiple S
details.



e flexibility in terms of user 
wired input switches. You can 
s light or sound levels. Feed-
g buttons and indicators as 

s showing analog values. You 
 graphics.

n sensor, which you can 
ctivated. The red buttons on 
rammed in the same way.

f how to use TOUCHLINK. 

ame way as a hard-wired 
n:

t “Virtual”.

perty of the virtual switch.

desired action (usually “Mo-

tput On” status property of the 

l button to a function, you can 
nctions. For example, if you 
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Touch Panels A TOUCHLINK touch panel provides the ultimat
interface. You can use buttons like you use hard-
also use sliders to control analog values, such a
back can be provided to the user b y highlightin
their functions are activated or using bar graph
can also use sounds, numeric readouts, text and

Furthermore, TOUCHLINK also contains a motio
program to perform any system function when a
the right hand side of TOUCHLINK can be prog

The following sections provide some examples o
Please refer to Chapter 6 for more details.

Buttons and Sliders A button on a TOUCHLINK can be used in the s
button. Follow these steps to create such a butto

• Add a Switch device to the Device window.

• Open its configuration dialog box and selec

• Draw the button on the panel.

• Link the button to the “Output On” status pro

• Open the button’s dialog box and select the 
mentary”) on the Action pop-up menu.

• Link your task triggering condition to the “Ou
virtual switch device.

In addition to this indirect way of linking a pane
also link panel items directly to specific device fu
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want to make a button start a tape deck, simply link it directly to the “Trans-
port:Play” status property of the tape deck.

rties can be controlled either using 
s, you can choose any of the Action 
crease or decrease as long as the button 

 page 163, “Slider” on page 170 and 
roperties” on page 160.

clear user feedback can not be over-
ourse, the best feedback is that the user’s 
ent result. However, sometimes this is not 
ase, providing “tentative” user feedback 
a. Furthermore, the user’s attention is 
 entry, so this is a good place to present 

may need to provide:

ke the form of an indicator or the button 
d, or a text message being displayed.

ay before the desired action begins, or 
cation is also a good idea. This can take 
wn text.
Analog, numeric or time status prope
buttons or sliders. When using button
modes, for example make the value in
is pressed.

For more information, see “Button” on
“Linking Panel Items to Device Status P

User Feedback The importance of instantaneous and 
stated in interactive applications. Of c
input gives and immediate and appar
possible for practical reasons. In this c
on the touch panel itself is a good ide
focused on the panel when making the
some feedback.

There are two kinds of feedback you 

• Immediate acknowledgment.

• Indication of progress.

The immediate acknowledgment can ta
itself lighting up, a sound being playe

If there’s going to be a noticeable del
concludes, some kind of progress indi
the form of a bar graph or a count-do



stem is working on providing 
long it will take before some-

ch as a video clip, it can also 
ining running time. If the user 
 5 seconds or 10 minutes to 
nd possibly frustrated.

gress feedback capabilities. 
d to a time or numeric status 
ple, you can provide running-
 Position status property of the 
nding times of the clip as the 
ge 171 for more details.
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In case of delayed start, this indicates that the sy
the requested action. It also gives a hint to how 
thing starts to happen.

For actions that will take a while to complete, su
be a good idea to provide feedback on the rema
can’t tell whether such an action is going to take
complete, this can make her feel out of control a

A TOUCHLINK touch panel provides several pro
You can use a bar graph or a display field linke
property of a device. For a video clip, for exam
time feedback by linking a bar graph to the Time
video player itself, and setting the starting and e
range of the bar graph. See “Bar Graph” on pa

Specify the tape range to be 
indicated here.

The indicator can be oriented 
horizontally or vertically on 
the panel. The sample in the 
dialog box, however, is 
always shown vertically.
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In the same way you can also use a display field to show numeric information. 
Do this by linking the display field to the status property to be shown.

the Indicator panel item, which can also 
function. It is similar to a button, but 
. See “Indicator” on page 168 for more 

lay item to a Text device. Use Note cues 
e the text to be displayed. You can fine-
display item’s dialog box. See “Display” 

e window that can provide the feedback 
er or counter device (see “Timer” on 

hat device.

hics elements – such as lines frames and 
ported from other programs.

using the last four tools in the tool-bar of 
n be further customized after drawing 
nd adjusting the settings in its dialog 

page 174 for more details.

rograms using cut and paste, you may 
d white) graphics or color pictures. For 
 color of the “black” and “white” pixels 
-clicking the picture. Furthermore, the 

ransparent, allowing the background 
h (see “Picture Options” on page 176).
Sound feedback can be provided by 
light up to indicate the status of some 
doesn’t respond to the user pressing it
details.

To provide text messages, link the disp
assigned to that Text device to provid
tune the look of the display inside the 
on page 172 for more details.

If there’s no suitable device in the devic
information, you can add a virtual tim
page 259), and link the indicator to t

Graphics TOUCHLINK supports both basic grap
backgrounds – as well as graphics im

To add basic graphic elements, draw 
the panel window. These graphics ca
them by double-clicking the graphic a
box. See “Line, Frame and Oval” on 

When importing pictures from other p
use either monochrome (i.e., black an
monochrome pictures, you can set the
in the dialog box displayed by double
“white” pixels can be designated as t
color or other pictures to shine throug



RAX. If desired, use a paint 
nd the desired background 

 of eight basic colors. Thus, 
 use the closest color or a mix 
ich method to use is specified 
gram that created the picture. 
ay also choose to render the 
ter specifying a palette of only 
, blue, cyan, magenta and 

 graphics program for details 
ndering options (often called 
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Color pictures can not be made transparent in T
program to create a composite of the graphics a
before pasting it into TRAX. 

TOUCHLINK has a fixed color palette consisting
when rendering color graphics, TRAX will either
of colors that approximate the desired color. Wh
by the picture itself, and is determined by the pro
For greater control of the resulting colors, you m
color picture in a separate graphics program, af
these eight basic colors: black, white, red, green
yellow. Please refer to the documentation of the
on how to set the palette and determine color re
“dithering”).

A picture using dithering to 
approximate the desired 
colors using alternating 
pixels. This may result in a 
grainier look.

The same picture without dith-
ering uses the closest possible 
colors, sometimes resulting in 
poor color fidelity.
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Pages In designing your panel’s user interface, you may want to limit the number of 
options presented to the user at any one time. This reduces the perceived 

o be used to guide the user in a desired 

 group related options. You can use a 
ng the button to the page number status 
n page 160), or you can use a cue in a 

rogrammatically.

e basic set of options across a range of 
ommon background picture or a button 
hen use a background page to hold all 
ckground page using the “Background” 
n the foreground page is displayed, the 
ill also be shown, and can be operated 
e 157 and “Background Pages” on 
complexity of the system, and can als
direction.

Use separate pages in TOUCHLINK to
button to go to another page (by linki
property of the panel itself, as shown o
task or along a timeline to control it p

Sometimes you need to present the sam
pages. This could, for example, be a c
to return to the previous menu level. T
those common elements. Select that ba
arrows on the foreground page. Whe
elements from the background page w
in the same way. See “Pages” on pag
page 159 for more details.

Background 
page.



uch as a lighting dimmer or a 
s. These devices behave just 

hey don’t have any physical 

at isn’t provided by a real 

o starting conditions of tasks.

ple, to track the number of 
e, you could start a task when 
 value of the virtual Still Store 
y turnstiles or other sensors at 

amed “People”. Note that its 
see the two sensors at the 
the cues that increase and 
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Virtual Devices In addition to the real devices in your system – s
video player – TRAX also provides virtual device
like real devices from TRAX’ point of view, but t
counterparts in the system.

Such virtual devices serve two main purposes:

• They can keep track of some system status th
device.

• They allow panel items to be linked directly t

System Status Tracking You can use a virtual Still Store device, for exam
people in a room. By referring to this virtual devic
the number of visitors exceed a certain limit. The
visitor-counter can be increased and decreased b
the entrance and exit doors.

In the example above, you can see the counter n
counter value is displayed in the icon. You also 
entrance and exit. In the Task window, you see 
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decrease the counter when the inputs are activated, as well as the timeline 
that’s started when the number reaches 10.

p track of how much time has elapsed 
en start the show if it’s more than 8 
eone in the room, even if there are 

complished by using a second virtual 
 on page 259). This timer will be re-
each show. You can then add a task to 
rol cue that will start the main show time-
n 8 minutes and there’s someone in the 
In this case, you may also want to kee
since the show was last started, and th
minutes ago, provided that there’s som
fewer than 10 people. This can be ac
device, acting as a timer (see “Timer”
started from zero at the beginning of 
the task list consisting of a single Cont
line when the elapsed time is more tha
room.



 linking the buttons and other 
wever, sometimes you may 
nce of events, rather than just 
ished using a virtual device as 
 task.

k the button to the switch, and 

n to start a task. Put a cue on 

 performed for as long as the 
 tasks. To make the task run 
 down, select “While True” in 

to be started when turned on 
s False” in the Task window to 
en the button is turned on or 
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Panel Item Linking You can control device functions from a panel by
items directly to the devices to be controlled. Ho
want to start a more complex action, or a seque
controlling a single device. This can be accompl
an intermediary between the panel item and the

For single buttons, use a virtual Switch device. Lin
set its Action pop-up menu as follows:

• Use “Set To” when you simply want the butto
the timeline to turn the switch off again.

• Use “Momentary” if you want an action to be
button is held down, or to activate single-cue
repeatedly as long as the button is being held
the Task window.

• Use “Toggling” if you want different actions 
and off. Select “Becomes True” and “Become
specify whether the action is to be started wh
off.
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Multiple Choices Use a virtual Still Store device to manage a set of buttons representing a 
multiple choice selection, such as a language menu including English, French, 

ber represent each language; e.g. 1 is 
umeric value 0 can in this case indicate 

 to this virtual Still Store device, select 
 each button’s dialog box, and enter the 
ge in the field next to the Action pop-up 

e user’s choice, test the value of the 
 conditions for the tasks using the “Is 
er of the appropriate language choice.
German and Spanish. Make one num
English, 2 is French, and so on. The n
that no choice has been made yet.

Link all the language selection buttons
“Set To” on the Action pop-up menu in
number corresponding to each langua
menu.

To start the desired action based on th
virtual Still Store device in the starting
Equal to” symbol, specifying the numb



information through the panel:

junction with a display or bar 
rogress indicator. 

o display fields.

ndicator on or off.

 you can provide the same 
ems to the same device status 
s, this will be automatically 
 status property.
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Feedback to Panels You can use virtual devices to provide feedback 

• Use a virtual Still Store or Time device in con
graph item as a clock, countdown timer or p

• Use a virtual Text device to put messages int

• Use a virtual Switch device to turn a simple i

If using several pages, or more than one panel,
information on them all by simply linking their it
property. When the status of the device change
reflected by all panel items linked to that device



Chapter 9: Interactivity 257

Timing TRAX excels at combining event-based and time-based actions – more tradi-
tional interactive authoring tools typically only provide the former. In addition 

elines, you can also have actions occur 
er-specified timers.

ns must be triggered with the highest 
ns, represented by cues along the time-
 of 0.01 second (one hundredth of a 
 about timelines.

onized to any device in the system 
on. This provides excellent long term 
 external device even if its speed varies 

hronizing to an Intelligent Device” on 
re information on how to synchronize a 

 condition in the Task window, just like 
ting Condition for a Task” on page 53). 
ing Control cues. When a timeline starts 
 of locking the target timeline to the orig-
ore like an extension of the originating 
ent timeline. This is determined by the 
l cue used to start the timeline (see 
to the precision timing provided by tim
based on time-of-day, calendar or us

Precision Timing Use one or many timelines when actio
possible timing precision. Those actio
lines, can be placed with an accuracy
second). See Chapter 3 to learn more

Furthermore, a timeline can be synchr
capable of supplying timing informati
precision, as the timeline will track the
slightly, or drifts over time. See “Sync
page 222 and following pages for mo
timeline to a device.

The timeline is triggered by a starting
other actions (see “Specifying the Star
Timelines can also start each other us
another timeline, you have the option
inating timeline – making it perform m
timeline – or to start it as an independ
“Synchronize To” option in the Contro
page 214).



using the clock built into the 
 add a Time device to the 
System Clock” on the Type 
ime” on page 152 for more 

the action to the Task list as 
 “Time” status property of the 

 the example on page 53.

started under a number of dif-
cue tasks, each with its own 
get timeline and choose “Run” 
e” on page 212).

r year in the same way, using 
ous section. You can combine 
symbol to trigger an action at 

k:Time > 9:00:00.00

xcept during July:

ode:Month:July = 0

k” on page 53 for more 
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Time of Day Actions can be started at a certain time of day, 
computer as a time source. To access this clock,
device window, and choose “Apple:Macintosh 
pop-up menu. Name the device “Clock”. See “T
details.

To start an action at a certain time of day, add 
either a single cue or a timeline. Then refer to the
Clock device in the Condition field, as shown in

◆ HINT: If you want an existing timeline to be 
ferent conditions, simply add single Control 
starting condition. Specify the name of the tar
inside those control cues (see “Target Timelin

Date, Day, Month You can refer to the date, day of week, month o
the same Time device as mentioned in the previ
the time with, say, the weekday using an “and” 
a certain time only during specific days:

Clock:Mode:WeekDay:Saturday & Cloc

Or, to trigger an action at 5:00 PM every day e

Clock:Time > 17:00:00.00 & Clock:M

See “Specifying the Starting Condition for a Tas
details.
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Timer You can use a virtual Time device to create a timer. That timer can act either as 
a countdown timer, or as a stopwatch. The current timer value can be 

 panel simply by linking the display item 

ogramming tasks. Let’s say you want a 
ressed for more than five seconds. If it’s 
ould start another action. This can be 
 The timer acts as a stop-watch, which is 
hen the button is released, either of two 
hether the elapsed time is more or less 

to set the timer back to zero using a 
 by the button as soon as the timeline is 

 in a way similar to the timer described 
d to count the number of times a certain 

rs, or other statistics.
displayed in a display item on a touch
to the timer device.

You can also use timers for specific pr
button to start an action only if it’s dep
depressed less than five seconds, it sh
handled by one timer and three tasks.
started when the button is pressed. W
timelines are started, depending on w
than five seconds.

The first thing both the timelines do is 
Locate Time cue, ready to be restarted
finished.

Counter You can use a virtual Still Store device
in the previous section. This can be use
option is chosen, the number of visito



el using a display item simply 
. It can also be used to make 
 tasks. See the example under 

atched against a fixed limit. 
e correct limit in advance, but 
his can be handled using two 
r controlled by buttons on a 

ices for the counter and for the 
 update the visitor counter, as 
o buttons on the panel directly 
d “Decrease” respectively on 
 to show the current counter 

pare the visitor counter to the 
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The value of the counter can be shown on a pan
by linking the display item to the counter device
decisions by including it in starting conditions for
“System Status Tracking” on page 252.

That example shows how the counter value is m
Sometimes it may not be possible to determine th
you may want to be able to adjust it as needed. T
counters; one driven by the sensors and the othe
touch panel. To do this, use virtual Still Store dev
limit value. Add cues triggered by the sensors to
shown in the example on page 252, and use tw
linked to the limit counter. Choose “Increase” an
their “Action” pop-up menus. Add display fields
and limit values.

Finally, adjust the task’s starting condition to com
limit counter instead of a fixed value.

Buttons to adjust the number of 
people required to start the show.
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Branching If you want to create a traditional, menu-based, interactive system – where the 
user is led through a hierarchy of selections – then use separate timelines for 

ads the user through a number of levels, 
l. Generally, you should try to keep the 
ber of choices at each level – to a 

by drawing the menu structure. This is 
rting point is at the root. Each branching 
c information and buttons, usually 
 user makes a choice at a node, that will 
 a direct jump, or it can be a “passage” 
g the way.

e created in TRAX using a TOUCHLINK 
OUCHLINK page represents each node 
ws” along the passages between nodes.

 such an interactive presentation can be 
w the pages representing each node in 

jump to the desired pages or start the 

es can be linked to the page number in 
 next page). In the same way, you may 
ck to previous pages. This gives the user 
as made.
each branch. Such a system usually le
with a choice to be made at each leve
number of levels – as well as the num
minimum to avoid confusion.

When designing such a system, start 
often depicted as a tree, where the sta
point (node) is associated with specifi
presented on a touch panel. When the
take him to the next node. This can be
which presents some information alon

Such an interactive presentation can b
touch panel for the user interface. A T
in the tree. Timelines run the “mini-sho

Most of the programming required for
done in the panel window. Simply dra
the tree, then program the buttons to 
desired timelines.

Buttons that jump directly to other pag
the panel’s icon (see the picture on the
want to provide a button that jumps ba
a way out in case the wrong choice w

1

3

42

6
75

10
11

12
13

9
8

Starting point

Jump
Passage



tation of some information, 
“Multiple Choices” on page 
e at a time, you can use the 
Simply give each choice a 
ice” device to that number.
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For buttons that are meant to result in the presen
link the button to a virtual Still Store device (see 
255). As the user can only be at one node/pag
same virtual Still Store device for all the nodes. 
number, and program the button to set the “cho

If a button simply jumps to another 
page then link the button to the 
desired page number of the panel 
itself. Open the button’s dialog 
box and enter the page number 
into the field next to the “Action: 
Set To” pop-up menu.

For buttons that should result in 
the presentation of some informa-
tion, link the button to a virtual Still 
Store device.

Combine the page and the choice 
in the Task window to start the 
timelines when appropriate.
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Use a timeline to create the actions according to the user’s choice. As the 
starting condition for each such timeline you need to combine the page number 
with the choice number using an “and” symbol.

a good idea to display another page on 
sentation is running. This could provide 

ss information for the presentation 
 the timeline, return to the page that 
device back to zero to re-set the choice 
While running a lengthy timeline, it’s 
the touch panel, indicating that the pre
a Stop button as well as some progre
segment that is running. At the end of
started it, and set the virtual “choice” 
buttons.



ERIAL 
ERS

rs to control devices equipped 
 is useful if you need to control 
le device driver. The informa-

of serial data communication.

 TRAX and SMARTPAX how to 
river available. Although stan-
 ability to make custom drivers 
 new device. Assuming that 

ou can have your serial driver 

 than most of the standard 
wer and functionality of a 
rial driver’s performance is 
, some of the standard drivers 
same lines as a custom-made 
10
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10 CREATING S
DEVICE DRIV
This chapter describes how to create serial drive
with an RS232, RS422 or MIDI control port. This
a device for which there isn’t any readily availab
tion in this chapter assumes a basic knowledge 

The Purpose of a Serial Driver By creating a serial device driver, you can teach
control a device for which there is no standard d
dard drivers are available for many devices, the
can prove useful if you quickly need to control a
you have all the relevant information at hand, y
up and running in a matter of minutes.

Although a serial driver is simpler in its structure
device drivers, it can still provide much of the po
standard driver. For many types of devices, a se
good enough for all kinds of applications. Indeed
supplied with TRAX are made along exactly the 
serial driver.
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When you create a serial driver, you tell TRAX which commands the device 
can handle as well as which data bytes need to be sent to the device so that it 
performs these commands. Each command is given a descriptive name, which 

and from within a Trigger cue.

modes, you tell TRAX which commands 
, most modern video projectors have 
 control protocol for the video projector, 
n the various inputs. Although these are 
e source mode of the projector. That’s 
ther and collectively call them the Source 
odes, such as Stand-By which has only 

ction makes it easier to use the driver. It 
e more reliable as TRAX keeps track of 
 when jumping forward or backward 
sible if all commands were entered en 
Chapter 10:

is later used when accessing the comm

By grouping commands together into 
work together and how. For example
several video inputs. In the serial data
there are commands to switch betwee
separate commands, they all affect th
why it makes sense to group them toge
Mode. The projector may have other m
two commands: On and Off.

Grouping commands according to fun
also makes the operation of the devic
the state of each mode independently
along a timeline. This would be impos
masse.



nt to the device can be 
2 or RS422 serial ports use 

evices controlled through MIDI 
escribed in this chapter allow 
egardless of whether they use 

formation Interchange, and is 
formation into computer data 
ta communication line. Serial 
ing controlled. Each data byte 
ows some ASCII characters as 

ry form when creating serial 
For devices not using ASCII 
nt the data bytes.

escribing serial data. One of 
ol listings that describe the 
le device.
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ASCII Encoding There are many ways in which the data bytes se
encoded. Many devices controlled through RS23
ASCII encoding for their commands. However, d
ports never use ASCII encoding. The methods d
you to create most kinds of serial data drivers, r
ASCII encoding or not.

ASCII stands for American Standard Code for In
a standardized way of encoding alphanumeric in
bytes, such as those transmitted over a serial da
drivers transmit such data bytes to the device be
consists of eight data bits. The table to the left sh
well as their corresponding binary values.

You never need to deal with the data in its bina
drivers. ASCII encoding is assumed by default. 
encoding you can use HEX encoding to represe

ASCII and HEX are the most common ways of d
these two formats is normally used in the protoc
communication language of a serially controllab

ASCII Char Binary Form

SPACE 00100000

& 00100110

1 00110001

2 00110010

A 01000001

z 01111010

Examples of ASCII encoding.



 Creating Serial Device Drivers 267

HEX Encoding HEX encoding is often used for devices that don’t use ASCII encoding. HEX 
encoding is closer to the actual binary representation of the data. In the HEX 

 byte is represented by two digits with 

 sixteen different values, our normal ten 
l 16 values. This is solved by simply 
y using the first letters of the alphabet.

EX digit A with the ASCII character A. 
 value, as you can see in the tables.

e HEX digit, it takes two HEX digits to 
e, a byte is written as two digits. This 
, the binary value and the HEX value of 

 characters, TRAX precedes each two 
 §7A.

HEX Form

20

26

31

32

41

7A
Chapter 10:

encoding scheme, each eight bit data
each digit representing four bits.

As four binary bits can accommodate
digits are not sufficient to represent al
adding six more “digits” at the end b

▼ CAUTION: Do not confuse the H
They do not have the same binary

As four bits can be represented by on
represent an eight bit data byte. Henc
table shows the ASCII character code
some data bytes.

To distinguish HEX bytes from normal
digit HEX byte with a § sign, like this:

HEX Digit Binary Form

0 0000

1 0001

2 0010

3 0011

4 0100

5 0101

6 0110

7 0111

8 1000

9 1001

A 1010

B 1011

C 1100

D 1101

E 1110

F 1111

ASCII Character Binary Form

Space 0010 0000

& 0010 0110

1 0011 0001

2 0011 0010

A 0100 0001

z 0111 1010



at you have all the required 

 thoroughly familiar with the 

port (data rate, stop bits, par-

nds, showing either the ASCII 
 device.

 is the grouping of commands 
ve a thorough understanding 
sed in your application. If 
g acquainted with all aspects 
te to each other.
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Before You Begin Before you start making the driver, make sure th
information at hand, including: 

• The actual device itself.

• The user’s manual of the device, or someone
device.

• The wiring of the serial port.

• The communication parameters of the serial 
ity, handshaking, etc.).

• A complete and up-to-date list of all comma
characters or the HEX codes to be sent to the

Understand the Device The most crucial aspect of creating a serial driver
into modes. Before you can do this, you must ha
of how the unit works as well as how it will be u
you’re new to the device, spend some time gettin
of the device, and how its various functions rela
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Commands and Modes It’s a good idea to start with pen and paper. List all the commands you intend 
to use by writing all closely related commands down together. Each such group 

command in a group sets the mode into 
or example, the commands for the Input 
Video1, Video2 and RGB. Modes typi-
es. Use a separate piece of paper for 
e of these pieces of paper, find that two 
ell be in effect at the same time, you will 

s:

 the various video inputs on a video pro-

ly On and Off. The Stand-By mode of the 
l candidate.

gmented by a numeric value. This could, 
de of a video projector.

 kinds are also possible. Indeed, in some 
u decide to think of a mode as a number 
h a numeric value.
Chapter 10:

of commands is called a mode. Each 
a specific state. In a video projector, f
Mode could set it to one of the states 
cally consist of mutually exclusive stat
each mode. If you, when looking at on
or more of the commands could very w
have to think again.

There are three typical kinds of mode

• Modes with multiple states, such as
jector.

• Modes with only two states; typical
video projector would be a typica

• Modes with only one state that is au
for example, be the Brightness mo

Combinations of the first and the third
cases, it is mostly a matter of taste if yo
of independent states or one state wit



as an external video switcher. 
igh-end video projectors. The 
ds to switch between the 
ended set of commands to 
er box. Assuming that the 
e of the projector could be 
able 1.
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Commands with Numeric 
Values

Consider, for example, a video projector which h
This is a common way to extend the capacity of h
control protocol then typically includes comman
various internal video modules, and then an ext
switch to any of the inputs on the external switch
external switcher has six inputs, the Source Mod
considered as having nine states, as shown in T

Video 1
Video 2
RGB
External 1
External 2
External 3
External 4
External 5
External 6

Table 1
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Alternatively, you could view it as having only four states, of which the last state 
takes a numeric value specifying the input number on the external switcher, as 
shown in Table 2. Here <n> represents a number designating the input on the 

on the external switcher, the first method 
 external switcher has 100 inputs, a list 

ould be impractical. In this case, the 
.

combinations, and then some, but it is 
etails before you start entering the 
Chapter 10:

switcher. If there are only a few inputs 
may feel most natural. However, if the
with a separate item for each input w
second method is certainly preferable

Serial drivers can handle all of those 
essential that you figure out all such d
commands into TRAX.

Video 1
Video 2
RGB
External <n>

Table 2



 have the appropriate cable 
taton RS232 or RS422 smart-

ink cables:

except 3488 which is an 
S232 and RS422 is that the 
 transmit and receive signals 
 makes RS422 more reliable 
speeds.

r of the plug at the device end 
emale connector on the back, 
rsa.

u select the correct cable for 
iagram of all the cables. Some 

7 
n 
le

3488 
9-pin 
male

Device 
Signal

8 > RxD

2 < TxD

— > TxReady

— < RxBusy

7 < Tx Gnd

3,4 > RxGnd
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Hardware Interface In order to get the driver to work, you must also
available. In many cases, one of the standard Da
links will work. This is the wiring of some smartl

In the table above, all the cables are for RS232 
RS422 cable. The primary difference between R
former have a common ground-pin for both the
while the latter have separate ground-pins. This
when used over longer distances and at higher 

The terms “male” and “female” refer to the gende
of the smartlink cable. Thus, if the device has a f
you need a cable with a male plug, and vice ve

◆ NOTE: The table shown above is to help yo
your application. It is not a complete wiring d
cables may contain additional components.

SMARTPAX
Signal

Wire 
Color

3480 
25-pin 
male

3486 
15-pin 
male

3487 
25-pin 
female

348
9-pi
fema

4 TxD > Yellow 3 3 3 2

2 RxD < Red 2 2 2 3

5 DTR > Green 5,6 — 5,6 6,8

1 Busy < Brown 20 4 20 4

3 RxGnd < Orange 7 1 7 5

8 TxGnd > White 7 1 7 5
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The “<“ and “>” signs in the table indicate the signal direction. Thus, data is 
transmitted from SMARTPAX on pin 4 and is received on pin 3 by a device 
connected through a 3480 smartlink cable. The description of signal directions 

ocumentation for devices, depending on 
 or a DCE. Look for indications of signal 

 the signals. An RS232 break-out box 
 be very useful when trying to figure out 

AX port) is used to implement hardware 
age 275). This must be connected if the 
 signal when it is ready to receive more 
nal from SMARTPAX pin 5 is not used by 

ropriate, you can make your own cable 
uct number 3450, see picture on 
connector that plugs into the SMARTPAX 
igtail” on the other, ready for soldering 
r nine-pin connectors in the SMARTPAX 
urely into the SMARTPAX, which may 
Chapter 10:

can sometimes be misleading in the d
whether the device is considered a DTE
directions in addition to the names of
with LED indicators for the signals can
how a device is really wired.

The Busy input (pin 1 on the SMARTP
handshaking (see “Handshaking” on p
device uses hardware handshaking to
data. The DTR handshaking output sig
serial drivers.

If none of the cables above seem app
based on an AUXILIARY CABLE (prod
page 339). This cable has the locking 
already attached on one end and a “p
your own connector. Avoid using othe
end of the cable as they don’t lock sec
cause reliability problems later on.



that determine the data signal 
, looking for the proper setting 

smission. Common values are 
 is switch-selectable on the 
the highest available rate.

cluded with each data byte. 
it may be either Odd or Even.

t in each “packet” of data. 

a start bit and a stop bit, to 
ay require two stop bits, but 

e signals it is busy to the 
g.

d between commands. Most 
 on page 276).
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Data Rate, Parity, etc. You also need to find out how to set parameters 
format. Check the protocol manual for the device
for the following parameters:

Baud rate. Determines the speed of data tran
1200, 4800, 9600 and 38400. Sometimes this
device, in which case you should generally use 

Parity. This is a simple check bit that can be in
Most devices don’t use parity checking. If used, 

Data Bits. The number of information bits sen
Virtually all devices use eight data bits.

Stop Bits. Each data packet is surrounded by 
indicate its beginning and end. Some devices m
this is very unusual.

Handshaking. This determines how the devic
SMARTPAX. Most devices don’t use handshakin

Delay. An additional delay that may be neede
devices don’t need any extra delay (see “Delay”
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Handshaking Handshaking is sometimes used as a way for the device to tell SMARTPAX that 
it is currently busy and unable to receive any more commands. In this case, 

until the device signals it is ready, before 

eck which method is used. These are 

cable is used to signal that the device is 
input on the SMARTPAX (see “Hardware 

nt by the device to signal it is busy. This 
ls. The “busy” character is §13 (DC3) 
1).

ata byte back to the SMARTPAX once it 
MARTPAX will automatically consider 

sent, until it receives a byte back. Note 
 be the same byte as the one sent – any 

e Byte Echo mode, but in this case the 
nt byte or sequence of bytes back once 
hich may have consisted of multiple 
ode handshaking.
Chapter 10:

SMARTPAX can be configured to wait 
sending the next command.

If the device requires handshaking, ch
some common handshaking methods:

Hardware. A separate wire in the 
busy. This has to be wired to the Busy 
Interface” on page 272).

Xoff-Xon. A special character is se
is only used with ASCII-based protoco
and the “ready” character is §11 (DC

Byte Echo. The device sends each d
has received and processed it. Thus, S
the device to be busy after each byte 
that the byte returned doesn’t have to
data byte will do.

Acknowledge. This is similar to th
device sends a special acknowledgme
it has completed the last command, w
bytes. This is sometimes called block-m



 before they will reliably 
e indicated by handshaking. 
ented, in which case adding 

nders.

lways described in the manual 
 error that the device behaves 
ou do come across this, first 
king. If it doesn’t, you must try 
etween commands to make 

cording to the command.

ave the complete and up-to-

ing up the device to a regular 
he commands. This works best 
ual often contains the proper 
ac. Use a communications 
ke sure you set the communi-
o the device’s specifications.
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Delay Some devices need extra time after a command
execute the next command. This should ideally b
Unfortunately, handshaking is not always implem
some extra delay after commands can work wo

This is one of the trickier parameters as it is not a
for the device. You often only find out by trial and
unreliable if commands are sent too rapidly. If y
double-check if the device supports any handsha
to figure out how much extra delay is required b
them work reliably. The delay time may vary ac

Protocol Listing Before you can start, you must make sure you h
date command list of the device.

If any details in the protocol are unclear, try hook
computer or a terminal and experimenting with t
if the protocol is ASCII based. The protocol man
wiring for connecting the device to a PC or a M
program to put the device through its paces. Ma
cations parameters (baud rate, etc.) according t
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Points to watch out for when evaluating the protocol in this way are how the 
commands begin and end, and how numeric parameters are sent (if appli-
cable). Some protocols use special lead-in and lead-out sequences, such as 

r a carriage-return character. These are 
l listing and then omitted in the descrip-
 misleading.

meters, make sure you understand how 
d, and the number can be greater than 
 required for numbers that don’t use all 

arameters are expressed as ASCII-
thout leading zeros.

the most complicated to evaluate as such 
inal emulation program. Refer to the 
e if and how non-ASCII characters can 
eric parameters in non-ASCII protocols 
u encounter problems, you’re always 
ler. You can also use Dataton’s HotFax 
-10 24 51, or send e-mail to 
Chapter 10:

brackets, special control-characters o
often discussed up front in the protoco
tion of each command, which may be

If some commands take numeric para
they are sent. If ASCII encoding is use
nine, check to see if leading zeros are
digit positions. Sometimes, numeric p
encoded HEX bytes, again with or wi

Binary protocols (i.e., non-ASCII) are 
data can’t be easily sent using a term
manual for the terminal program to se
be sent. The proper formatting of num
can also be difficult to figure out. If yo
welcome to contact your Dataton dea
technical support line at fax int+46-13
support@dataton.se.



a serial driver, you can open 
RAX distribution disk. To open 
X application, then start TRAX 

e-clicking the file itself. You 
rt TRAX, and then open it from 
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Editing an Existing 
Driver

To familiarize yourself with the look and feel of 
one of the sample serial drivers included on the T
the driver, move it to the same folder as the TRA
by double-clicking the application program.

◆ NOTE: You can’t open driver files by doubl
must move it to the TRAX folder before you sta
within TRAX.

Select “Device Drivers, Manual 
Mode” to reveal the Create and 
Edit buttons.
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1. Choose the Device Support command on the Window menu.

2. Select “Device Drivers, Manual Mode” on the pop-up menu at the bottom 
tton.

of the window to open the driver.

separate driver files in the TRAX folder 
’t edit any of the standard drivers built 
only active when you have selected an 

ght corner of the serial Device Driver 
parameters. Browse among the various 
e the data strings corresponding to the 
data string, click the Set/Change button 
og box. Finally, click Cancel to leave the 
ng any changes you may have made.

rivers you have made, or drivers made 

ditor dialog boxes in detail.
Chapter 10:

of the window to reveal the Edit bu

3. Scroll down to the serial drivers.

4. Select the driver you wish to open.

5. Click the Edit button at the bottom 

◆ NOTE: Only drivers that exist as 
can be edited in this way. You can
into TRAX itself. The Edit button is 
editable driver in the list.

Use the Settings button in the upper ri
dialog box to see the communication 
modes and states in the two lists to se
commands. For more details about a 
at the bottom of the Device Driver dial
Device Driver dialog box without savi

You can use this method to edit any d
by other TRAX users.

The next sections describe the driver e



ved in creating a serial driver. 
) is used as a case study. This 
oubler equipped with an 

evice Support window via the 
ode” on the pop-up menu at 

 button, located at the bottom 
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Creating a Driver This is a detailed description of all the steps invol
The IN1224 from Inline Inc. (La Habra, CA, USA
is a combined video/audio switcher and scan-d
RS232 control port.

To create a serial driver, start by opening the D
Window menu. Select “Device Drivers, Manual M
the bottom of the window. This reveals the Create
of the window.

Our case study: the Inline IN1224 
switcher/decoder/scan doubler.

Select “Device Drivers, Manual 
Mode” to reveal the Create button.

Create button.
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Click the Create button. This displays a small dialog box where you enter the 
name of the device for which you are about to create a driver. The name 
normally consists of two parts – the manufacturer and the model – separated 

 manufacturer’s name to avoid any 
er for this device.

er editor appears. This is where you will 
mands. Before you start entering 
 configure the data-rate and other 
Chapter 10:

by a colon. Enter “Test” instead of the
conflicts with an already existing driv

The main dialog box of the serial driv
enter the names of all the device’s com
commands, click the Settings button to
communications parameters.

Use a fake name here to not inter-
fere with a name of an existing 
serial device driver.

Click the Settings button.



e technical reference manual 

, 1200 baud (factory 

a serial device driver, so you 
s settings. The Delay setting 
d into the command strings 
 this case as we won’t use this 

shaking, acknowledging each 
d by sending OK back to the 
ified on the Handshake menu 
special character into the 
ledgment is expected (see 
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Driver Settings The section about communications protocol in th
for the IN1224 – our case study device – states

“8 data bits, 1 stop bit, No parity check
default setting).”

Incidentally, this matches the default settings of 
don’t have to change any of the communication
specifies additional delays that can be introduce
using the ≈ character. You can ignore this field in
feature.

Our case study device features block-mode hand
command that is properly received and execute
SMARTPAX. Block-mode handshaking isn’t spec
in this dialog box – it is specified by entering a 
command strings at the point where an acknow
“Acknowledge” on page 310).
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The following is a complete description of each field in the Serial Device Driver 
Settings dialog box.

as it will appear in the list in the Device 
ormally of two parts; the name of the 
 the device being controlled. The parts 
ctual name of a device, rather than a 
the right driver.

ates a hierarchical organization of 
 driver with the DEVICE button on the 
 Button” on page 322).

 of a driver simply by changing its file-
e driver is first created, the filename is 
owever, owing to limitations in the Mac 

wed to contain colons. Hence any colon 
ace in the file name. You can freely 
m the Finder without affecting the name 
e of the driver, open the Driver Settings 

river file away from the TRAX folder. 
s unless they are in the same folder as 
.

Chapter 10:

Device This is the name of the device driver, 
Support window. The name consists n
manufacturer and the model name of
are separated by a colon. Using the a
generic name, makes it easier to find 

The colon in the device name also cre
drivers. This is used when choosing a
SMARTPAX front panel (see “DEVICE

Note that you can’t change the name
name in the Mac OS Finder. When th
based on the driver name you enter. H
OS file system, file names are not allo
in the driver name is replaced by a sp
change the name of the driver’s file fro
of the driver itself. To change the nam
dialog box and enter a new name.

▼ IMPORTANT: Do not move the d
TRAX will not recognize driver file
TRAX when the program is started



ally enters the name from the 
up” control panel.

ur driver. You should update 
 changes or additions to the 
TPAX display when the driver 

 panel. If you have made 
version is being loaded into a 
ading the “DrvVer: xx” that’s 
” on page 322).

ing among multiple drivers 
not advisable, it is possible to 
ing a driver with the same 
ith the highest version number.

 or standard) can be seen by 
 and clicking the Info button. 

taining the driver is displayed 
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Creator Enter your name here.

When the driver is first created, TRAX automatic
Owner Name field in the Mac OS “Sharing Set

Version This number identifies the version number of yo
this number whenever you make any significant
driver. The version number is shown in the SMAR
is selected using the DEVICE button on the front
enhancements to a driver, it’s easy to tell which 
particular SMARTPAX unit by choosing it and re
briefly shown in the display (see “DEVICE Button

TRAX also uses the version number when choos
having the same type and name. Although it is 
have two files (with different file names) contain
name. In this case, TRAX will chose the driver w

The version number of any driver (custom-made
selecting the driver in the Device Support window
The version number and the name of the file con
at the bottom of the scrolling text field.
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Date When a driver is created, Date is set to the current date according to the clock 
built into your computer. You may want to change this field if you revise the 

u to specify the data-rate – or “baud 
vice. This must be set according to the 
ce will recognize any commands.

ers” allowing you to set the data-rate. 
e highest data-rate possible on the 
accordingly. In some cases, however, 
s specified, then use this rate rather than 
u to use a brand new unit if the old one 
 re-configuring it. Furthermore, some 
 data rates.

selecting communication parameters 
 trouble communicating with a device, 
k of the unit, check the technical manual 
jumper settings.

e pop-up menu corresponds to 31250 
 rate used for MIDI data.
Chapter 10:

driver.

Data Rate The Data Rate pop-up menu allows yo
rate” – for communicating with the de
device’s specifications before the devi

Some devices have switches or “jump
Generally speaking, you should set th
device, and then configure the driver 
there’s a factory default setting. If this i
the highest possible, as it will allow yo
should go down, without the need for
devices may work less reliably at high

Some manufacturers put switches for 
inside their products. If you’re having
and can’t find any switches on the bac
for information about DIP switches or 

The MIDI data rate at the bottom of th
bits per second, which is the standard



o the data bits of each byte 
ou can leave this set to None.

unication errors on a serial 
le-bit errors in modem-to-
wever, when controlling a 
s should never occur.

ve the option of selecting 
 set the Parity according to the 

 driver and the device must 
all. You can’t improve the reli-
the driver if the device doesn’t 
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Parity The Parity menu allows you to add a parity bit t
transmitted. In most cases parity is not used, so y

Parity is a simple method of checking for comm
data line. It was originally devised to catch sing
modem communication over telephone lines. Ho
device over a simple cable, such single-bit error

Some devices may still require parity, or may ha
parity using DIP switches or jumpers. In this case,
manufacturer’s recommendations.

▼ IMPORTANT: The parity setting of both the
match, or the communication won’t work at 
ability of the data line by activating parity in 
support this.
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Handshake Many devices need some extra time to process each byte or command received 
from the SMARTPAX. Handshaking is a method by which the device can tell 

h a command and will notify SMARTPAX 

TPAX insists on sending new commands 
portant that you select the right hand-
device does not require handshaking, 

le, and is preferred whenever possible. 
 separate signal wire to tell SMARTPAX 
nected to pin 1 on the SMARTPAX port 
72). SMARTPAX will not send any data 
s being held low in relation to pin 3.

 handshake pin is actually connected to 
evice before activating this mode. If the 
o signal on the pin to which it is connect-
ny data at all.
Chapter 10:

SMARTPAX that it is currently busy wit
when it is through.

In this case, errors may occur if SMAR
to the device before it is ready. It is im
shaking method for such devices. If a 
leave this pop-up menu set to None.

The Hardware mode is the most reliab
In this mode the device will activate a
that it is busy. This signal must be con
(see “Hardware Interface” on page 2
to the device while pin 1 on the port i

▼ IMPORTANT: Make sure that the
a live “read/busy” output on the d
pin is not connected, or if there’s n
ed, SMARTPAX will not transmit a



ode in concept, but is imple-
omes busy, it transmits a 
. This command is referred to 
AX to stop sending data to the 
ceiving new commands, it 
§11, ASCII DC1). This hand-

matically assume that the 
 byte back from the device 
us risk for a deadlock if a byte 
 is temporarily switched off in 

matically resume transmission 
 differs from the previous two 

byte sent by the SMARTPAX, 
h bytes to become “busy”.

n required on the device’s be-

he block-mode handshaking 
 back by the device for every 
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The Xoff-Xon mode is similar to the hardware m
mented in a different way. When the device bec
special “busy” command back to the SMARTPAX
as Xoff (HEX §13, ASCII DC3), and tells SMARTP
device. When the device is again capable of re
signals this by sending an Xon command (HEX 
shaking mode is not very common, though.

In the Wait for Echo mode, SMARTPAX will auto
device is busy after each byte sent, and await a
before sending the next byte. Owing to the obvio
is never received back (for example, if the device
the middle of a command) SMARTPAX will auto
again after a time-out of ten seconds. This mode
in two ways:

• Handshaking is always performed for each 
not just when the device has received enoug

• It is initiated automatically, without any actio
half.

Don’t confuse this byte-level handshaking with t
described next. Make sure a byte is indeed sent
byte received before you select this mode.
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Although not on the Handshake pop-up menu, there is actually a fourth 
method, referred to as block-mode handshaking. This is similar to the Wait for 
Echo mode, but here a response is returned for every command rather than 

 important distinction since a command 
 The response sent by the device after 
cknowledge”.

e on the Handshake menu is that the 
metimes different in TRAX compared to 
e being controlled. What appears to be 

ay sometimes be a sequence of sub-
knowledge byte, from the device’s point 
only used for professional broadcast 
is, where each command consists of 

ub-parts.

 handshaking is evoked by including a 
er in the command string. This character 
ucts SMARTPAX to stop sending further 
ack from the device before proceeding 

 on page 302). 

-mode handshaking, set the “Hand-
pecify the handshaking in the driver 
uest character (see page 310).
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every byte sent to the device. This is an
may consist of several bytes in a row.
each command is referred to as an “A

The reason for not including this mod
desired definition of a command is so
the protocol specification of the devic
a single command on the TRAX side m
commands, each requiring its own ac
of view. The ES-BUS protocol – comm
equipment – is a typical example of th
several, individually acknowledged, s

To handle such situations, block-mode
special Acknowledge Request charact
isn’t sent to the device, but rather instr
bytes at this point, and await a byte b
(see “Entering the Command Strings”

▼ IMPORTANT: When using block
shake” pop up menu to “None”. S
strings using the Acknowledge Req



d for ensuring that the device 
 all devices support hand-
at the device is capable of 

peed, without ever becoming 
 capable of this and which do 

oduced at the appropriate 
mb, devices performing some 
and need the time it takes to 

er commands. The same goes 
sing in the device, such as 
nother, causing it to change 

lf doesn’t introduce any delay 
ong any delays will be. To ac-
sert the special Delay charac-

“Delay” on page 309).

rent actions, enter the shortest 
 use multiple delay characters 
le, set the delay time to 100 
haracters to make a 300 milli-
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Delay Although handshaking is the most reliable metho
has enough time to process each command, not
shaking. In most such cases this simply means th
receiving and processing all commands at full s
“busy”. There are, however, devices that are not
not support handshaking.

To handle such devices, extra delays can be intr
points in the data stream. As a general rule of thu
kind of mechanical action in response to a comm
execute the task before they can receive any furth
for commands requiring a lot of internal proces
switching a video projector from one source to a
its scan-rate.

▼ IMPORTANT: The Delay parameter by itse
into the data stream. It simply specifies how l
tually introduce a delay in the data stream, in
ter at the desired positions in the string (see 

If the device needs different delay times for diffe
delay time required into the Delay field and then
in the string to obtain longer delays. For examp
milliseconds, and insert three successive delay c
second (0.3 second) delay.
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Data Bits This setting determines the number of data bits per byte transmitted by the 
SMARTPAX to the device. You can choose between seven and eight data bits. 

’t select the seven bit mode unless explic-
he device.

 use ASCII encoding of the commands. 
CII character set doesn’t use more than 
 anyway.

ost devices need only one stop bit. 
oesn’t hurt – it simply slows down the 
ing two stop bits can be used as a way 
byte sent. The delay time is fixed to the 
ich can be calculated by dividing one by 
Chapter 10:

Most devices use eight data bits. Don
itly stated in the protocol manual for t

Devices using seven bit data typically
This is possible since the standard AS
seven bits to represent each character

Stop Bits This is another seldom used setting. M
Adding a second stop bit generally d
communication slightly. Indeed, select
to introduce a small delay after each 
time corresponding to a single bit, wh
the data rate.



 box in order to return to the 

arious modes and commands. 
refully prepared for this 
 on page 268.
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Entering the 
Commands

Click the OK button in the Driver Settings dialog
main Serial Device Driver dialog box. 

Now it’s time to start entering the names of the v
To do this, you will need the pieces of paper ca
purpose in the section titled “Before You Begin”

Main serial device driver editing 
dialog box.
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Modes and States Once you’re done with the paperwork, you can start entering the results into 
the Mode and State lists in the dialog box. In the “Before You Begin” section, 

te piece of paper for each logical group 
ach of these papers, giving each group 

hey affect.

ommands for the IN1224, with each 
e:

ds have been chosen to be as descriptive 
e of the driver. We’re not yet concerned 
o perform these commands – only with 

odes which they control.

e Mode list in the dialog box. Likewise, 
d will go into the State list. It is called a 
cuted by the device, will cause the spec-
at state. All the states within each mode 
le, in the list to the left, the Source mode 

tes at a time – it is not possible to select 
neously.
Chapter 10:

you were encouraged to use a separa
of commands. Put a title at the top of e
of commands the name of the mode t

The list on the left shows some of the c
group titled with the proper mode nam

The names of the modes and comman
as possible, in order to simplify the us
with the actual ASCII strings needed t
the names of the commands and the m

The names of the modes will go into th
the names of each individual comman
state because the command, when exe
ified mode of the device to be set to th
must be mutually exclusive. For examp
can only be in one of the possible sta
both Video 2 and RGB Bypass simulta

Mode State

Source Video 1

Video 2

Video 3

RGB Bypass

Mute Off

On

Volume Value <nnn>

Gamma Curve <n>

Some of the IN1224 commands.



st called Anonymous. Use this 
is used more often than the 
probably a good candidate. 
at the top level of the pop-up 
sed to program the driver, 
named modes will appear on 
ence, there are no differences 
 explicitly named, modes.

e mode under the Anonymous 
uld look like;

de.
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The Anonymous Mode As you can see, there’s already a mode in the li
mode if the device has a primary mode, which 
others. In the IN1224 case, the Source mode is 
The states of the Anonymous mode will appear 
menu in the Trigger cue that will eventually be u
thereby making them more accessible. States of 
secondary menus. Except for this cosmetic differ
whatsoever between the Anonymous and other,

Assuming you would enter the states of the Sourc
mode, this is what the pop-up menu choices wo

States of the anonymous 
mode corresponding to 
the video source selection.

Named modes. States of the Mute mo
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If you decide not to use the Anonymous mode, but create a separate, named 
Source mode, the pop-up menu will look like the example shown to the left.

e between using the Anonymous or a 
at have one primary mode (or devices 
ple video switcher with no other func-
erally makes using the driver more 

nymous for the various video sources, 
 State list like this:

Named Source mode.
Chapter 10:

Again, there’s no functional differenc
named mode. However, for devices th
which have only one mode, like a sim
tions) using the Anonymous mode gen
convenient.

Assuming that you decide to use Ano
then enter the command names in the

States of the 
Source mode.



h item into the text field below 
ress the Return or Enter key 
e dialog box. If you do this by 
ox to dismiss it and press the 
ate name. When you’ve 
alog box will look like the one 

dd button next to the Mode 
k to the State list. This list will 
to the Mute mode yet.

mode. Then continue with the 
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When entering the items of the State list, type eac
the list and press the down-arrow key. Do not p
after each item, as this will open the Set/Chang
mistake, click the Cancel button in that dialog b
down-arrow key to continue entering the next st
entered all states of the Anonymous mode, the di
shown on the previous page.

Continue by adding the Mute mode. Press the A
title, type Mute and press the Tab key to get bac
now be empty, as there are no states entered in

Type in the two states Off and On for the Mute 
other modes and their states in the same way.

Click here to add a mode…

…then enter its name here.
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The Default State The order in which you enter the states in each mode is important. Specifically, 
the first state entered into each mode must match the default (power up) state 

ver won’t send any data to the device to 
es that the power-on state of the device 

mode is often not clear from the device’s 
or information about this, or try to figure 

 determine the initial state of some or all 
 particularly careful to ensure that these 
 driver assumes when turned on.

eginning of each show that uses this 
his complicates the use of the driver, 
never possible.
Chapter 10:

of the device being controlled. The dri
set it to its initial state. It simply assum
matches the first state of each mode.

Which state is the default one in each 
protocol list. Check the user’s manual f
it out from the device itself.

Some devices may have switches that
of the modes. In this case, you must be
switches are always set in the way the

Of course, you can add cues at the b
device to set the desired initial state. T
however, and should be avoided whe



 protocol in its manual. At the 
ally some general information 
of the device. If you are lucky, 
 command sequence that will 

 of commands, sometimes with 
this list only includes the 
ard parts – which are identical 
 general description of the 

N1224 – our case study 

ommand code, and an 
 the unit will accept a new 
sponse code; "[OK]" indi-
mand consists of: 

ct Input 4, the RGB input. 
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Command Strings Look up the description of the device’s command
beginning of the protocol description, there’s usu
about the formatting and possible handshaking 
there are also some complete examples of a full
make the device do something useful.

The initial description is usually followed by a list
detailed descriptions of each command.Usually 
central parts of each command, where the stand
for all commands – are simply inferred from the
protocol.

Protocol Format The description in the technical manual for the I
switcher/scan-doubler – is a typical example:

All commands sent to the unit must contain a leading code, the c
ending code. Each command must be completely executed before
command. When a command is completed, the unit provides a re
cates the command was received and executed. A complete com

       [ The leading code 

       CH4 The command code. In this case CH4 would sele

       ] The ending code 

Sample command code: 

       [CH1] Selects Input 1
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This clear and concise description of the protocol format translated into TRAX 
terms means:

d, you won’t need to deal with any HEX 

within square brackets.

ented. The device will acknowledge 
CII characters [OK] back to the SMART-

ing, this particular kind (block-mode 
river Settings dialog box, as you may 
owledge” handshaking mode on 

and acknowledgment is requested by 
mand strings (see page 304).
Chapter 10:

• The protocol is entirely ASCII base
or binary numbers.

• Each command must be enclosed 

• Block-mode handshaking is implem
each command by sending the AS
PAX.

Although there is a form of handshak
handshaking) is not specified in the D
recall from the discussion of the “Ackn
page 275. Instead, this kind of comm
adding a special character to the com



e following command strings:

mmands relevant for this case 

efault setting)

e Input

ue

n function (default)

curve x: 1 - 7
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Command Strings The IN1224 Technical Reference Manual lists th

◆ NOTE: This is not the full list, but only the co
study.

CH1 Select Input 1 (power on d

CH2 Select Input 2

CH3 Select Input 3

CH4 Select Input 4 - RGB Passiv

VOLxxx Set volume level to xxx val

MUTE0 Disable Audio Mute

MUTE1 Enable Audio Mute

GAM0 Disable Gamma Correctio

GAMx Select Gamma Correction 
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This list tells us the following important details:

• Most command strings are short, with no parameter values or other 

ake a numeric value. The Volume com-
o the Gamma command takes a value in 
ero through seven if you include the 
 considered just one more of the GAMx 

ences of ASCII characters. Even the nu-
 are encoded as decimal format ASCII-

 is Input 1 and Gamma Disabled.

n with the same characters, such as the 
M0/GAMx. This helps us group the 

ith mutually exclusive states, as shown in 
Chapter 10:

“extras.”

• Some of the command strings do t
mand takes a three digit value. Als
the range one through seven (or z
GAM0 command, which could be
commands). 

• All the commands are indeed sequ
meric values – where applicable –
encoded data.

• The default (i.e., power-up setting)

Commands that belong together begi
commands CH1 through CH4 and GA
commands into independent modes w
the table to the left.

Mode State

Source Video 1

Video 2

Video 3

RGB Bypass

Mute Off

On

Volume Value <nnn>

Gamma Curve <n>



eric value. In the Volume case, 
they are used or not – so 
n 100.

 (zero and one). However, as 
 give them descriptive names, 
 commands.

esponding name in the State 
uped under the Anonymous 

o the left. Then select Video 1 
utton.
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Numeric Values The Volume and Gamma commands take a num
this value must have three characters – whether 
leading zeros must be added for values less tha

In a way, the Mute command also takes a value
there are only two values, it’s probably better to
such as Off and On, and treat them as separate

Entering the Command 
Strings

To enter the first command string, select the corr
list. As the channel switching commands are gro
mode, you must first select this mode in the list t
in the list to the right and click the Set/Change b
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This displays the Serial Device Driver String dialog box.

o 1 in the text field.

er the brackets around the command, as 
f the test device’s protocol description.
Chapter 10:

Enter the string corresponding to Vide

▼ IMPORTANT: Don’t forget to ent
specified in the overview section o



ial character that tells 
ment from the device. Even 
ust still instruct SMARTPAX to 
ommand must not be sent until 
 to the right of the text field to 
 end of the string.

Click here to enter 
the Acknowledge 
Request character.
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Acknowledge Request At the end of the string, you must enter the spec
SMARTPAX to stop and wait for the acknowledg
though this is at the end of the command, you m
wait for the acknowledgment, as any following c
this one has been acknowledged. Use the button
enter the Acknowledge Request character at the

Acknowledge Request character.
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As the following command strings will look very much like this one, you can 
save some time by copying this command string and using it as a template for 
the next few commands. Select all the text in the text field, then copy it using 

log box. Move down to Video 2 in the 
ialog box. Paste in the string you copied 
H2. Continue in the same way with the 

de, entering the corresponding strings 
” on page 300.

 all the source switching commands then 
left. Enter the command strings corre-
Chapter 10:

the Copy command on the Edit menu.

Click OK to close the Driver String dia
State list and press Return to open its d
from Video 1 and change it to select C
other members of the Anonymous mo
from the list under “Command Strings

When you have entered the strings for
select the Mute mode in the list to the 
sponding to its Off and On states.



el state’s dialog box. This 
r all the characters in the 
til you eventually set the 

e character at the point in the 

ing, the fields at the bottom of 
 width of 3 characters and a 
e field width setting tells 
ters at this point in the string. 
ill add leading zeros as 

, SMARTPAX will only include 

Click here to 
enter the Value 
character.
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Numeric Values Select Volume in the Mode list and open the Lev
command takes a numeric value. You can’t ente
command now as three of them aren’t known un
volume using a Trigger cue. Instead, put a Valu
command string where the number will go.

When you enter the Value character into the str
the dialog box become available. Specify a field
minimum and maximum value of 0 and 255. Th
SMARTPAX that it must always put three charac
For numeric values less than 100, SMARTPAX w
required. If you leave the field width set to Auto

Value character.
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as many characters as necessary to represent the number specified in a Trigger 
cue.

lue fields specify the permitted range for 
enforce the values entered in the Trigger 
vice.

 to the Gamma mode. Open its Driver 
. Enter the Value character after GAM 
orget to add the Acknowledge character 
 Auto and set the Maximum Value field 

ck Save & OK in the main dialog box to 

ot available unless you have entered at 

 of all the items in the Driver String 

 width Width 3

OL0] [VOL000]

OL7] [VOL007]

L25] [VOL025]

L150] [VOL150]
Chapter 10:

Examples:

The Minimum Value and Maximum Va
the numeric value. This will be used to 
cues that will eventually control the de

Close the dialog box and move down
String dialog box and enter the string
and before the closing bracket. Don’t f
at the end. Leave the Field Width set to
to seven.

Close the Driver String dialog box. Cli
save the driver.

◆ NOTE: The Save & OK button is n
least one state into the State list.

The following is a detailed description
dialog box.

Value Auto

0 [V

7 [V

25 [VO

150 [VO



ndard break. It can only be 
 a common protocol standard 
plications. It normally uses the 

haracters to be interpreted as 
n page 267). Use this to enter 

or MIDI and ES-BUS devices, 
nds.

cters such as Carriage Return 
metimes used to delimit ASCII 
e common control characters 
 into the string.

d ASCII characters such as Å, 
cters varies depending on the 
of character codes in the 
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Break This special character introduces an ES-BUS sta
used as the first character in a string. ES-BUS is
for equipment used in professional broadcast ap
RS422 communications standard.

Hex This special character causes the following two c
a HEX-encoded data byte (see “HEX Encoding” o
the data for non-ASCII drivers, such as drivers f
which don’t use ASCII encoding of their comma

You can also use this button to enter control chara
(CR), Line Feed, (LF), etc. These characters are so
command strings. The table to the left shows som
and the Hex format you would use to enter them

You also need to use this method for non-standar
Ä, Ö, Ø, ß, etc. The actual code for such chara
character set used by the device. Look for a list 
device’s manual.

Character Hex

CR §0D

LF §0A

STX §02

ETX §03

ESC §1B

BS §08

BEL §07

HT §09

VT §0B

NUL §00
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Forcing Hex Format TRAX will, by default, display any data byte in the range §20 (space) to §7E 
(tilde) in its ASCII character form. Thus, even if you enter §41 into the string, 

he HEX code for the ASCII character A). 
 displayed in the §xx format. You can 
string in HEX form by checking the Hex 
river dialog box. This is practical if 
 (for example to control a MIDI device), 
laying some data bytes using their ASCII 

 to insert a numeric value at this position 
 isn’t determined until you use a Trigger 
 fields at the bottom of the Driver String 
ange of the numeric value.

lay in the data stream, which may be 
e that the device sometimes fails to 
t in rapid succession, you should first 
 (see “Handshaking” on page 275). If 
y still be able to adapt the driver to the 
.

y this special character is determined by 
iver Settings dialog box. Inserting 
ncreases the delay time by the corre-
es may be required for different 
ically only used at the end of command 
Chapter 10:

TRAX will convert it into an A (§41 is t
Any data outside this range is always
force TRAX to display all bytes in the 
check box in the main Serial Device D
you’re working on a non-ASCII driver
as it prevents TRAX from possibly disp
form.

Value This special character tells SMARTPAX
in the string. The actual numeric value
cue to activate this command. Use the
dialog box to specify the format and r

Delay This special character introduces a de
required by some devices. If you notic
execute commands properly when sen
look for any handshaking capabilities
handshaking is not available, you ma
device by adding the required delays

The duration of the delay introduced b
the “Delay ≈ in Strings” field in the Dr
multiple, successive delay characters i
sponding amount. Different delay tim
commands. The Delay character is typ
strings. 



 sending data to the device, 
mplements a form of hand-
u may insert multiple Acknowl-
 normally only use this special 

ss the device’s manual explic-
each command. If the device 
 send any more data to it for 

ormat to use for the numeric 
nd the last two are binary. The 

 a sequence of HEX bytes, it is 
hexadecimal format or the 
s hexadecimal numbers and 

r ASCII characters, you should 
 specify the field width for the 
CII parameters are two and 

, two character pairs, each 
t the binary format is used for 
 most values (for example, 
s in the range 0–127 (i.e., 
r Byte lo/hi. The hi/lo format 

ues to be sent first. In the lo/hi 
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Acknowledge This special character causes SMARTPAX to stop
and await a response before proceeding. This i
shaking known as block-mode handshaking. Yo
edge Request characters into a string. You would
character at the end of each command.

◆ NOTE: Do not use this special character unle
itly states that it sends a response back after 
fails to send a response, SMARTPAX will not
about ten seconds.

Value Format This pop-up menu allows you to specify which f
value. The first two formats are ASCII encoded a
decimal ASCII format is most common.

As some protocol manuals list each command as
often difficult to tell whether you should use the 
binary. In general, if the manual shows values a
the other parts of the command consist of regula
use the hexadecimal value format. You must also
value. Common field widths for hexadecimal AS
four.

If the entire command consists of HEX bytes (i.e.
preceded by a § character), it is more likely tha
the value. MIDI is a typical example here, where
note numbers) are encoded as binary data byte
§00–§7F). In this case choose either Byte hi/lo o
causes the most significant byte of multi-byte val
format, the least significant byte is sent first.
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Field Width The Field Width pop-up menu specifies the width of the numeric value, in char-
acters. In the Auto mode, the field width will be automatically adapted to the 

e. Many devices, however, require a 
 numeric values as part of commands. In 
 of digits using this pop-up menu. 
s as required when sending the numeric 

e enough to hold the largest value. If you 
racters and then send 1000 as the 
 able to express the value correctly. You 
um numeric value using the Maximum 

inimum and maximum values that will be 
m within a Trigger cue. Use this feature 

 to the device’s protocol specifications.

mands to the driver, click “Save & OK” 
ARTPAX to your Mac and to the device 

 driver by clicking the Download button 
ownloading in Manual Mode” on 

 and downloading drivers.
Chapter 10:

number of significant digits in the valu
fixed number of digits when supplying
this case, specify the required number
SMARTPAX will then add leading zero
value to the device.

Make sure the width you specify is wid
specify a width of, for example, 3 cha
numeric value, SMARTPAX will not be
can prevent this by limiting the maxim
Value field.

Minimum and Maximum 
Value

These fields allow you to specify the m
allowed when using this command fro
to limit the range of values according

Downloading the 
Driver

Once you have added all required com
in the main dialog box. Connect the SM
to be controlled. Download your new
in the Device Support window. See “D
page 69 for more details on selecting



e to the Device window, open 
he Type pop-up menu.

 the Device pop-up menu 
he file it came from) as well as 
ver Settings dialog box. Don’t 
 any significant changes to the 
rmine which version you have 
it.

g box to display the status 
odes you entered into the 

154 for more details on the 

w becomes active if you select 
ch as the volume level. 
ged by a number sign; #.
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Using Your Driver To use your new device driver, add a Serial devic
its dialog box, and choose your new driver on t

Clicking the question-mark button to the right of
shows the origin of the driver (i.e., the name of t
its version number, which you can set in the Dri
forget to change the version number if you make
driver in the future, as it allows you to easily dete
on a particular computer or in a SMARTPAX un

Click the Status button in the configuration dialo
window of the device. This window lists all the m
driver, as well as their current states. See page 
Serial device.

The value field at the bottom of the status windo
a command which requires a numeric value, su
Commands that require a numeric value are tag
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Using Trigger Cues To program the device as part of your show, open a timeline window, make 
sure that your Serial device is still selected in the Device window, and choose 

en the cue’s dialog box and choose the 
ecific Mode pop-up menu.

t the Serial device before creating a new 
ned to the cue, then the Device Specific 
 

he dialog box and run the cue by 
e device’s status window is updated to 
de.
Chapter 10:

a Trigger cue from the Cue menu. Op
desired command from the Device Sp

▼ IMPORTANT: Remember to selec
Trigger cue. If a device is not assig
Mode button will not be available.

Select the Mute:On command, close t
pressing the space bar. Notice how th
reflect the current state of the Mute mo



e the command on the pop-up 
 the right.

e pop-up menu indicates that 
 the right of the pop-up menu 
d, allowing you to type in the 

r the value here.
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Specifying a Value To use a command that takes a value, first choos
menu then type the value in the numeric field to

The number sign after the command name on th
the command requires a value. The value field to
becomes active when such a command is selecte
value.

The number sign indicates that 
this command requires a value.

Ente
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If a command has a value, then the current setting of that value is displayed in 
the device’s status window.

 window by selecting the command and 
ld at the bottom of the status window.

tatus window of a device that is owned 
The status will revert back to the pro-
turn to the timeline. See “Device Owner-
ls.

 

Chapter 10:

You can change the value in the status
typing another value into the Value fie

◆ NOTE: Such changes made in a s
by a timeline are only temporary. 
grammed status as soon as you re
ship” on page 121 for more detai

Select the command in the list to 
activate the Value field.

Change the value
and press Return.



tandard Dataton language 
poken by each brand and 
ded into SMARTPAX handles 
tlink cables, connecting 
nterface, ensuring that the 
11
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11 SMARTPAX
SMARTPAX acts as an interpreter between the s
spoken by TRAX and the individual languages s
model of device. The device driver software loa
the syntax of each device’s language. The smar
SMARTPAX to the devices, handle the physical i
proper kind of signal reaches the device.
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Front Panel

TRAX or the previous unit in a chain of 
STEM CABLE to link units together. This 
eter standard lengths. A system cable kit 
 cables.

etween SMARTPAX and TRAX may be 
nnecting to the DATA IN port on a 
 maximum cable length is 25 meters. 

MARTPAX, in these cases, will supply 

when data is being received by 
. This is very useful when installing a 
ignal from one unit to the next, making 

y-chain multiple control units. You can 
um cable length between units is 100 

or” for more details).

he OUT connector is a high-level, digital 
 and re-shaped in each unit to ensure 
e systems.
IN Connector The IN connector links SMARTPAX to 
multiple control units. Use Dataton SY
cable is available in 0.4, 1, 2 and 5 m
is available for making custom length

When connected to TRAX, the cable b
extended up to 100 meters. When co
TRANSPAX or AIRLINK RECEIVER, the
This limitation is due to the fact that S
power to the connected device.

The TAPE/DATA OK indicator shows 
SMARTPAX through the IN connector
system as it allows you to follow the s
sure that all units receive data.

OUT Connector The OUT connector allows you to dais
connect units in any order. The maxim
meters (see above under “IN Connect

The data sent to the next unit through t
signal. The signal is optically isolated
maximum reliability even in very larg



CODE control track, as 
is allows you to run a presen-
yer rather than from a 
age 225).

 it on to any following units 
al signal. As the signal that 
line-level signal, the cable 
chain should be kept as short 
rs. If longer cable runs are 
 close to the tape player and 

r of the TRANSPAX+ to the IN 

d, the control signal from the 
t of the first unit in the chain – 
ugh the system cable. You 
rs of a SMARTPAX at the same 
ying a control signal through 

trol signal by watching the 
e tape signal is connected. 
APE/DATA OK indicators, 
te the control signal’s quality. 
 playing the tape. Intermittent 
l. Try adjusting the playback 
u may have to replace it with 
to gradually decreased audio 
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TAPE Connector The TAPE input accepts a standard Dataton SYN
recorded by the TRANSPAX+ tape interface. Th
tation from a control track on an audio tape pla
computer (see “Recording a Control Track” on p

SMARTPAX decodes this tape signal and passes
through the OUT connector as a high level digit
comes from the tape player is a relatively weak 
between the tape player and the first unit in the 
as possible, preferably no longer than two mete
required, you may instead place a TRANSPAX+
then run a system cable from the OUT connecto
connector of the first control unit.

For final playback without a computer connecte
tape player must be connected to the TAPE inpu
the control signal will not travel backwards thro
should never use both the IN and TAPE connecto
time – always disconnect the computer while pla
the TAPE input of a SMARTPAX.

You can monitor the quality of the received con
TAPE/DATA OK indicator of the unit to which th
Although the other units in the chain also have T
only the first unit’s indicator will accurately indica
The indicator should remain on all the time while
flickering indicates a poor quality or weak signa
level to correct the problem. If the tape is old, yo
a new tape. While the human ear may get used 
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quality resulting from a worn out tape, the SMARTPAX isn’t as adaptable and 
will eventually fail to read the signal reliably.

APE input which might be helpful when 

 ground.

ion scheme used by the control signal, it 
ular VU meters or when using an aver-

ape output. Use an oscilloscope to check 

ed on when data is received either 
. This is very useful when troubleshooting 
w the data signal from unit to unit – 
ve data.

 tape control track played into the TAPE 
indicator also indicates the quality of the 
tly, this indicates a poor quality or low 
 page 318).

nly indicated by the first unit in the chain 
ed. This is due to the fact that the first unit 
 from the tape, so it will not be passed 
These are some specifications of the T
troubleshooting an installation:

Input sensitivity: 150 mV peak relative

Input impedance: 10 kOhm.

Tape speed tolerance: ±20%.

◆ NOTE: Due to the sparse modulat
appears as very weak on most reg
aging volt meter connected to the t
the output level, if required.

TAPE/DATA OK Indicator The TAPE/DATA OK indicator is turn
through the IN or the TAPE connectors
an installation as it allows you to follo
ensuring that all units do indeed recei

If a control unit receives its data from a
input of that unit, the TAPE/DATA OK 
signal. If the indicator flickers frequen
signal level (see “TAPE Connector” on

◆ NOTE: The tape signal quality is o
to which the tape player is connect
will remove any bad data received
onto the following units.



ice driver selection and 
ck of the SMARTPAX. See 
hanging the address and 

riefly indicates the system soft-
ersion of TRAX used to down-

ay and show an error 

rrors and device driver errors. 
he left, is an example of a 
t an error occurred while 
 To recover from a download 
mputer, open the Device 
ivers, Manual Mode” on the 
 is checked in the list, and click 
ual Mode” on page 69). This 
 severe system errors may 
. Even so, performing a 

rors.

select that port using the PORT 
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CONFIGURATION Display The configuration display shows the current dev
address assignment for the four ports on the ba
below under ADDR and DEVICE for details on c
device driver.

When SMARTPAX is powered up, the display b
ware version. This is normally the same as the v
load the device drivers.

If an error occurs, SMARTPAX will flash its displ
message.

There are two kinds of error messages: system e
The “Download failure” message, as shown to t
system error. This particular message means tha
downloading drivers to SMARTPAX from TRAX.
failure, connect the SMARTPAX directly to the co
Support window in TRAX, and select “Device Dr
pop-up menu. Make sure that at least one driver
the Download button (see “Downloading in Man
will restore SMARTPAX to its normal state. Some
result in a flashing display but no error message
manual download usually corrects most such er

If the error is related to a specific port, you must 
button in order to see the error message.

Address

Port

Device

System 
software 
version.

Error 
message.
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PORT Button Press the PORT button to cycle through the four ports, as indicated by the four 
dots in the lower left corner of the display. The same symbols are shown next 

PAX.

address and device icon in the display 
rt selection has no effect on the operation 

s of the currently selected port. This must 
e Choose Port sub-dialog box of the 
ort Assignment” on page 117). Set the 
AX units before downloading the device 
 which device drivers should go where, 
gly.

AX conforms to the same restrictions as 
 Port dialog box, i.e., it must be in the 
it can exceed 7. In addition, you can 

its address to 00.
to each port at the back of the SMART

As you change the port selection, the 
change accordingly. Changing the po
of the SMARTPAX.

ADDR Button The ADDR button changes the addres
be set to match the Address field in th
corresponding device in TRAX (see “P
addresses of all ports on your SMARTP
drivers. This allows TRAX to determine
and assign them to the ports accordin

The address selection on the SMARTP
the corresponding field in the Choose
range 10 through 77, and neither dig
disable a SMARTPAX port by setting 

Leftmost port 
selected 
(front view).



vice driver selection for the 
 available in that SMARTPAX. 
ey were loaded, as described 

 three step procedure: 

 upper or lower part of the 
yed. The icons at this level 
e 94).

on to move down to the manu-
 part of the Device button to 

on again and select the model 
nfirm your selection.

you reach the last level, the 
ill be displayed briefly. The 

thin TRAX by selecting the 
g the Info button (see 
ttom of the text field. This 
in your computer is the same 
it.

, as described in Chapter 10, 
 the driver if you revise it. This 
ialog box (page 282). If you 
he difference between an old 
s.
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DEVICE Button The DEVICE button allows you to change the de
currently selected port, choosing from the drivers
Which drivers are available depends on how th
on the next page.

Selecting a device driver on the SMARTPAX is a

• Select the proper device type by pressing the
DEVICE button until the correct icon is displa
correspond to the Device menu in TRAX (pag

• Press firmly on the middle of the DEVICE butt
facturer level. Then press the upper or lower
choose the device manufacturer.

• Press firmly on the middle of the DEVICE butt
name. Press firmly on the middle again to co

Some drivers may have additional levels. Once 
driver will be activated and its version number w
driver version number can also be seen from wi
driver in the Device Support window and clickin
page 65). The version number is found at the bo
method allows you to see if the driver you have 
version as the one loaded into a SMARTPAX un

◆ NOTE: If you make your own device drivers
remember to increase the version number of
is done in the Serial Device Driver Settings d
forget to do this, you will not be able to tell t
and a revised driver by their version number
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Device Driver Availability When downloading device drivers using the automatic driver selection 
method, as described on page 68, TRAX downloads only the required drivers 

l driver selection method, as described 
cify exactly which drivers that will be 

ected directly to the computer, with no 
der to use the manual device driver 

tton on the SMARTPAX to choose which 
ed on the previous page.
into each SMARTPAX unit.

Alternatively, you may use the manua
on page 69. In this case, you can spe
downloaded. 

◆ NOTE: SMARTPAX must be conn
other units connected after it, in or
selection method.

After downloading, use the DEVICE bu
drivers to actually activate, as describ



 the devices being controlled, 
ol above each of the four ports 
ft corner of the front panel 

SMART-
PAX

C power input
 only)

Request To Send/Clock
Serial Data Out
Common Out

V Out (switched)
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Rear Panel

The four ports on the back of the unit connect to
using the appropriate smartlink cable. The symb
corresponds to the port indicator in the lower le
display.

24V AC or D
(leftmost port

Clear To Send
Serial Data In

Common In

+120V

1
6

NOTE:
Input terminals
are optically 
isolated.

Wiring of one SMARTPAX port. 
Power can be supplied to 
SMARTPAX through the leftmost of 
the four ports (front view). Most 
devices are not capable of 
supplying power to the SMARTPAX, 
however. Thus, in most cases, a 
separate power supply is required.
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24V AC EXT POWER Connect an ACPAX or ACPAX ADAPTOR here for power supply. Dataton rack 
adaptors (page 341) have built-in power distribution, allowing you to power 

using an 11 UNIT RACK ADAPTOR), or 
(using a 2.5 UNIT RACK ADAPTOR).

the 24 V AC cable, always pull the con-
r is mechanically secured in the recepta-
 damage or result in bad contact and 

her power sources as well. SMARTPAX 
 the range 15 to 24 Volt. Current 
1 Ampere, depending on the supply 
up to ten units from a single ACPAX (
two units from an ACPAX ADAPTOR 

▼ CAUTION: When disconnecting 
nector, not the wire. The connecto
cle. Pulling on the wire may cause
malfunction later on.

You can supply a SMARTPAX from ot
will accept either DC or AC voltage in
consumption varies between 0.2 and 
voltage and output loads.

AC PAX ADAPTOR (product number 
3337) and AC PAX (product 
number 3338) power supplies.



TPAX to the device. A wide 
 simple RS232 cables to 

built-in intelligence.

 your Dataton dealer for the 

using EXTENSION CABLE, 
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SMARTLINKS Use a suitable smartlink cable to connect SMAR
variety of smartlinks are available, ranging from
sophisticated “active” smartlinks with their own 

Refer to the Dataton product catalog, or contact
latest news on available smartlinks.

Extensions You can extend a smartlink by up to 10 meters 
available in 1, 2, and 5 meter lengths. 

RS232 SMARTLINK 3480

ANALOG SMARTLINK 3492
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SERIAL SMARTLINKS Various RS232 and RS422 smartlinks are available for connecting SMARTPAX 
to devices using these communication standards. In most cases you will be able 

g up the device in the database built into 

ers, using the Serial device driver editor 
n of the various RS232 and RS422 

” on page 272 for wiring information. 
e cable using a Dataton AUXILIARY 
able has a snap-locking SMARTPAX 
in the other, for soldering your own 

70) is used to interface SMARTPAX to 
d port, common on most professional 
vices. The MIDI standard is also used on 
uipment.

rds, uses separate connectors for data 
ctor on the MIDI SMARTLINK provides 
X to the MIDI IN port on the device. The 
 coming from MIDI OUT on the device 

AX provides additional information on 
o be used with SMARTPAX.

MIDI device drivers using the Serial 
 described in Chapter 10, assuming you 
 of the device to be controlled.
to tell which smartlink to use by lookin
TRAX (see page 65).

If you’re making your own device driv
built into TRAX, then see the descriptio
smartlinks under “Hardware Interface
You can also make your own interfac
CABLE (product number 3450). This c
connector at one end and a “pigtail” 
connector (see page 339).

MIDI SMARTLINK MIDI SMARTLINK (product number 34
devices equipped with a MIDI standar
synthesizers and many other audio de
some lighting consoles and related eq

MIDI, unlike most other digital standa
input and output. The male DIN conne
the output data, going from SMARTPA
female DIN connector is used for data
going to SMARTPAX.

The device information database in TR
how to configure the device in order t

You can create your own specialized 
device driver editor built into TRAX, as
have all the details about the protocol



rovides 32 solid state switch 
ted to pin 1 through 32. Pins 
ach output is capable of 
L SMARTLINK has built-in arc 
 as relays and small motors – 
l components.

ARTLINK
, 34

32 solid
state
switches
and
sensors.

al
els,

Digital outputs,
32 channels,
pin 1–32

1

20
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DIGITAL SMARTLINK DIGITAL SMARTLINK (product number 3491) p
outputs/inputs. These outputs/inputs are connec
33/34 are common for all the outputs/inputs. E
switching up to 0.5 Ampere, 50 Volt DC. DIGITA
suppression, meaning that inductive loads – such
can be controlled directly, without any additiona

Power to DIGITAL SM
12–24V DC, pin 36

Power from
SMARTPAX
12V DC


Common termin
for all 32 chann
pin 33, 34

+

19

37

–

+ –

INSIDE
DIGITAL
SMARTLINK
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Whether a pin on the DIGITAL SMARTLINK is used as an input or output is 
determined by its configuration. It is possible to use a single pin both as an 
input and as an output, for example to drive a feedback indicator in a button.

 by the SMARTPAX by strapping pin 35 
s case, the common pins 33/34 will be 
X. You can draw up to 0.5 Ampere from 

ITAL SMARTLINK to power, for 
amps controlled by the DIGITAL 

e DIGITAL SMARTLINKs connected to the 
ust not exceed 0.5 Ampere. Other smart-

 SMARTLINK or TOUCHLINK, may also 
 Additional power can be supplied to in-
ng the 12V DC INJECTOR, as shown on 

TAL SMARTLINK from outside. To do so, 
V DC) to pin 36 and the power supply 
DIGITAL SMARTLINK is connected to the 
TPAX, it will supply power to the 
mption will vary between 0.2 and 1 
d the load. 24 V DC is recommended for 
onditions.

-34 and 37-36 when powering the 
side through pin 36.
Power Supply Considerations DIGITAL SMARTLINK can be powered
to pin 34 and pin 37 to pin 36. In thi
connected to ground in the SMARTPA
SMARTPAX through pin 37 on the DIG
example, small relays, LEDs or small l
SMARTLINK.

◆ IMPORTANT: If you have multipl
same SMARTPAX, the total load m
links and devices, such as ANALOG
draw power from the SMARTPAX.
dividual smartlinks, if required, usi
page 345.

Alternatively, you can power the DIGI
connect the power supply (+12 to 24 
ground to pin 34. Furthermore, if the 
leftmost port (front view) of the SMAR
SMARTPAX as well. The current consu
Ampere, depending on the voltage an
reliable operation under heavy load c

▼ WARNING: Do not strap pin 35
DIGITAL SMARTLINK from the out



TLINK, connect it between the 
eft) and the positive pin of the 
om SMARTPAX, else the posi-

RTLINK pin will be pulled to 
ned on. 

y, you must add the current 
the power requirement. You 
om a single SMARTPAX (see 
If your total load exceeds this 
upply the current to your load 
n under “Combined Input/
 of how this can be done.
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Digital Output Functions To drive a lamp or a relay from a DIGITAL SMAR
desired output pin (pin 1 in the example to the l
power supply (i.e., pin 37 if you draw power fr
tive output from your external power supply).

When the output is activated, the DIGITAL SMA
ground, causing the lamp or relay coil to be tur

When driving several lamps or relays in this wa
consumption (mA) of all the loads to determine 
can not draw more than 0.5 A (i.e., 500 mA) fr
“Power Supply Considerations” on page 329). 
limit, you must use a separate power supply to s
and the DIGITAL SMARTLINK. See the illustratio
Output Functions” on page 332 for an example

1

37

36

35

34

+12V

Pin number

Ground

Lamp
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Digital Input Functions To use a DIGITAL SMARTLINK for input functions, such as push-buttons or relay 
closures, connect the buttons/relay switches as shown in the illustration to the 

und. The DIGITAL SMARTLINK considers 
in (pin 1 and 2 in the example to the left) 

RTLINK detect when the input switch is 
 needed to pull the input pin away from 
 pull-up resistor to each input pin, as 
esistor is recommended if the pin is used 
e same pin both as an input and output, 

 the pull-up as well, as shown in the 
tput Functions” on page 332.

INK input from an active source – i.e. a 
+12 volt – a pull-up resistor is not 
left. Note that the switches close to gro
an input as activated when the input p
is grounded.

Conversely, to make the DIGITAL SMA
no longer pressed, a pull-up resistor is
ground. You must connect a separate
shown to the left. A 10 kOhm pull-up r
only for input functions. When using th
the output load can usually double as
example under “Combined Input/Ou

If you are driving a DIGITAL SMARTL
source that can actively output 0 and 
required

1

2

37

36

35

34

+12V
Pin number

Ground

Switches

10 kΩ pull-up
resistors 



ox for the switch (page 130), 
t and an output. This can be 
lt into the button used to acti-

for both the input and output 
ut is activated while the output 

e 242 for more details.

sistor/LED) in the example 
t function.
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Combined Input/Output Func-
tions

By selecting “Both” in the configuration dialog b
you can make the same pin act both as an inpu
used, for example, to control a lamp or LED bui
vate a function.

▼ IMPORTANT: When the same pin is used 
functions, it is not possible to detect if the inp
is on.

See “Input Switches and User Feedback” on pag

◆ NOTE: The output load (i.e., the lamp or re
above, also doubles as a pull-up for the inpu

1

2

36

34

+12V supply
DIGITAL SMARTLINK
Pin number

Ground

Switches

1 kΩLamp

LED
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RELAY SMARTLINK RELAY SMARTLINK (product number 3494) provides two independent single 
pole, double throw electromechanical relays. The relays are housed inside a 

EDs indicate the status of the relays.

 to 2 Ampere, 24 Volt DC or AC. For 
” and “normally open” terminals are 
both relays in their passive states (i.e., 

 also two built-in arc suppression varis-
elay switch when switching inductive 

 relays (page 129). See the device infor-
igital Smartlink” for more details.

1

9

ristors

Switch 1
nc  no
15 pin female D-sub connector. Two L

Each relay is capable of switching up
each relay, both the “normally closed
accessible. The drawing below show 
normally closed).

In addition to the two relays, there are
tors, intended to be wired across the r
loads such as motors or other relays.

Use two Switch devices to program the
mation database entry for “Dataton:D

INSIDE
RELAY
SMARTLINK

8

15

Va

Switch 2
nc  no



rovides 32 independent 0–10 
. Pins 33/34/35 are common 
 is capable of sinking and 
ighest accuracy on the output 
r than 20 kOhm.

onverter, resulting in up to 
of this high precision by 
s in the Set/Fade cue.

ts (page 149). See the device 

er, 32 channel

Analog output
channels, 0–10V
pin 1–32

1

20
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ANALOG SMARTLINK ANALOG SMARTLINK (product number 3492) p
V DC analog output channels (pin 1 through 32)
for all the output channels. Each output channel
sourcing up to 10 mA. However, to achieve the h
voltage, the load impedance should not be lowe

The output precision is based on a 12 bit D/A c
4096 discrete steps. TRAX takes full advantage 
allowing you to use fractional percentage value

Use Level or Lamp devices to program the outpu
information database for more details.

10 bit DA convert

Common
for all 32 channels,
pin 33, 34, 35 

19

37

INSIDE
ANALOG
SMARTLINK
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AUDIO SMARTLINK AUDIO SMARTLINK (product number 3493) is an eight input/two output 
audio mixer (four stereo pairs). Two additional, fixed inputs allow multiple 

ut capacity. LEDs indicate overloading 
nal. Max input level is +10 dBU (unbal-
unbalanced outputs can drive 600 Ω.

IO SMARTLINK channels (page 149). 
 for controlling AUDIO SMARTLINK; one 
ndent levels while the other one treats 
 levels (see the device information data-
ore details).

ion dialog box allows you to determine 
pond to 0 dB (no gain) or +30 dB (the 
 at 100% level).

Select this checkbox to amplify 
a weak audio signal by 30 dB.
units to be cascaded for increased inp
resulting in distortion of the audio sig
anced, 10 kΩ input impedance). The 

Use Level devices to program the AUD
There are two device drivers available
treats the eight inputs as eight indepe
them as four volume and four balance
base entry for each device driver for m

A checkbox in the device’s configurat
whether the 100% level should corres
input signal is boosted by 30 dB when



rovides control of up to 32 
rol protocol is supported by 
ing and theater environments.

 the DMX-512 channels 
es, allowing you to, for 
tness and Level devices for the 

for further details on how to 
ts. As the DMX-512 protocol 

X SMARTLINK to control 
upport window. If so, please 
 to connect and configure the 

rovides control of up to 32 
 is supported by most dimmers 
o, Italy) and Pulsar 

the channels (page 149). You 
o for example use a Lamp 
r positioning.

etails on how to connect and 
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DMX SMARTLINK The DMX SMARTLINK (product number 3485) p
DMX-512 lighting channels. The DMX-512 cont
most dimmer manufacturers, particularly in stag

Use up to 32 Lamp or Level devices to program
(page 149). You can mix Lamp and Level devic
example, use a Lamp device to control the brigh
positioning of a movable light.

Please refer to the device information database 
connect and configure specific dimmers and ligh
is standardized, you can most likely use the DM
devices even if they are not listed in the Device S
refer to the manufacturer’s documentation on how
device.

PMX SMARTLINK The PMX SMARTLINK (product number 3456) p
PMX lighting channels. The PMX control protocol
and lights manufactured by Clay Paky (Pedreng
(Cambridge, U.K.).

Use up to 32 Lamp or Level devices to program 
can mix Lamp and Level devices, allowing you t
device to control brightness and Level devices fo

Please refer to the device database for further d
configure specific dimmers and lights.
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TAPE SMARTLINK The TAPE SMARTLINK (product number 3458) provides a programmable time-
code output, according to the SMPTE and EBU LTC timecode standards. This 

able of synchronizing to external time-
chase lock”. 

ode stream, you can also program the 
ode standards. These user bits are some-
ol over the device.

E SMARTLINK (page 133), choosing the 
 may need to use Trigger cues to 

e driver according to the device. Please 
se for more details.

er 3457) provides control of most 
g on Apple Macintosh computers and 
DB port, and works by emulating the 
rogram.

trol the Macintosh (page 147). Choose 
e pop-up menu in the device’s configu-
device information database for more 

resentation software can be controlled in 
LINK (product number 3487).
can be used to control any device cap
code – a feature often referred to as “

In addition to programming the timec
user bits, which are part of those timec
times used to provide additional contr

Use a Tape device to program the TAP
“Timecode:SMPTE” device driver. You
configure the parameters of the devic
refer to the device information databa

MAC SMARTLINK The MAC SMARTLINK (product numb
presentation graphics software runnin
compatibles. It connects through the A
keyboard to control the presentation p

Use a Still Store device in TRAX to con
your presentation software on the Typ
ration dialog box. Please refer to the 
details.

◆ NOTE: PC and Windows based p
the same way, using a PC SMART



control most devices equipped 
e functions of the remote. It is 
 devices, as well as generic IR 
r to the device information 

, TRAX also comes with addi-
 basic support for many 
 move them to the same folder 

lease contact your Dataton 

477) and SYSTEM OUT 
a Dataton product to a 
TEM OUT SMARTLINK to 
stem when used in the Interac-
 16). Likewise, a SYSTEM IN 
 to a SMARTPAX for use with 
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IR SMARTLINK The IR SMARTLINK (product number 3453) can 
with an infrared remote control by emulating th
used by some Audio Disc, Video Disc and Tape
devices (including video projectors). Please refe
database for each device for more details.

In addition to the IR drivers built into TRAX itself
tional IR driver libraries. These libraries provide
domestic AV devices. To activate these libraries,
as the TRAX application and re-start TRAX.

Specialized IR device drivers can be supplied. P
dealer for further information.

SYSTEM IN/OUT SMARTLINK Use SYSTEM IN SMARTLINK (product number 3
SMARTLINK (product number 3478) to connect 
SMARTPAX port. For example, you need a SYS
connect TRANSPAX+ and/or PAX to a TRAX sy
tive system mode (see “System Modes” on page
SMARTLINK is required to connect a MICTOUCH
TRAX.

SYSTEM
OUT

IN
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Other Smartlinks Other smartlinks may be available for specialized purposes and new smart-
links are under constant development. Please contact your Dataton dealer for 

s and supported devices.

 an AUXILIARY CABLE, which provides 
X end, and a “pigtail” at the other end. 
uired for the device at hand. This 

terface, such as RS232 or similar, is 
vices can be made using the Serial 

ee Chapter 10).

SMARTPAX port is shown on page 324.

1 Brown
2 Red
3 Orange
4 Yellow
5 Green
6 Blue
7 Violet
8 White
9 Black
the latest news on available smartlink

Specialized cables can be made using
the snap-locking plug at the SMARTPA
Here you can attach the connector req
assumes that a standard hardware in
being used. Device drivers for such de
device driver editor built into TRAX (s

◆ NOTE: The wiring diagram for a 

Use AUXILIARY CABLE (product 
number 3450) for making special-
ized interface cables.



 to the SMARTPAX.

r at the back.

using selected smartlinks and 

nt panel from the next SMART-

 supply power to the 
ntation for the device or smart-
nect an ACPAX ADAPTOR or 
ower distribution feature built 
s can also be used, if desired 

 SIMDA slide projectors are 
 the leftmost device port. The 
 an external power supply, as 
 on page 329.

n be used for powering the 

T port is provided as a safety 
AX fails, it may be able to get 
e chain to keep working until 
 not be sufficient under heavy 
rmal use.
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Power Supply There are three possibilities for supplying power

• Through the 24 V AC EXT POWER connecto

• Through the leftmost device port (front view) 
devices.

• Through the DATA OUT connector on the fro
PAX in the chain.

The 24 V AC EXT POWER is the primary way to
SMARTPAX. Use this method unless the docume
link tells you otherwise. Normally you would con
an ACPAX here, either directly or through the p
into Dataton rack adaptors. Other power source
(see “24V AC EXT POWER” on page 325).

Currently, only the DIGITAL SMARTLINK and the
able to supply power to the SMARTPAX through
DIGITAL SMARTLINK then has to be connected to
described under “Power Supply Considerations”

◆ NOTE: Only the leftmost port (front view) ca
SMARTPAX in this way.

The ability to take power through the DATA OU
feature only. If the power supply for the SMARTP
enough power from the next unit further down th
the problem has been resolved. This supply may
load conditions, and is not recommended for no

AC PAX ADAPTOR (product number 
3337) and AC PAX (product 
number 3338) power supplies.
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ranging from two to ten units with 
r distribution. The illustration 
(product number 3505).
Rack Adaptors Rack adaptors are available with capacities 
room for power supply and integrated powe
below shows the 11 UNIT RACK ADPATOR 



T
p
u
s
S
o
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12 TOUCHLINK

OUCHLINK is a color LCD touch 
anel that can provide an attractive 
ser interface for your TRAX-based 
ystem. It connects to a port on a 
MARTPAX. You can use any number 
f TOUCHLINK units in a system.
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Specifications • 320 x 240 pixel backlit, color LCD display.

• High-resolution touch surface.

.

, indicators, etc.

.

lay backlighting plus programmable 

push-buttons on the side.

mpled audio.

0 mA maximum.

g TOUCHLINK to SMARTPAX. This can 
0 meters (see “Power Supply” on page 

en can be adjusted by keeping the small 
 the top or bottom part of the large side 
y programmed functions of these 
• 2 MB non-volatile FLASH memory

• 0.5 MB RAM memory.

• Up to 99 pages of buttons, sliders

• Custom graphics.

• Two fonts, three sizes, two weights

• Motion sensor controlling the disp
function.

• Three programmable mechanical 

• Loudspeaker with 11 kHz, 8 bit sa

• Power requirements: 12 V DC, 50

• Rugged, solid aluminum housing.

• 2 meter black cable that connectin
be extended if required by up to 3
344).

◆ NOTE: The contrast of the LCD scre
side button pressed while pressing
button. This works regardless of an
buttons.



pearance and functionality of 
 device. All user input is sent 
s functions as programmed. 
em as well as feedback to 

 to design and program your 

. This stand raises the back of 
. It can be easily detached for 

 wall using the optional 
 This fastens the unit securely, 
ool. Furthermore, it hides the 
plug the unit.

SMARTPAX to which it is 
s is not possible, such as:

 the TOUCHLINK needs to be 

 connected to the same 

e same SMARTPAX which also 
IGITAL SMARTLINK, as shown 
344 Chapter 12: TOUCHLINK

Design and Programming TRAX provides all that is needed to design the ap
TOUCHLINK, as well as to download this to the
back to TRAX, which then carries out the variou
This provides control over the devices in the syst
TOUCHLINK.

Please refer to Chapter 6 for full details on how
TOUCHLINK application.

Mounting Accessories TOUCHLINK comes with a clear plastic tilt-stand
the unit, making it more suitable for desktop use
handheld operation.

Alternatively, TOUCHLINK can be mounted on a
TOUCHLINK WALL KIT (product number 3551).
and it can only be removed using the included t
connector and cable, making it impossible to un

Power Supply TOUCHLINK normally takes its power from the 
connected. However, under some conditions thi

• When the cable between the SMARTPAX and
extended by more than 5 meters.

• When there are more than one TOUCHLINK
SMARTPAX.

• When there are other devices connected to th
may draw power from SMARTPAX (such as D
in the example on page 330).
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In these cases, power should be supplied to TOUCHLINK separately using a 
12V DC INJECTOR (product number 3419) and a 12V DC ADAPTOR (product 
number 3334). The DC INJECTOR connects between SMARTPAX and 

u may extend the TOUCHLINK cable by 
e of the DC INJECTOR. The cable 

MARTPAX can then be up to 25 meters.

12 VDC
INJECTOR

2 m cable on
TOUCHLINK

5 m optional
extension cable
TOUCHLINK, close to TOUCHLINK. Yo
up to 5 meters on the TOUCHLINK sid
between the DC INJECTOR and the S

12 VDC
ADAPTOR

Up to 25 m
extension cable

SMARTPAX

Supplying power separately 
to a TOUCHLINK using 
12 VDC INJECTOR.



an be used for many different 
e projectors to large-scale 

.

nnecting it directly to the com-

ing it to a SMARTPAX port.

trol of up to four slide projec-
pabilities.

48) has 13 keys. Individual 
, or removed to simplify the 
vides labels for customizing 
for most applications.

n total darkness, is normally 
n, such as START, NEXT or 

ulation technology to provide 
little power. The built-in high-
normal conditions.
13
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13 AIRLINK
AIRLINK is a wireless remote control system. It c
applications, ranging from controlling a few slid
multimedia systems and interactive applications

• Use it for speaker support applications by co
puter running TRAX.

• Use it for interactive applications by connect

• Use it with PAX or SMARTPAX for direct con
tors, with full dissolve and random access ca

Transmitter The AIRLINK TRANSMITTER (product number 34
keys can be labelled according to their function
layout. The enclosed AIRLINK OVERLAY KIT pro
the transmitter with numbers, texts and symbols 

A special outsize key, that is easy to find even i
used for the most basic function of the applicatio
ON/OFF.

The transmitter uses proprietary power pulse mod
unmatched operational range while using very 
energy lithium cells will last for ten years under 
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Speaker Support Applications To control a TRAX timeline using an AIRLINK TRANSMITTER, first connect the 
receiver to the computer, as described under “Connecting to the Computer for 

 press the large key on the transmitter to 
 current track. This utilizes the current 
der “Timing of Events” on page 226.

w must be the active window in order to 

ey plus the three below) mimic the arrow 
s you can use the up arrow or the left 
 previous cue on the stop track. Use the 
 the next cue. The down arrow key runs 
urrent Track Locked” check box in the 
ge 105) to prevent the current track 
tally while you are using it as a stop 

nsmitter mimic function keys F5 through 
y can be used to jump directly to any 
ckFind feature by simply entering the 
e. Whenever you press the corre-
AIRLINK TRANSMITTER, the show will 
sing QuickFind” on page 88 for more 
Speaker Support” on page 351. Then
run the timeline to the next cue on the
track as a stop track, as described un

▼ IMPORTANT: The timeline windo
be controlled by AIRLINK. 

The four buttons at the top (the large k
keys on the computer’s keyboard. Thu
arrow key to rewind the timeline to the
right-hand arrow key to skip ahead to
in real time to the next cue. Use the “C
Timeline Specifications dialog box (pa
selection from being changed acciden
track.

The remaining nine buttons on the tra
F13 on the computer’s keyboard. The
position on the timeline using the Qui
corresponding name into a Control cu
sponding key on the keyboard or the 
instantly jump to that position. See “U
details.

F5 F6 F7

F8 F9 F10

F11 F12 F13



, as described on the previous 
er the active timeline window 
 for fully interactive applica-
 limited.

K RECEIVER through a 
ng through SMARTPAX for 
witch device to the Device 
RLINK, and program the 
. You program the AIRLINK 

her inputs to the system. See 

lity, this way of connecting the 
n one AIRLINK to the system, 
ermore, the receivers can be 
they are connected through 
roughout the building, rather 
348 Chapter 13: AIRLINK

Fully Interactive Applications Connecting the AIRLINK directly to the computer
page, provides convenient and direct control ov
without any additional programming. However,
tions, this kind of fixed functionality may be too

For increased flexibility, you can connect AIRLIN
SMARTPAX port, as described under “Connecti
Interactive Applications” on page 353. Add a S
window corresponding to each button on the AI
behavior of the buttons through the Task window
buttons in the same way you would program ot
“Inputs” on page 242 for more details.

◆ NOTE: In addition to providing more flexibi
receiver also allows you to connect more tha
for example for use in different rooms. Furth
located farther away from the computer, as 
SMARTPAX units, which can be distributed th
than directly to the computer.

2

1

3 4

5 6 7

8 9 10

11 12 13

Numbering of AIRLINK 
buttons when connected 
through a SMARTPAX port.
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Slide Projector Control You can use AIRLINK to directly control one, two, three or four slide projectors, 
without using any computer at all. Using the numeric keys on the AIRLINK, you 

er. When used with two or more projec-
ves between projectors, both forwards 

NSMITTER as shown to the left. If you 
ss, the related keys can be removed and 
eguards against pressing the wrong key 
 slide. If you’re not using fast random 
 a while, and can be very annoying in 

next slide. If you’re using two or more 
second dissolve. If you’re using only one 
ay. Press the minus key to go back one 
can directly locate any slide by numb
tors, AIRLINK will make smooth dissol
and backwards.

Label the buttons on the AIRLINK TRA
don’t want slide number random acce
covered with the blank labels. This saf
and sending the projectors to another
access projectors, this could take quite
the middle of a presentation.

Press the NEXT key to advance to the 
projectors, this will be done by a one 
projector, it will simply advance the tr
slide.

1

NEXT

2 3

4 5 6

7 8 9

CLEAR 0 —



r. This works with all slide 
dom access slide projectors 

First enter the desired slide 
T to go there. Press CLEAR to 

ed to home the slide projectors 
e zero position, the lamps will 

ilable slide projectors sequen-
 first slide will be in tray posi-
 in position one in the second 
rojector, and so on. This must 
nd when entering the slide 
er entered corresponds to the 
number of its slot in the tray 
e). It also means that it isn’t 
you run out of tray slots. If you 
 all slides around to match the 
350 Chapter 13: AIRLINK

Use the numeric keys to go to a slide by numbe
projectors, but is particularly useful with fast ran
such as the Simda and Kodak Ektapro models. 
number using the numeric keys, then press NEX
cancel the numeric entry if you make a mistake.

◆ HINT: This numeric access feature can be us
by pressing 0 and NEXT. When returned to th
go off as well.

In order to make dissolves, AIRLINK uses all ava
tially. Thus, if you have two slide projectors, the
tion one in the first projector, the second slide is
projector, the third is in position two in the first p
be taken into account when loading the trays, a
number using the numeric keys. Thus, the numb
slide’s sequential position in the show – not the 
(unless you use only a single projector, of cours
easy to add another projector to the show when 
must add a projector, then you must also shuffle
new sequencing order.
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Receiver The AIRLINK RECEIVER (product number 3449) can be connected to 
SMARTPAX, PAX or the ADB port on the TRAX computer. Its application varies 

escribed below.

g maximum operational range and reli-
descent lamps or in direct sunlight.

AIRLINK RECEIVER can be extended, if 

on a Mac: five meters maximum using 
oesn’t recommend extending the ADB 
le by moving the computer instead.

 maximum using five SYSTEM CABLE 
ng SYSTEM CABLE KIT 3420.

nnect the AIRLINK RECEIVER to the ADB 
e TRAX computer. You can connect the 
nector on the back of the computer or to 
board. Some computer models have 
ailable for the AIRLINK RECEIVER if you 
e time. In this case, use an ADB expan-
iver. Although the PowerBook models 

ave this problem as both the keyboard 
cted internally.

e AIRLINK RECEIVER to the ADB port be-
ecting the receiver while the power is on 
r computer.
according to how it is connected, as d

The receiver is very sensitive, providin
ability. Avoid placing it close to incan

The standard two meter cable on the 
required, using Dataton system cable:

• When connected to the ADB port 
SYSTEM CABLE 3415. As Apple d
bus, try to avoid this where possib

• All other cases: twenty-five meters
3415 or a custom-made cable usi

Connecting to the Computer 
for Speaker Support

For basic speaker support functions, co
(i.e., keyboard) port on the back of th
receiver either directly to the ADB con
the loop-through connector on the key
only one ADB port, leaving no port av
want the mouse connected at the sam
sion box or Y-cord to connect the rece
only have one ADB port, they don’t h
and the trackball/trackpad are conne

▼ IMPORTANT: Always connect th
fore turning on the computer. Conn
may cause serious damage to you



AX, but it can also be used 
eystrokes to perform the 
 as CE Software’s QuicKeys, 
ys making, for example, the 
ns. 

on page 347 for details on 

DB 
tor: 

 MAC 
 3440
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AIRLINK is specifically designed to work with TR
with other applications that use a similar set of k
desired functions. Using a macro program, such
you can further customize the behavior of the ke
function keys switch between different applicatio

Please refer to “Speaker Support Applications” 
how to use AIRLINK in this configuration.

Connects to the A
bus connec

AIRLINK
ADAPTOR

AIRLINK 
TRANSMITTER
3449

AIRLINK
RECEIVER
3448
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Connecting through 
SMARTPAX for Interactive 

For fully interactive applications, connect AIRLINK RECEIVER to a port on a 
SMARTPAX using the enclosed SYSTEM IN SMARTLINK cable. Add a number 

 in TRAX, corresponding to the number 
 Choose “Dataton:Airlink” on the Type 
ces. Download the device driver to 

 page 348 for more details.

necting the AIRLINK RECEIVER to a port 
connecting it to the DATA IN connector 
xt page. In order to use it with TRAX for 
ust connect the receiver to the back of 

priate device driver.

◆ NOTE: You must select the 
Interactive system mode 
(page 112) in order to use 
AIRLINK in this way.
Applications of Switch devices to the Device window
of AIRLINK buttons you intend to use.
pop-up menu inside those switch devi
SMARTPAX to activate the receiver. 

See “Fully Interactive Applications” on

▼ IMPORTANT: Don’t confuse con
on the back of a SMARTPAX with 
on the front, as described on the ne
fully interactive applications, you m
the SMARTPAX and use the appro

Select “Dataton:Airlink”.

Enter the key number, as shown 
in the picture on page 348, as 
the sub-address.



PAX or SMARTPAX for direct 
Projector Control” on page 

t 1L, and its OBJECT selector 
ee Chapter 14). Connect the 
bles, starting with the leftmost 

ropriate device driver and 
 projector (see Chapter 11 for 
 smartlink cables starting with 

, you must make sure that all 
e time as the power to the PAX 

, this is normally not a 
n all projectors using a 
ors one by one, you must turn 
ont view) last, as this projector 

s 24 VAC EXT POWER socket 
re or at the same time as you 
l unit is powered before all the 
ot recognize the projectors.
354 Chapter 13: AIRLINK

Connecting to PAX or 
SMARTPAX for Slide Control

Connect AIRLINK RECEIVER to the IN port on a 
control of up to four slide projectors (see “Slide 
349).

If you’re using PAX, then set its BANK selector a
according to the type of projector being used (s
projectors using the relevant projector adaptor ca
port (front view).

If you’re using a SMARTPAX, then select the app
address, beginning with address 10 for the first
details). Connect the projectors with the relevant
the leftmost port (front view).

▼ IMPORTANT: When turning on the system
projectors are turned on before or at the sam
or SMARTPAX.

If the control unit is powered from the projectors
problem. The easiest way to do it is by turning o
common power switch. If you turn on the project
on the projector connected to the leftmost port (fr
supplies power to the PAX/SMARTPAX.

If you supply power to the control unit through it
on the back, then turn on all the projectors befo
turn on the power to the control unit. If the contro
projectors have been turned on, AIRLINK may n
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14 14 PAX
trol unit. It handles up to four electro-

be adapted to most kinds of projectors 
or, which use straight or rotary slide 

lling slide projectors equipped with an 

 can play back shows originally created 
g Arion and Kodak PDC (MATE TRAC), 
ctrosonic (Alphasync). See Chapter 15 

 eight switch functions, providing two 
rt can be used for either two relay func-
 at the same time.
PAX is a dedicated slide projector con
mechanical slide projectors, and can 
equipped with a dissolve unit connect
trays.

◆ NOTE: Use SMARTPAX for contro
RS232 control port.

When used with a TRANSPAX+, PAX
on other multi-image systems, includin
AVL (Procall-5 and Procall-X) and Ele
for details.

PAX can also be used to control up to
relays on each of the four ports. A po
tions or a slide projector, but not both



ous unit in a chain of multiple 
nits together. This cable is 
ths. A system cable kit is avail-

primary system cable bus, 
 mode. If you are using the in-
ndary bus, connected through 
 the TRANSPAX+ or open-reel 
on page 16 and “Connecting 
.

X and TRAX may be extended 
RANSPAX+ or AIRLINK 
rs. This limitation is due to the 
to the connected device.

 is being received by PAX 
en installing a system as it 
the next, making sure that all 
356 Chapter 14: PAX

Front Panel

IN Connector The IN connector links PAX to TRAX or the previ
control units. Use Dataton system cable to link u
available in 0.4, 1, 2 and 5 meter standard leng
able for making custom length cables.

▼ IMPORTANT: When connecting PAX to a 
TRAX must be set to its backward compatible
teractive system mode, PAX must be on a seco
a SMARTPAX port. This port must use one of
related device drivers. See “System Modes” 
TRANSPAX+” on page 369 for more details

When connected to TRAX, the cable between PA
up to 100 meters. When connecting PAX to a T
RECEIVER, the maximum cable length is 25 mete
fact that PAX, in these cases, will supply power 

The TAPE/DATA OK indicator shows when data
through the IN connector. This is very useful wh
allows you to follow the signal from one unit to 
units receive data.
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OUT/RMT IN Connector The OUT connector allows you to daisy chain multiple control units. You can 
connect units in any order. The maximum cable length between units is 100 

56).

the OUT connector is a high-level digital 
 and re-shaped in each unit to ensure 
e systems.

ed with a Kodak S-AV wired remote 
sic dissolve functions using two, three or 
ple speaker support presentations using 
 reverse buttons on the remote control 

r previous slide. The focus button on the 
e, which can be stopped at any point by 
o superimpose one image on another.

taton control signal, as recorded by the 
rding a Control Track” on page 225). 

from a control track on an audio tape 

and passes it on to any following units 
-level digital signal. As the signal that 
vely weak line-level signal, the cable 
unit in the chain should be kept as short 
 two meters. If longer cable runs are 
ANSPAX+ close to the tape player and 
 connector of the TRANSPAX+ to the IN 
meters (see “IN Connector” on page 3

The data sent to the next unit through 
signal. The signal is optically isolated
maximum reliability even in very larg

Alternatively, this connector can be us
control or compatible. This provides ba
four projectors, and is suitable for sim
slide projectors only. The forward and
will dissolve sequentially to the next o
remote control provides a slow dissolv
releasing the button. This allows you t

TAPE Connector The TAPE input accepts a standard Da
TRANSPAX+ tape interface (see “Reco
This allows you to run a presentation 
player rather than from a computer.

PAX decodes the control track signal 
through the OUT connector as a high
comes from the tape player is a relati
between the tape player and the first 
as possible, preferably no longer than
required, you may instead place a TR
then run a system cable from the OUT
connector of the first control unit.



d, the control signal from the 
t of the first unit in the chain – 
ugh the system cable. You 
ors of a PAX at the same time 
g a control signal through the 

al by watching the TAPE/
 signal is connected. Although 
A OK indicators, only the first 
ol signal’s quality. The indi-
g the tape. Intermittent flick-
ignal. Try adjusting the 
 is old, you may have to 

ually be unable to read the 

ay be helpful when trouble-

e used by the control signal, it 
eters or when using an aver-

t. Use an oscilloscope to check 
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For final playback without a computer connecte
tape player must be connected to the TAPE inpu
the control signal will not travel backwards thro
should never use both the IN and TAPE connect
– always disconnect the computer before playin
TAPE input of a PAX.

You can monitor the quality of the received sign
DATA OK indicator of the unit to which the tape
the other units in the chain also have TAPE/DAT
unit’s indicator will accurately indicate the contr
cator should remain on all the time while playin
ering indicates a poor quality or weak control s
playback level to correct the problem. If the tape
replace it with a new tape as the PAX will event
signal reliably.

The following specifications of the TAPE input m
shooting an installation:

Input sensitivity: 150 mV peak relative ground.

Input impedance: 10 kOhm

Tape speed tolerance: ±15%

◆ NOTE: Due to the sparse modulation schem
appears as very weak on most regular VU m
aging volt meter connected to the tape outpu
the output level, if required.
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TAPE/DATA OK Indicator The TAPE/DATA OK indicator will be turned on when data is received either 
through the IN or the TAPE connectors. This is very useful when troubleshooting 

w the data signal from unit to unit, 
data.

trol signal played into the TAPE input of 
r also indicates the quality of the signal. 

 indicates a poor quality or low-level 

nly indicated by the first unit in the chain 
ted. This is because the first unit will re-
 the tape, so it will never be received by 

 to the kind of projector or relay func-
 small, flat screwdriver to turn the 

ector model on the Type pop-up menu in 
ox (see page 123).

els.

models when electronic home sensing is 

odels.

c III models when electronic home 
e).
an installation as it allows you to follo
ensuring that all units indeed receive 

If the unit receives its data from a con
that unit, the TAPE/DATA OK indicato
If the indicator flickers frequently, this
control signal.

◆ NOTE: The tape signal quality is o
to which the tape player is connec
move any bad data received from
the following units.

OBJECT Selector Use the OBJECT selector to adapt PAX
tions being controlled. You will need a
selector. Select the corresponding proj
the projector’s configuration dialog b

SAV. All Kodak Carousel S-AV mod

SAV NH. All Kodak Carousel S-AV 
not desired (NH = No Home).

EKTA III. All Kodak Ektagraphic III m

EKTA III NH. All Kodak Ektagraphi
sensing is not desired (NH = No Hom

EKTA II. This position isn’t used.



 150 Watt halogen lamps.

 halogen lamps.

 trays.

nly. Use this setting when no 

bove the E AUX position for 

80 projector, it is recommend-
R to supply power to the PAX. 
s on the projectors to activate 

graphic III modes defeats the 
r models. This can be useful 
image systems which do not 

or can be used for two relay 
ept LIN 1 and LIN 2. PAX will 
cted to the port or not. Use the 
X is being used for relay func-
for more details on how to use 
360 Chapter 14: PAX

LIN 1. All linear tray projectors equipped with

LIN 2. All linear tray projectors with 250 Watt

RA. Random Access projectors with rotary slide

E AUX. For controlling switch relay functions o
projectors are connected to the PAX. 

There is an additional, unmarked, position just a
use with the Hasselblad PCP80 slide projector.

◆ NOTE: When used with the Hasselblad PCP
ed that you use a separate ACPAX ADAPTO
If not, you may have to press the LAMP button
them.

The “No Home” positions for the S-AV and Ekta
electronic home sensing built into these projecto
when running older shows made on other multi-
support this feature.

Any port not used for controlling a slide project
functions. This applies to all OBJECT settings exc
automatically sense whether a projector is conne
E AUX position of the OBJECT selector if the PA
tions only. See “Switch Functions” on page 367 
a PAX port for relay functions.
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BANK Selector Use the BANK selector to set the address range used by the PAX unit. The 
setting of this switch corresponds to the entry in the Port field in the devices’ 

s are assigned from left to right, front 
 connected to the leftmost port of a PAX 

sses are assigned from right to left, front 
tor address assignment.

the first two ports and relay functions on 
ned like this: 10, 11, 11, 10.

ed with TRAX. Setting the BANK selector 
les that PAX unit, and it will not respond 

BANK Addresses
4H 44 – 47

5L 50 – 53

5H 54 – 57

6L 60 – 63

6H 64 – 67

7L 70 – 73

7H 74 – 77
configuration dialog boxes:

When used with projectors, addresse
view. Thus, the address of a projector
set to 2H is 24.

When used with relay functions, addre
view. This is the opposite of the projec

For a PAX set to 1L with projectors on 
the other two, the addresses are assig

The last settings, 8L and 8H, are not us
to any of these settings effectively disab
to any commands from TRAX.

BANK selector at 2H, 
using projectors only.

24 25 26 27

BANK selector at 2L, using 
relay functions only.

23 22 21 20

BANK Addresses

1L 10 – 13

1H 14 – 17

2L 20 – 23

2H 24 – 27

3L 30 – 33

3H 34 – 37

4L 40 – 43



ps on and off in order to align 
uence the projectors automat-

he projectors is left on 
e used as a reference for the 
ecommended.

gh the TAPE on IN connector 
to move, then the line-up se-
heir programmed levels.

onds to force all projectors to 
their home positions. This 
ample at the end of a speaker 
nected to OUT/RMT IN.

X receives data through the IN 
ately restore the projectors to 
t cue instead.
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LINE-UP Button Press the LINE-UP button to turn the projector lam
the images on the projection screen. PAX will seq
ically as you press the LINE-UP button. One of t
throughout the line-up sequence, allowing it to b
others. Using special alignment slides is highly r

◆ NOTE: If PAX receives any instruction throu
during the line-up which causes a slide tray 
quence will be aborted and all lamps set to t

Manual Reset Press the LINE-UP button firmly for about two sec
turn off their lamps and return the slide trays to 
allows you to manually reset all projectors, for ex
support presentation using a remote control con

◆ NOTE: Manual reset can’t be used while PA
or TAPE connectors, as this data will immedi
their programmed states. Use a Trigger:Rese
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Rear Panel

connect to the slide projectors, or other 
propriate projector adaptor cables or 
e 339).

Y switch
W switch

Switch Common

INSIDE
PAX
The four ports on the back of the unit 
devices being controlled, using the ap
AUXILIARY CABLE (see picture on pag

Y W

24V AC
power supply

(leftmost port only)

1
6

Power can be supplied to PAX 
through the leftmost of the four 
ports (front view). Most slide 
projectors are capable of 
supplying power to the PAX in this 
way. Check the documentation for 
the particular projector adaptor 
for details. If the projector can’t 
supply power to the PAX, a sepa-
rate ACPAX or ACPAX ADAPTOR 
is needed.

PAX Relay Functions, 
Wiring Diagram



Lamp triac
triggering

Snap 

Slide tray
forward
relay

Slide tray
reverse
relay

Reverse 

Forward

Common

wer
tor 
rt only)

INSIDE
PAX
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Snap relay

Lamp triac
triggering

circuit.

24V AC po
from projec
(leftmost po

Slide tray
home sense

signal

1
6

▼ IMPORTANT: All projectors 
connected to one PAX unit must 
be powered from the same out-
let in order to avoids phasing 
problems. Projector lamps will 
not turn off properly if connect-
ed to power outlets that are on 
different phases. Projectors con-
nected to different PAX units, 
however, may be connected to 
different outlets or mains phases 
without any restrictions.

PAX Projector Functions, 
Wiring Diagram
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24V AC EXT POWER Connect an ACPAX or ACPAX ADAPTOR to this connector for power supply 
when not powered by a slide projector. 

wer distribution, allowing you to power 
ower supply (using an 11 UNIT RACK 
om an ACPAX ADAPTOR (using a 2.5 

the 24 V AC cable, always pull the con-
r is mechanically secured in the recep-

se damage or result in bad contact and 

er sources as well. PAX will accept either 
24 Volt. The current consumption varies 
ng on the supply voltage and external 

jectors, DC power can not be used. Fur-
st be plugged into the same power outlet 
t PAX unit in order to avoid phasing 
Dataton rack adaptors have built-in po
up to ten units from a single ACPAX p
ADAPTOR, page 341), or two units fr
UNIT RACK ADAPTOR).

▼ CAUTION: When disconnecting 
nector – not the wire. The connecto
tacle. Pulling on the wire may cau
malfunction later on.

You can supply a PAX from other pow
DC or AC voltage in the range 15 to 
between 0.2 and 1 Ampere, dependi
load.

◆ NOTE: When used with slide pro
thermore, the AC power supply mu
as any projectors connected to tha
problems.

AC PAX ADAPTOR (product number 
3337) and AC PAX (product 
number 3338) power supplies.



le for interfacing PAX to most 
ector. See the latest Dataton 

adaptors, or contact your 

 tray cycling and lamp bright-
t advanced features such as 
 cycle sensing for maximum 

 connected to one PAX. Use of 
units is possible, but generally 
ctors’ performance.
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Projector Adaptors A variety of slide projector adaptors are availab
projectors equipped with a dissolve control conn
product catalog for a list of available projector 
Dataton dealer for details.

In addition to controlling basic functions such as
ness, some projector adaptors may also suppor
shutter control, electronic home sensing and tray
speed.

◆ NOTE: Use only projectors of the same kind
different kinds of projectors on different PAX 
not advisable due to differences in the proje

PAX EKTA ADAPTOR 3432, 
connects PAX to Kodak Ekta-
graphic III slide projectors.



Chapter 14: PAX 367

Switch Functions Any output port on a PAX not used for controlling projectors can be used to 
control two switch relay functions. Such functions are commonly used for 

e tape at the end of the show, controlling 

 W and Y. Use a separate Switch device 
29). Use the Type pop-up menu in the 
ox to specify which relay to control. 
ataton:PAX Y-Relay” when the same 
 “Dataton:PAX E AUX W-Relay” or 

using relays only from a PAX with its 
e port’s address into the Port field in the 
 Selector” on page 361).

dresses are allocated right to left on PAX 
ght for slide projectors, as shown on 

onnect your own functions to the PAX 
ds, such as relays or motors, make sure 
nts included with the AUXILIARY CABLE 
h voltage spikes cause by such loads. 
nt across either the load or the PAX 

.

4 Volt AC or DC, 1 Ampere. Although 
 the same pin on the nine pin connector, 
d or any other parts inside the PAX. The 
from each other as well as the internal 
 used for totally separate functions.
various purposes such as rewinding th
motorized screens or curtains, etc. 

The two relays on each port are called
in TRAX to control each relay (page 1
Switch device’s configuration dialog b
Choose “Dataton:PAX W-Relay” or “D
PAX is also controlling projectors. Use
“Dataton:PAX E AUX Y-Relay” when 
OBJECT selector set at E AUX. Enter th
configuration dialog box (see “BANK

▼ IMPORTANT: Switch function ad
(front view) as opposed to left to ri
page 361.

Use a Dataton AUXILIARY CABLE to c
relays. When controlling inductive loa
you use the arc suppression compone
to protect the PAX relays from the hig
Connect the arc suppression compone
relay, as close to the load as possible

The maximum load for each relay is 2
one side of both relays is connected to
it is not electrically connected to groun
four ports are galvanically separated 
parts of the PAX, allowing them to be



.

ort (front view).

r at the back.

ector connected to the leftmost 
adaptor appropriate for your 

n be used for powering the 

e PAX is an alternative way of 
ctors aren’t capable of 
unctions only. See “24V AC 
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Power Supply There are two ways to supply power to the PAX

• From a slide projector through the leftmost p

• Through the 24 V AC EXT POWER connecto

PAX normally takes its power from the slide proj
port. Check the documentation for the projector 
slides projectors.

◆ NOTE: Only the leftmost port (front view) ca
PAX in this way.

The 24 V AC EXT POWER input at the back of th
powering the PAX. Use this method if your proje
supplying power, or when using PAX for relay f
EXT POWER” on page 365 for more details.

Include VARISTOR 6028 whenever switching 
inductive  loads such as relays and motors.
Mount the varistors 
close to the
load.

1 Brown

2 Red – Y Switch

3 Orange – W Switch

4 Yellow

5 Green – Switch Common

6 Blue

7 Violet

8 White

9 Black

AUXILIARY CABLE 3450
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15 15 TRANSPAX+
l and cassette recorders to the Dataton 
ses:

nd then reads it back into TRAX in order 
soundtrack.

a separate track, allowing you to run the 
 the computer.

ns, either in a basic way using a simple 
 locator adaptor for fully automatic tape 

ntrol unit (page 355), it can translate 
 most other non-Dataton multi-image 

epending on the chosen system mode 
the backward compatible system mode, 
ary system bus, usually as the first unit 

e 17). In this case there can only be one 

SPAX+ must be connected through a 
T SMARTLINK (product number 3478). 

ust be connected on a separate sub-bus 
ustration on page 19).
TRANSPAX+ interfaces most open ree
control system. It has four main purpo

• It records timecode onto the tape a
to synchronize a timeline with the 

• It can record a control signal onto 
final show from tape without using

• It can control tape transport functio
remote control cable, or through a
positioning (autolocator).

• Together with the PAX projector co
and play back shows prepared on
systems.

Connecting TRANSPAX+ TRANSPAX+ is connected differently d
(see “System Modes” on page 16). In 
TRANSPAX+ is connected on the prim
on the bus (see the illustration on pag
TRANSPAX+ in a system.

In the interactive system mode, TRAN
SMARTPAX port, using a SYSTEM OU
Furthermore, any PAX control units m
following this TRANSPAX+ (see the ill



ary system bus uses a more 
 system is in its interactive 
ucts, TRANSPAX+ and PAX 
ever, by putting them onto a 
 still be incorporated into the 
e SMARTPAX acts as a medi-

o has the benefit of giving it a 
PAX+ itself doesn’t have an 
ected has. This allows you to 
 which is not the case when 
 bus.

on the primary system bus or 
e Tape device’s configuration 

d to add it as a Tape device to 
ce type on the Type pop-up 

istication:

 control signals.

pe deck (play, pause, record, 

ific positions on the tape using 
ack from the tape recorder 
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The reason for this arrangement is that the prim
sophisticated communication protocol when the
mode. Belonging to an older generation of prod
aren’t capable of coping with this protocol. How
separate, secondary, system cable bus, they can
same system. In this case, the device driver in th
ator between the two buses.

Putting a TRANSPAX+ on a SMARTPAX port als
unique address in the system. While the TRANS
address, the SMARTPAX port to which it is conn
use more than one open-reel deck in a system –
TRANSPAX+ is connected on the primary system

You must tell TRAX whether the TRANSPAX+ is 
on a secondary bus by using the checkbox in th
dialog box (see next section).

Specifying Device Type and 
Connection Method

In order to use TRANSPAX+ with TRAX, you nee
the Device window, and specify the proper devi
menu in the configuration dialog box.

TRANSPAX+ can be used at three levels of soph

• Simply recording and reading timecode and

• The above, plus basic remote control of the ta
etc.).

• Both the above, plus the ability to locate spec
the recorded timecode as well as other feedb
(auto-locator).



Chapter 15: TRANSPAX+ 371

If all you want to do is to record and play timecode and control signals, then 
choose “Dataton:TRANSPAX+” on the Type pop-up menu. If your tape 
recorder has provisions for remote control, and you have the correct tape 

 instead choose “Dataton:TRANSPAX+ 
u.

tolocator control, and you have the 
 choose the specific brand and model of 
such as the “Otari:5050 BQ2” in the 

atible mode, you have the option of 
y to the TRAX computer on the primary 
bus through a SMARTPAX (see 
69). You must tell TRAX how 
adaptor cable (page 392), you should
with remote” on the Type pop-up men

If your tape recorder is capable of au
appropriate locator cable, you should
tape deck on the Type pop-up menu, 
example above.

If you use TRAX in its backward comp
connecting TRANSPAX+ either directl
system cable bus, or on a secondary 
“Connecting TRANSPAX+” on page 3

Choose your tape deck here, or 
select one of the generic 
Dataton:TRANSPAX+ types.

Select this checkbox if TRANSPAX+ 
is connected directly to the computer 
on the primary system cable bus 
(backward compatible mode only).



 the configuration dialog box. 
active mode, in which case 
RTPAX port.

er to enter the address of that 
 the computer, it doesn’t have 
ray.

AX+ (i.e., your tape recorder 
ANSPAX+ using a locator 
utolocator. This is done using 
he tape device, which can be 
ndow.

uto. In this setting, they use 
 selected model of recorder 

 this 
r.
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TRANSPAX+ is connected using the checkbox in
This option is not available if TRAX is in its inter
TRANSPAX+ must be connected through a SMA

If connected through a SMARTPAX port, rememb
port in the Port field. When connected directly to
a user selectable address, and the Port field is g

Configuring the Autolocator If you use the autolocator feature of the TRANSP
is connected to the TAPE CONTROL output of TR
adaptor cable), you may need to configure the a
the Pulses, Retardation and Reversed modes of t
seen at the bottom of the tape device’s status wi

All three of these parameters are initially set to A
default values supplied by TRAX, suitable for the
under normal conditions.

Autolocator settings.

Enter a time value and click
button to test the autolocato
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However, if you use smaller reels or a different tape speed than normal, you 
may need to adjust these values. For example, if you choose to run your tape 
at half speed, you need to explicitly specify the correct number of tacho-pulses 

ewise, if you use smaller or lighter reels 
pe, you may need to tweak the Retarda-

tus window. Try them out by entering a 
cking the Locate button. If the tape deck 
rease the Retardation value. Conversely, 
ue.

for these values, you need to make them 
ering them into Trigger cues assigned to 
Mode” on page 208). Put these trigger 
 run when the system is started, or at the 
he tape deck.

re related to one of the two kinds of tape 
ck:

ariety of such signals. A master tape 
onization purposes. It is also common 
o the master tape if the show is intended 
 from a computer. The control signal can 
per second using the Pulses mode. Lik
than the standard ones, or a shorter ta
tion value.

You can tweak these settings in the sta
time value in the Position field, and cli
slows down too early, you need to inc
if it overshoots, try decreasing the val

After determining the correct settings 
a permanent part of your show by ent
the tape device (see “Device Specific 
cues either on a timeline that’s always
beginning of each timeline that uses t

Tape Signals Most of the functions of TRANSPAX+ a
data signals it can record and play ba

• Timecode

• Control signal

TRANSPAX+ can record and play a v
often uses a timecode track for synchr
practice to record a control signal ont
to eventually run from tape rather than



ape. The show tape can be a 
l tape.

ollowing pages for an over-
for preparing various kinds of 

e cues on a timeline to the 
uous stream of unique, 
e, TRAX knows exactly where 

 matches up.

 formats:

ECAM).

e timecode (NTSC).

hich can be used by most 
BU or SMPTE depending on 
efore using either of these 
he SMPTE/EBU position.
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also be recorded onto – or copied to – a show t
cassette, while the master is usually an open-ree

See “Canned Presentations” on page 220 and f
view of how to use timecode and control signals 
presentations.

Timecode A timecode track allows TRAX to synchronize th
sound on tape. The timecode consists of a contin
increasing numbers. By reading these off the tap
the tape is, and can make sure that the timeline

TRANSPAX+ can record the following timecode

• EBU 25 frames per second timecode (PAL/S

• SMPTE 30 frames per second non-dropfram

These are industry standard timecode formats w
professional audio and video systems. Choose E
which video standard is used in your country. B
formats, set the TRANSPAX+ CODE selector in t
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Recording Timecode Click the Record button in the tape device’s status window to record the time-
code. Connect the RECORD output of the TRANSPAX+ to LINE IN on the 

 mode. When recording, make sure you 
s before the first cue’s position. Adjust 
 dB readout on the VU meter. Don’t 

 end of the show, as it is not possible to 

T of the timecode track to the PLAY input 
input either on the front or the back. Set 
ode, play the tape, and adjust the play-
OK indicator on the TRANSPAX+ front 
 selector on the TRANSPAX+ front panel 

k the Record button in the status 
dow to display the TRANSPAX+ 
ording dialog box.
recorder and set the channel in record
begin the timecode at least ten second
the recording level, if possible, for a 0
forget to record extra timecode at the
extend the timecode afterwards.

Playing Timecode To play the timecode, connect LINE OU
on the TRANSPAX+. You can use the 
the timecode track to Play or Repro m
back level (if possible) until the TAPE 
panel is steady. Make sure the CODE
is set in the SMPTE/EBU position.

1

2

3

4

Timecode being recorded 
on a free audio track.

Clic
win
Rec



eld of the tape device’s status 
e control feature, then start the 
rather than the play button on 

page 223 for information on 

 control signal track on the 
ing the computer, simply by 
control unit chain. This can be 
’re all equipped with a control 

 signal, and then pass it on to 
 high-level, digital signal. As 

 a weaker, line-level, audio 
ly no longer than two meters. 
y from the system, a separate 
 control signal, and then pass 
ontrol unit.

ANSPAX+ must be connected 
NSPAX+” on page 369) and 

le mode. You can not record a 
 “System Modes” on page 16 

 output from the TRANSPAX+ 
ignal. Set that track in Record 
ay as for timecode recording 
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The timecode will be displayed in the Position fi
window. If you’re using the autolocator or remot
tape using the play button in the status window 
the player itself.

Please refer to “Synchronizing to Timecode” on 
how to synchronize a timeline to the timecode.

Control Signal Recording The final show can be recorded onto a separate
tape. This allows you to run the show without us
feeding the control signal into the first unit in the 
a TRANSPAX+, a SMARTPAX or a PAX, as they
signal input on the front panel.

The first unit in the chain will decode the control
the other units through the system cable bus as a
the signal from the tape player to the first unit is
signal, this cable should be kept short – preferab
If the tape player needs to be located farther awa
TRANSPAX+ can be used up front to decode the
it on through a longer system cable to the first c

▼ IMPORTANT: To record a control signal, TR
directly to the computer (see “Connecting TRA
the system must be in its backward compatib
control signal while in Interactive mode. See
for more details.

To record the control signal, connect the RECORD
to LINE IN of the track to be used for the control s
mode, and set the recording level in the same w

1

2

3

4

Timecode being 
read back.

Control signal 
being recorded.
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(see page 375). Make sure that the PLAY input on the TRANSPAX+ is still 
connected to LINE OUT of the timecode track. Start the tape in record mode, 
either by clicking the record button in the tape device’s status window and 

PAX+ Recording dialog box, or – if your 
ONTROL output of the TRANSPAX+ – by 
e recorder. Run through the show as 

as you go.

U meter may fluctuate and show a lower 
nal. This is due to the sparse modulation 
 Do not compensate for it by increasing 

on page 225 for more details on 

o the PLAY or TAPE input of the first unit 
nal playback, you generally don’t need 
ect the TRANSPAX+ from the rest of the 
l directly to the first control unit.

 connected, then quit TRAX and discon-
X+.

e disconnecting the TRANSPAX+. If you 
isconnect the power to the TRANSPAX+ 
l signal properly.

l through a TRANSPAX+ in this way, a 
l is provided on the RECORD connector. 
ith its control signal.
choosing Control Signal in the TRANS
recorder isn’t connected to the TAPE C
pressing the appropriate buttons on th
usual – the control signal is recorded 

◆ NOTE: The level indicated by the V
level while recording the control sig
scheme used by the control signal.
the recording level. 

Refer to “Recording a Control Track” 
recording the control signal.

Control Signal Playback To play the control signal, connect it t
in the system and start the tape. For fi
the TRANSPAX+. In this case, disconn
system, and connect the control signa

If you prefer to keep the TRANSPAX+
nect the computer from the TRANSPA

◆ NOTE: You must quit TRAX befor
forget this, you can momentarily d
in order to make it play the contro

While playing a Dataton control signa
re-generated copy of the control signa
This can be used to duplicate a tape w



ignals or cue tracks produced 
using any of the following 

s, set the CODE selector 
TRANSPAX+. TRANSPAX+ 
ediate format, which is then 
en receiving this signal, PAX 
luding dissolve curve charac-
fic to each system.

junction with the PAX dissolve 
RTPAX, even if used with slide 
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Other Control Signals TRANSPAX+ can play, but not record, control s
by most other professional multi-image systems 
formats:

• Procall 5 and Procall X (AVL).

• Mate-Trac (Arion and Kodak PDC).

• Alphasync (Electrosonic).

To play a show recorded in any of these format
accordingly and play the control signal into the 
decodes and translates the signal into an interm
further interpreted by the PAX dissolve unit. Wh
will emulate all aspects of the original show, inc
teristics, flashes, loops, and other features speci

▼ IMPORTANT: This feature works only in con
unit. Specifically, it does not work with SMA
projectors only.
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Front Panel

d compatible mode (page 16), connect 
g the gray TRAX cable. If you’re using 
), then connect TRANSPAX+ to the 
 its interactive mode (page 18), connect 
EM OUT SMARTLINK (product number 
” on page 369 for more details.

nded using a Dataton system cable (0.4, 
M CABLE KIT for custom lengths up to a 

tem cable has a male connector at one 
er which makes daisy-chaining multiple 

ntrol unit in the chain. The cable between 
+ and the next unit must not be more 
 its power from the next unit through the 
RANSPAX+ locally through its 24 V AC 
system cable can be up to 100 meters 
3).

its interactive mode, any PAX units must 
rough the OUT connector of the TRANS-
IN Connector When using the system in its backwar
the computer to the IN connector usin
both ports on the computer (page 111
modem port. When using the system in
IN to a SMARTPAX port using a SYST
3478). See “Connecting TRANSPAX+

The cable connected to IN can be exte
1, 2 and 5 meter lengths) or the SYSTE
maximum of 100 meters. Dataton sys
end and a female connector at the oth
cables easy.

OUT Connector The OUT connector links to the next co
the OUT connector on the TRANSPAX
than 25 meters as TRANSPAX+ takes
cable. Alternatively, you can supply T
EXT POWER input, in which case the 
long (see “Power Supply” on page 39

◆ NOTE: When using the system in 
be connected as a secondary bus th



RTPAX. See “Connecting 
.

nnector is a high-level digital 
aped in each unit to ensure 

rol signal standards, as deter-

ckwards through the IN 
ugh a SMARTPAX port), 
line with the audio tape.

d a cue track), first quit TRAX 

 TRANSPAX+, a re-generated 
pe duplication purposes. 

gnal, and passes it on as a 
 comes from the tape player is 
tween the tape player and the 
, preferably no longer than 
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PAX+. This applies to PAX only – not to SMA
TRANSPAX+” on page 369 for more details

The data sent to the next unit through the OUT co
signal. The signal is optically isolated and re-sh
maximum reliability even in very large systems.

PLAY Connector The PLAY input accepts most timecode and cont
mined by the CODE selector (page 384).

When playing timecode, the timecode is sent ba
connector to the computer (either directly or thro
where it can then be used to synchronize a time

When playing a control signal (sometimes calle
then play the control signal into TRANSPAX+.

When playing a Dataton control signal through
signal is available on the RECORD output for ta

TRANSPAX+ decodes the timecode or control si
high-level, digital data stream. As the signal that
a relatively weak audio level signal, the cable be
TRANSPAX+ should be kept as short as possible
two meters.
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You can monitor the quality of the received tape signal by watching the TAPE 
OK indicator. Although the other units in the chain also have TAPE/DATA OK 
indicators, only the first unit’s indicator will accurately indicate the tape 

remain on all the time while playing the 
oor quality or a weak signal. Try 

t the problem.

AY input which might be helpful when 

 ground.

±20%, timecode: ±15%.

tion scheme used by the Dataton control 
 most regular VU meters or when using 
 to the tape output. Use an oscilloscope 
d.
signal’s quality. The indicator should 
tape. Intermittent flickering indicates p
adjusting the playback level to correc

Here are some specifications of the PL
troubleshooting an installation:

Input sensitivity: 150 mV peak relative

Input impedance: 10 kOhm.

Tape speed tolerance; control signal: 

◆ NOTE: Due to the sparse modula
signal, it appears as very weak on
an averaging volt meter connected
to check the output level, if require



per signal is received through 
of the signal. If the indicator 
r low-level signal is received.

SPAX+ is different from those 
s that a proper signal is being 
onitor the IN connector as it 

ugh you know you’re playing 
pe may be of a different type 
y changing the setting of the 
til the TAPE OK indicator 

or a list of the various settings.

ode of the TRANSPAX+ when 
sible to have the TRANSPAX+ 
end of the control signal is 
w.

 disconnect the computer. The 
TROL output of the 

ble or locator adaptor.

ignal.

l signal.

start it.
382 Chapter 15: TRANSPAX+

TAPE OK Indicator The TAPE OK indicator is turned on when a pro
the PLAY connector. It also indicates the quality 
flickers frequently, it means that a poor quality o

◆ NOTE: The TAPE OK indicator on the TRAN
on PAX and SMARTPAX in that it only indicate
received through the PLAY input. It doesn’t m
does on those other units.

If the TAPE OK indicator fails to come on even tho
a signal into the PLAY input, the signal on the ta
than the current setting of the CODE selector. Tr
CODE selector slowly, one position at a time, un
comes on. See “CODE Selector” on page 384 f

MODE Selector The MODE selector determines the operation m
using its auto-present functions. This makes it pos
automatically stop or rewind the tape when the 
reached, as well as optionally re-starting the sho

In order to use these features, first quit TRAX and
tape player must be connected to the TAPE CON
TRANSPAX+ using a suitable remote control ca

STOP. Stop the tape at the end of the control s

REW. Rewind the tape at the end of the contro

REW-PLAY. Rewind the tape and re-start it.

REW-WAIT-PLAY. Rewind, wait and then re-
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The action performed according to the setting of the MODE selector is trig-
gered by the disappearance of the control signal. Thus, if you manually stop 
the tape, TRANSPAX+ will also perform the selected action. To avoid this, 

L connector.

des with an open-reel tape player, the 
ning-of-tape sensor. This tells 
the tape. See “TAPE CONTROL 
tails.

lly re-start the tape. If a beginning-of-
-started as soon as the beginning of the 
(for example if you’re using a cassette 
tape two minutes after initiating the 

 to the REW-PLAY mode, but adds an 
 the rewind and the re-start. If you’re not 
means that there will be a ten minute 
ime is then fixed at two minutes. If you 
 actual rewind time plus eight minutes.
simply disconnect the TAPE CONTRO

When using any of the rewinding mo
player must be equipped with a begin
TRANSPAX+ when to stop rewinding 
Connector” on page 388 for more de

The REW-PLAY mode will automatica
tape sensor is used, the tape will be re
tape is reached. If a sensor isn’t used 
player), TRANSPAX+ will re-start the 
rewind.

The REW-WAIT-PLAY mode is similar
eight minute delay between the end of
using a beginning-of-tape sensor this 
break between shows, as the rewind t
use a sensor, the total time will be the



ignal accepted by the PLAY 

in off even if a signal is being 
g the setting of the CODE 
e TAPE OK indicator comes on.

l through the TRANSPAX+. 
ay from the first PAX or 
 without the TRANSPAX+ and 
ut of the first PAX or 

 the TRANSPAX+ in this way, 
RD output. This can be used 
irst generation copy of the 

dard SMPTE or EBU timecode 
 timecode that’s being used 

gh the TRANSPAX+, you must 
n’t forget to set it back to 
SPAX+ will fail to recognize 
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CODE Selector The CODE selector determines the type of tape s
input.

If set incorrectly, the TAPE OK indicator will rema
fed into the PLAY input. In this case, try changin
selector slowly – one position at a time – until th

Dataton Use this position to play a Dataton control signa
This is useful if the tape player is located far aw
SMARTPAX. However, in most cases you can do
play the control signal directly into the TAPE inp
SMARTPAX unit in the chain.

When playing a Dataton control signal through
a re-generated signal will appear on the RECO
when duplicating show tapes in order to get a f
control signal.

SMPTE/EBU Use this position together with TRAX to read stan
from tape. TRANSPAX+ auto-detects the type of
and passes it on to the computer.

If you want to play a Dataton control signal throu
set the CODE selector to its Dataton position. Do
SMPTE/EBU when using the computer, or TRAN
the timecode.
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ES Use this position to play shows originally produced on Electrosonic equipment 
using the Alphasync control signal format. This format is used by the ES 4000 

nic equipment use other formats which 
.

s to the OUT connector of the 
ors at 1L, 2L, 3L, etc., according to the 
X unit can control up to three slide 
shows.

ctions, those are also emulated using the 

ree relays.
series of control units. Older Electroso
are not compatible with TRANSPAX+

Connect up to eight PAX dissolve unit
TRANSPAX+ and set their bank select
original show programming. Each PA
projectors when running Electrosonic 

If the program uses auxiliary relay fun
fourth output port on each PAX:

Pin 5 on the PAX is common for all th

ES PAX pin
A 3

B 2

C 4



ed on Arion equipment using 
 the Kodak PDC two-projector 

 connector of the TRANSPAX+ 
according to the original show 
four slide projectors.

le two-projector control units, 
 run the show.

se are also emulated using a 
d OBJECT E AUX:

relays on that port.

ced on AVL equipment using 
(PosiTrak). TRANSPAX+ does 

 connector of the TRANSPAX+ 
ccording to the original show 
three slide projectors when 
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MATE Use this position to play shows originally produc
the Mate-Trac format. This format is also used by
dissolve unit, and some other manufacturers.

Connect up to four PAX dissolve units to the OUT
and set their bank selectors at 1L, 2L, 3L and 4L, 
programming. Each PAX unit can control up to 

◆ NOTE: If the show is programmed for multip
the same number of PAX units are needed to

If the program uses auxiliary relay functions, tho
separate PAX, which must be set to BANK 1L an

Pin 5 on each PAX port is common for all three 

AVL Use this position to play shows originally produ
the Procall-5 or Procall-X control signal formats 
not read shows produced on Enhanced Procall.

Connect up to five PAX dissolve units to the OUT
and set their bank selectors at 1L, 2L, 3L, etc., a
programming. Each PAX unit can control up to 
running AVL shows.

Auxiliary relay functions 
on separate PAX set to 1L 
and E AUX.

D C B A

Arion PAX pin
1 3

2 2

3 4
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◆ NOTE: Shows using more than 15 projectors use a second tape track. In 
this case, an additional TRANSPAX+ is needed to play the show.

ctions, these are also emulated using the 

relays.

 the full set of features supported by that 
be used for special purposes, or for 

ve the AVL position, disregards the Posi-

 compatibility with old two projector 
nd third port on each PAX.

 the S2 position, combines the NP and 

PAX+ to reset all devices to their home 
ton will light up when the button is 
es are ready.

hile TRAX is active. Instead, use TRAX to 
eset cue (page 209).
If the program uses auxiliary relay fun
fourth output port on each PAX:

Pin 5 on the PAX is common for both 

In the AVL position, TRANSPAX+ uses
system. The other three positions can 
compatibility with older shows:

NP. The NP position, located just abo
Trak tray positioning information.

S2. Selects the Sequence 2 mode, for
shows. In this case, use only the first a

,NP. This position, located just above
S2 modes.

HOME Button Press the HOME button on the TRANS
positions. The indicator below the but
pressed and will go off when all devic

◆ NOTE: This button doesn’t work w
home all devices using a Trigger:R

AVL PAX pin
L 3

R 2



for power supply, if this is not 
ack adaptors have built-in 
 ten control units from a single 
 ADAPTOR, as shown on 
OR (using a 2.5 UNIT RACK 

C cable, always pull the con-
nically secured in the recepta-
r result in bad contact and 

r sources as well. It will accept 
olt. The current consumption 
n the supply voltage and 

d by TRAX.

tape remote or a locator 
to your recorder. Most profes-
 the back for basic tape trans-
388 Chapter 15: TRANSPAX+

Rear Panel

24V AC EXT POWER Connect an ACPAX or ACPAX ADAPTOR here 
supplied by the next unit in the chain. Dataton r
power distribution, allowing you to power up to
ACPAX power supply (using an 11 UNIT RACK
page 341), or two units from an ACPAX ADAPT
ADAPTOR).

▼ CAUTION: When disconnecting the 24 V A
nector – not the wire. The connector is mecha
cle. Pulling on the wire may cause damage o
malfunction later on.

You can supply a TRANSPAX+ from other powe
either DC or AC voltage in the range 15 to 24 V
varies between 0.2 and 1 Ampere, depending o
external load.

POWER CONTROL Connector The POWER CONTROL connector isn’t supporte

TAPE CONTROL Connector To control tape transport from TRAX, connect a 
adaptor cable from the TAPE CONTROL output 
sional recorders have a remote control socket on
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port functions. High-end open-reel recorders often have a more sophisticated 
connector intended for connecting an autolocator or synchronizer.

Common

PAUSE

FORWARD

RECORD

REWIND

PLAY

STOP
BOT Sense –


1
6

INSIDE
TRANSPAX

BOT Sense +

Wiring diagram for the 
TAPE CONTROL 
connector.



of professional tape recorders 
heck with your Dataton dealer 

 be able to make a simple 
number 3450), which comes 
ropriate connector (see the 

must also configure the corre-
 may also have to adjust the 
cribed under “Configuring the 

 TRANSPAX+ to improve relia-
tallations. Without this sensor, 
e-up reel. The sensor can be 
 be implemented using either 
, it usually consists of a light 
omponent. Wire the sensor to 
will apply 5 V DC across pin 
.
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A wide range of cables suitable for most brands 
is available (see the Dataton product catalog). C
for details on specific models.

For basic remote control functions, you may also
cable based on the AUXILIARY CABLE (product 
with a “pigtail” at one end for soldering the app
picture on page 339).

When using an autolocator adaptor cable, you 
sponding Tape device in TRAX accordingly. You
autolocator parameters for your recorder, as des
Autolocator” on page 372.

A beginning-of-tape sensor can be connected to
bility when using open reel recorders in fixed ins
the tape can accidentally be rewound off the tak
retro-fitted to most open reel recorders, and can
transmissive or reflective methods. In either case
source and a sensor – often integrated into one c
the TAPE CONTROL input in such a way that it 
7(+) and 1(–) when at the beginning of the tapeA transmissive beginning-of-tape 

sensor.
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In addition to this sensor, the tape must be prepared by splicing in a trans-
parent or reflective leader. Make this leader at least 12 meters (40 feet) long to 
guarantee that the tape will stop gracefully even when winding at maximum 

ning-of-tape signal, it will stop the tape. 
g the end of the control track, as deter-

PAX+ will proceed according to the 

 or control signals onto tape. Connect it 
e channel. Proceed as described under 

 signal, the level indicated by the VU 
 be lower than a timecode signal level. 
 for it by increasing the recording level.

nector is 1 V peak over 10 kOhm. The 
d 3 kHz depending on type of signal.

the PLAY input on the front. Use only one 
speed and with large tape reels.

When TRANSPAX+ receives the begin
If the rewind was triggered by reachin
mined by the MODE selector, TRANS
MODE setting (page 382).

RECORD Connector This output is used to record timecode
to the LINE IN input on the desired tap
“Tape Signals” on page 373.

◆ NOTE: While recording a control
meter may fluctuate and appear to
This is normal; do not compensate

The output signal on the RECORD con
signal frequency varies between 1 an

PLAY Connector This input serves the same purpose as 
of these inputs at a time.



olling most professional tape 
his offers the following capa-

n reel players, for fixed instal-
 desired function for stand-
nctions through TRAX.

ice’s status window in TRAX.

ost professional open reel re-
izer socket.

n producing presentations. As 
matically positioned accord-

abilities, you may be able to 
 transport functions. This also 
t functions built into 

for more details. Contact your 
 with specific tape recorders.
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Tape Adaptors A range of adaptor cables is available for contr
recorders through the TAPE CONTROL output. T
bilities:

• Auto-present functions using cassette or ope
lations. Use the MODE selector to choose the
alone operation, or program the transport fu

• Basic remote control functions, using the dev

• Full autolocator capabilities, together with m
corders equipped with a locator or synchron

The autolocator feature is a great time-saver whe
you move along a timeline, the tape can be auto
ingly.

For recorders not equipped with autolocator cap
use a simple remote control cable for basic tape
allows you to take advantage of the auto-presen
TRANSPAX+.

See “TAPE CONTROL Connector” on page 388 
Dataton dealer for information on compatibility
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Power Supply There are two ways to supply power to TRANSPAX+.

• From a PAX or SMARTPAX control unit connected to OUT.

 connector at the back.

rom the next unit connected through the 
mum length of the cable between the 
eters.

 back of the TRANSPAX+ is an alterna-
od if the control unit to which the 
le of supplying power, or if a longer 
 “24V AC EXT POWER” on page 388.

SPAX+ through a SMARTPAX port (see 
e 369), it does not receive power from 

ontrol unit connected to the OUT connec-
upply it through its 24 V AC EXT POWER 
• Through the 24 V AC EXT POWER

TRANSPAX normally takes its power f
OUT connector. In this case, the maxi
TRANSPAX+ and the next unit is 25 m

The 24 V AC EXT POWER input at the
tive way of powering it. Use this meth
TRANSPAX+ is connected isn’t capab
cable than 25 meters is required. See

◆ NOTE: When connecting a TRAN
“Connecting TRANSPAX+” on pag
the SMARTPAX port. If there’s no c
tor on the TRANSPAX+, you must s
connector.

An AC PAX ADAPTOR (product 
number 3337) or AC PAX (product 
number 3338) can be used to 
power a TRANSPAX+.



AX 3
tween TRAX versions 2 and 3. 
y be particularly helpful as it 

anual, which you need to read 
es introduced in version 3.

lve around three things:

r tasks simultaneously.

, such as buttons and sensors.

es as you want. New timelines 
n the Window menu 
e, double-click its name in the 
” on page 29). A timeline can 
e bar while the timeline 
 its starting condition in the 
ition for a Task” on page 53).
A
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A. NEWS IN TR
This appendix describes the main differences be
If you’ve used TRAX version 2, this appendix ma
contains pointers to other relevant parts of this m
in order to take full advantage of the new featur

Overview Most of the new features in TRAX version 3 revo

• The ability to run multiple timelines and othe

• Active inputs to TRAX from the outside world

• The TOUCHLINK touch panel.

Multiple Timelines In TRAX version 3, you can have as many timelin
are created using the New Timeline command o
(page 102). To open an already existing timelin
Task window (see “Opening a Timeline Window
be started either manually, by pressing the spac
window is active, or automatically according to
Task window (see “Specifying the Starting Cond
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As each timeline can potentially control any devices, a number of mechanisms 
have been implemented in order to keep things straight: 

wnership” on page 121).

k’s Priority” on page 52). 

ausing a Timeline” on page 42).

 be of little use if there were no inputs to 
tarted. Hence, TRAX version 3 supports 
ich feed back information from the 
side TRAX (see “Digital Input Functions” 

d into arbitrarily complex starting condi-
 Starting Condition for a Task” on page 

ctive” system mode in order to use such 
ge 16.

es hand in hand with multiple timelines, 
e to any device in the system capable of 
ludes most tape and disc devices. See 
” on page 42.

oth interactive applications and for more 
ntrol functions. TRAX version 3 includes 

r interface for your presentation, as well 
essly. Learn all about this in Chapter 6.
• Device Ownership (see “Device O

• Task Priority (see “Changing a Tas

• Task Life span (see “Stopping vs. P

Active Inputs The ability to run multiple tasks would
TRAX by which these tasks could be s
active inputs through SMARTPAX, wh
system to the corresponding devices in
on page 331).

This information can then be combine
tions for the tasks (see “Specifying the
53).

◆ NOTE: TRAX must be in its “Intera
inputs. See “System Modes” on pa

Another kind of active input, which go
is the ability to synchronize any timelin
supplying timing information. This inc
“Synchronizing a Timeline to a Device

TOUCHLINK Touch panels are commonly used in b
traditional environment and remote co
all you need to design an elegant use
as integrating it into the system seaml



, such as the Note and Tape 
tionality has been incorpo-
er windows have been 

eline window; it now has four 
The Pause button is new, and 
AX version 2. The Stop button 
ated by a gray numeric time 
e is stopped in this way, it 
e back and forth along such a 

 of the timeline automatically 
 is not necessarily the case in 
have been set by other means 
imeline, or directly by the user 
d by a timeline regards the 
ver it as its correct home posi-
their home positions at the 
 at the beginning of that time-
t (Home)” on page 209.

 choosing the corresponding 
e window is active (see “Time-
ou can name the timeline and 
end.
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Windows Some specialized windows from TRAX version 2
Control window, have been removed. Their func
rated into devices, as described below. Most oth
enhanced.

Timeline Window There’s one small but important change in the tim
buttons in the lower left corner instead of three. 
corresponds functionally to the Stop button in TR
now permanently stops the timeline. This is indic
readout in the timeline window. While a timelin
doesn’t control any devices. Thus, you may mov
timeline without affecting the devices.

In TRAX version 2, going back to the beginning
reset all the devices to their home positions. This
TRAX version 3, as the status of the devices may 
before the timeline was started, i.e. by another t
through a touch panel. Instead, each device use
status it had when the timeline first took control o
tion. If you want the devices to always return to 
beginning of a timeline, put a Trigger:Reset cue
line and assign it to all those devices. See “Rese

Timeline Settings The Timeline Settings dialog box is displayed by
command on the Window menu when a timelin
line Settings” on page 103). In this dialog box y
specify other details, such as its beginning and 
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A checkbox allows you to determine whether the timeline should stop auto-
matically after running past its last cue. This automatically frees up any devices 
it has acquired, allowing them to be controlled by touch panels or other time-

e 121).

eline Settings dialog box indicate 
o a device or another timeline, and 
 device’s time position and the timeline’s. 
naged by the revised Control cue (see 

nd Record Timecode windows are gone, 
ctionalities have been added to the 
e drivers for the open reel and cassette 
AX+. 

irectly from the computer or through a 
 works only in “Backward Compatible” 

o Computer” on page 133). 

ugh device specific modes in the tape 
te to set these parameters if desired.

nization between the tape recorder and 
 possible to have any number of tape 

d not be practical. Instead, you must use 
ch device a timeline should be synchro-
e” on page 223.

ow to use TRANSPAX+ with TRAX.
lines (see “Device Ownership” on pag

The two fields at the bottom of the Tim
whether the timeline is synchronized t
whether there’s any offset between the
The synchronization of timelines is ma
“Synchronize To” on page 214).

Tape Control Window The old Tape Control, Tape Settings a
along with their menu items. Their fun
regular Tape device, using new devic
recorders controlled through TRANSP

You can control TRANSPAX+ either d
SMARTPAX. The direct control method
mode (see “TRANSPAX+ Connected t

Auto-locator settings are handled thro
device. Use Trigger cues as appropria

There’s no longer any implied synchro
the timeline, as in TRAX 2. As it is now
devices as well as timelines, that woul
a Control cue to explicitly state to whi
nized. See “Synchronizing to Timecod

See Chapter 15 for more details on h



iated settings at the bottom of 
n over by the new Text device 

, sophisticated multitasking in 
1.

tus window that can be 
en. This is in addition to its 
opened by selecting the 
on the Object menu. Refer to 

-named “Device Support”. It 
gh PAX and TRANSPAX+. All 

el designs to TOUCHLINK. A 
 you to specify what you want 
n.

ils.

 device drivers to SMARTPAX 
2.3 or earlier when TRAX is in 
oftware version is shown brief-
hed on. If you have problems 

to temporarily set the system 
rences dialog box (page 16).
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Note Window The Note window is gone, together with its assoc
the Window menu. Its functionality has been take
and its status window (see page 151).

Task Window This window is new. It is the home of all the new
TRAX version 3. See “Task Window” on page 5

Device Status Windows Each device in the Device window has a new sta
opened, and – if desired – left open on the scre
configuration dialog box. The status window is 
device’s icon and choosing Show Device Status 
each device in Chapter 5 for full details. 

Device Support Window The old SMARTPAX Drivers window has been re
now lists all devices, even those controlled throu
non-SMARTPAX devices are shown in italics.

This window also manages downloading of pan
pop-up menu at the bottom of the window allows
to download before clicking the Download butto

See “Device Support” on page 63 for more deta

▼ IMPORTANT: It is not possible to download
units equipped with system software version 
its Interactive mode. The SMARTPAX system s
ly in the display when the SMARTPAX is switc
downloading device drivers, you may have 
mode to “Backward Compatible” in the Prefe
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Menus The menu structure of TRAX version 3 is similar to version 2, with only minor 
alterations.

nds on the File menu have been 
orporated in the Tape device (see 

 removed. You can import devices from 
ting them into the new show. The ability 
trol has been removed. Speaker support 
LINK remote control unit instead.

 Front” commands are used to change 
ms such as buttons and sliders. See 
e 84.

nd is used to open the status windows of 
u can Option-double-click on the device 
also a check-box in the Preferences 
the behavior of double-clicking a device 
s window, in which case Option-double-
indow instead.

nu, which is used as an aid when 
 “Symbol Menu” on page 96.

d. The “Big Notes” and “Black Notes” 
ote window’s appearance, are gone 

. Corresponding selections for the new 
File All tape and timecode related comma
removed. These functions are now inc
page 375).

The ability to import devices has been
other shows by copying them and pas
to run using the mouse as a remote con
presentations can be run from an AIR

Edit The new “Send to Back” and “Bring to
the front-to-back ordering of panel ite
“Bring to Front, Send to Back” on pag

Object The new “Show Device Status” comma
the selected devices. Alternatively, yo
to open its status dialog box. There’s 
dialog box that allows you to reverse 
so that it will, by default, open it statu
clicking will open the configuration w

Symbol TRAX version 3 has a new Symbol me
entering start conditions for tasks. See

Window Menu The Window menu has been simplifie
items, previously used to control the N
(together with the Note window itself)



onfiguration dialog box (see 

ws as you want, the timeline 
. To open a timeline window, 
lumn of the Task window.

rseded by the “Device 
ontrolled through PAX and 
of panel designs to 

 on the Window menu.

he same, with only minor alter-

nged to Serial. Likewise, what 
erial device drivers. The CD 

 LaserDisc is now called Video 

”) can still be typed straight 
ialog box. However, an addi-

he various parts of the port 
ox is accessed by clicking the 
’s configuration dialog box. 
puter port to use (previously 
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Text device’s status window can be made in its c
page 151).

As TRAX can now have as many timeline windo
window is no longer listed on the Window menu
double-click the timeline’s name in the Action co

The old “SMARTPAX Drivers” menu item is supe
Support” item, as it now also includes devices c
TRANSPAX+ as well as handling downloading 
TOUCHLINK.

Keyboard shortcuts are provided for most items

Devices The functionality of most of the devices remains t
ations and enhancements.

The name of the old ASCII device has been cha
used to be called ASCII drivers are now called S
device is now called Audio Disc, and the former
Disc.

Device Port Selection The port assignment (previously called “Address
into the Port field of each device’s configuration d
tional dialog box is now provided for entering t
assignment in a more intuitive way. This dialog b
Choose button next to the Port field in the device
Here, two radio buttons let you select which com
this was done by adding 100 to the address). 
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Device Ownership As TRAX 3 can have many timelines running at the same time, conflicts may 
occur when a timeline wants to use a device. If the device is already owned by 

her priority than the new timeline trying 
e granted access to the device. The 

 (see “Device Ownership” on page 121).

 way it’s supposed to, check if it is 
e. This can be done by opening the 
e device is currently owned, the owner’s 
r of the configuration dialog box. Open 
 by its ID number. 

virtual” devices using a radio-button in 
cludes the Switch, Level, Still Store, Text 

ce works like a real device in most 
nterpart. Hence, it does not need a port 
ally in TRAX (see “Virtual Devices” on 

ether with panels, and as variables in 
xample under “System Status Tracking” 

 to support both output and input func-
r DIGITAL SMARTLINK, AIRLINK and 
itch” on page 129.

e device’s configuration dialog box, 
nu, then select Output, Input or Both, as 
another timeline with the same or hig
to access it, the new timeline will not b
device is said to be “owned” by a task

Thus, when a device doesn’t work the
already owned by some other timelin
device’s configuration dialog box. If th
ID number will be stated in the title ba
the Task window and look up the task

Virtual Devices Some devices can be designated as “
their Configuration dialog box. This in
and Time devices. Such a virtual devi
aspects, except it has no physical cou
address, and can only be used intern
page 122).

These devices are useful primarily tog
starting conditions for tasks. See the e
on page 252.

Switch Device The Switch device has been enhanced
tions. Input functions are supported fo
MIDI (note on/off messages). See “Sw

To activate the input function, open th
select the device driver on the Type me



put or output functions, in 

em mode in order to use such 

 Switch device allows you to 
es may be activated at a time. 
ains or screens, where you do 
” switches simultaneously 

RANSPAX+ related functions. 
pe Control window. 
mputer, as before, when the 

de (page 16). This is specified 
n dialog box (page 133).

ough a SMARTPAX port, as a 
y to use TRANSPAX+ when 
 device also has the ability to 

ded to the Tape device. 
to the Tape, Video and Audio 

port these features. Check the 
ual devices for the latest news.
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appropriate. Some devices may support only in
which case the other options will be grayed out.

◆ NOTE: TRAX must be in its “Interactive” syst
inputs. See “System Modes” on page 16.

The “Mutually Exclusive in Group” option in the
specify that only one switch in a group of switch
This is useful, for example, when controlling curt
not want to activate both the “open” and “close
(page 130).

Tape Device The Tape device has been enhanced to handle T
This made it possible to remove the separate Ta
TRANSPAX+ can be connected directly to the co
system is used in its “Backward Compatible” mo
by a checkbox in the Tape device’s configuratio

Alternatively, TRANSPAX+ can be connected thr
kind of “open reel smartlink”. This is the only wa
TRAX is used in its “Interactive” mode. The Tape
record timecode.

The ability to locate Index numbers has been ad
Recording and Eject functions have been added 
Disc devices, as well as in the Trigger cue. 

◆ NOTE: Initially, few of the device drivers sup
device information database entry for individ
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Panel Device The new Panel device is used together with TOUCHLINK. Its status window 
provides all the tools for creating and editing buttons, sliders, graphics and 

provided either by direct linkage to 
indow. The panel design is downloaded 
device drivers are downloaded into 
ter 12 for full details.

es: 

w. You can now have as many note win-

nels.

 monitors and other similar devices. Ini-
vailable for such devices.

 a Text device in order to have any effect 
implicitly assigned to the Note window). 
uration dialog box allow you to specify 

previously specified using items on the 

RAX 2 shows into TRAX 3, you must 
ssign all Note cues in the show to it, or 
e “Using Shows Made on TRAX 2” on 

 about this new device type.
other panel items. The functionality is 
devices, or through tasks in the Task w
into TOUCHLINK in the same way as 
SMARTPAX. See Chapter 6 and Chap

Text Device The new Text device has three purpos

• To substitute for the old Note windo
dows as you want.

• To put text into display items on pa

• To talk to LED signs, printers, data
tially, there are no device drivers a

The Note cue must now be assigned to
(in TRAX version 2, the Note cue was 
Checkboxes in the Text device’s config
larger font or white-on-black text, as 
Window menu.

▼ IMPORTANT: When importing T
manually add a Text device and a
the notes will not be displayed. Se
page 405.

See “Text” on page 151 for all details



: 

 the time of day, day of week, 

e set using a Locate cue, and 
just like a Tape or Disc device. 

 from the outside world, allow-
ode source. Initially, there are 

is new device.

2. A new use of all cues is that 
llows you to create single-cue 

port Record and Eject. Check 
ividual devices for the latest 

ply to the new Time device 
 a programmable timer, open 
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Time Device The new Time device has the following purposes

• To allow tasks to be triggered depending on
month, etc. 

• To act as a general purpose “timer”. It can b
started and stopped using a Trigger:Play cue 

• To provide a generic timecode input to TRAX
ing a timeline to be synchronized to any timec
no device drivers available for this purpose.

See “Time” on page 152 for full details about th

Cues Most cues have not changed from TRAX version 
they can also be entered into the Task list. This a
tasks. 

Locate and Trigger Cues The Trigger cue has three new functions:

• Reset devices to their power-up status.

• Record.

• Eject.

◆ NOTE: Initially, few of the device drivers sup
the device information database entry for ind
news.

In addition, both the Locate and Trigger cues ap
when used as a programmable timer. To use it as
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the Time device’s configuration dialog box and select Virtual (see “Timer” on 
page 259). 

m cue) has been enhanced significantly 
es as well as the ability to sync timelines 

e revised Control cue on page 212.

 that the “Don’t display in Note window” 
 the Note cue can now be assigned to 
 the Text device’s status window open, 
 Note window.

portant addition; the System Mode 
X 3 between its “Interactive” and “Back-
mportant distinction, since it determines 
trol units (SMARTPAX, PAX, 
s the capabilities in terms of interactivity 

System Modes” on page 16.

ted using older versions of TRAX. 
es in TRAX 3, such shows may not 
anual adjustments. For this reason, it 

vious version of TRAX on your hard disk 
 3 have a different icon than shows 
llows the Mac OS Finder to start the 
e-click a show file.
Control Cue The Control cue (formerly called Syste
in order to manage the multiple timelin
to different devices. Read all about th

Note Cue The Note cue looks like before, except
checkbox has been removed. Instead,
one or many Text devices. By keeping
you will get the same effect as the old

Preferences The Preferences dialog box has one im
radio buttons allow you to switch TRA
ward Compatible” modes. This is an i
both the physical arrangement of con
TRANSPAX+) in the system, as well a
and active inputs.

See “Preferences” on page 108 and “

Using Shows Made 
on TRAX 2

TRAX version 3 can open shows crea
However, due to the number of chang
always perform as expected without m
may be a good idea to keep your pre
as well. Shows saved by TRAX version
saved by earlier TRAX versions. This a
correct TRAX version when you doubl



X versions on your hard disk 
eep in mind:

e. Only one program at a time 

ice drivers to SMARTPAX if 
 TRAX version 2 can use most 
sion 3, but not vice versa. This 
ctive system mode of TRAX 3.

use with TRAX 3, these are the 

ontrol window, if used.

line to establish the synchroni-
plicable.

e main timeline to ensure that 

indow, if used.

references dialog box to take 

f those steps.

sion 2 has been removed in 
 configure it for your recorder 
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If you choose to keep both the new and old TRA
in this way, there are a few things you should k

• Don’t run both TRAX versions at the same tim
can use the serial port on the computer.

• Always use TRAX version 3 to download dev
you’re using both versions with the same rig.
drivers that have been downloaded using ver
is particularly important if you use the Intera

If you choose to convert an older TRAX show for 
steps you need to take:

• Add a Tape device to replace the old Tape C

• Add a Control cue up front on the main time
zation relationship to the tape recorder, if ap

• Add a Trigger:Reset cue at the beginning of th
all devices start out at their home positions.

• Add a Text device to replace the old Note w

• Activate the Interactive system mode in the P
full advantage of all the new features.

The following is a detailed description of each o

Add a Tape Device The separate Tape Control window in TRAX ver
TRAX version 3. Instead, add a Tape device and
as described in Chapter 15.
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Add a Control Cue to 
Synchronize the Timeline

There’s no implied synchronization between the tape device and the timeline in 
TRAX 3, as was the case in version 2. You must establish this explicitly using a 

chronizing to Timecode” on page 223.

ent timelines synchronized to different 
nc sources at any point along a timeline.

es, it would be impractical to have all 
me positions whenever a new timeline is 
pt the initial status of the devices as their 

u return to the beginning of that timeline, 
e position they had when the timeline 

eir power-up positions at the beginning 
o using a Trigger:Reset cue (page 209).

res in TRAX version 3, you must activate 
es” on page 16). This is done in the Pref-
e 112.

 mode, you must make sure that only 
 system bus originating from the 
 units must be on a secondary bus, 
(see “Connecting TRANSPAX+” on page 
ll SMARTPAX units in the system have 
sion 3 or later (see page 320). This can 
download before activating the Interac-
in Automatic Mode” on page 68).
Control cue, as described under “Syn

This not only allows you to have differ
devices. It also allows you to switch sy

Add a Trigger cue to Reset the 
Devices

As you can now have multiple timelin
devices in the system return to their ho
started. Instead, each timeline will acce
correct home positions. Thus, when yo
all devices used by it will be reset to th
was started.

If you want all devices to be reset to th
of a timeline, you must explicitly say s

Activate the Interactive 
System Mode

To take full advantage of the new featu
its Interactive mode (see “System Mod
erences dialog box, as shown on pag

Before activating the Interactive system
SMARTPAX units are connected to the
computer. Any TRANSPAX+ and PAX
connected through a SMARTPAX port 
369). You must also make sure that a
been upgraded to system software ver
be done by performing an automatic 
tive system mode (see “Downloading 



as been removed in TRAX 
ctionality. To make the text 
f a Text device, simply assign 

 you can automate the process 
/Replace command. Start by 
d on all cues that contain the 
e careful to set all options 

along the timeline should be 
orth to confirm that your note 
, though, as doing so will de-

ent of all those cues with the 
ou gave the text device the 
gain. This time, configure it 
alog box to the left.

 selected cues with an assign-

vice, using the “Show Device 
 the timeline to verify that the 
ger typeface or black back-
ext device, if desired.
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Using a Text Device to Display 
Note Cues

The separate Note window of TRAX version 2 h
version 3. The new Text device takes over its fun
from a Note cue show up in the status window o
the Text device to the Note cue.

After creating a new Text device named “Note”,
of assigning all the Note cues to it using the Find
selecting the timeline window and making a Fin
word Note, as shown in the picture to the left. B
exactly as show to the left.

After that first Find command, all the Note cues 
selected. You may scroll the window back and f
cues have been selected. Don’t leave the window
select those cues.

Next, you can replace the blank device assignm
name of your new Text device. Assuming that y
name “Note”, use the Find/Replace command a
exactly as shown in the second Find/Replace di

This will replace all blank device assignments of
ment to the device named Note.

Finally, open the status window for the Note de
Status” command on The Object menu, and run
note cues display properly. You can select a lar
ground in the configuration dialog box for the T
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B B. GLOSSARY
 of the Task window, performed when 
ee also task, condition.

le Macintosh and compatible computers 
ard, AIRLINK RECEIVER, etc.

 10 through 77, used to identify a port 
ol unit, octal.

e spikes from damaging electrical 
igh voltages are generated when the 
 relay or a motor, is cut off. The arc 
cal component, such as a varistor, which 
ee also varistor.

tion Interchange. The most common stan-
 the English alphabet plus numbers and 
g seven bits of information. See also bit, 

ating an arbitrary position on a tape.

 control unit for user-defined functions.

s displayed as a background of other 

here the polarity of the signal is inverted 
e receiver uses the differential voltage 
action A timeline or cue in the Action column
the task’s start condition is satisfied. S

ADB port Apple Desktop Bus. Connector on App
for connecting an ADB mouse, keybo

address A two digit octal number in the range
on a control unit. See also port, contr

arc suppression The process of preventing high voltag
components, such as switches. Such h
power to an inductive load, such as a
suppression is performed by an electri
short-circuits the high voltage spike. S

ASCII American Standard Code for Informa
dard for representing the characters in
punctuation marks in binary form, usin
byte.

autolocator A device capable of automatically loc

auxiliary relay An extra relay provided on a dissolve

background page A page on a TOUCHLINK panel that’
pages. See also page.

balanced signal A signal sent over two twisted wires w
in one wire compared to the other. Th



ults in a signal path that’s less 
e the RS422 and RS485 serial 
tically isolated.

ation. It can only take on two 
yte.

t”. Often used to represent an 
decimal notation. See also bit, 

sks where the same amount of 
. When used with video discs, 
 See also CLV.

ve) to another device (the 
tolocator to position the slave 
, and then using vari-speed to 
ke it match the master’s posi-

.

 where the density of informa-
formation on the outer tracks 

 must rotate at a slower speed. 
e disc. When used with video 
sus 36 minutes for CAV disks 
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between the wires to decode the signal. This res
susceptible to noise. Examples of such signals ar
data standards. See also unbalanced signal, op

baud rate See data rate.

bit Binary digit. The smallest possible unit of inform
states, often represented by 0 and 1. See also b

boolean expression See logical expression.

byte A group of eight bits. Sometimes called an “octe
ASCII character. Typically expressed using hexa
ASCII, hexadecimal.

CAV Constant Angular Velocity. A format used for di
information is stored on each cylinder of the disc
this usually means one full frame per revolution.

chase-lock The process of synchronizing one device (the sla
master). This is typically performed using an au
according to timecode recorded on both devices
fine tune the slave’s position while playing to ma
tion. See also autolocator, timecode, vari-speed

CLV Constant Linear Velocity. A format used for disks
tion is the same all over the disk. Thus, to read in
at the same speed as on the inner tracks, the disk
This results in the ability to store more data on th
discs, this translates into 60 minutes per side ver
(PAL). See also CAV.
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condition An expression in the Condition column of the Task list which, together with the 
condition variant, specifies when the task’s action is to be performed. This 
expression is evaluated as a mathematical formula. If the result is a non-zero 

e true. See also task, expression, action, 

 of the Task list that specifies whether the 
tion is or becomes true or false. See also 

anges, such as the number 5. See also 

 tape track that contains all information 
trol signal track can be fed into the PLAY 
ontrol unit, which decodes it and 

or TRANSPAX+, that can control presen-
ol unit, device.

ormed by one or many devices. Can be 
a timeline.

erred from one place to another, usually 
 See also bit, byte, serial data.

evice used to adapt a computer to a 
m. On such a device, a signal named 
ee also DTE.
value, the condition is considered to b
condition variant, true.

condition variant Information entered in the 1/0 column
task should be started when the condi
task, expression, action, condition.

constant A value in an expression that never ch
expression, variable.

control signal A data signal recorded onto an audio
needed to run a presentation. This con
input of the first SMARTPAX or PAX c
forwards it to the rest of the system.

control unit A device, such as a SMARTPAX, PAX 
tation devices. See also dissolve contr

cue A package with instructions to be perf
placed either in the Task list or along 

cue track See control signal.

data rate The speed at which data can be transf
expressed in bits or bytes per second.

DCE Data Communications Equipment. A d
communications network, e.g. a mode
TRANSMIT is an input to the device. S



, such as a laserdisc player or 
are kept in the Device window 

 a cue by selecting the devices 
devices that have been 
 that cue. See also device, cue.

resents a presentation device. 

tion device supported by 
lect the device in the Device 

that currently controls it. This 
uration dialog box. A device 
s of equal or lower priority or 

rticular make and model. For 
ideo, not all can switch 
o source; i.e., the video 
he device-specific modes 
m of the status window for that 
r cue. See also mode, state.

status property and a panel 
ition. This is done by clicking 
cted, and choosing the status 

n, item, device status property.
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device A piece of equipment used to run a presentation
a slide projector. Icons representing the devices 
in TRAX. See also device icon, virtual device.

device assignment The process of assigning one or many devices to
using the mouse while the cue is selected. Only 
assigned to a cue in this way will be affected by

device icon A symbol in the Device window in TRAX that rep
See also device.

device information database A repository of information about each presenta
TRAX. To see the information about a device, se
Support window and click the Help/Info button.

device ownership The relationship between a device and the task 
can be seen in the title bar of the device’s config
owned by a task can’t be controlled by other task
by panel items. See also task, device, priority.

device-specific mode A function of a device that is specific for that pa
example, while all video disc players can play v
between the internal video and an external vide
switching capability is a device specific mode. T
supported by a device are displayed at the botto
device, and can be programmed using a Trigge

device status linking The process of forming a link between a device 
item, such as a button or a slider, or a task cond
the device icon while the item or condition is sele
property on the pop-up menu. See also conditio
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device status property An attribute of a device which can be affected by cues and panel items, and 
can be used as a variable in task conditions. Some status properties are read-
only, and can not be changed by cues or panel items. See also property, item, 

used to provide information in order to 
 window, non-modal window.

s in discrete steps, such as the slide 
time-continuous device.

 handle slide projectors, e.g. the PAX. 

rs can be simulated by using multiple 
 pixel.

olling dimmers and other lighting instru-
pported by most lighting equipment 
S485.

 as device drivers or graphics, from the 
el devices. Performed using the Down-
dow.

at is an origin or destination of data (as 
rds the data). On such a device, a signal 
he device. See also DCE.

 signal that’s part of the RS-232C stan-
task, cue, device status linking.

dialog box A window on the computer’s monitor 
perform a command. See also modal

discrete-position device A device that has a position that varie
number in a slide projector. See also 

dissolve control unit A control unit specifically designed to
See also control unit.

dithering A process by which intermediate colo
pixels with alternating colors. See also

DMX-512 A digital serial data protocol for contr
ments. Standardized by USITT and su
manufacturers. See also serial data, R

downloading The process of transferring data, such
computer to the control units and pan
load button in the Device Support win

DTE Data Terminal Equipment. A device th
compared to a DCE, which only forwa
named TRANSMIT is an output from t

DTR Data Terminal Ready. A handshaking
dard. See also handshaking.



uivalent of SMPTE. Sometimes 
 standard. See also timecode, 

ssion, such as the starting 
n manually evaluate such 
ssing Command-Enter.

esult. See also condition, eval-

ession. See also true, logical 

 and icons, start applications, 

ideo signal. Common frame 
r second. See also timecode.

 the same time. See also half 

 a Gang cue in order to 
ng members.

hrough the ground and a 
ipment. This can result in unre-
nt. See also optically isolated.

t not at the same time. In this 
es the direction of communi-
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EBU European Broadcasting Union. The European eq
used as a generic name for the 25 fps timecode
fps, SMPTE.

evaluate The process of calculating the result of an expre
condition of a task in the TRAX Task list. You ca
expressions by selecting the expression and pre

expression A simple mathematical formula, giving a single r
uate, sub-expression, logical expression.

false One of the two possible results of a logical expr
expression.

finder The part of the Mac OS that is used to move files
etc. See also Mac OS.

fps Frames per second. Usually used to describe a v
rates are 25 (PAL) and 29.97 (NTSC) frames pe

full duplex The ability to communicate in both directions at
duplex, RS232, RS422.

gang A set of devices that have been combined using
perform operations simultaneously on all the ga

ground loop An unwanted current path where current flows t
communication cable between two pieces of equ
liable communication or damage to the equipme

half duplex The ability to communicate in both directions bu
case, a protocol must be established that manag
cation. See also full duplex, RS485.
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handshaking The procedure by which a device can tell a control unit if it is ready to receive 
new commands.

ssible values of four bits using the 
 through F. Such hexadecimal digits are 
antities, consisting of two or four hexa-

device, etc., on the computer’s monitor. 

essor and supports two way communica-

 as a button, slider or picture.

hnology used in TOUCHLINK.

wo values; true or false. In TRAX, a result 
ng else is considered true. See also 

 that can be recorded onto an audio 
ode, VITC, EBU, SMPTE.

acintosh computers and compatibles. 

 standard by which musical instruments 
g serial data streams. It’s optically 
rial data, optically isolated, unbalanced.
hexadecimal A method of expressing all sixteen po
numbers 0 through 9 plus the letters A
often combined to form 8 or 16 bit qu
decimal digits. See also bit, byte.

icon A small symbol representing a file, a 
See also device, finder.

intelligent device A device that has a built-in microproc
tion. See also device.

item, on panel An object on a page in a panel, such

LCD Liquid Crystal Display. The display tec

linking See device status linking.

logical expression An expression that results in either of t
that is zero is considered false; anythi
condition, expression, false, true.

LTC Longitudinal timecode. Timecode data
track of a tape or disc. See also timec

Mac OS The operating system used by Apple M
See also finder.

MIDI Musical Instrument Digital Interface. A
and computers can communicate usin
isolated and unbalanced. See also se



be dismissed before you can 
utton. See also dialog box, 

de, which can have a state or 
 commands sent to the device 
ally exclusive states. See also 

OS computer marked with a 

eral tasks seemingly at the 
ndow.

 in effect at any one time.

screen while you continue 
. E.g. a device status window 

 memory of a control unit or 
ice is switched off. See also 

sent a group of three bits. See 

 constants and variables in 
able.
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modal window A window on the computer’s monitor that must 
proceed, usually by clicking an OK or Cancel b
non-modal window.

mode An attribute of a device, such as its transport mo
value. When creating Serial drivers in TRAX, the
are grouped into independent modes with mutu
device-specific mode, state.

mode-less window See non-modal window

modem port The communications port on the back of a Mac 
telephone handset. See also port, printer port.

multi-tasking A method by which a computer can perform sev
same time. Implemented in TRAX by the Task wi

mutually exclusive A number of functions of which only one can be

non-modal window A window or dialog box that can be left on the 
working with other functions in the same program
in TRAX. See also modal window, dialog box.

non-volatile A technology by which information stored in the
other device can be retained even while the dev
RAM, ROM.

octal A number in the range 0 through 7, used to repre
also bit, address, hexadecimal.

operator A symbol, such as +, / and <, used to combine
expressions. See also expression, constant, vari
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optically isolated A technology by which a data signal can be transferred a short distance using 
light. This is done to break up the electrical connection between pieces of 
equipment, such as two control units, in order to avoid noise and ground loop 

nced signal, control unit.

e related items. Those items can be 
y that page. See also background page.

n image displayed on a computer 
r, each individual pixel can be either on 
pixel can also take on intermediate 
l can have its own color. The number of 
displayed by each pixel depends on its 
as the number of bits used to store the 
lso bit, dithering.

 unit used to transfer data. See also 
.

ds its most prominent value, e.g. the 
osition to be located by a Locate cue.

 of a Mac OS computer marked with a 
 port.

 in the Priority column in the Task 
et precedence when two tasks try to use 
.

bject which can be changed by the use, 
. See also status property.
problems. See also ground loop, bala

page A page is used on a panel to combin
accessed by telling the panel to displa

pixel Picture element. The smallest part of a
monitor. On a black-and-white monito
or off. On a grayscale monitor, each 
values. On a color monitor, each pixe
grayscale levels or colors that can be 
depth, which is sometimes expressed 
pixel in the computer’s memory. See a

port A connector on a computer or control
modem port, printer port, control unit

primary value field The value field inside a cue which hol
dissolve rate in a Dissolve cue or the p

printer port The communications port on the back
printer symbol. See also port, modem

priority The ranking of a task. This is specified
window. Determines which task will g
the same device. See also task, device

property An attribute of a device, cue or other o
such as its position, color, level or rate



ter’s memory that holds tran-
 objects they manipulate. The 

uter is switched off. See also 

mputer’s memory, typically 
tem or other information that 
 computer is switched off. See 

t is non-volatile and semi-
alter the contents of a FLASH 
 complicated than changing 

a timeline and restoring them, 
e timeline is running. This can 
le, a soundtrack.

rs, such as < and ≥, resulting 
ed to compare variables to 
pression, variable, constant.

ication standard commonly 
e for shorter distances (up to a 
ent device, full duplex, serial 

ion standard used by some 
er distances than RS-232C, 
ee also balanced signal, intel-

op.
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RAM Random Access Memory. The part of the compu
sient data, such as application programs and the
RAM memory is usually cleared when the comp
ROM, non-volatile.

ROM Read Only Memory. The permanent part of a co
containing parts of the computer’s operating sys
never changes. This memory is retained when the
also RAM, non-volatile.

FLASH memory A memory technology, used in TOUCHLINK, tha
permanent. A specific procedure is required to 
memory, which is significantly slower and more
the contents of a RAM memory.

re-recording The process of temporarily removing cues from 
one at a time, by pressing the space-bar while th
be used to synchronize the cues with, for examp

relational expression A logical expression using the relational operato
in a true or false value. Such expressions are us
other variables or constants. See also logical ex

RS-232C An unbalanced, full duplex, serial data commun
used by intelligent devices, modems, etc. Suitabl
few meters). See also unbalanced signal, intellig
data.

RS-422 A balanced, full duplex serial data communicat
professional intelligent devices. Suitable for long
but may still have problems with ground loops. S
ligent device, full duplex, serial data, ground lo
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RS-485 A balanced, half duplex, serial data communication standard used by some 
professional intelligent devices. This is basically a half-duplex variant of the 
RS–422 standard. DMX-512 is a variant of RS-485, which improves upon the 

evice to be isolated from the bus in order 
-512, half duplex, serial data, ground 

s of TRAX, causing it to evaluate all 
ible tasks. This is done by clicking the 

f the Task window or by pressing 
non-modal TRAX window. See also eval-

s you to run a show but not make 

standardized way of connecting periph-
canners, to a computer. Used on most 

ing it one bit at a time, thereby reducing 
mmunication. This method is used by 
 such as RS-232C and RS-485. An alter-
at the same time, using individual wires. 
e SCSI standard and by the internal bus 

th Mac OS. In addition to opening text 
s those captured from the screen by 
Mac OS.
RS–485 standard by requiring each d
to avoid ground loops. See also DMX
loop.

running the tasks list Activating the full multi-tasking abilitie
conditions in the task list and start elig
play symbol in the lower left corner o
Command-spacebar from within any 
uate, condition, task, multitasking.

runtime version A limited version of TRAX which allow
changes to it.

SCSI Small Computer Systems Interface. A 
eral devices, such as hard disks and s
Mac OS computers.

serial data A method of transferring data by send
the number of wires needed for the co
most data communications standards,
native method is to send multiple bits 
That method is used for example by th
in a computer.

Simple Text A simple text editor that’s included wi
files, it can also open pictures, such a
pressing Command-Shift-3. See also 



rs – the North American 
 name for the timecode stan-
timecode, fps, EBU.

 the Task window which, 
e task’s action to be started. 
sk.

e mutually exclusive. See also 

h the timeline will pause auto-
s controlled with the down-
te control.

e physical counterpart of a 
ample, a pin-number on a 
 lighting dimmer controlled 
separated from the main 
ess, port.

per expression; e.g. the part 

ol units, going from the OUT 
 next. This bus carries a full 
signal.
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SMPTE Society of Motion Picture and Television Enginee
equivalent of EBU. Sometimes used as a generic
dard maintained by the organization. See also 

starting condition A logical expression in the Condition column of
together with the condition variant, can cause th
See also logical expression, condition variant, ta

state A named setting of a mode. States in a mode ar
mode, device-specific mode, mutually exclusive.

status property See device status property.

stop track A track along a timeline containing cues at whic
matically. Used for speaker support presentation
arrow key on the keyboard or an AIRLINK remo

sub-address An additional address used to further qualify th
TRAX device. This can be used to specify, for ex
DIGITAL SMARTLINK or a specific channel on a
through a SMARTPAX port. The sub-address is 
address digits by an apostrophe. See also addr

sub-expression A part of an expression that in itself forms a pro
5 * 6 of the expression 5 * 6 + 9 / 2.

symbol See operator.

system cable The black cable running between Dataton contr
connector of one unit to the IN connector on the
duplex, optically isolated, balanced serial data 

system run mode See running the task list.
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task An entry in the Task window, consisting of the following parts: condition, 
condition variant, priority and action. See also condition, condition variant, 
priority, action, multi-tasking, running the task list.

ges in linear relation to time, such as the 
lso discrete-position device.

e-continuous device with equally 
mbers are often expressed in hours, 
ng to the SMPTE or EBU timecode stan-
e count, such as a frame number on a 
y possible to tell an intelligent device to 
ecific video frame), as well as to know 
 synchronize, for example, a timeline to 
e-continuous device.

uence of cues. Each cue has a time posi-
ack. By running the timeline, the cues are 
sing them to perform as programmed. A 
ice, to another timeline, or free running. 
oned. When re-positioned, it will calcu-
the new position. See also cue, track, 

g which you can place cues (see also 
annel on an audio or video tape.

f a logical expression. See also false, 
time-continuous device A device that has a position that chan
current position of a video tape. See a

timecode A method to mark the medium of a tim
spaced, increasing numbers. These nu
minutes, seconds and frames, accordi
dards. Alternatively, it can be a simpl
video disc. Using this data, it is usuall
locate an arbitrary position (e.g., a sp
exactly where the device is in order to
the device. See also SMPTE, EBU, tim

timeline A kind of task action containing a seq
tion along the timeline, and sits on a tr
applied to their assigned devices, cau
timeline can be synchronized to a dev
A timeline can be paused or re-positi
late the correct status of its devices at 
action, priority, device assignment.

track 1. A horizontal part of a timeline alon
timeline, cue). 2. A separate audio ch

true The other of the two possible results o
logical expression.



n signal ground. This method 
is more susceptible to noise 
so balanced signal, RS-232C.

d in the SMPTE/EBU timecode 
e application. You can 
SMARTLINK.

een evaluations. In TRAX, the 
This may be a status property 
t exists in the system, or virtual 
 virtual device.

ime-continuous device, for 
m another device. See also 

ally change its own resistance 
eshold. Used to prevent the 
uch as relays and motors, 
onent damage. See also arch 

n’t have any physical counter-
le to keep track of statistics in 

ntation on a panel. See also 

mecode data can be included 
rtical blanking intervals 
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unbalanced signal A signal sent over a single wire relative a commo
is used by the RS-232C serial data standard. It 
than a balanced signal, such as RS-422. See al

user bits Extra data bits included with timecode as define
standards. The purpose of these bits vary with th
program these bits from TRAX by using a TAPE 

variable A value in an expression that may change betw
status properties of the devices act as variables. 
of a real device, for which a physical counterpar
device. See also expression, evaluate, constant,

vari-speed The ability to gradually change the speed of a t
example in order to chase timecode coming fro
time-continuous device, chase-lock.

varistor An electrical component with the ability to drastic
when the voltage across it exceeds a certain thr
high-voltage spikes caused by inductive loads, s
which could otherwise result in arching and comp
suppression.

virtual device A device in the TRAX Device window which does
part in the system. Used as a variable, for examp
order to use this in a task condition or for prese
device, variable.

VITC Vertical Interval Timecode. A method by which ti
as part of the video signal by putting it in the ve
between video frames. See also timecode, LTC.
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Index Audio Disc device
configuring 141
status properties 140

LINK 335
ization 220
, 388, 392, 409
, downloading in 68
114, 240
LE 339

129, 206, 409

ges, of panels 159, 251, 409
atible mode 16

l 409

 use with time device 153

 410
pe sensor 390

dshaking 304

ors 101
 level device 149
Numerics
1/0 column in Task window 57
12V DC ADAPTOR 345
12V DC INJECTOR 345

A
AC PAX 340
acknowledge, in serial driver 304
action 409
ADB port 409
address, of device 118, 409
AIRLINK 10, 88, 231, 244, 346

receiver 351
speaker support applications 347
transmitter 346
use in fully interactive applications 348
use with slide projectors 349

Alphasync 378, 385
ANALOG SMARTLKINK 334
animate 202
anonymous mode 294
arc suppression 328, 333, 409
Arion 378, 386
arithmetic symbols 98
ascend, dissolve cue option 195
ASCII 266, 409

AUDIO SMART
audio synchron
autolocator 372
automatic mode
automatic start 
AUXILIARY CAB
auxiliary relay 
AVL 378, 386

B
background pa
backward comp
balanced signa
bar graph 171
bar graph item,
bau drate 285
baud rate 274,
beginning-of-ta
big endian 310
big notes 399
blend 194
block mode han
boardroom 235
boolean operat
boost output, in
branching 261

Hint
Click a page number to go to that page.
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f 59

, 328

t 215

, 357, 373, 376, 384, 411
ws 405

0
ening a show 4, 114
9

424 Index

bring to front 84
button 163

action 161, 164
colors 166
icon 167
kind 165
linking to a numeric status property 161
shape 166
text 167

byte hi/lo 310

C
cable length, maximum between units 8
calendar functions 153
canned presentation 220
CAV disc format 146, 410
CD player 141
chapter numbers, on laserdiscs 144
chase-lock 410
choose button, in device 117
Clay Paky 336
clear command 81
clipboard 78
clock 153, 258
CLV disc format 146, 410
colors, of panels items 158
comments 218
computer port, selection in device 117
condition 411

conditional execution, of c
conditions 245

editing 55
evaluating the result o
variants 57, 411

constant 411
constants

using in conditions 58
contact closures 130, 242
control cue 212

finding by name 85
jump to 213
pause 214
perform only if... 216
run 214
special names of 217
stop 214
synchronization offse
syncronize to 214
target timeline 212

control signal 16, 18, 225
converting older TRAX sho
copy command 78
copying between shows 8
copyright notice, while op
countdown timer 153, 25
counter 259
crossfade 194
cue menu 95, 180
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cue track 16, 18, 225, 373, 376, 411
cue types

control 212

gray line below 107
grouping 91, 184
importing from other shows 76, 183

 184

g the keyboard 38
9
lue 181
lue field 417
, 185
g 43
rapbook 184

 list view 48
enu 95

ng 43
n of 182
ment 182

itution 181
s 180
s, importing 76
8

285, 411

45
45
dissolve 194
flash 202
gang 210
locate 186
note 218
set/fade 190
snap 204
trigger 206
wipe 200
zoom 198

cues 178, 411
adding to menu 180
adding to the menu 180
assigning to devices 40
black line below 107
creating 34, 95, 178
customizing 95, 180
deleting from menu 93
device assignment 183
distributing 89
duplicating 82
editing 178
editing in list view 49
editing specifications 40
expanding/compressing 90
general characteristics of 179
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picture item
color fidelity of 175
options 176
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presentation software, controlling 337
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printer port 2, 111, 417
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settings 282
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value, specifying in trigger cue 314
version 284
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serial port 2, 111
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level 193
live edit 193
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creating new 73
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saving 75
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show device status 93
show slide numbers 110
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cycle time 125
flashing 125
preferences for 110
remote control of 349
sequencing 124
status indication 125
status properties 128
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status properties 147
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stop track 105, 420
stopping a fading 128, 191
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sub-expression 101, 420
switch 206
switch closures 242, 328
Switch device
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input 130
mutually exclusive in group 130
output 130
status of 131
status properties 132
virtual 129

symbol menu 96
symbols 420

arithmetic 98
logical 101

precedence of 97
relational 100

synchronization 220, 337
offset 215

synchronizing a timeline t
synchronizing cues 43
system cable 8, 420
System cue 405
SYSTEM IN/OUT SMART
system modes 16, 112
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tab key, in timeline windo
tape control window 397
Tape device

configuring 133
recording 136
status of 135
status properties 140

tape remote cable 392
tape signals 373
TAPE SMARTLINK 337
task 421
Task window 15



Index 437

tasks
adding 51
copying between shows 52

time format
in locate cue 189
in time device 152

tions 153, 258
eline 107

 on panels 153
337, 374, 375, 384, 421
 373
 devices 186, 421

 position of 30
s 42

adout 41
time position 103
ndow 29

ile running 105
ength of 31
nother 106
04
tomatically 105
. pausing 42
ng 214
ng to a device 42

9, 107
, 29
deleting 52
editing action of 51
ID number of 62, 121
moving 52
priority 52
priority vs. panel items 162
running 60, 419
selecting 52
starting 420
starting automatically 58
starting condition 53

text 218
text device
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timeline settings command 103
timelines

control cue 212
creating 102
jumping to a time position 213
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pausing 214
priority 52
settings 103
starting 214
starting from other timeline 228
stopping 214
synchronizing to a device 223

timers 153, 259
toggle, button action 164
touch panel 246, 342
TOUCHLINK 10, 246

buttons on side 165
cable, extending 345
color fidelity of pictures 175
contrast, adjusting 343
Graphics Sampler 3
motion sensor 165
mounting accessories 344
power supply 344
sound 169
specifications 343
wall mount kit 344

tracks 421
in timeline window 32
locking 33, 105
renaming 32

TRANSPAX+ 11
autolocator 372
CODE selector 384
connecting 133, 369
control signal 376
front panel 379
HOME button 387
IN connector 379
MODE selector 382
OUT connector 379
PLAY connector 380,
power supply 388, 3
rear panel 388
RECORD connector 3
remote control 392
signal types 373
system modes 369
tape adaptors 392
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trigger 206
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output control 207
play 207
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serial driver 313
switch 206
toggle 206
transport 207
with serial device 154
with tape device 135
with video disc device 143, 145

turn-key installation 114
twinkle 202
type pop-up menu, in device 116
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volume control 
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weekday 258
window menu 102
windows

closing 73
moving and resizing 22
note 398, 399
opening and closing 20, 102
tape control 397, 402

wipe 200
direction of 201
lamp rates 201
with slide projector 1

wireless remote control 34

Z
zoom 198

lamp rates 199
sequencing of 199
with slide projectors 1
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